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Using This Manual
This preface is divided into the following sections:

1.The Contents of This Manual

2.Typographical Conventions

1. The Contents of This Manual

This document provides information about using the Fluent application within Workbench.

A brief description of what is in each chapter follows:

• Getting Started With Fluent in Workbench (p. 21), describes an overview of Fluent within Workbench.

• Working With Fluent in Workbench (p. 49), describes the details of using Fluent within Workbench.

• Appendix A: The Fluent Ribbon Tab Under Workbench (p. 595), describes the differences in the Fluent
File ribbon tab within Workbench.

• Appendix B: The Fluent Meshing Menu under Workbench (p. 601), describes the differences in the
Fluent Meshing File menu within Workbench.

• Appendix C: The Workbench Tools Toolbar Commands (p. 603), describes the Workbench Tools
toolbar that is available in Fluent when running within Workbench.

2. Typographical Conventions

Several typographical conventions are used in this manual’s text to help you find commands in the
user interface.

• Different type styles are used to indicate graphical user interface items and text interface items.
For example:

Iso-Surface dialog box

surface/iso-surface text command

• The text interface type style is also used when illustrating exactly what appears on the screen
to distinguish it from the narrative text. In this context, user inputs are typically shown in boldface.
For example,

solve/initialize/set-fmg-initialization

 Customize your FMG initialization:
   set the number of multigrid levels [5]

   set FMG parameters on levels ..

    residual reduction on level 1 is:  [0.001]
    number of cycles on level 1 is:  [10]  100

    residual reduction on level 2 is:  [0.001]
    number of cycles on level 2 is:  [50]  100

xv
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• Mini flow charts are used to guide you through the ribbon or the tree, leading you to a specific
option, dialog box, or task page. The following tables list the meaning of each symbol in the
mini flow charts.

Table 1: Mini Flow Chart Symbol Descriptions

Indicated ActionSymbol

Look at the ribbon

Look at the tree

Double-click to open task page

Select from task page

Right-click the preceding item

For example,

Setting Up Domain → Mesh → Transform → Translate...

indicates selecting the Setting Up Domain ribbon tab, clicking Transform (in the Mesh group
box) and selecting Translate..., as indicated in the figure below:

And

Setup → Models → Viscous Model → Realizable k-epsilon

indicates expanding the Setup and Models branches, right-clicking Viscous, and selecting
Realizable k-epsilon from the Model sub-menu, as shown in the following figure:
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And

Setup → Boundary Conditions → velocity-inlet-5

indicates opening the task page as shown below:
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In this manual, mini flow charts usually accompany a description of a dialog box or command,
or a screen illustration showing how to use the dialog box or command. They show you how to
quickly access a command or dialog box without having to search the surrounding material.

• In-text references to File ribbon tab selections can be indicated using a "/". For example
File/Write/Case... indicates clicking the File ribbon tab and selecting Case... from the Write
submenu (which opens the Select File dialog box).
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Part I: General Applications

• Getting Started With Fluent in Workbench (p. 21)

• Working With Fluent in Workbench (p. 49)

• Getting Started with Fluent Meshing in Workbench (p. 103)





Chapter 1: Getting Started With Fluent in Workbench
This document is designed to provide information about using Fluent within Ansys Workbench. Some
basic information about using Workbench is provided here, but the majority of the information about
using Workbench can be found in the Workbench online documentation.

This chapter provides some basic instructions for getting started with using Fluent in Workbench.

1.1. Introduction to Workbench

1.2.The Workbench Graphical User Interface

1.3. Creating Fluent-Based Systems

1.4. Understanding Cell States with Fluent in Workbench

1.5. Starting Fluent in Workbench

1.6. Registering and Unregistering Startup Scheme Files

1.7. Saving Your Work in Fluent with Workbench

1.8. Exiting Fluent and Workbench

1.9. An Example of a Fluent Analysis in Workbench

1.10. Getting Help for Fluent in Workbench

1.1. Introduction to Workbench

Ansys Workbench combines access to Ansys applications with utilities that manage the product workflow.

Applications that can be accessed from Workbench include: Ansys DesignModeler and Ansys SpaceClaim
Direct Modeler (for geometry creation); Ansys Meshing (for mesh generation); Ansys Fluent or CFX (for
setting up and solving fluid dynamics analyses); and Ansys CFD-Post (for postprocessing the results). In
Workbench, a project is composed of a group of systems. The project is driven by a schematic workflow
that manages the connections between the systems. From the schematic, you can interact with work-
spaces that are native to Workbench, such as Design Exploration (parameters and design points), and
you can launch applications that are data-integrated with Workbench (such as Ansys Fluent or CFX).
Data-integrated applications have separate interfaces, but their data is part of the Workbench project
and is automatically saved and shared with other applications as needed. This makes the process of
creating and running a CFD simulation more streamlined and efficient.

Workbench allows you to construct projects composed of multiple dependent systems that can be up-
dated sequentially based on a workflow defined by the project schematic. For instance, you can construct
a project using two connected Fluent-based systems where the two systems share the same geometry
and mesh; and the second system uses data from the first system as its initial solution data. When you
have two systems connected in this way, you can modify the shared geometry once and then update
the results for both systems with a single mouse click without having to open the Ansys Meshing ap-
plication or Fluent. Some examples of when this is useful include: performing a reacting flow analysis
starting from the solution obtained from a cold flow analysis; performing a second order analysis
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starting from the solution obtained from a first order analysis; and performing a transient simulation
starting from the solution obtained from a steady-state analysis.

In addition, Workbench also allows you to copy systems in order to efficiently perform and compare
multiple similar analyses. Workbench also provides a parametric modeling capabilities in conjunction
with optimization techniques to allow you to efficiently investigate the effects of input parameters on
selected output parameters.

For more information, see the following section:

1.1.1. Limitations

1.1.1. Limitations

The following limitations are known when using Fluent in Workbench:

• Fluent design point studies using the Remote Solve Manager may not completely update due to
errors. Should this happen, you can rerun the affected design points and they will update as expected
(you may have to rerun failed design points multiple times).

• Workbench units and options are not passed to Fluent.

• The text user interface (TUI) shortcuts, or aliases, for reading case and data files for Fluent in
Workbench are disabled by design. For example,file read-case, f read-case, and f r-
c can be used, however f rc cannot be used.

• The version of Fluent used under Workbench must always be the version of Fluent that was packaged
and installed with that version of Ansys Workbench. It is not possible to use previous versions of
Fluent under Workbench even through a Fluent Inc. environment variable.

• Graphical user interface (GUI) journal files in Fluent 2021 R2 are not backwards compatible. That
is, Workbench journal files (*.wbjn files) created in version 12.0 or version 12.1 that contain Fluent
GUI commands may need to be recreated if they fail due to a change in the Fluent graphical user
interface or a string used therein.

• For older Fluent in Workbench projects (prior to version 2021 R2), when making any changes to
the mesh using Ansys Meshing (for example, renaming a surface), you should first open Fluent using
the Setup cell of the Fluid Flow (Fluent) analysis system in order for Fluent to be aware of the up-
stream mesh changes (for example, when detecting upstream zone name changes).

• Changing the meshing method to "Assembly Meshing" methods (for example, CutCell) from other
meshing methods may not preserve the previously defined contact regions. Currently, the Fluent
simulation workflow does not support this type of change.

Note:

Ansys Fluent only allows a period to be used as a decimal separator. If your system is set
to a European locale that uses a comma separator (for example, Germany), fields that accept
numeric input may accept a comma, but may ignore everything after the comma. If your
system is set to a non-European locale, numeric fields will not accept a comma at all.

Ansys Workbench accepts commas as decimal delimiters. These are translated into periods
when data is passed to Ansys Fluent.
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1.2. The Workbench Graphical User Interface

The Workbench graphical user interface (Figure 1.1: The Workbench Graphical User Interface (p. 24))
consists of the Toolbox, the Project Schematic, the Toolbar, and the Menu bar. The most common way
to begin work in Workbench is to drag an item, such as a component system (application) or an analysis
system, from the Toolbox to the Project Schematic, or to double-click an item to initiate the default
action. You will view your component and/or analysis systems – the pieces that make up your analysis
– in the Project Schematic, including all connections between the systems. The individual applications
in which you work will display separately from the Workbench graphical interface, but the actions you
take in the applications will be reflected in the Project Schematic.

Important:

Note that Fluent can be accessed in Workbench as either a component system or as an ana-
lysis system. Details for using both are described throughout this document.
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Figure 1.1: The Workbench Graphical User Interface

Important:

Note that Fluent in Workbench uses informational, question, and warning dialog boxes that
are designed to guide you in various ways as you work through your CFD analysis. Informa-
tional dialog boxes display messages that assist you in a specific task, or provide additional
information relating to the task at hand. Question dialog boxes present questions concerning
a task that is about to be performed, displaying an OK and a Cancel button in order to enable
you to choose from one of two options (to proceed or not to proceed). Warning dialog boxes
contain only an OK button and are designed to display a cautionary message indicating that
you need to be aware that the application is about to change something or has internally
changed something to maintain the consistency.

Note:

You can set various Fluent–specific preferences in Workbench (for example, Launcher settings).
For more information, see Configuring Workbench in the Workbench User's Guide.
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1.3. Creating Fluent-Based Systems

There are two basic types of systems: analysis systems and component systems. The following Fluent-
based systems are available in Workbench:

• The Fluid Flow (Fluent) analysis system enables you to perform a complete CFD analysis and contains
cells that allow you to create geometry, generate a mesh, specify settings in Fluent, run the Fluent solv-
er, and visualize the results in CFD-Post.

• The Fluent component system enables you to access the Fluent application from within Workbench and
contains only the cells needed to specify settings in Fluent and run the Fluent solver. When using a
Fluent component system, a mesh must be imported into the system or provided through a connection
from an upstream system.

• The Fluent (with Fluent Meshing) component system enables you to generate a mesh, specify settings
in Fluent, and run the Fluent solver. For this system, you can provide a geometry through the upstream
connection and use a journal file to automatically generate a mesh for your application.

Note:

A separate cell for results visualization is only needed when using CFD-Post. The postpro-
cessing capabilities in Fluent can be accessed from both the Fluid Flow (Fluent) analysis
system and the Fluent component system.

To create an analysis or component system in Workbench: In the Toolbox, double-clicking the desired
system under Analysis Systems or Component Systems, respectively. Or you can click the system and
drag it onto the Project Schematic. Notice that when you hover over systems in the Toolbox, a tool
tip appears.

For more information, see the following sections:

1.3.1. Fluent-Based Analysis Systems

1.3.2. Fluent-Based Component Systems

1.3.1. Fluent-Based Analysis Systems

The Fluid Flow (Fluent) analysis system is found in the Toolbox under Analysis Systems.

Figure 1.2: Selecting the Fluid Flow (Fluent) Analysis System in Workbench
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When you create the new Fluid Flow (Fluent) analysis system in Workbench (as described above),
it appears in the Project Schematic as a box containing several cells (Figure 1.3: A Fluid Flow (Fluent)
Analysis System (p. 26)). Each cell corresponds to a typical task you would perform to complete a
CFD analysis.

Figure 1.3: A Fluid Flow (Fluent) Analysis System

The following cells are available in a Fluid Flow (Fluent) analysis system:

Geometry

allows you to define the geometrical constraints of your analysis. You can perform the following
operations:

• Import a pre-existing geometry into your system by using the context menu accessible through
right-clicking the cell.

• Create a new geometry either in Ansys SpaceClaim Direct Modeler (Windows only) or Ansys
DesignModeler. The geometry editor is launched by either double-clicking the Geometry cell
or right-clicking the cell and selecting an appropriate geometry option from the cell context
menu. On Windows machines, the default geometry editor is SpaceClaim. You can change the
preferred geometry editor to Ansys DesignModeler in the Options dialog box (Tools → Options
→ Geometry Import → Geometry Import → Preferred Geometry Editor).

• Modify an existing geometry. Note that double-clicking a Geometry cell opens the geometry
in the most recently used editor. You can also launch the editor of your choice by selecting
the corresponding context menu option.

Mesh

allows you to define and generate a computational mesh for your analysis. Double-clicking the
Mesh cell opens Ansys Meshing and loads the current mesh database (or the geometry defined
by the Geometry cell) if you have not yet begun working on the mesh. Alternatively, you can
use the context menu (by right-clicking the Mesh cell) to import a pre-existing Fluent mesh into
the system.

Important:

• Importing a Fluent mesh file into the Mesh cell results in the Mesh cell becoming
the starting point for your analysis (and the name of the Mesh cell changes to Im-

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.26

Getting Started With Fluent in Workbench



ported Mesh). Therefore, the Geometry cell (and data it contains) will be deleted
from the system. The deleted Geometry cell can be retrieved by selecting Reset
from the context menu of the Imported Mesh cell.

• Fluent meshes imported into the Mesh cell cannot be modified by the Ansys Mesh-
ing application.

Setup

allows you to define the boundary conditions, physical models and solver settings for the Flu-
ent analysis. Double-clicking the Setup cell opens Fluent and loads the mesh defined by the Mesh
cell as well as any Fluent settings that have already been specified. Alternatively, you can use the
context menu (by right-clicking the Setup cell) to import a pre-existing Fluent case or mesh file
into the system. After you specify the file you want to import, Fluent will open and load the file.

Important:

• If you open Fluent before defining a mesh, Fluent will open without loading any
files. You can then choose to import files from the File ribbon tab in Fluent.

• Importing a Fluent case or mesh file into the Setup cell or the Fluent application
results in the Setup cell becoming the starting point for your analysis. Therefore,
the Geometry and Mesh cells (and any data they contain) will be deleted from the
system.

Solution

allows you to calculate a solution in Fluent. Double-clicking the Solution cell opens Fluent and
loads the current Fluent case and data files. If you have not yet performed any calculations, Flu-
ent will load the mesh file as well as any settings that have been specified.

Important:

You can also use the Solution cell context menu to import a pre-existing Fluent data
file to use for initial solution data. If you have not yet performed any calculations, Flu-
ent will load this data file in addition to the mesh and settings.

Results

allows you to display and analyze the results of the CFD analysis. Double-clicking the Results cell
opens CFD-Post and loads the current Fluent case and data files as well as the current CFD-Post state
file.

Note:

While it is possible to apply different names for the Setup or the Solution cells by right-
clicking either cell, and selecting the Rename command in the context menu, it is not
generally recommended to do so.
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1.3.2. Fluent-Based Component Systems

The Fluent and Fluent (with Fluent Meshing) component systems are found in the Toolbox under
Component Systems.

Figure 1.4: Selecting the Fluent Component System in Workbench

Fluent Component System

When you create a new Fluent component system in Workbench (as described above), it appears in
the Project Schematic as a box containing two cells: Setup and Solution (Figure 1.5: A Fluent
Component System (p. 29)).
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Figure 1.5: A Fluent Component System

The Setup and Solution cells in a Fluent component system work in the same manner as described
above for the Fluid Flow (Fluent) analysis system (see Fluent-Based Analysis Systems (p. 25)). The
only difference is that the mesh must originate from a file imported into the Setup cell or the Flu-
ent application, or it must be provided through a connection from an upstream system.

Fluent (with Fluent Meshing) Component System

When you create a new Fluent (with Fluent Meshing) component system in Workbench, it appears
in the Project Schematic as a box comprising three cells: Mesh, Setup, and Solution.

Figure 1.6: A Fluent (with Fluent Meshing) Component System

By double-clicking the Mesh cell, you can access Fluent Meshing, and define and generate a compu-
tational mesh for your problem. Upon opening, Fluent Meshing will automatically load either the
current mesh data or, if the mesh data is not available, the geometry defined in the upstream Geometry
cell. Otherwise, you can import input data file(s) directly into Fluent Meshing.

The Setup and Solution cells work in the same way as in the Fluid Flow (Fluent) analysis system
(see Fluent-Based Analysis Systems (p. 25)).

1.4. Understanding Cell States with Fluent in Workbench

Workbench integrates multiple data-integrated (for example, Fluent) and native applications into a
single, seamless project flow, where individual cells can obtain data from and provide data to other
cells. Workbench provides visual indications of a cell’s state via icons on the right side of each cell. Brief
descriptions of the each possible state are provided below. For more information about cell states, see
the Workbench online help:

• Unfulfilled ( ) indicates that required upstream data does not exist. For example, when you first
create a new Fluid Flow (Fluent) analysis system, all cells downstream of the Geometry cell appear
as Unfulfilled because you have not yet specified a geometry for the system.
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• Refresh Required ( ) indicates that upstream data has changed since the last refresh or update. For
example, after you assign a geometry to the Geometry cell in your new Fluid Flow (Fluent) analysis
system, the Mesh cell appears as Refresh Required since the geometry data has not yet been passed
from the Geometry cell to the Mesh cell.

• Attention Required ( ) indicates that the current upstream data has been passed to the cell, however,
you must take some action to proceed. For example, after you launch Fluent from the Setup cell in
a Fluid Flow (Fluent) analysis system that has a valid mesh, the Setup cell appears as Attention
Required because additional data must be entered in Fluent before you can calculate a solution.

• Update Required ( ) indicates that local data has changed and the output of the cell must be regen-
erated. For example, after you launch Ansys Meshing from the Mesh cell in a Fluid Flow (Fluent)
analysis system that has a valid geometry, the Mesh cell appears as Update Required because the
Mesh cell has all the data it needs to generate a Fluent mesh file, but the Fluent mesh file has not
yet been generated.

• Up-To-Date ( ) indicates that an update has been performed on the cell and no failures have occurred
(or an interactive calculation has been completed successfully). For example, after Fluent finishes
performing the number of iterations that you request, the Solution cell appears as Up-to-Date.

• Interrupted, Update Required ( ) indicates that you have interrupted an update (or canceled an
interactive calculation that is in progress). For example, if you select the Cancel button in Fluent while
it is iterating, Fluent completes the current iteration and then the Solution cell appears as Interrupted,
Update Required.

• Input Changes Pending ( ) indicates that the cell is locally up-to-date, but may change when next
updated as a result of changes made to upstream cells. For example, if you change the Mesh in an
Up-to-Date Fluid Flow (Fluent) analysis system, the Setup cell appears as Refresh Required, and
the Solution and Results cells appear as Input Changes Pending.

• Pending ( ) indicates that a batch or asynchronous solution is in progress. When a cell enters the
Pending state, you can interact with the project to exit Workbench or work with other parts of the
project. If you make changes to the project that are upstream of the updating cell, then the cell will
not be in an up-to-date state when the solution completes.

If a particular action fails, Workbench provides a visual indication as well. Brief descriptions of the failure
states are described below.

• Refresh Failed, Refresh Required ( ) indicates that the last attempt to refresh cell input data failed,
and so the cell must be refreshed.

• Update Failed, Update Required ( ) indicates that the last attempt to update the cell and calculate
output data failed, and so the cell must be updated.

• Update Failed, Attention Required ( ) indicates that the last attempt to update the cell and calculate
output data failed, and so the cell requires attention.

If an action results in a failure state, you can view any related error messages in the Messages pane by
clicking the Show Messages button on the lower right portion of Workbench.
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1.5. Starting Fluent in Workbench

This section describes how to start Fluent in Workbench using Fluent-based systems and how you can
use Fluent Launcher within Workbench.

For more information, see the following sections:

1.5.1. Starting Fluent from a Fluent-Based System

1.5.2. Specifying Fluent Launcher Settings Within Workbench

1.5.3. Specifying Other Setup and Solution Cell Settings

1.5.1. Starting Fluent from a Fluent-Based System

You can start Ansys Fluent by double-clicking the Setup cell in a Fluid Flow (Fluent) analysis system
or a Fluent component system. Fluent launches and loads the Setup cell’s input data (for example,
mesh) and the Setup cell’s local data, if it exists (for example, Fluent settings or setup output case
file). If no mesh has been specified, Fluent launches and waits for your input.

You can also start Ansys Fluent by double-clicking the Solution cell in a Fluid Flow (Fluent) analysis
system or a Fluent component system. Fluent launches and loads the current case and data files, as
well as the Setup cell’s input data (for example, mesh), the Setup cell’s local data, if it exists (for ex-
ample, Fluent settings), and the Solution cell’s initial data, if it exists. If no mesh has been specified,
Fluent launches and waits for your input.

Important:

When Fluent is launched from the Setup cell, it loads only the mesh and settings that
served as the starting point for your analysis and are associated with the Setup cell. In
order to load the current case and data files or the initial data file, you must launch Flu-
ent from the Solution cell.

1.5.2. Specifying Fluent Launcher Settings Within Workbench

You can use Fluent in Workbench on either Windows or Linux machines, both interactively and in
batch mode. You can also start Fluent on Linux from a Workbench session running on Windows and
you can use the same Fluent-specific project (and related files) in Workbench using both Linux and
Windows hardware interchangeably. The information is this section is the same for both Windows
and Linux, except where noted.

When you start Ansys Fluent from either type of Fluent-based system within Workbench, Fluent
Launcher will appear by default. Most Fluent Launcher settings are available, except for the following
options:

• Version (disabled)
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• Working Directory (disabled)

Note:

In some instances, the working directory shown in the Fluent Launcher may not match
the true working directory. You can confirm the working directory in Fluent by entering
pwd into the Fluent console.

The Do not show this panel again option allows you to bypass Fluent Launcher for subsequent
Fluent sessions. This option is only available when running Fluent in Workbench.

Important:

When using LSF to schedule a Fluent run from Workbench, by default the working directory
is used for checkpointing. You can specify an alternate directory for checkpointing using
the LSB_CHKPNT_DIR environment variable.

Important:

Note that, when using Fluent with Workbench on Linux, the Fluent Root Path option is
disabled in the General tab of Fluent Launcher.

To start your Fluent simulation on a Linux cluster from a Workbench session running on Windows,
use the Use Remote Linux Nodes option in Fluent Launcher. This option is available in the Remote
tab (visible when you click the Show More Options button).

Important:

The Remote tab of Fluent Launcher can only be used for 64-bit Linux machines.

Important:

If you are using the Select IP Interface option in the Parallel tab of Fluent Launcher, the
selected interface address is not saved. As a workaround, you can define the FLU-
ENT_HOST_IP=host:ip-address environment variable.

For more information about Fluent Launcher, see Starting Ansys Fluent Using Fluent Launcher. For
more information about using Fluent Launcher to access remote Linux clusters, see Setting Remote
Options in Fluent Launcher.

1.5.2.1. Specifying Fluent Launcher Settings Using Cell Properties

You can view the properties of a selected cell in Workbench by selecting the Properties option
under the View menu, or by right-clicking a cell and selecting Properties from the context menu.
The properties of the selected cell are displayed in the Properties pane in Workbench.
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Figure 1.7: Properties for Fluent-Based Systems in Workbench

The Fluent-based system Setup and Solution cells have the following properties that you can set
for Fluent Launcher:

Use Setup Launcher Settings

(for Solution cells only) allows you to specify that the current systems Solution cell should use
the Fluent Launcher property settings from the current system’s Setup cell. By default, the
Fluent-based system Setup and Solution cells share Fluent Launcher settings, however, if re-
quired, these settings can be set autonomously using this property.

Precision

allows you to choose either the single-precision or the double-precision solver

Show Launcher at Startup

allows you to show or hide Fluent Launcher when Fluent starts.

Display Mesh After Reading

allows you to show or hide the mesh after the mesh or case/data is read into Fluent.

33
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Starting Fluent in Workbench



Embed Graphics Windows

allows you to embed the graphics windows in the Fluent application window, or to have them
free-standing.

Set up Compilation Environment for UDF

allows you to specify compiler settings for compiling user-defined functions (UDFs) with Fluent.

Use Job Scheduler

allows you to specify settings for running Fluent with the available job scheduler. On Linux, you
can use either LSF, SGE, PBS Pro or Slurm as the job scheduler. On Windows, you can use the
Microsoft Job Scheduler, or, when Run Parallel Version and Use Remote Linux Nodes are
selected, you can use the LSF, SGE, PBS Pro or Slurm job schedulers.

Run Parallel Version

allows you to choose to run the parallel version of Fluent or not.

UDF Compilation Script Path

(if Set up Compilation Environment for UDF is selected) allows you to specify the path to the
UDF compilation script.

Initialization Method

allows you to initialize your Fluent simulation. Available options are:

• Program Controlled (default) allows Fluent to use any existing results (solution data) to ini-
tialize the solution.

– For a new calculation, if no results are available, then the system initializes the solution
using the settings specified in Fluent.

– For existing projects, if the system is not connected to another upstream system
through the Solution cell, then the system uses results available from the previous
calculation. If the results are not compatible with the mesh, then the system initializes
the solution using the settings specified in Fluent.

– For existing projects, if the system is connected to another upstream system through
the Solution cell, then the Initialization Method is not available for the downstream
Solution cell. In this case, the downstream Solution cell always uses results coming
from the upstream Solution cell to initialize its solution for the initial design point
(DP0) as well as any other design points. If the solution data file from the upstream
Solution cell is not available or not compatible with the mesh, then Workbench uses
the upstream data interpolation (*.ip) file for solution initialization. If the *.ip file
is also not available, or the results are not compatible with the mesh, then the system
initializes the solution using the settings specified in Fluent.

• Solver Controlled allows Fluent to always initialize the solution using settings specified in
Fluent, enforcing the initialization method available in Fluent for new and existing projects.
This option is not available for Solution cells connected with upstream Solution cells.
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• Use Solution Data from File allows you to import a solution data file (*.dat) or data inter-
polation file (*.ip) that Fluent will use to initialize the solution. If selected, you are prompted
to provide an Initial Data File. For new and existing calculations, the Solution cell uses a
registered file as the initial data in Workbench.

For more information, see Using the Update Command (p. 55).

Use Remote Linux Nodes

(available only when Run Parallel Version is selected) allows you to run your Fluent simulation
on 64-bit Linux machines.

If Run Parallel Version is selected, the following additional properties are available:

Number of Processors

allows you to set the number of processors you want to use for the parallel calculations (for
example, 2, 4, and so on).

Interconnect

allows you to set the interconnects you want to use for the parallel calculations (for example,
infiniband).

MPI Type

allows you to set the MPI type you want to use for the parallel calculations (for example, intel,
msmpi, and so on).

Use Shared Memory

allows you to specify if shared memory is to be used or not.

Machine Specification

(if Use Shared Memory is not selected) allows you to specify a list of machine names, or a file
that contains machine names.

Machine List

(if Use Shared Memory is not selected and Machine List is selected as the Machine Specific-
ation) allows you to specify a list of machine names to run the parallel job.

Machine Filename

(if Use Shared Memory is not selected and File Containing Machine List is selected as the
Machine Specification) allows you to specify the name of the file that contains a list of machines
to run the parallel job.

If Use Remote Linux Nodes is selected, the following additional properties are available (for 64-
bit Linux machines only):

Remote Fluent Root Path

allows you to specify the remote Fluent Linux installation root path.
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Use Specified Remote Working Directory

allows you to specify a directory other than temp directory as the working directory for the
remote Linux nodes. When this property is selected, you can specify the directory in the Remote
Working Directory property that appears.

Use Remote Cluster Head Node

allows you to specify the remote node that Fluent will connect to for spawning (for example,
via ssh). When this property is selected, you can specify the remote node in the Remote Host
Name property that appears.

Important:

When the PBS Pro option is selected for the Job Scheduler, the host specified
in the Use Remote Cluster Head Node field should be the PBS Pro submission
host.

If Use Job Scheduler is selected, the following additional properties are available:

Computer Cluster Head Node Name

allows you to specify the name of the compute cluster head node.

Job Template

(available only when running Microsoft HPC Pack 2008 or newer) allows you to create a custom
submission policy to define the job parameters for an application. The cluster administrator can
use job templates to manage job submission and optimize cluster usage.

Node Group

(available only when running Microsoft HPC Pack 2008 or newer) allows you to specify a collection
of nodes. Cluster administrators can create groups and assign nodes to one or more groups.

Processor Unit

(available only when running Microsoft HPC Pack 2008 or newer) allows you to choose the fol-
lowing:

• Core refers to a single, named host in the cluster.

• Socket refers to a set of processors with a dedicated memory bus. This is also known
as a non-uniform memory access (NUMA) node.

• Node refers to an individual CPU on a node. For example, a dual-core processor is con-
sidered two cores.

Start When Resources Are Available

allows you to start the job when resources are available.
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Create Job Submission XML

allows you to create the job submission XML file.

Job Submission XML File

(if Create Job Submission XML is selected) allows you to specify the name of the job submission
XML file.

If Use Job Scheduler and Use Remote Linux Nodes are selected, the following additional properties
are available:

Job Scheduler

allow you to specify the job scheduler for the remote Linux nodes. Available options are LSF
(the default), SGE, PBS Pro, or Slurm.

If LSF is selected as the job scheduler, the following additional properties are available:

Use LSF Queue

allows you to use an LSF queue.

LSF Queue

(when Use LSF Queue is selected) allows you to specify the name of the LSF queue.

Use Checkpointing

allows you to use checkpointing with LSF.

Enable Automatic Checkpointing

(when Use Checkpointing is selected) allows you to automatically checkpoint within a
specific period of time.

Checkpointing Period

(when Use Checkpointing and Enable Automatic Checkpointing are selected) allows you
to specify a time period for automatic checkpointing.

Important:

When using LSF to schedule a Fluent run from Workbench, by default the working
directory is used for checkpointing. You can specify an alternate directory for
checkpointing using the LSB_CHKPNT_DIR environment variable.

If SGE is selected as the job scheduler, the following additional properties are available:

SGE Qmaster

allows you to set the machine in the SGE job submission host list.
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SGE Queue

allows you to set the queue where you want to submit your Fluent jobs. Leave this field
blank if you want to use the default queue.

SGE PE

allows you to set the parallel environment where you want to submit your Fluent jobs.
Leave this field blank if you want to use the default parallel environment.

Use SGE Settings

allows you to use SGE settings.

SGE Settings

(when Use SGE Settings is selected) allows you to specify SGE settings.

Important:

When running Fluent in Workbench via SGE, there may be instances when not
enough time is allotted for Fluent to start. By default, Workbench performs two
steps: starting the Fluent process and establishing initial contact, with a default
wait time of one minute; completing the Fluent start up process and establishing
a final connection (for example, to spawn parallel nodes, to checkout licenses,
and so on), with a default wait time of five minutes. You can change the waiting
time increments for each step by defining the Fluent_WB_MAX_STARTUP_WAIT
environment variable before starting Workbench. Note that you cannot define
this environment variable within Fluent Launcher. The value of this environment
variable is equivalent to the wait time in minutes for each start up step. So, the
overall wait time is double the value specified for the environment variable.
Fractions are allowed as values for the environment variable, and any value less
than or equal to zero will let Workbench wait indefinitely for Fluent to start. Note
that while Workbench is waiting for Fluent to start, the Workbench interface is
locked, and if, for some reason Fluent fails to start, you will have to manually kill
the Workbench session.

If PBS Pro is selected as the job scheduler, the following additional property is available (on
Linux only):

PBS Submission Host

(optional) allows you to specify the name of the PBS Pro submission host if the machine
you are using to run Workbench cannot submit a job to PBS Pro.

If Slurm is selected as the job scheduler, the following additional properties are available:

Slurm Submission Host

allows you to specify a machine to submit jobs to Slurm if the machine you are using to run
Workbench cannot submit to Slurm.
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Slurm Partition

allows you to request a specific partition for the resource allocation.

Slurm Account

specify the Slurm account.

Important:

When running Fluent in Workbench via Slurm, there may be instances when not
enough time is allotted for Fluent to start. By default, Workbench performs two steps:
starting the Fluent process and establishing initial contact, with a default wait time
of one minute; completing the Fluent start up process and establishing a final con-
nection (for example, to spawn parallel nodes, to checkout licenses, and so on), with
a default wait time of five minutes. You can change the waiting time increments for
each step by defining the Fluent_WB_MAX_STARTUP_WAIT environment variable
before starting Workbench. Note that you cannot define this environment variable
within Fluent Launcher. The value of this environment variable is equivalent to the
wait time in minutes for each start up step. So, the overall wait time is double the
value specified for the environment variable. Fractions are allowed as values for the
environment variable, and any value less than or equal to zero will let Workbench wait
indefinitely for Fluent to start. Note that while Workbench is waiting for Fluent to
start, the Workbench interface is locked, and if, for some reason Fluent fails to start,
you will have to manually kill the Workbench session.

These properties are the same as the settings within Fluent Launcher. For more information about
Fluent Launcher, see the Fluent Getting Started Guide.

Properties for Setup and Solution cells related to problem setup and solution processes are discussed
in Specifying Other Setup and Solution Cell Settings (p. 40).

1.5.2.2. Copying Fluent Launcher Property Settings

Typically, Fluent Launcher settings are specified in the Fluent Launcher dialog box when Fluent is
launched from the Setup cell.

By default, the Solution cell uses the same Fluent Launcher property settings as the Setup cell. If
you want the Solution cell’s Fluent Launcher settings to be different than those specified for the
Setup cell, you can disable the Use Setup Launcher Settings property setting (see Specifying
Fluent Launcher Settings Within Workbench (p. 31)) and then set the Solution cell’s Fluent
Launcher property settings without impacting the settings for the Setup cell.

You can copy the Setup cell’s Fluent Launcher settings to the Solution cell by selecting the Copy
Launcher settings to Solution cell command from the Setup cell’s context menu (available only
when the Use Setup Launcher Settings property setting is disabled). Note that the values that are
written are retained, even if you later disable this setting. Likewise, you can also copy the Solution
cell’s Fluent Launcher settings to the Setup cell by selecting the Copy Launcher settings to Setup
cell command from the Solution cell’s context menu (available only when the Use Setup
Launcher Settings property setting is disabled).
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1.5.3. Specifying Other Setup and Solution Cell Settings

The Setup cell has the following property related to the problem setup process:

• Others

– Generate Output Case File: enables or disables the generation of the setup output case
file, name-Setup-Output.cas.h5. If the state for the Setup cell is Update Required and the
upstream mesh has not been modified, Fluent will read the output case file (name-Setup-
Output.cas.h5) as opposed to the mesh and settings files when editing the Setup cell. This
way you can improve the Fluent run time speed provided the upstream mesh data has not
changed.

The output case file will be generated when

→ recorded mesh operations (Recording Mesh Manipulation Operations and Resolving
Mesh Incompatibility in Fluent (p. 76)) have been performed prior to running the
simulation in Fluent, or

→ Fluent session is started with a mesh file only

This setting overrides the Enable Generation of Setup Output Case File preference in the
Options settings.

The Solution cell contains additional general properties and some specific properties related to the
solution process:

• General

– Component ID: the name of the cell (not editable).

– Directory Name: the name of the directory (“FFF”) where solution files are located (not
editable).

– Use Setup Launcher Settings: enables or disables the use of the Setup cell's Fluent
Launcher settings (see above).

– Solution Monitoring: allows you to be able to graphically view Fluent solution convergence
and monitor data without having Fluent open. When this option is enabled, you can use
the Show Solution Monitoring option in the Solution cell context menu to display a con-
vergence and monitor charts. This property overrides the Enable Solution Monitoring
preference in the Options settings.

Note:

→ A report definition will only be included in a solution monitor chart if it is in-
cluded in a report plot.

→ Each report plot will be shown as a separate solution monitor chart.

→ A single report definition will only appear once in the solution monitor charts,
even if that report definition is included in multiple report plots.
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– Generate Solution Monitor Plots for Report: when selected, Fluent will automatically
generate the report images during a Solution cell update or project report export. See
Generating Fluent Project Reports (p. 68) for information about exporting project reports
and the types of report images. This option is disabled by default.

– Data Interpolation: enables or disables the interpolation file generation at the end of the
Fluent solver run. The solver will automatically create an *.ip file that can be used when
restarting the Fluent session, even if the project mesh or case file has been modified and is
no longer compatible with the existing data file (if available). This setting overrides the Enable
Generation of Interpolation File preference in the Options settings. Note, that you can
use the Clear Generated Data command to delete the generated interpolation file (see
Using the Clear Generated Data Command (p. 61) for details).

• Solution Process

– Update Option: enables the solution process to be either Run in Foreground (solutions
are run within the current Workbench session), Run in Background (solutions are run in
the background on the local machine), or Submit to Remote Solve Manager (solutions are
run in the background by submitting the solution to Remote Solve Manager (RSM)). For
more information about these options and the Remote Solve Manager, refer to Submitting
Solutions to Remote Solve Manager in the Ansys Workbench User's Guide.

1.6. Registering and Unregistering Startup Scheme Files

You can register or unregister a customized Scheme file through your Fluent setup using the context
menu for the Fluent Setup cell. Fluent loads this registered scheme file at startup. To register a scheme
file, use the Register Startup Scheme File... command from the context menu for the Fluent Setup
cell. Likewise, to unregister a scheme file, use the Unregister Startup Scheme File... command. If Fluent
is already started, these menu commands are disabled and grayed out.

1.7. Saving Your Work in Fluent with Workbench

Data that is read into and written by Fluent when it is run within Workbench is split into two parts:

• Setup data

• Solution data

Setup data is the data used to start a simulation over from the beginning. This data is associated with
the Setup cell and includes the mesh (.msh.h5) file and the settings (.set) file.

Important:

• The settings file is a file used when Fluent is run under Workbench. It contains the case
settings but does not contain mesh data. The settings file and the mesh file are read by
Fluent whenever Fluent is launched from the Setup cell.

• Note that sometimes, instead of a mesh file, a case file (.cas.h5) is used to represent
the mesh. In this situation, Fluent reads the case file first and then reads the settings file
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if it exists. Therefore, the settings stored in the settings file will overwrite any settings that
might be contained in the case file.

Solution data is the data that results from performing a calculation and is used to restart a simulation
from existing data. This data is associated with the Solution cell and includes the current case (.cas.h5)
file and the current data (.dat.h5) file.

Important:

The case file and the data file are read by Fluent whenever Fluent is launched from the
Solution cell.

When working in Workbench, your work in Fluent is automatically saved as needed. For example,
whenever you close Fluent or save your Workbench project, your unsaved data is automatically saved.

You can save your Workbench project directly from Fluent by selecting Save Project command under
the File ribbon tab.

File → Save Project

Alternatively, you can save your Workbench project by selecting the Save command under the File

menu within Workbench or by clicking the Save Project icon ( ) from the Workbench toolbar.

1.8. Exiting Fluent and Workbench

You can end your Fluent session by using the Close Fluent command under the File ribbon tab.

File → Close Fluent

If you want to end your Fluent session without saving your work, you can use the Close Without Save
command under the File ribbon tab. You can also use the corresponding text command (file/close-
without-save).

File → Close Without Save

Alternatively, to discard unsaved changes in Fluent and load the setup files into the current Fluent
session, you can use the Reload command in the Fluent  File ribbon tab (see Reloading Data and Syn-
chronizing Fluent with Workbench (p. 60) for details).

File → Reload

You can end your Workbench session by using the Exit command under the Workbench File menu.

File → Exit

All open applications that are associated with your Workbench session, including any open instances
of Ansys Fluent, are automatically closed upon exiting Workbench. If there is any unsaved data in
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Workbench or any of the open applications associated with your Workbench session, you will be
prompted to save your project before exiting Workbench.

Important:

There are several other circumstances in which open instances of Fluent as well as other
applications are automatically closed:

• Whenever you close the current project in Workbench, all open applications are
automatically closed.

• Whenever you open a different project in Ansys Workbench, all open applications
associated with the original project are automatically closed.

• Whenever a system is deleted, all open applications associated with that system are
automatically closed.

• Whenever data is reset or cleared from a cell, all open applications associated with
that cell are automatically closed.

1.9. An Example of a Fluent Analysis in Workbench

This example describes when the files that are generated and used by Fluent are written and how the
cell states change as you work with a Fluent-based system in Workbench.

1. Add a new Fluid Flow (Fluent) analysis system to the Project Schematic. The state of the Geometry
cell is Attention Required and that the states for the Mesh, Setup, Solution, and Results cells are
Unfulfilled.

2. Import a geometry file by using the context menu on the Geometry cell. The state of the Geometry
cell becomes Up-to-Date and the state of the Mesh cell becomes Refresh Required.
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3. Double-click the Mesh cell. The Ansys Meshing application launches and loads the geometry file.
The state of the Mesh cell becomes Update Required.

4. In the Ansys Meshing application, specify settings for the mesh, then select the Update command.
The mesh is generated, the mesh (.msh) file is written, the state of the Mesh cell becomes Up-to-
Date, and the state of the Setup cell becomes Refresh Required.

5. Double-click the Setup cell. Fluent launches and loads the mesh file. The state of the Setup cell
becomes Attention Required.
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6. In Fluent, specify boundary conditions, initialize the solution, and enter a nonzero number of iterations
on the Run Calculation task page. The state of the Setup cell becomes Up-to-Date, and the state
of the Solution cell becomes Refresh Required.

7. In the Fluent application, select the Calculate button. The settings (.set) file is written and iterations
begin. The state of the Solution cell becomes Update Required.

Iterations are completed, or the solution meets the convergence criteria. The state of the Solution
cell becomes Up-to-Date and the state of the Results cell becomes Refresh Required.
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8. Double-click the Results cell. CFD-Post launches.

The case (.cas.h5) and data (.dat.h5) files are written, CFD-Post loads the case and data files,
and the state of the Results cell becomes Up-to-Date.

1.10. Getting Help for Fluent in Workbench

Accessing help from within Ansys Workbench:

Workbench offers three levels of help:

• Quick help - available for most cells in a system. Click the blue triangle in the bottom right corner of
the cell to see a brief help description on that cell. For Fluent-based systems, Fluent-specific quick
help is available for the Setup and Solution cells, providing you with instructions for proceeding
further. For example:
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• Sidebar or context-sensitive help - available at any time by clicking F1.

• Online help - available from the Help menu, or from any of the links in the quick help or sidebar
help.

For more information about Workbench help, see the online documentation.

Accessing help from within Fluent:

Fluent documentation and help can be accessed by clicking  once the Fluent application is running.
The documentation is automatically installed when you install Workbench.
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Chapter 2: Working With Fluent in Workbench
This chapter provides instructions for using Fluent in Workbench.

2.1. Importing Fluent files in Workbench

2.2. Using the Update Command

2.3. Refreshing Fluent Input Data

2.4. Reloading Data and Synchronizing Fluent with Workbench

2.5. Deleting Solution and Setup Cell Data for Fluent-Based Systems

2.6. Interrupting, Restarting, and Continuing a Calculation

2.7. Monitoring Fluent Solutions in Workbench

2.8. Generating Fluent Project Reports

2.9. Connecting Systems in Workbench

2.10. Duplicating Fluent-Based Systems

2.11. Recording Mesh Manipulation Operations and Resolving Mesh Incompatibility in Fluent

2.12. Changing the Settings and Mesh in Fluent

2.13. Case Modification Strategies with Fluent and Workbench

2.14.Working With Input and Output Parameters in Workbench

2.15. Reduced Order Model (ROM) Evaluation in Fluent

2.16.Viewing Your Fluent Data Using Ansys CFD-Post

2.17. Understanding the File Structure for Fluent in Workbench

2.18.Working with Ansys Licensing

2.19. Using Fluent With the Remote Solve Manager (RSM)

2.20. Using Custom Systems

2.21. Using Journaling and Scripting with Fluent in Workbench

2.22. Performing Fluent and Maxwell Coupling in Workbench

2.1. Importing Fluent files in Workbench

In Ansys Workbench, you can import Fluent mesh, case, and data files into a Fluent-based system in
one of the following ways:

• from the Workbench Project Schematic

• from within the active Fluent session

The information about importing Fluent files in Workbench is described in details in the following sec-
tions:
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2.1.1. Importing files from Workbench Project Schematic

2.1.2. Importing Files Directly in Fluent

2.1.1. Importing files from Workbench Project Schematic

The details of how you can import various file types into a Fluent-based system from Workbench
Project Schematic are provided in the following sections:

2.1.1.1. Importing Mesh and Case Files

2.1.1.2. Importing Solution Files

2.1.1.3. Importing Case and Data Files

2.1.1.1. Importing Mesh and Case Files

You can import Fluent mesh (*.msh*) and case (*.cas*) files into Fluent-based system using the
Import Fluent Case command in Setup cell context menu as follows:

1. Right-click the Setup cell.

2. From the cell’s context menu, point to Import Fluent Case and then click Browse....

3. (For mesh files only) In the Open dialog box, select the Fluent Mesh File type from the drop-
down menu next to File name.

4. Browse to the location of a specific case or mesh file and select the file.

Expected Outcome:

• Mesh file import: Once the import operation is complete, the Setup cell status becomes Attention

Required ( ).

You can launch Fluent to commence the setup procedure.

• Case file import: Once the import operation is complete, the Setup cell status becomes one of
the following:

– Attention Required ( ) – if the iterations or time step of the imported case is set to 0.

You can launch Fluent to commence the setup procedure.

– Up-To-Date ( ) – if the case iterations or time step of the imported case is set to a positive
value.

You can either proceed directly to the solution stage, or you can first alter the setup settings
by editing the Setup cell.

If the Setup cell already has setup information associated with it, the setup information is deleted.

If your Fluent-based system contains a Mesh cell, Ansys Workbench informs you that the imported
information will not be compatible with the information coming from the Mesh cell and asks
whether the Mesh cell (and Geometry cell, if it also exists) should be deleted and replaced by the
mesh from the imported file.
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If your Fluent-based system has a connection to a Mesh cell in an upstream system, Ansys Workbench
informs you that the mesh is being provided to the current system from an upstream system and
asks whether the connection should be deleted and the mesh replaced with the mesh from the
imported file.

2.1.1.2. Importing Solution Files

You can import Fluent solution files as start-up files or as final results as described below.

2.1.1.2.1. Importing Fluent Solution Files for the Purpose of Initialization

If you want to use the solution file as a start-up file, you can import the following files:

• *.dat or *.dat.gz – if imported results match the mesh used at the setup stage

• *.ip (interpolation file) – if imported results do not match the mesh used at the setup stage

To import the solution file as a start-up file into the Fluent-based system:

1. In the Properties pane for the Solution cell, select Use Solution Data from File from the
Initialization Method drop-down list.
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2. In the Initial Data File cell that appears below Initialization Method enter the filename (in-
cluding path) or navigate to the file location and select the file.

For the alternative procedure on importing initial results within Fluent, see Importing Files Directly
in Fluent (p. 54).

Expected Outcome:

Importing an initial data file does not affect the state of the system. When the case and "initial"
data files are imported into Fluent, Ansys Workbench treats them as start-up files and not results

files. Therefore, the state of the Solution cell becomes Refresh Required ( ) and not Up-to-
Date ( ).
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Once the Solution cell is in the Refresh Required state, the old data generated in previous runs
will be deleted when you Refresh or Update the cell (including autosaved data files).

Important:

The Use Solution Data from File option is not available if the Solution cell is connec-
ted to the up-stream component.

2.1.1.2.2. Importing Data Files as Final Results

You can also import a Fluent final data set (for example, a legacy Fluent data or a large data set
solved on an external cluster) into a Fluent-based system. Using this approach, you can:

• Immediately perform postprocessing on the results using Ansys CFD-Post, or

• Directly transfer the data to another system in Ansys Workbench (for example, to perform one-
way fluid-structure interaction (FSI) analysis).

To import the solution file as final results into the Fluent-based system:

1. Right-click the Solution cell.

2. From the cell’s context menu, point to the Import Final Data and then click Browse....

3. When prompted, browse to the location of a specific data file and select the file.

4. If the Data Interpolation option is enabled for the Solution cell, then you will be prompted
about .ip file generation.

If you click Yes in the dialog box, then the Solution cell becomes Update Required, otherwise
it will remain Up-to-Date.

Expected Outcome:

The state of the Solution cell becomes Up-to-Date ( ).

For unsteady cases only:

• If the last time-step data file is imported as a final data set, then Ansys CFD-Post can load all
the previous time-step data as well, provided:

– All case/data file pairs are originally generated by Fluent and their base names are the
same.

– All of the previous time-step data files are copied into the same Workbench Fluent
system directory (you must do this manually) where the last data file is located (for ex-
ample, dp0/FLU/Fluent). You can see the location of the final data file by enabling
Files from the View drop-down menu. Here you can also confirm that the previous time-
step files are also located in the same folder.

– The case file imported into the Setup cell is the same as that of original case file (includ-
ing the filename).
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• If you want to use Ansys CFD-Post (the Results cell or component system) downstream of your
Fluent system into which you have imported a pair of case and data files with different names,
then you need to perform at least one iteration in Fluent in Workbench. When you close Fluent
or save the Workbench project, Ansys Workbench automatically saves the new data file with
the same name as the case file. Alternatively, you can manually rename the case and data files
to have the same base filename prior to importing the final data set.

• The Solution cell does not extract any of the solution history information from the imported
data file, and further calculations will result in loss of this information. Performing additional
calculations changes the solution history, however, it does not affect the data that has been
loaded into Ansys CFD-Post.

2.1.1.3. Importing Case and Data Files

You can also import Fluent final result files with corresponding case files into Fluent-based system
in a single step using the Import Fluent Case And Data command in the Setup cell context menu:

1. Right-click the Setup cell.

2. From the cell’s context menu, point to Import Fluent Case And Data and then click Browse....

3. When prompted, browse to the location of a specific case or mesh file and select the file.

4. If the Data Interpolation option is enabled for the Solution cell, then you will be prompted
about .ip file generation.

If you click Yes in the dialog box, then the Solution cell becomes Update Required, otherwise it
will remain Up-to-Date.

Expected Outcome:

The states of the Setup and Solution cells become Up-to-Date ( ).

Important:

Imported case and data files must share the same name for the importing operation to
work properly.

2.1.2. Importing Files Directly in Fluent

Alternatively, you can also import pre-existing mesh, case, and data files from within Fluent by using
one of the following ribbon tab items:

File → Import → Case...

File → Import → Data...

File → Import → Case and Data...

When mesh and case files are imported from within Fluent using these commands, the behavior is
exactly the same as when files are imported from the Project Schematic.
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When data file is imported directly into Fluent using these commands, they are treated as initialization
data. In this case, the behavior is the same as when using the Use Solution Data from File option
in the Properties pane for the Solution cell (for details, see Importing Fluent Solution Files for the
Purpose of Initialization (p. 51)).

In addition, you can also import the mesh from pre-existing mesh and case files from within Fluent by
using the following ribbon tab item:

File → Import → Mesh...

When using this command, Fluent gives you the following two options:

• Discard Case, Read New Mesh: discards any settings information currently in Fluent and imports
the specified file. If the specified file is a case file, the settings information from that case file is also
imported.

• Replace Mesh: preserves the settings information currently in Fluent and imports only the mesh
from the specified file.

2.2. Using the Update Command

The Update command is available from:

• the context menu of all cells

• the context menu for the system

• the Workbench toolbar

• the Workbench  Tools menu

• the context menu for the Project Schematic

• the Workbench Tools toolbar in Fluent ( ) (not available for Fluent (with Fluent Meshing) com-
ponent systems) (For more information, see Appendix C: The Workbench Tools Toolbar Com-
mands (p. 603).)

When selected from a cell, the Update command updates the current cell and all upstream cells that
must be updated to bring the current cell Up-to-Date. When a cell is updated, any new upstream data
is passed to it before performing the update command.

When selected from the system, the Update command updates all of the out-of-date cells in the current
system, as well as any cells in upstream systems that must be updated to bring the current system Up-
to-Date.

When selected from the Workbench Toolbar, the Workbench  Tools menu, or the context menu for the
Project Schematic, the Update command updates all out-of-date cells in the project.

When updating the Solution cell in a Fluent-based system, the following steps take place:

1. Fluent launches in the background.
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2. Fluent performs either the number of iterations (or time-steps) specified in the settings or case file
or the number of iterations required to reach convergence.

3. Fluent writes the following files:

• case file

• data file

• data interpolation file, name.ip

The data interpolation file will be generated when Data Interpolation is selected in the Solution
cell properties. Fluent will use this file as a restart data file in future sessions, but only if the
solution data file becomes incompatible with the mesh.

If you select the Data Interpolation property after completing calculations, the state of the
Solution cell will change to Update Required. Upon the next update, Fluent will only write the
.ip file.

Note:

If the data interpolation file is not available and the upstream mesh has not been
modified, Fluent will use the regular data file (.dat.h5) as a restart file.

• output case file, name-Setup-Output.cas.h5

The output case file will be generated when

– the Setup cell property Generate Output Case File is enabled, and

– mesh operations have been performed prior to running the simulation in Fluent.

• solution transcript file Solution.trn

• residual file SolutionMonitor.gz (if Solution Monitoring is enabled in the Properties pane
for the Solution cell) and miscellaneous files for generating reports (see Generating Fluent Project
Reports (p. 68) for details).

• image files for any graphics objects that are defined, such as contours and vectors. You can turn
this feature on/off by toggling the Generate Post Processing Images option in the properties
of the Solution cell in Workbench (right-click the Solution cell and select Properties).

4. If Data Interpolation is cleared in the Solution cell properties, Fluent removes the existing .ip file
(if available).

5. Fluent exits.

If Fluent is already open, you can use the Update toolbar command from the Update

Mesh/Setup/Solution tool ( ) drop-down menu to bring the state of the system cells Up-To-Date.

While updating the Solution cell, you can visually monitor the solution convergence data for your Fluent
simulations in Workbench using the solution monitoring charts, if Solution Monitoring is enabled in
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the Properties pane for the Solution cell. See Monitoring Fluent Solutions in Workbench (p. 64) for
more information.

Important:

When an update is performed on a Solution cell and a Fluent session from the same system
as that Solution cell is open, the calculation will be performed in that open Fluent session.
This may not result in the action that you intended, therefore it is recommended that you
close any open Fluent sessions before executing an Update command. For example, if you
have specified initial data using either a connection from an upstream solution cell or by
importing initial data into the Solution cell and you open Fluent from the Setup cell of the
system, the initial data is not loaded (see Starting Fluent from a Fluent-Based System (p. 31)).
If you subsequently perform an Update, the calculation will be performed in the open Flu-
ent session and the initial data you specified will not be used as the starting point.

The Update command is particularly useful when you make changes to upstream data that impact
downstream data. For example, if you start with an Up-to-Date Fluid Flow (Fluent) analysis system
and then modify the mesh in the Ansys Meshing application, you can simply select Update from the
system’s context menu to generate the new results.

When performing an Update, you can specify whether the Solution cell in a Fluent-based system should
be updated starting from existing solution data, case file data, or from an imported data file. This is
specified by selecting an appropriate Initialization Method option from the Solution cell Properties
pane (see Specifying Fluent Launcher Settings Using Cell Properties (p. 32)).

The Initialization Method options for the Solution cell in a Fluent-based system will always have the
highest priority.

If you perform parametric studies, you can use the following Design Point Initiation options in Prop-
erties of Schematic for Parameter Set:
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Figure 2.1: The Properties Pane of the Parameter Set

• From Current: Fluent uses the Initialization Method specified in the Solution cell properties (see
Specifying Fluent Launcher Settings Using Cell Properties (p. 32)). Additionally, if Program Controlled
or Use Solution Data from File options are selected and the mesh compatible solution data file is
available, Fluent uses this data to initialize subsequent design point studies, or

• From Previous Updated: Fluent uses the last computed design point’s data file to initialize the
solution for the next design point (that is, DP2 uses DP1's data file, DP5 uses DP4's data file, and so
on).

If the solution data is not available, or if the solution data is not compatible with the updated solution
mesh, Fluent initializes the solution using the methods set in the case file. The available initialization
methods in Fluent, relevant to Design Point studies in Workbench, consist of the following:

• The Initialization Method set in the Solution Initialization task page in Fluent.

• Specify a case modification strategy (see Case Modification Strategies with Fluent and Work-
bench (p. 86)).

Initial data can also be specified by:
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• Importing an initial data file into the Solution cell or the Fluent application (see Importing Fluent
files in Workbench (p. 49)).

• Creating a connection from an upstream Solution cell (see Connecting Systems in Workbench (p. 69)).

If you have imported an initial data file or created a connection to specify initial data, that data will
override the initialization method specified on the Solution Initialization task page. If you have a case
modification strategy defined, the initialization step in that strategy will always be performed regardless
of whether initial data is specified in any other way.

Important:

• There is also an Update command in the Ansys Meshing application which generates the
mesh and creates the input files required by downstream cells. The Generate Mesh com-
mand in the Ansys Meshing application generates the mesh but does not produce any
input files. If a connection is made from an up-to-date Mesh cell, the state of the Mesh
cell may become Update Required, indicating that the Ansys Meshing application needs
to generate an additional input file. This file can be generated by selecting the Update
command from the context menu of the Mesh cell. If you try to open Fluent before the
Mesh cell is updated, a warning message is displayed informing you that you must update
the Mesh cell before you can start Fluent, since the mesh file required for Fluent does not
yet exist.

• Whether you edit the project through the Setup or Solution cells, your project’s postpro-
cessing settings in Fluent (including any surface definitions that you may have created),
are saved at the start of iteration or when you close Fluent. When Fluent is later opened
from either cell, these new settings will be available. Changes made to postprocessing
settings in Fluent do not affect cell state.

2.3. Refreshing Fluent Input Data

You can refresh the input data for a cell by right-clicking the cell and selecting the Refresh command
from the context menu. The Refresh command passes modified upstream data to the cell but does not
conduct any long-running operations to regenerate the cell’s output data.

For example, you can refresh the mesh by right-clicking the Setup cell in Workbench and selecting the
Refresh command from the context menu. The state of the Setup cell becomes Update Required. It
will become Up-to-Date the next time you launch Fluent from the Setup cell, or if you select the Update
command from the context menu of the Setup cell.

You can refresh the input data for the Setup cell in a Fluent-based system by using either the Refresh
command from the cell’s context menu or, if Fluent is already open, by selecting the Refresh Input
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Data option in the Fluent  File ribbon tab, or using the Refresh Input Data of Mesh/Setup/Solution

toolbar button ( ).

Important:

• Selecting the Update command from the context menu performs a Refresh command (if
needed) before performing the Update command. You do not need to perform a Refresh
and an Update in two separate steps.

• If you open Fluent after making a modification to the mesh and without refreshing the
input data, you will be asked whether you want to load the modified mesh before Flu-
ent launches.

• If Fluent is open and you make a modification to the mesh, you will be informed that the
upstream mesh has changed and asked whether you want to load the new mesh before
proceeding.

2.4. Reloading Data and Synchronizing Fluent with Workbench

When performing multiple preliminary investigative analyses with Fluent in Workbench (for example,
establishing the most suitable solver settings) your Fluent settings are changed multiple times. In order
to quickly and safely discard recently unsaved changes in your Fluent settings and to read input data
from the Setup cell, you can use the Reload command in the Fluent File ribbon tab:

File → Reload

or the corresponding Reload toolbar command from the drop-down menu of the Mesh ( ), Setup

( ), or Solution ( ) Cell Commands. Reloading information will discard any changes performed in
the current session and will delete any corresponding generated data from the Solution cell. This
command is available only if input data is present. See Appendix C: The Workbench Tools Toolbar
Commands (p. 603) for more details.

In addition, you can directly update Workbench with the most recent Fluent changes using the Sync
Workbench option in the Fluent File ribbon tab, or the corresponding Synchronize WB cell status

toolbar button ( ). You can also use the corresponding text command (file/sync-workbench).

2.5. Deleting Solution and Setup Cell Data for Fluent-Based Systems

The following sections describes how to delete solution and setup data for your Fluent-based systems
by using the Clear Generated Data command, the Reset command, and the Clear Old Solution Data
command.

2.5.1. Using the Clear Generated Data Command

2.5.2. Using the Reset Command from the Setup and Solution Cells of Fluent-Based Systems

2.5.3. Using the Clear Old Solution Data Command from the Solution Cells of Fluent-Based Systems
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2.5.1. Using the Clear Generated Data Command

You can delete all past and current generated files associated with a Mesh, Setup, or Solution cell
by right-clicking the cell and selecting the Clear Generated Data command from the context menu.
The following actions will be performed:

Solution cell: All past and current generated case and data files associated with the cell are deleted
and the Fluent application is closed if it is open. All solution monitoring data generated during the
run will be cleared from the Scene pane (if applicable).

Setup cell: output case file name-Setup-Output.cas.h5 (if available)

Mesh cell: generated mesh file (if available)

If the cell status is Up-to-Date, it will become Update Required when the Clear Generated Data
command is executed.

If Fluent is already open, you can use the corresponding Clear Generated Data command from the

drop-down menu of the Mesh ( ), Setup ( ), or Solution ( ) Cell Commands. See Ap-
pendix C: The Workbench Tools Toolbar Commands (p. 603) for more details.

2.5.2. Using the Reset Command from the Setup and Solution Cells of Fluent-
Based Systems

For either type of Fluent-based systems, you can delete all local and generated data from the Setup
cell or from the Solution cell by right-clicking either cell and selecting the Reset command from the
context menu.

For Setup cells, the Reset command removes the Setup cell’s references to the mesh file, deletes
the settings file associated with the Setup cell, sets the cell property values to their defaults, and
closes the Fluent application if it is open. If the Setup cell is Up-to-Date, it will become Refresh Re-
quired when the Reset command is executed.

For Solution cells, the Reset command deletes all past and current case and data files (not including
imported initial data files) associated with the cell, sets the cell property values to their defaults, and
closes the Fluent application if it is open. If the Solution cell is Up-to-Date, it will become Refresh
Required when the Reset command is executed.

If Fluent is already open, you can use the corresponding Reset command from the drop-down menu

of the Mesh ( ), Setup ( ), or Solution ( ) Cell Commands. See Appendix C: The Workbench
Tools Toolbar Commands (p. 603) for more details.

2.5.3. Using the Clear Old Solution Data Command from the Solution Cells
of Fluent-Based Systems

For either type of Fluent-based systems, you can delete all older local and generated data from the
Solution cell by right-clicking the cell and selecting the Clear Old Solution command from the
context menu.
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For Solution cells, the Clear Old Solution Data command retains only the most recent solution files
associated with the Solution cell, and removes older case and data files that are not part of the current
solution history. This command is only available if there are already solutions associated with the cell,
in addition to the most recent solution.

Note:

• Archived projects will only contain the most current solution files, and all solution files
that are associated with the current run (that is, solution history).

• While importing design points, the next design point (dp1) will contain only the last
data file of the current solution from the last design point (dp0).

2.6. Interrupting, Restarting, and Continuing a Calculation

The following topics are discussed in this section:

2.6.1. Interrupting a Calculation

2.6.2. Continuing and Restarting a Calculation

2.6.3. Recovering Case and Data Files after an Unexpected Interruption

2.6.1. Interrupting a Calculation

To interrupt the calculation in an interactive Fluent session, do one of the following:

• Click Cancel in the Working dialog box

• Press Ctrl+c

To interrupt an ongoing Fluent calculation from Workbench, click the  icon in the Progress pane
(see Progress Pane in the Workbench User's Guide for more details). This displays a prompt, asking if
you would like to interrupt or stop the calculations.

You can select from the following options:

• Interrupt: Stops the calculation at the next point where data can be safely stored for later use.
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• Abort: Stops the calculation immediately without concern for whether data associated with the
current action can be stored. Closes the associated Fluent session, if open.

Important:

When the calculation is interrupted from within an interactive Fluent session, it always
stops the data at the next point where data can be safely stored for later use.

When a calculation is interrupted, the state of the Solution cell becomes Interrupted, Update Re-
quired. If a background calculation is interrupted, Fluent writes the case and data file and then closes.

If you interrupt a calculation, review the results, and decide that the solution is converged, you can
force the Solution cell state to be Up-to-Date by right-clicking the Solution cell and selecting the
Accept Interrupted Solution as Up-to-Date command from the context menu.

2.6.2. Continuing and Restarting a Calculation

You can continue a previously interrupted Fluent calculation from within Workbench by right-clicking
the Solution cell and selecting Continue Calculation or Update from the context menu. This will
allow you to continue the calculation from the current case and data files, performing the total
number of iterations (or time-steps) specified in the case file.

If Fluent is already open, you can use the corresponding Continue toolbar command from the Update

Mesh/Setup/Solution tool ( ) drop-down menu. If you want to start the interrupted simulation

over, you can use the Restart toolbar command from the Update Mesh/Setup/Solution tool ( )
drop-down menu. See Appendix C: The Workbench Tools Toolbar Commands (p. 603) for more details.

2.6.3. Recovering Case and Data Files after an Unexpected Interruption

To recover the missing latest matching/compatible case and data files from the system folder:

1. Open Fluent from the Solution cell.

Warning:

Opening Fluent from the Setup cell will clear all solution data.

2. Select the File/Solution Files... ribbon tab item.

3. In the Solution Files dialog box, click Recover Missing Solution...

4. From the Solution Files at list, select the desired restart point, click Read and close the Solution
Files dialog box.

For more information, see Managing Solution Files in the Fluent User's Guide.

63
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Interrupting, Restarting, and Continuing a Calculation



2.7. Monitoring Fluent Solutions in Workbench

You can visually monitor solution convergence data for your Fluent simulations in Workbench using
solution monitoring charts. To control the display of the solution monitoring charts, select the Solution
Monitoring option in the Properties pane for the Solution cell.

Once this option is enabled, you can open the solution monitor workspace from within Workbench by
right-clicking a Fluent-based system Solution cell and selecting the Show Solution Monitoring command
from the context menu.

The Show Solution Monitoring command opens the Solution tab with an Outline pane for the
Solution Monitors cell (see Figure 2.2: Example of the Solution Monitors Outline Pane Within Work-
bench (p. 65)) and a chart for the system (see Figure 2.3: Example of a Fluent Scene Pane within Work-
bench (p. 67)).
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Figure 2.2: Example of the Solution Monitors Outline Pane Within Workbench

The Outline Pane

The following types of monitors are available in the Outline of Solution Monitor pane:

• Residual convergence monitors, such as Continuity, Energy, Velocity, and so on

• User-defined monitors that have been defined in Fluent, such as Surface, Volume, Lift, Drag, and
Moment based monitors.

The residual convergence monitors are grouped under the Residual group. User-defined monitors are
listed with their names specified in Fluent under corresponding monitor groups. The default names for
monitor groups have the following pattern: type-name , where type  is the type of user-defined
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monitor and name  is the monitor name defined in Fluent. You can edit the names of the monitor
groups directly in the cells. The monitor names can only be edited in Fluent.

The Scene Pane

As the Fluent simulation progresses, the convergence graphs are plotted interactively in the Scene
pane. By default, Workbench displays a fully populated residual convergence chart (for example, con-
tinuity, energy, velocity, and so on). The user-defined monitor charts (that is, force, moment, and integrals)
are not displayed by default. To view user-defined monitor plots, click the corresponding cell in the
Outline of Solution Monitor pane.

Once the solution is complete, or while the solution is progressing, right-click the cell for the appropriate
monitor group and select Remove Variable, Add Variables, or Add All Variables (if applicable) from
the context menu to add or remove available residual and/or user-defined monitors in the Fluent Scene
pane (see Figure 2.3: Example of a Fluent Scene Pane within Workbench (p. 67)). You can create a new
residual or user-defined chart by right-clicking the Solution Monitors cell in the Outline pane and se-
lecting Create Residual Monitor Chart or Create User-Defined Monitor Chart respectively from the
context menu.

The solution monitor chart is embedded in the Workbench Scene pane and once it is visible, it can be
hidden and displayed by disabling or enabling the View > Scene menu option, respectively. You can
save the chart that you are viewing as a graphic by right-clicking the background of the chart and se-
lect Save Image As from the context menu. You can alter the appearance of individual plots by changing
Color, Line Width and Symbol Size in the Properties pane for the correspondent plot cells. You can
control the settings for the monitor charts in the Scene pane using the Properties pane for the monitor
groups as described in Setting Chart Properties in the Workbench User's Guide.

Note:

Solution monitoring in Ansys Workbench provides only basic insight into the convergence
process of your simulation. To access full spectrum of solution monitoring features available
in Ansys Fluent, you need to run an interactive session in Fluent.

You can also monitor the solution convergence of any design points in your simulation. When you
perform an update of all design points during the calculation, the Design Point value (as shown in
Figure 2.2: Example of the Solution Monitors Outline Pane Within Workbench (p. 65)) changes internally
and will be in read-only mode. Once all of the design points are updated, you can change the Design
Point value (using the corresponding drop-down menu) to view the data of any design point. Once
the Design Point is selected, then the data of the selected system will be displayed in the Scene pane.

Note:

• For the following situations, solution monitoring data will become available only
at the end of the calculation and the chart will not be updated during the calcu-
lation:

– when you run a parametric study in the foreground and you update the
Solution cell in the background, or
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– when you remotely run a parametric study, for example, calculating design
points using the Remote Solve Manager (RSM) for the parameter set.

• All residual monitoring data is plotted with iteration number as X axis data. User-
defined monitors can be plotted with Iteration, Flow Time, or Time Step as the
X axis quantity.

Figure 2.3: Example of a Fluent Scene Pane within Workbench

For more information about using charts in Workbench, see Working with the Chart Pane.

The Fluent Transcript Pane

The Fluent Transcript pane displays the content of the Fluent solution transcript. To close the Fluent
Transcript pane, deselect it from the View menu of the Solution tab.
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In a design point study, you can review the solution transcript for each design point (if available) by
selecting the design point in the Properties pane for the Design Point cell as shown in Figure 2.2: Ex-
ample of the Solution Monitors Outline Pane Within Workbench (p. 65). By default, the transcript for
the current design point is displayed.

When simulating multiple systems, you can review the transcript for each system (if available) by clicking
any cell relevant to the system of interest in the Outline pane.

During the foreground or component-level local Remote Solve Manager (RSM) update of the system,
the Fluent Transcript pane will continue being updated with the solution progress information.

You can use the following standard keyboard short-cuts to navigate through the content displayed in
the Fluent Transcript pane:

• Page Up and Page Down to scroll up or down one page, respectively

• Ctrl+Home and Ctrl+End to jump to the top or the bottom of the transcript, respectively

The Fluent Result Image Pane

The Fluent Solution Images pane displays contour and vector plots that have been previously defined
in Fluent (see Creating and Using Contour Plot Definitions and Creating and Using Vector Plot Definitions
in the Fluent User's Guide for details). To access the Fluent Solution Images pane, select Fluent Solution
Images from the View menu of the Solution tab. You can use the scroll bar or standard navigation
keyboard buttons (Page Up, Page Down, Ctrl+Home and Ctrl+End) to view a desired plot.

Similar to the Fluent Transcript pane, if you are running a design point study, you can review solution
plots for each design point by selecting the desired design point in the Properties pane for the Design
Point cell.

To close the Fluent Solution Images pane, deselect it from the View menu of the Solution tab.

To return to viewing the Project Schematic, click the Project tab above the Workbench toolbar.

Note:

Fluent Solution Images are not populated when running Fluent in the background or via
the Remote Solve Manager.

2.8. Generating Fluent Project Reports

When you update a Solution cell or interrupt an ongoing Fluent calculation, Fluent automatically
generates the following files:

• report.xml that contains the information about the current design point.

• .png images of residuals and any solution monitors that have been defined in Ansys Fluent (if
Generate Solution Monitor Plots for Report is selected in the Properties pane for the Solution
cell.
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• (if available) .png images of contour and/or vector plots that have been previously defined in Ansys
Fluent.

Fluent saves these files in appropriate file directories within the Workbench project. These files appear
in the Files pane.

The Fluent project report XML file contains the following information in a tabular format:

Version

displays the information about the solver version.

Models

lists the Ansys Fluent models and their status.

Material Properties

lists all the materials defined in the case and their properties.

Cell Zone Conditions

displays information about cell zones defined in the problem and their setup conditions.

Boundary Conditions

displays information about boundary zones that exist in the problem and their specific conditions.

Solver Settings

shows information about solution controls, discretization schemes, and other solution-related settings
specified in the simulation.

When you export the project report as HTML as described in Working with Project Reports in the
Workbench User's Guide, the content of the Fluent project report file will be added to the end of the
generated project report. In addition, the following sections will be included at the end of the project
report:

Solution Monitor Plot Images

display the convergence history and available solution monitor plots (if Generate Solution Monitor
Plots for Report is selected in the Properties pane for the Solution cell). Note that the solution
monitor plot images can be created only if the SolutionMonitor.gz file has been generated
during the update.

Post Processing Graphics Object Images

(if available) display contour and vector plots that have been previously defined in Fluent.

2.9. Connecting Systems in Workbench

In Workbench, you can create connections between multiple systems that enable the systems to access
the same data. This is useful, for instance, when you want to compare the results from multiple Fluent-
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based systems in the same Ansys CFD-Post session. In this case, you would connect the various Solution
cells to one Results cell (either in one of your Fluent-based systems or in a separate Results system).
When you double-click that Results cell, the results from all connected systems will be loaded into
Ansys CFD-Post at the same time.

Another example would be where you want to load multiple meshes created in the Ansys Meshing
application to your Fluent-based system. See Connecting Multiple Upstream Meshes to a Setup Cell of
a Fluent-Based System (p. 71) for further information on such connections.

Workbench supports two different types of connections:

• Shared data connections

– Used when the inputs and outputs of the two connected cells are identical

– Can only be created between two cells of the same type

A shared data connection is represented in the Project Schematic by a line with a square on its right

(target) side  (see Figure 2.4: Connected Systems Within Workbench (p. 71)).

• Transfer data connections

– Used when the output of one cell is used as the input to the connected cell

– Usually created between two cells of different types. One exception is that a transfer data connection
can be used between the Solution cells of two Fluent-based systems when you want to use the
current data from one system as the initial data for the other system.

A transfer data connection is represented in the Project Schematic by a line with a circle on its right

(target) side  (see Figure 2.4: Connected Systems Within Workbench (p. 71)).

There are four ways to create connected systems in Workbench.

• Click a cell in one system, then drag and drop it onto a compatible cell in another system.

• Click a system in the Toolbox, then drag and drop it onto a compatible system in the Project
Schematic.

• Create a duplicate system (see Duplicating Fluent-Based Systems (p. 75)).

• Right-click a cell and select one of the options under Transfer Data From New... or Transfer Data
To New... (these options are not available for all cells). Transferring data from the Solution cell to a
new Fluent system's Setup cell transfers the mesh (but not the settings) to the Setup cell.

When you click and hold down the mouse button at a system in the Toolbox, Workbench highlights all
of the compatible drop targets in the Project Schematic. As you move the mouse over a drop target,
it is highlighted in red and a message appears in the Project Schematic that informs you what the
result will be if you drop the system onto that target.

There are usually several compatible drop targets on empty space in the Project Schematic. Dropping
the system onto one of these targets will create a stand-alone system in that location.

Similarly, when you highlight a cell and begin to drag it, Workbench highlights all of the compatible
drop targets in the Project Schematic. As you move the mouse over a drop target, it is highlighted in
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red and a message appears in the Project Schematic that informs you what the result will be if you
drop the cell onto that target.

Figure 2.4: Connected Systems Within Workbench

For more information about connecting systems, see the Workbench online help, as well as the following
sections:

2.9.1. Connecting Multiple Upstream Meshes to a Setup Cell of a Fluent-Based System

2.9.2. Connecting Systems by Dragging and Dropping a System from the Toolbox onto Another System

2.9.3. Connecting Systems By Dragging and Dropping Fluent-Based Solution Cells Onto Other Systems

2.9.1. Connecting Multiple Upstream Meshes to a Setup Cell of a Fluent-
Based System

You can connect multiple Mesh cells of Mesh component systems to the Setup Cell of a Fluent-based
system. The mesh data, including the mesh input parameters that you may have defined in the Ansys
Meshing application, will then be transferred to the Setup cell. When you start Fluent from the Setup
cell, Fluent will read the mesh data from the connected Mesh cells in the order in which the connec-
tions were created. If your Fluent-based system contains a Mesh cell, Fluent will read this data first.

Note the following limitation with these connections:

• If any upstream mesh is modified while the currently open Fluent session is running, then on refresh,
Fluent will reload all mesh files.

Important:

If you change the zone topology of one of the upstream meshes, Fluent may report a mesh
incompatibility. You must then resolve the mesh incompatibility issue in order to proceed
with the case setup.
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2.9.2. Connecting Systems by Dragging and Dropping a System from the
Toolbox onto Another System

The following example demonstrates the procedure for creating connected systems by dragging a
system from the Toolbox and dropping it onto a compatible system in the Project Schematic. (See
Figure 2.5: Applying the Mesh Settings to a New Fluent-Based Component System by Dragging and
Dropping Systems (p. 72))

Figure 2.5: Applying the Mesh Settings to a New Fluent-Based Component System by Dragging
and Dropping Systems

1. Starting from a project with an up-to-date Mesh component system, select the Fluent-based
component system from the Toolbox; the compatible drop targets are highlighted in green.

2. Drag the system over the Project Schematic and pause over the Mesh cell of the Mesh component
system; the Mesh cell target is highlighted in red and a message informs you that selecting that
target will transfer the data from cell A3 to the new system.

3. Drop the system on the drop target and a transfer data connection is created between the Mesh
cell A3 and the Setup cell B1.
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Note that Mesh cell A3 becomes Update Required, this is because the input data for the new
system has not yet been generated by the Ansys Meshing application.

Important:

If you try to open Fluent before the Mesh cell is updated, a warning message is displayed
informing you that you must update the Mesh cell before you can start Fluent, since
the mesh file required for Fluent does not yet exist.

4. Right-click Mesh cell A3 and select Update.

5. Double-click Setup cell B1; Fluent launches and loads the mesh from cell A3.

In the previous example, a transfer data connection was created. Shared data connections can also
be creating by dragging a system from the Toolbox and dropping it onto a compatible system in the
Project Schematic. The type of connection that Workbench creates depends on which drop target
you select. The red preview messages in the Project Schematic inform you of the type of connection(s)
that will result from your action.

When a Fluent-based component system is dragged from the Toolbox onto the Solution cell of an
existing Fluent-based analysis system, you are presented with two choices: Transfer Solution Data
or Transfer Mesh Data. The connection that is made between the two systems is based on the option
selected.

Figure 2.6: Transferring Solution Data or Mesh Data to a New Fluent-Based Component System
by Dragging and Dropping Systems

Important:

The mesh from the case file associated with the Solution cell of a Fluent-based analysis
system or component system can be transferred to the Setup cell of a Fluent-based com-
ponent system only and not the Setup cell of a Fluent-based analysis system.
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2.9.3. Connecting Systems By Dragging and Dropping Fluent-Based Solution
Cells Onto Other Systems

The following figures demonstrate the procedure for creating a transfer data connection by dragging
a Solution cell from a Fluent-based system and dropping it onto a compatible cell in another system:

Figure 2.7: An Example of Two Unconnected Systems

Figure 2.8: An Example of Dragging and Dropping a Solution Cell Onto Another Compatible
Cell

Figure 2.9: An Example of Two Connected Systems
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The following table lists the compatible drop targets for the Solution cell from a Fluent-based system:

Table 2.1: Compatible Drop Targets for the Solution cell of a Fluent-Based System

Cell(s)Analysis or Component System

SetupFluent

Solution

SolutionFluid Flow (Fluent)

Results

ResultsCFX

Fluid Flow (CFX)

Vista TF

Results

SetupStatic Structural (ABAQUS)

Static Structural (Samcef)

Shape Optimization (Ansys)

Static Structural

Steady-State Thermal

Transient Structural

Thermal-Electric

Transient Thermal

2.10. Duplicating Fluent-Based Systems

Workbench allows you to create a duplicate of a system so that you can set up multiple, similar systems
and analyze them at the same time. For instance, if you would like to study the differences in the fluid
flow between two slightly different geometries, then you can create, set up, and solve a single fluid
flow analysis system, duplicate the entire system, change the geometry in the duplicate system and
perform another fluid flow analysis on the new geometry.

You can create a duplicate of a Fluent-based system by performing the following steps:

1. In the Project Schematic, right-click the system header to open the system’s context menu.

2. Select Duplicate from the context menu.

A copy of the original Fluent-based system is created in the Project Schematic.

All data associated with the Fluent-based system, except for any case, data, and initial data files associated
with the Solution cell, are copied to the new system. The states of the Geometry, Mesh, and Setup
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cells in the new system will be the same as the states of the cells in the original system. The state of
the Solution and Results cells in the new system will be different than those of the original system if
the original system had case and data files associated with its Solution cell.

In addition, you can use the Duplicate command to create a duplicate of a Fluent-based system in
which the data in the Geometry cells or the data in both the Geometry cells and the Mesh cells is
shared between the two systems rather than copied.

To create a duplicate system in which the geometry is shared between the original and new system:

1. In the Project Schematic, right-click the Mesh cell in the system you want to duplicate to open the
context menu.

2. Select Duplicate from the context menu.

A copy of the original Fluent-based fluid flow system is created in the Project Schematic. A shared
data connection is created between the Geometry cell in the original system and the Geometry
cell in the new system.

To create a duplicate system in which both the geometry and the mesh are shared between the original
and new system:

1. In the Project Schematic, right-click the Setup cell or any cell below it in the system you want to
duplicate to open the context menu.

2. Select Duplicate from the context menu.

A copy of the original Fluent-based fluid flow system is created in the Project Schematic. Two
shared data connections are created: one between the Geometry cell in the original system and
the Geometry cell in the new system, and the other between the Mesh cell in the original system
and the Mesh cell in the new system.

2.11. Recording Mesh Manipulation Operations and Resolving Mesh In-
compatibility in Fluent

When you perform mesh manipulation operations in Fluent while running under Workbench, Fluent
preserves some basic mesh operations listed below. These operations are saved as part of the Workbench
project in the Setup cell such that the operations are explicitly applied by Workbench once Fluent loads
the mesh (and before reading the settings file) and automatically reapplied the next time an update is
performed. This enables you to more easily update the system if the upstream mesh has changed, or
parameters have been modified (see Changing the Settings and Mesh in Fluent (p. 81)).

Fluent under Workbench preserves the following mesh operations:

• Scaling

• Rotation

• Translation

• Smoothing

• Swapping
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• Merging

• Fusing

• Zone/Domain renaming

• Zone/Domain reordering

• Zone type changing (The final zone type is dependent on the settings file. This is recorded
primarily to address occasional mesh changes triggered by a change in the zone type.)

• Creating periodic zones

• polyhedra operations (convert to polyhedra, convert skewed cell to polyhedra)

The following mesh operations are not recorded within Fluent in Workbench:

• Separating faces and cells

• Zone operations, such as activating, deactivating, deleting, and replacing zones, as well as appending
case and data files

• Replacing meshes

• Adapting meshes, specifically using:

– Boundaries

– Gradients

– Iso-values

– Regions

– Yplus/Ystar

– Anisotropic

– Volume

See Modifying the Mesh in the User's Guide for more information about manipulating the mesh in
Fluent.

When you start Fluent from the Setup cell in Workbench, you can review or delete the preserved mesh
manipulation operations using the Recorded Mesh Operations and Incoming Zones dialog box (Fig-
ure 2.10: The Recorded Mesh Operations and Incoming Zones Dialog Box (p. 78)). When Fluent is started
from the Solution cell, the Recorded Mesh Operations toolbar button is not available.
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Figure 2.10: The Recorded Mesh Operations and Incoming Zones Dialog Box

To access the Recorded Mesh Operations and Incoming Zones dialog box, select the File/Recorded

Mesh Operations... ribbon tab item (or click the Recorded Mesh Operations toolbar button ).

In the Recorded Mesh Operations and Incoming Zones dialog box, you can view the mesh manipu-
lation operations that are currently stored. You can also delete, see new operations, or see if an operation
has failed due to an incompatible upstream mesh.

To view information about a mesh operation, select it from the recorded mesh operations list. The
specific details about the selected mesh manipulation operation appear under Operation Details. In
Figure 2.11: Reviewing the Details of Rotating the Mesh in the Recorded Mesh Operations Dialog
Box (p. 79), you can see the details of the rotation operation applied to a mesh. Note that when rotating
the mesh, the angle is displayed in radians, and when translating the mesh, the distance is displayed
in meters.
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Figure 2.11: Reviewing the Details of Rotating the Mesh in the Recorded Mesh Operations
Dialog Box

To review information about boundary and cell zones coming from an upstream mesh, click Print In-
coming Zones. Fluent lists the details about the incoming zones in the console.

Incoming zones from upstream mesh data are:
  id  name                       type                material              kind  status
----  -------------------------  ------------------  --------------------  ----  ----------
    1  wall-part_1               wall                air                   face  regular
    2  interior-part_1           interior                                  face  regular
   20  velocity_inlet1           velocity-inlet                            face  new
    -  pressure_outlet           -                                         -     modifed
    3  part_1                    fluid               air                   cell  regular

The status column indicates whether a zone is new, modified, or regular, that is existing and
unmodified.

To manually manage upstream topological changes (such as zone name changes) or correct any issues
with missing or new incoming zone names:

1. Click the Match Zone Names... button.

2. In the Match Zone Names dialog box, select a zone from the Missing Zones selection list and select
a corresponding zone from the New Zones selection list.
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The selected zones will be removed from their zone lists, and a matched zone pair will be added to
the Matched Zone Pairs list.

Figure 2.12: The Match Zone Names Dialog Box

If you want to break the association between missing and new zones that you have created, select
the corresponding matched zone pair from the Matched Zone Pairs list and click Remove. The
zone pair will be removed from the Matched Zone Pairs list, and the zone names will reappear in
their original zone lists.

3. To remove any unmatched zones in the selection Missing Zones list, and/or keep any additional
new zones in the New Zones selection list, select the Discard unmatched missing zones and accept
new zones option.

4. When you have completed matching zone names, click Apply.

5. When prompted whether or not you want to reload the Setup cell, click Yes.

In addition, the following controls are available in the Recorded Mesh Operations dialog box (see
Figure 2.10: The Recorded Mesh Operations and Incoming Zones Dialog Box (p. 78)):

• Reset — resets the stored mesh operations, clearing out all existing mesh operations, and ac-
cepting the current zones as expected incoming zones.
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• Delete — deletes the selected stored mesh operation.

• Reload — saves only the current set of mesh operations and incoming zone information, and
reloads the Setup cell.

The Reset, Delete, and the Reload buttons are disabled when there are no mesh operations listed in
the Recorded Mesh Operations dialog box.

Important:

Using the Reset, Delete, or the Reload buttons is not recommended for cases with topolo-
gical mesh transformations because of potential mismatches between recorded operations
and the settings file.

2.12. Changing the Settings and Mesh in Fluent

In order to use the Update command (see Using the Update Command (p. 55)) when changes are
made to your project, Fluent must know which settings changes should be stored as part of the Setup
cell’s data (and therefore used during an update) and which settings changes should only be reflected
in the results data that is associated with the Solution cell.

Important:

Note that there are certain changes to the mesh that you can perform within Fluent that are
able to be recorded and reviewed and are treated as settings. In addition, there are other
changes to the mesh within Fluent that are not recorded, and, as such, are not saved as
settings, and cannot be automatically re-applied when the Update command is used. For
more information about recording and reviewing mesh manipulation operations in Fluent
in Workbench, see Recording Mesh Manipulation Operations and Resolving Mesh Incompat-
ibility in Fluent (p. 76).

In order to address these issues, if you make certain changes to the mesh and/or settings in Fluent, you
may be prompted when you attempt to calculate, close Fluent, or save the project from Fluent. The
dialog boxes that appear (described in more detail below) allow you to select an action or to cancel
the operation.

Important:

If you save the project from an application other than Fluent or from the Project Schematic,
you will not be prompted; Fluent will automatically perform the default action for each dialog
box described below.

For more information, see the following sections:

2.12.1. Changing Case and Mesh Settings Before Beginning a Calculation

2.12.2. Changing Case and Mesh Settings After a Calculation Has Started
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2.12.1. Changing Case and Mesh Settings Before Beginning a Calculation

Important:

Note that in the descriptions below, mesh changes performed within Fluent only include
those mesh modifications that are not recorded in Fluent in Workbench. In addition, changes
to the settings can also include any mesh modifications that can be recorded in Fluent in
Workbench. For more information about recording and reviewing mesh manipulation op-
erations in Fluent in Workbench, see Recording Mesh Manipulation Operations and
Resolving Mesh Incompatibility in Fluent (p. 76).

If the mesh has not been changed using tools in Fluent, any changes to the settings are automatically
saved to the settings (.set) file.

If the mesh has been changed using tools in Fluent and the mesh was imported into the Fluent ap-
plication or the system’s Setup cell, any changes to the settings are automatically saved to the settings
(.set) file. In addition, a case file is saved and registered to the Setup cell to represent the modified
mesh.

If the mesh has been changed using tools in Fluent and the mesh was provided to the system’s Setup
cell by an upstream cell, the saved settings may not be compatible with the original mesh available
to the Setup cell, and you are prompted with the following dialog box:

Figure 2.13: The Mesh has changed! Dialog Box

Since the mesh was provided to the system’s Setup cell by an upstream cell, the original mesh cannot
be replaced by the modified mesh without also making changes to the Project Schematic. Since
there are several ways in which the schematic can be modified, Fluent does not provide a way to do
this automatically.

You can choose any of the following actions:

• Select OK in the Mesh has changed! dialog box. The action you requested when you were
prompted will proceed. Any changes to the settings will be saved to the settings file. If you
had selected to calculate, the iterations (or time-steps) will be performed on the modified
mesh. If you had selected to close Fluent or save the project, the modified mesh will be stored
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in the case file that is written as a result of either of those actions. The modified mesh will not
be saved if Fluent is closed without initializing or generating data.

Important:

– If you open Fluent from the Setup cell, or update or refresh the Setup or
Solution cell from the Project Schematic, the modified mesh will be replaced
with the mesh provided by the upstream cell. To calculate using the modified
mesh, either open Fluent from the Solution cell or select Continue Calcula-
tion from the Solution cell’s context menu.

– If you specified settings before you changed the mesh, you must also verify
that those settings are consistent with the modified mesh.

– If you want to use the modified mesh as the starting point for another ana-
lysis, simply create a new Fluent-based system and import the new case file
that contains the modified mesh into its Setup cell.

• Select Cancel in the Mesh has changed! dialog box and create a case modification strategy
that automatically performs the desired mesh modification steps (as well as any settings
changes that are dependent on the modified mesh) before calculating (see Case Modification
Strategies with Fluent and Workbench (p. 86)). This will allow you to automatically repeat the
desired mesh modifications every time you perform an Update or restart the calculation from
the Setup cell.

Important:

If you plan to make modifications to your mesh in Fluent (such as scaling, rotating,
or converting to polyhedra) before performing any calculations, and you do not
require any change made upstream of the Fluent Setup cell to be propagated to
the mesh in the future, you should import the mesh you plan to modify directly
into the Setup cell of a Fluent-based analysis or component system.

2.12.2. Changing Case and Mesh Settings After a Calculation Has Started

Important:

Note that in the descriptions below, mesh changes performed within Fluent only include
those mesh modifications that are not recorded in Fluent in Workbench. In addition, changes
to the settings can also include any mesh modifications that can be recorded in Fluent in
Workbench. For more information about recording and reviewing mesh manipulation op-
erations in Fluent in Workbench, see Recording Mesh Manipulation Operations and
Resolving Mesh Incompatibility in Fluent (p. 76).

If changes to the settings have been made and the mesh has not been changed using tools in Fluent,
you are prompted with the following dialog box:
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Figure 2.14: The Settings have changed! Dialog Box

Since changes were made to the settings after you began the calculation, you have to specify
whether or not the settings changes should be saved to the settings file.

You can choose any of the following actions:

• Select the Use settings changes for current calculations only option in the warning dialog box.
The action you requested when you were prompted will proceed. The modified settings will not
be saved to the settings file. If you had selected to calculate, the iterations (or time-steps) will start
using the new settings. If you had selected to close Fluent, or save the project, the new settings
will be stored in the case file that is written as a result of either of those actions.

Important:

– If you open Fluent from the Setup cell, or update or refresh the Setup or Solution
cell from the Project Schematic, the settings will be replaced with the settings in the
settings file that is associated with the Setup cell. To calculate using the new settings
either open Fluent from the Solution cell or select Continue Calculation from the
Solution cell’s context menu.

– If you want to use the new settings as the starting point for another analysis, simply
create a new Fluent-based system and import the new case file that contains the new
settings into its Setup cell.

• Select the Use settings changes for current and future calculations option in the warning dialog
box. The action you requested when you were prompted will proceed. The modified settings will
be saved to the settings file. If you had selected to calculate, the iterations (or time-steps) will start
using the new settings. If you had selected to close Fluent, or save the project, the new settings
will also be stored in the case file that is written as a result of either of those actions.

• Select Cancel in the warning dialog box. Create a new duplicate system (see Duplicating Fluent-
Based Systems (p. 75)), modify the settings, and connect the Solution cells for the two systems so
that the calculations will be performed in sequence.

• Select Cancel in the warning dialog box and create a case modification strategy that automatically
performs the desired settings changes after the appropriate number of iterations (or time-steps);
see Case Modification Strategies with Fluent and Workbench (p. 86) for more details.
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The last two approaches allow you to automatically repeat setting changes after a specified number
of iterations (or time-steps) every time you perform an Update or restart the calculation from the
Setup cell.

If the mesh has been changed using tools in Fluent, and the mesh includes changes made using dy-
namic or sliding mesh, you are prompted with the following dialog box:

Figure 2.15: The Mesh and settings have changed! Dialog Box

Important:

Note that when Fluent modifies the mesh, Fluent does not allow you to save the modified
settings and/or mesh operations once the calculation has started.

Otherwise, if the mesh has been changed using tools in Fluent, you are prompted with the following
dialog box:

Figure 2.16: The Mesh and settings have changed! Dialog Box

You need to specify whether or not any changes you made to the settings after you began the calcu-
lation should be saved to the settings file. Note that in cases where unrecorded mesh operations are
performed in Fluent, those mesh operations will be ignored in future solution runs.

Important:

• Whenever you modify the mesh in Fluent, you also make changes to some settings in
Fluent. Therefore, mesh modifications always result in setting changes.

• The original mesh cannot be replaced by the modified mesh after the calculation has
begun.
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You can choose any of the following actions:

• Select the Use settings and mesh changes for current calculations only option in the warning
dialog box. The action you requested when you were prompted will proceed. The modified settings
will not be saved to the settings file. If you had selected to calculate, the iterations (or time-steps)
will start using the new settings and the modified mesh. If you had selected to close Fluent, or
save the project, the new settings and the modified mesh will be stored in the case file that is
written as a result of either of those actions.

Important:

– If you open Fluent from the Setup cell, or update or refresh the Setup or Solution
cell from the Project Schematic, the settings and the modified mesh will be replaced
with the mesh and settings in the files that are associated with the Setup cell. To
calculate using the new settings and the modified mesh, either open Fluent from the
Solution cell or select Continue Calculation from the Solution cell’s context menu.

– If you want to use the new settings and the modified mesh as the starting point for
another analysis, simply create a new Fluent-based system and import the new case
file that contains the new settings and the modified mesh into its Setup cell.

• Select the Use settings and mesh changes for current and future calculations option in the
warning dialog box. The action you requested when you were prompted will proceed. The modified
settings will be saved to the settings file. If you had selected to calculate, the iterations (or time-
steps) will start using the new settings and the modified mesh. If you had selected to close Fluent,
or save the project, the new settings and the modified mesh will also be stored in the case file that
is written as a result of either of those actions.

Important:

If you open Fluent from the Setup cell, or update or refresh the Setup or Solution cell
from the Project Schematic, the new settings will be used in conjunction with the mesh
in the file that is associated with the Setup cell. Since those settings may have been
specified after the mesh was modified, you must verify that the new settings are consist-
ent with the original mesh.

• Select Cancel in the warning dialog box and create a case modification strategy that automatically
performs the desired settings changes and mesh modification steps after the appropriate number
of iterations (or time-steps); see Case Modification Strategies with Fluent and Workbench (p. 86)
for more details. This allows you to automatically repeat the desired setting changes and mesh
modification steps after a specified number of iterations (or time-steps) every time you perform an
Update or restart the calculation from the Setup cell.

2.13. Case Modification Strategies with Fluent and Workbench

Fluent allows you to specify your own initialization and start-up routines using automatically executed
strategies that you can define using the Automatic Solution Initialization and Case Modification
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option on the Calculation Activities task page within Fluent. Selecting the option and clicking the
Edit... button opens the Automatic Solution Initialization and Case Modification dialog box.

Figure 2.17: Accessing Solution Strategies in Fluent

Using the Automatic Solution Initialization and Case Modification dialog box, you are able to specify
your initialization method on the Initialization Method tab and use any text user interface (TUI) com-
mand to modify the case after a specified number of time steps or iterations in the Case Modification
tab. This option replaces the need for some simple journal files, especially for cases where a prescribed
start-up and solution routine is used (start with 1st order, switch to 2nd order, turn on reactions, and
so on)

When a case modification strategy is defined within Fluent, it will be used when a system is updated
from the Project Schematic in Workbench.

As mentioned in Changing the Settings and Mesh in Fluent (p. 81), mesh manipulations steps executed
from within Fluent are not repeated when an update is performed from the Project Schematic or you
start Fluent from the Setup cell. However, for mesh manipulation, you can specify steps that will be
executed at the beginning of your calculation if you incorporate them into a case modification strategy.

Solution strategies can also be useful when you need to perform mesh manipulation steps after a spe-
cified number of iterations during a calculation.

Important:

Whenever you run a case modification strategy interactively, make sure to reload the original
mesh and revert to the original settings before re-running the case modification strategy
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(see the separate Fluent User's Guide for information on how the original settings can be
reset automatically as part of a case modification strategy).

Important:

When running Fluent in Workbench, the behavior when continuing the calculation from the
Solution cell, when a solution strategy is defined, is different than when additional iterations
or time steps are specified in the Run Calculations task page. When a solution strategy is
defined, Fluent will complete the iterations or time steps specified by the solution strategy.
Once the solution is Up-to-Date, continuing the calculation has no effect. On the other hand,
when additional iterations or time steps are specified in the Run Calculations task page,
every time you choose to continue the calculation, Fluent will try to perform the specified
number of iterations or time-steps.

For more information about using these features in Fluent, see the Fluent User's Guide.

2.14. Working With Input and Output Parameters in Workbench

Workbench uses parameters and design points to allow you to run optimization and what-if scenarios.
You can define both input and output parameters in Fluent that can be used in your Workbench project.
You can also define parameters in other applications including Ansys SpaceClaim Direct Modeler, Ansys
DesignModeler and Ansys CFD-Post. Once you have defined parameters for your system, a Parameters
cell is added to the system and the Parameter Set bus bar is added to your project. Arrows representing
input and output parameters connect the bus bar to each system in which you have defined parameters.

Double-click the Parameter Set bus bar to open the Parameters Set tab. The Parameters Set tab in-
cludes the Outline of All Parameters table that lists all of the parameters in your project as well as
the Table of Design Points table in which you can specify design points.

To create a new design point, enter the input parameter values that you want to use for that design
point in the Table of Design Points in the row with an asterisk (*) in the first column. You can create
several design points. Once you have finished specifying design points, you can right-click the row for
one design point and select the Update Selected Design Point command from the context menu to
compute the output parameters for that design point. Alternatively, you can select Update All Design
Points from the Toolbar to update all of your design points in sequence.

Important:

By default, Workbench only saves the calculated data for the design point in the row labeled
Current. If you want to save the data for a design point other than Current within the project
(so you can postprocess the results from a different design point in either Ansys Fluent or
Ansys CFD-Post), enable the option in the Retain column for that design point before you
update it. After the calculation is complete, you can then right-click the design point in the
Table of Design Points and select Set as Current to access the data. Alternatively, you can
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export design points to separate projects. For details, see Retaining Design Point Data and
Exporting Design Points to New Projects in the separate Workbench User's Guide.

Important:

Note that you cannot create, edit, delete, or rename parameters in Fluent if any iterations
(or time-steps) have been performed. If you want to create, edit, delete, or rename parameters
in Fluent for a case with an existing solution, you must first initialize the solution. Alternatively,
you can disable the Use as parameter option in the Expression dialog box in Fluent to edit
the expression, then re-enable the Use as parameter option.

Note:

In Fluent, you can directly access the Parameters dialog box using the Parameters & Cus-
tomization/Parameters tree item in Fluent, or the corresponding Parameter System toolbar

command ( ).

For more information about using input and output parameters in Fluent (along with using them in
Scheme functions and UDFs), see Defining and Viewing Parameters and Creating Output Parameters in
the Fluent User's Guide.

For more information about parameters, design points, what-if scenarios and optimization studies in
Workbench, see the Workbench online documentation.

2.15. Reduced Order Model (ROM) Evaluation in Fluent

In addition to reviewing solved reduced order models (ROMs) in the ROM Viewer (Using ROMs in the
DesignXplorer User's Guide), you can view and evaluate the results in Ansys Fluent. For additional inform-
ation about this functionality, refer to Reduced Order Model (ROM) Evaluation in Fluent in the Fluent
User's Guide.

2.16. Viewing Your Fluent Data Using Ansys CFD-Post

Ansys CFD-Post is a postprocessing application that helps you visualize the results of your Ansys Flu-
ent CFD simulations. For Fluent-based analysis systems, the Results cell provides access to the Ansys
CFD-Post application. In addition, the Toolbox contains a separate Results component system (that is,
Ansys CFD-Post) that you can add to the Project Schematic and connect to Fluent-based systems.

When a Results cell is connected to a Fluent-based system’s Solution cell and the Results cell’s state
is either Refresh Required or Update Changes Pending, you can view the results of your Fluent calcu-
lation in Ansys CFD-Post by double-clicking the Results cell. This will load the Fluent results into Ansys
CFD-Post.
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Figure 2.18: Multiple Fluent Results Loaded Into Ansys CFD-Post

Important:

In addition to analyzing your results in Ansys CFD-Post, you can also view the results of your
simulation using the standard Fluent postprocessing tools. For more information, see the
separate Fluent User's Guide.

Important:

There are two options for exporting Fluent files for Ansys CFD-Post:

1. Fluent data files in the legacy format (.dat files) do not contain all variables; however,
you can add additional quantities using the Data File Quantities dialog box in Fluent.

2. Lightweight data files are created by exporting Ansys CFD-Post compatible files. These
files can be used to save just the variables of interest.

When you edit a Results cell that is connected to the Solution cell in a Fluent-based system,
Ansys CFD-Post always loads the standard Fluent case and data files. For more information
on exporting Fluent files for Ansys CFD-Post, see the separate Fluent User's Guide.
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2.17. Understanding the File Structure for Fluent in Workbench

When you save a Workbench project (for example,my-project), the project is saved with a .wbpj
extension (for example, my-project.wbpj). Other files associated with the project (through other
Workbench applications such as Ansys Fluent or CFX) are located in the dp0 folder within a _files
folder (for example, my-project_files).

Each system in the Project Schematic has its own directory under the dp0 directory. The directory is
named using the corresponding system identifier (for example, FFF represents a Fluent-based analysis
system; FLU represents a Fluent-based component system; Post represents a Results component
system, and so on). The directory name is appended with a number to distinguish it from the directories
for other systems of the same type (with the exception of the directory name for the first system of a
specific type which has no number appended to it).

Within each system directory is a folder for each application that is part of the system. This folder is
used to store the files generated and used by the application.

In addition to the settings, case and data files, the following files are managed by Fluent in Workbench:

• monitor files

• flamelet files

• view factor files

• non-premixed files (.pdf)

• interpreted user-defined (UDF) files

• compiled UDF libraries

• Discrete Transfer Radiation (DTRM) .ray files

• mechanism files (.che or .inp)

• property database files (thermo.db and transport.db)

You may use other types of files with Fluent in Workbench, however, you are responsible for making
sure that they are located in the appropriate folder within the project file structure.

The following figure represents an example of the directory structure for Workbench project with two
Fluid Flow (Fluent) systems and one Results system:
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Figure 2.19: Example of the Directory Structure for a Fluent-Based Project in Workbench

You can view the files associated with your Workbench project by selecting the Files option under the
View menu.

View → Files

Figure 2.20: The Files Pane for a Project in Workbench

If data is shared between two systems, then files are also shared between the two systems. The shared
file will exist in either the directory of the first system that used it, or in a global directory in the design
point directory (depending on the type of system that generated the file).
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The _files folder also contains a user_files directory. This directory should be used for any files
you create or reference that you would like to store with the project.

Important:

In general, you should not modify the structure of the project directories or delete or modify
any of the files that Workbench applications have stored in the project directories. However,
you may delete Fluent case and data files that are stored with the project but are no longer
needed. You should close Fluent before deleting Fluent case and data files from the project
directories.

Important:

Monitor files are automatically written to the appropriate working directory within the
Workbench project files directory. You will not be able to specify a different path for monitor
files from within Fluent. When reading older case files in which a different location is specified
for monitor files, a warning message will inform you that the path will be modified.

Important:

If you intend to use a Fluent journal file that reads or writes files while running under Work-
bench, the journal file and the files it references should be moved to the appropriate Flu-
ent folder in the appropriate system folder in the Workbench project working directory. File
paths in the journal files should use relative paths to point to the new locations for the files.

Important:

If you use models that generate mesh-dependent information the first time they are set up
(for example, DTRM, S2S) and then you change the mesh used in your system, the mesh
dependent information (for example, .dtrm file, .s2s file) may be incompatible with the
new mesh. To resolve this issue, you can:

• Open Fluent from your system, compute/write the .dtrm or .s2s output files, and then
update the system.

• Use a solution strategy and write the .s2s file as a pre-initialization method using the
appropriate command (for example, (write-sglobs "2d.s2s.gz")).

Important:

If your Fluent setup involves compiling and loading a user-defined function (UDF), it is recom-
mended that you copy the UDF source code files to the same location as your mesh and
settings files before compiling the UDF libraries. This location is available in the Files pane
in Workbench. You may need to save the project first to create the appropriate files folder
within the Workbench project (for example project name\dp0\FFF\Fluent\). If you
need to unload a UDF library for any reason during your simulation, it is recommended that
you save the project soon after unloading the library. If you archive a project that includes
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compiled user defined functions, you will need to recompile the libraries after opening the
archived project. To do so, you will need to open Fluent from the Setup cell, go to the UDF
Library Manager dialog box (User Defined/User Defined/Functions/Manage...) and unload
the existing UDF library. Next, rebuild the UDF library locally by going to the Compiled
UDFs dialog box (User Defined/User Defined/Functions/Compiled...), selecting the archived
.c and .h files, compiling, and loading the new UDF library. Finally, save the project.

For more information, see the following section:

2.17.1. Fluent File Naming in Workbench

2.17.1. Fluent File Naming in Workbench

When running under Workbench, Fluent automatically saves the settings, case, and data files for your
system as needed.

Fluent names these files using the base name of the mesh file. If a mesh (or case) file is imported, the
base name of the imported file is used as the base name for the settings, case, and data files. If the
mesh is created in Workbench, the mesh file uses the system’s directory name as its base name.

When Fluent saves a case file, it appends the base name with the run number. When Fluent next
writes a case file, the run number is incremented in order to avoid overwriting the previous case file.
When Fluent saves a data file, it appends the base name with the same run number as the associated
case file and with the iteration (or time-step) number at which it was saved. A new case file is not
written every time that a data file is written. The case file is only written when the settings and/or
mesh is changed.

The following example shows how file naming works in Fluent under Workbench. In this example,
you have a single Fluid Flow (Fluent) analysis system and you have created the mesh in Workbench.

1. Double-click Setup cell. Fluent launches and loads FFF.msh.h5.

2. In Ansys Fluent, specify boundary conditions, initialize the solution and enter 10 iterations on the
Run Calculation task page.

3. In the Fluent application, select the Calculate button.

FFF.set file is written and 10 iterations are completed.

4. Save the project.

FFF-1.cas.h5 and FFF-1-00010.dat.h5 are written.

5. In the Fluent application, select the Calculate button.

10 additional iterations are completed.

6. Save the project.

FFF-1-00020.dat.h5 is written.
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7. In the Fluent application, change the value of the inlet velocity, select the Calculate button. When
prompted, select the Store the modified settings for a future calculation and use them this
time option.

FFF.set is written (overwriting the existing file) and 10 additional iterations are completed.

8. Save the project.

FFF-2.cas.h5 and FFF-2-00030.dat.h5 are written.

Important:

The same naming convention is used when autosaving with Fluent under Workbench.

2.18. Working with Ansys Licensing

When working with Workbench, you have the option to share a single license between applications
that use the same license or the option for each application to check out its own license.

For more information, see the following section:

2.18.1. Shared Licensing Mode

2.18.1. Shared Licensing Mode

When using shared licensing, although a single license is shared between multiple applications, only
one application can actively use the license at a time. Therefore, with just a single license, you can
have both Ansys Fluent and Ansys CFD-Post open at the same time. If iterations are being performed
in the Fluent session, you cannot do anything in the Ansys CFD-Post session. However, if the Fluent ses-
sion is open and idle, you can work in Ansys CFD-Post without closing Fluent. Similarly, you can have
multiple sessions of Fluent open at the same time using just a single license.

If you open an application, it will first check to see if it can use a license that is already checked out.
If it can, and that license is available, it will use that license. If the license is not available because it
is being used by another application, you will be informed that the required license is not available.
You will not be able to use the new application until that license becomes available. If there is not a
license checked out that is compatible with the new application, the new application will check out
an additional license.

In shared mode, you can have multiple licenses of each type of non-shareable licenses checked out
at a time. For example, you can have 1 acfd license and 1 acfd prepost license checked out at
the same time but you cannot have 2 acfd licenses checked out at the same time.

In shared mode, you can have multiple licenses of each type of non-shareable licenses checked out
at a time. Non-shareable licenses include solver-only licenses and parallel licenses.

For more information about licensing and shared license mode, see the Workbench online document-
ation.
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2.19. Using Fluent With the Remote Solve Manager (RSM)

The Remote Solve Manager (RSM) is a job queuing system used to distribute tasks that require computing
resources. RSM schedules and manages tasks within Workbench and allows tasks to be sent only to the
local machine to run in background mode, or they can be broken into a series of jobs for parallel pro-
cessing.

For more information about using Fluent in Workbench and RSM (with associated limitations), see
Submitting Solutions to Remote Solve Manager and Submitting Fluent Jobs to Remote Solve Manager.

2.20. Using Custom Systems

Workbench allows you to add custom templates and includes some pre-defined custom templates. To
use a custom template, double-click the template to add it to the Project Schematic.

Under Custom Systems in the Toolbox, there is a predefined Fluent-based custom system (FSI: Fluid
Flow (Fluent) Static Structural – the single arrow is meant to convey that the interaction is one-
way). When you double-click the template to add it to the Project Schematic, Workbench automatically
creates a link between the Geometry cell in the Fluent system and the Geometry cell in the Structural
system and between the Solution cell in the Fluent system and the Setup cell in the Structural system.

You can create your own system template and then save it as a Custom System by performing the
following steps:

1. Manually create the desired system diagram in the Project Schematic.

2. Right-click the white space in the Project Schematic and select Add to Custom from the context
menu.

Important:

When you use Fluent to perform a one-way fluid-structure interaction (FSI) analysis using
the approach demonstrated in the predefined Fluent-based custom system, you can only
exchange surface data for force and thermal loads.

Important:

When you use Fluent to perform a one-way fluid-structure interaction (FSI) analysis using
the approach demonstrated in the predefined Fluent-based custom system, and you are
performing a multiphase simulation in Fluent, you cannot exchange thermal load data.

2.21. Using Journaling and Scripting with Fluent in Workbench

You can keep a history of your interactions within Workbench, that can also include your interactions
within Fluent, by recording your interactions with the program(s) in session journals (also referred to
as journaling). This is done using the Scripting submenu in the Workbench File menu:

File → Scripting → Record Journal...
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In addition, since the journal files are Python-based scripts, you can edit and/or play back previously
recorded journal files, or create new journals manually (also known as scripting), that include your inter-
actions within Workbench and, if applicable, any interactions within Fluent:

File → Scripting → Run Script File...

For more information about recording and using session journals in Workbench, as well as reference
documentation containing available commands and properties, see the separate Ansys Workbench
Scripting Guide.

Important:

• When using the Send Command method to directly call a Fluent text user interface (TUI)
command, the TUI command will not be recognized unless you use double quotes around
it (for example, setup.SendCommand("define model energy no")). If a string
is included in the TUI command, then a backslash is required before the quotes around
the string. For example:

setup1.SendCommand(Command="(cx-gui-do cx-activate-item \"MenuBar*FileMenu*Close Fluent\") ")

• Fluent internal Scheme commands may not work properly when called directly using the
Send Command method. Therefore, you should use Fluent text user interface (TUI) com-
mands instead.

2.22. Performing Fluent and Maxwell Coupling in Workbench

Fluent can be coupled with Ansys Maxwell within Workbench in order to perform either a one-way or
a two-way electromagnetic-thermal interaction problem. Coupling between Maxwell and Fluent applic-
ations within Workbench can be used for applications such as simulating fluid flow around or inside
electromechanical (EM) devices, when the temperature of the device is influenced by electromagnetic
or electrical losses.

Maxwell is supported for one–way and two-way coupling between Maxwell and Fluent in Workbench.

Additional information can be found in the following sections:

2.22.1. One–Way Coupling Between Maxwell and Fluent Within Workbench

2.22.2.Two–Way Coupling Between Maxwell and Fluent Within Workbench

2.22.3. Handling Coupling Iterations Between Maxwell and Fluent

2.22.1. One–Way Coupling Between Maxwell and Fluent Within Workbench

The coupling involves solving an electromagnetic problem in Maxwell, and mapping the resulting
volumetric and/or surface loss information into Fluent. Volumetric loss is mapped onto the cell zones
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as a heat source (load) at the cell centroids that is then added to the energy equation. Surface loss
is applied to the adjacent cells of the solid zones that contribute to the source terms of these cells.

Note:

Surface loss is highly concentrated near the surface of the solid zone, so it is recommended
that you have a layer of good quality hexahedral or prism mesh elements located where
surface loss occurs.

Note:

You can analyze the results of volumetric/surface losses using the following postpro-
cessing variables:

• Volumetric loss: Temperature EM Source ( )

• Surface loss: Temperature EM Surface Source ( )

The overall workflow for an Maxwell-Fluent analysis is as follows:

1. Create and solve the electromagnetic application using Maxwell.

2. Drag and drop a Fluent–based system and import a case or mesh file into Fluent, and then
double-click the Setup cell to start Fluent.

Note:

If you import a mesh into Fluent that was generated using non-SI units, then you
should scale and/or translate the mesh before you perform any coupling with
Maxwell.

3. Drag and drop the Solution cell of the Maxwell system onto the Setup cell of Fluent system to
enable the data transfer.

4. Update the Solution cell of the Maxwell system.

5. Refresh the Setup of Fluent system.

6. Specify the EM settings in Fluent (File/EM Mapping).

7. Set up the Fluent analysis as you normally would (for example, specify boundary conditions,
solution settings, and so on).

8. Solve the Fluent analysis.
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During EM mapping, Fluent automatically turns on the energy model, if you have not already done
so.

Note:

In 2D axisymmetrical cases only, Maxwell uses the RZ (or XZ) plane while Fluent uses the
XY plane by default. Therefore, when you export a geometry from Maxwell, you need to
rotate the geometry in order for Fluent to mesh the geometry before EM mapping can
take place properly. This is not a concern for regular 2D or 3D cases. If you use Ansys
DesignModeler, rotate the geometry exported from Maxwell by performing the following
steps:

1. Define a new plane based on the XY plane, applying a 90 degree rotation along
the X axis, and a 90 degree rotation along the Y axis.

2. Move the geometry from the XY plane to the new plane.

If you use SpaceClaim (Windows only), follow the steps below:

1. Make sure that the world origin is displayed (Display → Display → Show → World
Origin).

2. In the Design ribbon tab, select the Orient tool (Assembly group).

3. Select an edge of the geometry you want to rotate and then select a global axis.

The geometry will be rotated so that the selected edge is aligned along the selected
global axis.

2.22.2. Two–Way Coupling Between Maxwell and Fluent Within Workbench

Two-way coupling enables thermal feedback to be provided between the systems so that you can
exchange temperature data from Fluent to Maxwell within Workbench.

Aside from the basic workflow described in Performing Fluent and Maxwell Coupling in Work-
bench (p. 97), to enable two–way coupling between Fluent and Maxwell, you should perform the
following steps:

1. Open the Maxwell project and define temperature–dependent material properties (enabling the
Thermal Modifier field in the View/Edit Material dialog box and editing the material’s thermal
property definition). This makes sure that the Maxwell and Fluent applications generate the
temperature–dependent data.
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2. Select the Enable Feedback option in the Temperature of Objects dialog box.

Maxwell 3D → Set Object Temperature...

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.100

Working With Fluent in Workbench



Once Maxwell generates the centroid file, Fluent detects the centroid file, and generates the
temperature file as feedback data and places the file in the appropriate location. An example of
what Fluent displays in the console window is presented below:

Starting Thermal feedback for EM ...

Reading centroid file... Number of Nodes = 4031
Writing mechanical.ths...

Note:

In Maxwell, you can have different losses (Ohmic loss, Core loss, Hysteresis loss) depending
on the type of simulation. Maxwell can also compute the "total loss" which is the sum of
all the losses when appropriate. All the different losses mentioned above including the
"total loss" are a function of space and they are also a function of time in the Maxwell
transient solver. When doing the coupling simulation, the "total loss" is mapped to Fluent
for the temperature calculation. For transient simulations, the total loss is time averaged
between two times that you specify before it is mapped to Fluent.

2.22.3. Handling Coupling Iterations Between Maxwell and Fluent

You can perform automatic system updates (coupling iterations) using the Maxwell Feedback Iterator.
Refer to the Maxwell help documentation for more information on Feedback Iterator.
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You can also perform manual cyclic updates of individual system components until the solution stops
changing within a desired level of tolerance. For example:

• Coupling Iteration 1

– Update Maxwell Solution cell

– Perform EM Mapping on solid zones in Fluent

– Update Fluent Solution cell

– Perform Enable Update on Maxwell Solution cell

– Update Maxwell Solution cell

• Coupling Iteration 2

– Update Fluent Setup cell

– Update Fluent Solution cell

– Perform Enable Update on Maxwell Solution cell

– Update Maxwell Solution cell

• Coupling Iteration 3

– Update Fluent Setup cell

– Update Fluent Solution cell

– Perform Enable Update on Maxwell Solution cell

– Update Maxwell Solution cell

• Coupling Iteration 4

– Update Fluent Setup cell

– Update Fluent Solution cell

– Perform Enable Update on Maxwell Solution cell

– Update Maxwell Solution cell

• and so on

Within the Workbench environment, you can create a script to accomplish these tasks. Workbench
scripts are written in the Python programming language and can be created, modified and executed
with tools available in Workbench. For more information on writing scripts in Workbench, see Work-
bench Scripting Guide in the Workbench Scripting Guide. You can contact your support representative
to obtain a sample script.
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Chapter 3: Getting Started with Fluent Meshing in
Workbench
This chapter provides some basic instructions for getting started with using Fluent Meshing in Workbench.
It describes how to use Fluent (with Fluent Meshing) component systems within Ansys Workbench.
Since working with a Fluent (with Fluent Meshing) component system is similar to working with a
Fluent component system, only differences in these two systems are covered in this chapter. For gen-
eral information about using Fluent in Ansys Workbench, see Getting Started With Fluent in Work-
bench (p. 21). For details about using component systems in Workbench, refer to Working With Fluent
in Workbench (p. 49).

The chapter discusses:

3.1. Limitations

3.2. Starting Fluent (in Meshing Mode or Solution Mode) in Workbench

3.3. Using the Fluent Guided Meshing Workflows

3.4. Saving Your Work in Fluent Meshing with Workbench

3.5. Exiting Fluent Meshing and Workbench

3.6. An Example of a Fluent Meshing Analysis in Workbench

3.7. Using Parallel Fluent Meshing

3.8. Connecting to Upstream Geometry

3.9. Support for the Remote Solve Manager (RSM) in Fluent (with Fluent Meshing) Systems

3.10. Using a Journal File for the Mesh Cell

3.11. Using a Journal File to Parameterize Fluent Meshing Inputs

3.12. Getting Help for Fluent Meshing in Workbench

See the Fluent User's Guide for more details about Fluent Meshing.

3.1. Limitations

The following limitations exists when using the Fluent (with Fluent Meshing) component system:

• The Fluent (with Fluent Meshing) component system only supports mesh changes derived
from using the Fluent Meshing guided workflows. Mesh changes outside of the guided workflows
(such as from another connected Fluent component system, for example) are currently not
supported. In such cases, for an otherwise up-to-date component system, the Setup and Solution
cells remain as up-to-date even though the mesh has been changed.

• When using the Watertight Geometry workflow, all CAD bodies should have unique names.
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• Saving a project and exiting Workbench (or creating a new project) while Fluent Meshing is still
open may not register the generated mesh file with the Mesh cell of Fluent (with Fluent
Meshing) component. To resolve this, launch Fluent Meshing by editing a Mesh cell, read the
generated mesh file from the project directory, close the Fluent Meshing session, and save the
project.

• You should open Fluent Meshing and confirm that all settings are correct.

• In the Mesh cell context menu, mesh import options are not available. (You can only import a
geometry, mesh, or case file from within Fluent Meshing).

• Solver-to-mesh-solver workflows in Workbench (that is, returning to meshing mode after
switching to solver mode) are currently not supported.

• 2D simulations are currently not supported.

• There are no limitations on the Set Up or Solution cells, including Fluent parameters.

• Fluent Meshing parameters are currently not supported, however, you can parameterize real
arguments using the appropriate scheme commands in the registered update journal file (*.jou).

3.2. Starting Fluent (in Meshing Mode or Solution Mode) in Workbench

Once you create a Fluent (with Fluent Meshing) component system (as described in Fluent-Based
Component Systems (p. 28)), you can start the Fluent application in

• meshing mode by double-clicking a Mesh cell

• setup mode by double-clicking a Setup cell

• solution mode by double-clicking a Solution cell

Note that you can also click Edit... in the corresponding cells context menu. When Fluent Launcher
opens, click OK to start Fluent. You are able to start the Fluent application in either meshing mode or
solution mode under certain conditions, depending on the state of the cells within the Fluent (with
Fluent Meshing) component system.

• If you are working with a new Fluent (with Fluent Meshing) component system (where all cells
are not Up-To-Date):

– Double-clicking the Mesh cell opens Fluent in meshing mode.
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– Double-clicking either the Setup cell or the Solution cell opens Fluent in solution setup mode
where you are expected to import the mesh or case file, which deletes the Mesh cell from the
Fluent (with Fluent Meshing) component system.

• If you are working with a preexisting Fluent (with Fluent Meshing) component system where
the Mesh cell is Up-To-Date:

– Double-clicking the Mesh cell loads available mesh in Fluent Meshing.

– Double-clicking the Setup cell opens Fluent in setup mode and loads the mesh and settings
files.

– Double-clicking the Solution cell opens Fluent in solution mode and loads the case and data
files.

• If you are working with a preexisting Fluent (with Fluent Meshing) component system where
all cells are Up-To-Date:

– Double-clicking the Mesh cell loads available mesh in Fluent Meshing.

– Double-clicking the Setup cell opens Fluent in setup mode and loads the mesh and settings
files.

– Double-clicking the Solution cell opens Fluent in solution mode and loads the case and data
files.

3.3. Using the Fluent Guided Meshing Workflows

To access and use the Fluent meshing workflows in Workbench, perform the following:

1. Open the Workbench environment.

2. Add a Geometry component system to your Workbench project, and import a CAD geometry
file into the Geometry cell.
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3. Add a Fluent (with Fluent Meshing) component system to your project.

4. Connect the Geometry cell of the Geometry component system to the Mesh cell of the Fluent
(with Fluent Meshing) component system.

5. Select the Mesh cell and view it's properties.
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Note the Use Workflow check box in the properties of the Mesh cell. By default, the Use
Workflow check box is enabled, and you are able to select a workflow from the Workflow
Type field. When the check box is disabled, you are still able to set CAD faceting and other
options within the properties of the cell.

The Save Task Editing Data Within Project option (enabled by default) allows you to save
relevant task-related data files (such as mesh information and task state) directly in your
Workbench project, making it easier to use the workflow, for example, when reverting and
editing tasks. This property is available for standalone Fluent (with Fluent Meshing) component
systems, whether or not there is a connected upstream Geometry system. If this property is
enabled, the Saving data for editing tasks workflow preference will use the Write mesh files
option. See Setting Preferences for Workflows in the Fluent User's Guide for more information
on workflow preferences.

6. In the Workflow Type field, select the Watertight Geometry option to use that workflow, or
select the Create New option to create your own workflow.

7. Start Fluent in Meshing mode.

Double-click the Mesh cell in the Fluent (with Fluent Meshing) component, and make any
appropriate selections in the Fluent Launcher, then proceed to open Fluent in Meshing mode
to start working with a workflow.

The Workflow tab is automatically opened in Fluent and the corresponding workflow is initialized
with the imported CAD geometry from the Geometry cell from your Workbench project.
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8. Proceed with setting up the various tasks of the workflow (for example, defining local sizing,
capping inlets and outlets, extracting fluid regions, and generating the volume mesh).

Once all workflow tasks are completed (and marked as up-to-date), and a volume mesh is
generated, the state of the Mesh cell becomes Up-to-Date.

Tasks can be added, removed, or otherwise customized to your needs, and the configuration
will be retained when you return to Fluent from your Workbench project. See Working With
Fluent Guided Workflows in the Fluent User's Guide for more information.

When you have completed setting up the workflow, you can return to your Workbench project
and update the Mesh cell in the Fluent (with Fluent Meshing) component.

9. Proceed, as usual, with completing the CFD simulation through the Setup and Solution cells
in the Fluent (with Fluent Meshing) component.

This functionality can be especially useful when you have similar geometries that use the same
object labels (for example, different, but similar, manifold geometries that each contain three
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inlets named in1, in2, and in3 and an outlet named out1). These similar geometries can
be imported using a separate Geometry component that is connected to a single Fluent (with
Fluent Meshing) component that already has a workflow defined to generate a compatible
volume mesh for the same geometric configuration. The geometries can be swapped out, and
once the Fluent (with Fluent Meshing) component is updated, the defined workflow will
automatically update itself to generate a corresponding volume mesh.

3.4. Saving Your Work in Fluent Meshing with Workbench

You can save your Workbench project directly from Fluent Meshing by selecting Save Projectunder the
File menu.

File → Save Project

Alternatively, you can also save your Workbench project by selecting the Save option under the File

menu within Workbench or by clicking the Save Project icon ( ) from the Workbench toolbar.

For more information, see Saving Your Work in Fluent with Workbench (p. 41).

3.5. Exiting Fluent Meshing and Workbench

You can end your Fluent Meshing session by using the Close Fluent option under the File menu.

File → Close Fluent

You can end your Workbench session by using the Exit option under the File menu.

File → Exit

For more information, see Exiting Fluent and Workbench (p. 42).

3.6. An Example of a Fluent Meshing Analysis in Workbench

This example describes when the files that are generated and used by Fluent Meshing are written and
how the cell states change as you work with a Fluent (with Fluent Meshing) component system in
Workbench.

1. Add a new Fluent (with Fluent Meshing) component system to the Project Schematic.

The state of the Mesh cell is Attention Required and the states for the Setup, and Solution cells
are Unfulfilled.
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2. Double-click the Mesh cell. The Fluent Meshing application launches (the Meshing Mode option is
automatically enabled in Fluent Launcher). In the Fluent Meshing application, import a geometry
and/or create a mesh file, then perform your mesh operations. You can also import a Fluent case
file into the Fluent Meshing application.

3. Switch to the solver (solution) mode (by using the Switch to Solution button in the Solution group
box of the ribbon, or by using the switch-to-meshing-mode text command). The state of the
Mesh cell becomes Up-to-Date, and the Setup cell becomes Attention Required. If you save the
project at this point, the mesh (.msh.h5) and the settings (.set) files are written.

4. In Fluent, specify boundary conditions, initialize the solution, and enter a nonzero number of iterations
on the Run Calculation task page. The state of the Setup cell becomes Up-to-Date, and the state
of the Solution cell becomes Refresh Required.

5. Start the simulation in Fluent by clicking Calculate on the Run Calculation task page. The settings
(.set) file is written and iterations begin. The state of the Solution cell becomes Update Required.
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When iterations are completed, or the solution meets the convergence criteria, the state of the
Solution cell becomes Up-to-Date.

3.7. Using Parallel Fluent Meshing

If you want to run Fluent Meshing in parallel, you can specify the value for Number of Parallel Pro-
cessors in the Properties pane for the Mesh cell.

You can override this parallel-process setting by setting the Meshing Processes under the Parallel
processing options in Fluent Launcher.

3.8. Connecting to Upstream Geometry

You can connect an upstream Geometry cell to a Mesh cell of a Fluent (with Fluent Meshing) com-
ponent system to transfer geometry data to Fluent Meshing.
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Figure 3.1: Connecting Upstream Geometry and Mesh Cells

Once the cells have been connected, and once the Use Workflow property has been disabled, the fol-
lowing CAD import options and controls become available in the Properties for the Mesh cell:

Feature Angle

specifies the feature angle to determine the features to be imported. A smaller value will result in
importing more features. The default value is 40.

Unit

specifies the length units for scaling the mesh. Models created in different units will be scaled ac-
cordingly. The default is meters (m).

Tessellation Option

contains options that enable you to control the tessellation (faceting).

CAD faceting

enables you to control the tessellation (faceting) refinement during the file import.

CFD surface mesh

enables conformal tessellation (faceting) that uses the curvature size function based on the
minimum and maximum facet sizes, Min Size and Max Size, the specified facet Curvature
Normal Angle, and the edge proximity size function Edge Proximity.

CAD faceting Controls

(when CAD faceting is selected for Tesselation)
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Tolerance

specifies the tolerance for the tessellation (faceting) refinement. The default value of 0 implies
no tessellation (faceting).

Max

specifies a maximum facet size for the imported model to avoid very large facets.

CFD surface mesh Controls

(when CFD Surface Mesh is selected for Tesselation)

Use Size Field File

if enabled, you can provide a size field file.

Min Size, Max Size

specify the minimum and maximum facet sizes, respectively.

Curvature Normal Angle

specifies the curvature normal angle based on the underlying curve and surface curvature.

Edge Proximity

enables the use of the edge proximity size function based on the number of cells per gap spe-
cified.

Cells Per Gap

specifies the number of element layers to be generated in a gap for the edge proximity size
function.

Save Size Field

enables you to save the size field in a file, which is computed based on the specified parameters
(Min Size, Max Size, Curvature Normal Angle, and Cells Per Gap).

Size Field File Location, Size Field File Name

specifies the file name and the location for the size field file, respectively.

3.9. Support for the Remote Solve Manager (RSM) in Fluent (with Fluent
Meshing) Systems

You can run Workbench parametric studies with the Remote Solve Manager (RSM) when using the
Geometry and the Fluent (with Fluent Meshing) component systems. For more information about
RSM in general, see Remote Solve Manager User's Guide.
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RSM Host on Linux

When the Geometry component system is connected to a Fluent (with Fluent Meshing) component
system, and the geometry type is set to *.scdoc, you can run a parametric study on both Windows
and Linux. Since Ansys SpaceClaim Direct Modeler files (*.scdoc) CAD geometry files are not supported
on Linux, Fluent internally creates a compatible .pmdb file at the same location to be used for the
parametric study, irrespective of whether the RSM host's operating system is Linux or Windows. These
generated .pmdb files are used only when the RSM host's operating system is Linux. If the RSM host's
operating system is Windows, these .pmdb files are still generated, however, they are not explicitly
used.

Additionally, if the geometry type is set to *.scdoc, make sure that the Pre-RSM Foreground Update
option is set to Geometry in the Parameter Set's Properties panel.

3.10. Using a Journal File for the Mesh Cell

For Fluent (with Fluent Meshing) component systems, you can use a journal file (*.jou) to implement
the text user interface (TUI) commands and/or Scheme expressions related to mesh generation.

To associate the journal file with the Mesh cell:

1. Right-click the Mesh cell and from the context menu, select Register Update Journal File.

2. Browse to the journal file location and select the file.

Once the journal file has been associated with the Mesh cell, the Register Update Journal File
command is replaced by Unregister Startup Journal File. You can execute this command if you
want to disassociate the assigned journal file from the Mesh cell.

On performing Update of the Mesh cell, the registered journal file associated with the cell will be ex-
ecuted in Fluent Meshing in the background.

3.11. Using a Journal File to Parameterize Fluent Meshing Inputs

As discussed in Limitations (p. 103), parameters are not currently supported by Fluent Meshing; however,
you can parameterize real arguments using the appropriate scheme commands in the registered update
journal file (*.jou).

A journal file that parameterizes some inputs for Fluent Meshing is shown below:

;================================================================================= 
;==Define scheme variable connected to input parameters exposed in Workbench====== 
(define tg-input-parameter-data '( 
   (p1 (value . 0.0025)) ;thickness of the first prism layer 
   (p2 (value . 5))      ;number of prism layers 
   (p3 (value . 0.05))   ;max element size for global size settings 
)) 
(create-scheme-input-parameters tg-input-parameter-data) 
; (print-scheme-input-parameters);check the list for current value in fluent-meshing side 
;================================================================================== 
;===Add required TUI/scheme commands to generate volume mesh 
;===Mesh Cell will be marked up-to-date on exit of Fluent or changing mode to solver=========== 

/size-functions set-global-controls 0.005 p3 1.2 
/size-functions create-defaults 
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/objects/improve-object-quality (*) surface-remesh 
/mesh/prism/controls/zone-specific-growth apply-growth (wall) last-ratio p2 p1 40 no 
/mesh/auto-mesh "fluid" () yes zone-specific pyramids tet 
/mesh/clean-up yes 

/boundary/manage/type (inlet-cold) velocity-inlet 
/boundary/manage/type (inlet-hot) velocity-inlet 
/boundary/manage/type (outlet) pressure-outlet 
/boundary/manage/name interior* interior 
;==================================================================================

/boundary/manage/name interior* interior 

The above journal file was created by modifying (that is, parameterizing) a journal file that was recorded
during an earlier Fluent Meshing session.

The recorded journal file was edited to remove all of the commands that are not necessary for the desired
parametric study, such as:

• Commands related to graphics operations (usually these commands start with “cx-”)

• Commands that manage lists

Next, commands were added at the top of the journal file in order to create the parameters that will
be exposed in Workbench. These commands are as follows:

• The define statement creates the user-defined scheme list tg-input-parameter-data with
three sub-lists (p1, p2, and p3). Each of the sub-lists consists of a variable symbol-name (p1, p2, or
p3) and an initial value.

• The create-scheme-input-parameters statement is the Fluent-specific scheme API function
that creates input parameters for the name-value pairs in tg-input-parameter-data and connects
it to the input parameters exposed in Workbench. After executing this command, Workbench will list
p1, p2, and p3 under Input Parameters.

• The print-scheme-input-parameters is the Fluent-specific scheme API function that prints
the current input parameter values in the Fluent console. In the above example, it is commented out,
but you can use this statement to check these values.

Lastly the specific values entered for the Fluent Meshing inputs during the recorded session were replaced
by corresponding parameters (p1, p2, or p3).

3.12. Getting Help for Fluent Meshing in Workbench

Accessing help from within Ansys Workbench:

For information on how to access help for Ansys Workbench, see Getting Help for Fluent in Work-
bench (p. 46).

Accessing help from within Fluent Meshing:

Fluent Meshing documentation and help can be accessed by clicking  once the Fluent Meshing ap-
plication is running. The documentation is automatically installed when you install Workbench.
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Chapter 1: Introduction to Internal Combustion
Engines
The IC Engine (Fluent) system is being deprecated and will be removed in a future release. Consider using
Forte in Component Systems for conducting simulations of internal combustion engines in Workbench.

The design and manufacture of Internal Combustion (IC) Engines is under significant pressure for im-
provement. The next generation of engines needs to be compact, light, powerful, and flexible, yet
produce less pollution and use less fuel. Innovative engine designs will be needed to meet these com-
peting requirements. The ability to accurately and rapidly analyze the performance of multiple engine
designs is critical. Information in this chapter is organized into the following sections:

1.1. Engine Performance

1.2. Engine Design

1.3. Fluid Dynamics During the Four Cycles

1.4. Designing High Efficiency IC Engines

1.1. Engine Performance

The performance of an IC Engine depends upon complex interactions between mechanical, fluid,
chemical, and electronic systems. However, the central challenge in design is the complex fluid dynamics
of turbulent reacting flows with moving parts through the intake/exhaust manifolds, valves, cylinder,
and piston. The time scales of the intake air flow, fuel injection, liquid vaporization, turbulent mixing,
species transport, chemistry, and pollutant formation all overlap, and need to be considered simultan-
eously.

Computational Fluid Dynamics (CFD) has emerged as a useful tool in understanding the fluid dynamics
of IC Engines for design purposes. This is because, unlike analytical, experimental, or lower dimensional
computational methods, multidimensional CFD modeling allows designers to simulate and visualize
the complex fluid dynamics by solving the governing physical laws for mass, momentum, and energy
transport on a 3D geometry, with sub-models for critical phenomena like turbulence and fuel chemistry.
Insight provided by CFD analysis helps guide the geometry design of parts, such as ports, valves, and
pistons; as well as engine parameters like valve timing and fuel injection.

Engine analysis using CFD software has always been hampered due to the inherent complexity in

• Specifying the motion of the parts.

• Decomposition of the geometry into a topology that can successfully duplicate that motion.

• Creating a computational mesh in both the moving and non-moving portions of the domain.

• Solving the unsteady equations for flow, turbulence, energy, and chemistry.

• Postprocessing of results and extracting useful information from the very large data sets.
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This is a time consuming and error prone process, creating a significant impediment to rapid engine
analysis and design feedback.

The solution to this problem is an integrated environment specifically tailored to the needs of modeling
the internal combustion engine. The environment requirements are as follows:

• It should have the necessary tools to automatically perform a problem setup.

• It should require minimal inputs from the user.

• It should be able to transfer information rapidly between the different stages of the CFD analysis.

• It should significantly compress the setup and analysis process.

• There should be no loss in the accuracy.

• The potential for errors should be reduced.

The IC Engine Analysis System provides such an integrated environment with the capabilities integrated
to set up most IC Engine designs.

The IC Engine System includes:

• Bidirectional CAD connectivity to mainstream CAD systems.

• Powerful geometry modeling tools in Design Modeler.

• Flexible meshing using Ansys Meshing.

• Solution using Ansys Fluent.

• Powerful postprocessing in CFD-Post.

• In addition, persistent parameterization and design exploration (DX) allow users to modify geo-
metry or problem setup parameters and to automatically regenerate analysis results.

The time taken for geometry, meshing, and solution setup has been reduced from several hours of work
to minutes, with reduced potential for error. The user specifies the engine parameters and geometry
at the beginning of setup, instead of at the solution stage, to guide and automate the entire setup
process.

The next few chapters will introduce the automation tools in the IC Engine Analysis System and how
to use them. A deeper examination of the fluid dynamics issues in IC Engines and the CFD modeling
process will be conducted first, followed by details of the IC Engine Analysis System.

1.2. Engine Design

IC engine design involves several critical decisions which impact and interact with the fluid dynamics.
The primary design decisions are

• The specifications for engine type.

• Peak power at a specified speed or RPM.
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• The number of cylinders.

• Fuel and emissions characteristics.

• The total volume of the engine.

• Overall "packaging" of the engine including all the sub-systems.

Mechanical and electronics systems may also be specified at this stage, such as using different cam
configurations. There may be additional specifications, such as the engine power at idle speed or low
RPM.

These design decisions impact the computation of the amount of air and fuel needed by the engine
and lead to a cascade of design decisions to maximize the overall efficiency of the engine. This efficiency
is given by the following equation for engine brake power:

(1.1)

where

 is the indicated (brake) efficiency

 is the combustion efficiency

 is the mechanical efficiency

 is the volumetric efficiency of the engine

 is the density of the air at the intake

 is the engine displacement volume

 is the rotational speed

 is the number of revolutions per power stroke

 is the fuel air ratio

 is the calorific value of the fuel per unit mass

• The primary goal of engine design is to maximize each efficiency factor, in order to extract the
most power from the least amount of fuel. In terms of fluid dynamics, the volumetric and com-
bustion efficiency are dependent on the fluid dynamics in the engine manifolds and cylinders.

• The second goal of engine design is to meet emissions requirements, which are always specified
by regulations. The pollutants include oxides of nitrogen, sulfur oxides (SOx), CO (carbon
monoxide), unburned hydrocarbons (HC), and Poly Aromatic Hydrocarbons (PAH or “soot”), which
are all products of the combustion process. Pollutants are formed by a variety of interactions of
the mechanical and chemical processes inside the engine and are intimately tied to fluid dynamics
in the cylinder. Though the pollutants in the exhaust stream can be reduced utilizing after-
treatments, often these technologies add considerable cost to the engine. Therefore, it is desirable
to minimize the pollutant formation at the source.

1.3. Fluid Dynamics During the Four Cycles

The volumetric efficiency of the engine depends on several fluid dynamic phenomena in the intake and
exhaust tracts leading to the combustion chamber.
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• When the air is pumped into the combustion chamber during the intake cycle, it passes through
the gap between the valve and the valve seat. As it squeezes through the gap, the flow separates
from the walls of the port and valve surfaces, forming a tangential jet. The jet from the valves
impinges on the cylinder walls and tumbles into the space between the valves and the piston.
This jet imparts angular momentum, known as swirl and tumble, to the fresh charge. The gross
motions of the fresh charge are recirculation regions that promote mixing.  If there is strong
swirl (usually described by a normalized angular momentum value about the vertical axis through
which the piston motion is constrained) the flow may develop stratification with regions of high
and low velocity. The intake port may be designed to impart additional angular momentum to
the air; and multiple intake valves or any partially open exhaust valves may have flow interaction.

• When the piston travels back up towards the top during the compression stroke, most of the
energy contained in the tumble (or angular momentum orthogonal to the swirl axis) of the jet
is converted to turbulence as the available space in the vertical direction is reduced significantly.
The swirl will become stronger as the air is squeezed out to the side. If there is a narrow region
between the piston and the cylinder head, the air may be squeezed (or “squished”) from the
sides of the cylinder into the combustion chamber, converting the energy in the swirl into tur-
bulence. Flow phenomena, which affect volumetric efficiency include

– separation, jet formation, and reattachment on the cylinder head

– swirl and tumble in the cylinder volume to promote mixing

– turbulence production during the compression of air due to squeezing of the main flow

– flow stratification in the cylinder

Engines that utilize port fuel injection (PFI) or carburetion are known as premixed engines. For
a port fuel injected engine, the fuel is sprayed into the ports normally onto the back of the intake
valve, where it vaporizes and mixes with the intake air. An engine that uses a carburetor mixes
the air and fuel as the air enters the intake manifold. In this type of premixed engine, at least
from the fluid mechanical point of view, a mixture of fresh air and fuel is inducted into the engine,
through the intake port.

For Direct Injection (DI) and all modern diesel engines, high pressure fuel is injected directly into
the combustion chamber as the piston nears the end of the compression stroke. The liquid fuel
spray breaks up into smaller droplets and vaporizes into the surrounding air. High levels of tur-
bulence in the cylinder enhance the mixing and high pressure of the fuel spray enhance breakup.
In any engine, charge motion at the start of combustion is necessary for efficient burning of the
mixture. However, often some compromises need to be made in the range of speeds over which
the engine operates.

• In a spark ignited (SI) engine, a flame front is formed which moves outwards from the ignition
point, consuming the available fuel air mixture. Turbulence again plays a significant role in flame
propagation, since the flame moves at the turbulent flame speed. Hence, if the turbulence levels
are high, the flame front will move more rapidly to all parts of the combustion chamber. For SI
engines, the rapid flame propagation avoids knock due to autoignition of fuel air ahead of the
flame. The flame speed depends on the air fuel ratio of the mixture. If the mixture is outside of
the flammability limits, usually between equivalence ratios of 0.5 and 4, the flame will not
propagate and the engine will misfire. Similarly, if regions exist inside the cylinder that are outside
of the flammability limits, these regions will not burn and will most likely be pushed out through
the exhaust and into the atmosphere.
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For compression ignition engines, air is compressed to a high temperature and pressure and
fuel is injected directly into the combustion chamber. After some time for spray breakup, mixing,
and low temperature chemical breakdown to occur, the mixed air and fuel in the spray plume
ignites and begins to burn, usually forming a stratified, or diffusion flame. Compression ignition
engines have no knock limit, however are limited by the amount of mixing in the cylinder and
the material limits of the components.

Combustion produces a rise in pressure and temperature as the energy contained in the fuel is
released and the chemical reaction is completed. The fuel combustion produces a spike in
pressure and temperature as the energy contained in the fuel is released, with the production
of exhaust gases. Some of the energy is radiated and convected to the cylinder walls, cylinder
head, piston and the valves; and is lost. Most of the energy goes into the power stroke, where
the exhaust gases expand under high pressure and push the piston down to the bottom center
position. A thermodynamic energy balance shows that the energy produced due to combustion
is used for work done due to expansion, while the thermal losses includes heat losses through
the walls and the enthalpy of the exhaust gases at high temperature.

• During the subsequent exhaust stroke, the exhaust gases are pushed out through the exhaust
valves, which start opening towards the end of the power stroke. This process involves formation
of a high speed, high temperature jet in the gap between the exhaust valves and ports.

During combustion, the fuel, which is a long chain hydrocarbon, breaks up into smaller molecules.
The carbon and hydrogen contained in these molecules combine with the oxygen in the air in
exothermic reactions. If the fuel air ratio is stoichiometric at each location in the combustion
chamber, carbon dioxide and water are formed. However, if the fuel air ratio is rich at particular
locations due to inadequate mixing, the oxygen molecules are not sufficient and the combustion
will be incomplete. Here carbon monoxide (CO) and unburnt hydrocarbon molecules will be
produced.

Some of the unburnt hydrocarbons will be polycyclic or poly-aromatic as the carbon chains wrap
around each other and form solid particles, which is called soot. If the carbon monoxide and
unburnt hydrocarbons are then transported to a region with adequate oxygen, then the combus-
tion may still reach completion. If not, they will leave with the exhaust gases and represent a
loss of energy. Due to high temperatures, the nitrogen molecules contained in the air break up
under intense heat and the nitrogen ions combine with the available oxygen radicals to form
nitrous oxides or NOx. If the fuel contains nitrogen or sulfur atoms, they will also form NOx and
sulfur oxides (SOx).

Thus, the combustion efficiency of the engine and pollutant formation depends on the fluid dynamics
of swirl, tumble, mixing, and turbulence production during the intake and compression strokes, losses
due to incomplete combustion, the heat transfer losses to the wall, and the exhaust losses. Engine
emissions include carbon dioxide, water, carbon monoxide, NOx, SOx, unburnt hydrocarbons, and soot.

1.4. Designing High Efficiency IC Engines

The design of high efficiency IC engines has to take into account the complex fluid dynamics that occurs
in the manifolds and cylinders. Several design issues come to the forefront here.

1.4.1. Port Flow Design

1.4.2. Combustion Chamber and Piston Shape

1.4.3. Squish
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1.4.4. Compression Ratio

1.4.5. Design for Low Speed and Idle

1.4.6. Spark and Injection Timing

1.4.1. Port Flow Design

The air flow rate through the intake manifold ports, depends on the pressure difference between the
cylinder and the manifold, as well as the throttle position. A critical consideration here is the packaging;
i.e. the engine and its supporting systems have to fit in a certain amount of space and still allow easy
access for future maintenance. This means that the intake manifolds and engine ports might be routed
around other parts; which introduces an additional resistance to the air flow and affects the swirl and
tumble in the cylinder. Port flow design to achieve a given air flow rate and desired levels of
swirl/tumble within a certain packaging layout to maximize volumetric efficiency, thus becomes a
critical fluid dynamics design problem.

1.4.2. Combustion Chamber and Piston Shape

A critical design issue is the size and shape of the combustion chamber, the piston crown shape, and
the layout of the valves. Here, the chamber can be flat, a hemispheric dome, or a penta-head, while
the piston crown can be flat, domed, or a bowl. The valves can be positioned as "straight", i.e. the
valves are aligned with the cylinder axis as shown in Figure 1.1: Straight Valve Engine (p. 124),  or they
can be "canted", i.e. they are at an angle to the cylinder axis and normal to the surfaces of the com-
bustion chamber (Figure 1.2: Canted Valve Engine (p. 125)).

Figure 1.1: Straight Valve Engine
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Figure 1.2: Canted Valve Engine

It has been shown that the volumetric efficiency and the amount of air that makes it into the cylinder
is dependent on the ratio of the intake valve area relative to the cross section area of the cylinder.
Hence it is desirable that the intake valves be as large as possible relative to the bore. However, if
the combustion chamber is flat, it limits the surface area available for the valve layout to just the
cross section. If the combustion chamber is hemispheric or penta-headed, it opens up more surface
area for the intake and exhaust valves, allowing them to be larger and more efficient. However, this
means that the combustion chamber has a larger volume and surface area, which implies that the
flame front for combustion has a longer distance to travel, increasing the chance of incomplete
combustion. Also the compression ratio will be decreased since there is a larger volume at the top
center. In addition, a larger wall surface area increases the heat losses during combustion. Thus, there
is adverse impact on combustion efficiency.

This may be counteracted by changing the piston shape from the flat shape to a domed shape to
reduce the volume. But this means that the flame front has to travel around the piston dome to reach
all parts of the combustion chamber volume, thus increasing the time taken for complete combustion,
raising the possibility of knocking in SI engines. The piston could then be made to have a bowl in
the center, which would reduce the flame travel time, but reduce the compression ratio.

1.4.3. Squish

An additional geometric design consideration is the "squish" region, which is the region around the
perimeter of the combustion chamber with the smallest clearance volume between the piston and
the cylinder head at top center. As noted before, a small or low squish region causes the swirling air
flow to get squeezed out into the combustion chamber and form a turbulent jet, which converts the
mean flow energy in the swirl into turbulence, increasing the turbulent flame speed and the compres-
sion ratio and the combustion efficiency.
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But if the squish is too low, there is a chance of collision between the piston and the cylinder head
when the engine material expands at high temperature. In addition, mass manufacturing of engines
requires that there should be room for production and manufacturing tolerances. Hence the squish
needs to be low enough to allow higher turbulence production, but high enough to allow room for
variability due to thermal expansion and manufacturing tolerances.

1.4.4. Compression Ratio

The compression ratio, which is defined as the ratio of the cylinder volume at the bottom center to
the volume at the top center, is a critical factor in combustion efficiency and pollutant formation. A
high compression ratio enhances the combustion efficiency, but the higher temperatures cause more
NOx to form, thus increasing the emissions.
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Automotive engines in the 1970s had much higher compression ratios since the emissions standards
were much lower. With stricter environmental regulations on emissions, the compression ratios were
reduced to meet the new standards. In the 1990s, technological improvements in catalytic converters
and improvements in combustion efficiency allowed higher compression ratios and improved fuel
economy. An additional consideration, especially for diesel engines, is that the materials used for the
piston and combustion chamber must be able to withstand the peak temperatures and pressures
encountered with high compression ratios and high boost levels.

Figure 1.3: Different Piston Shapes Used to Achieve Desired Compression Ratio for an Engine
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Thus the geometric design of intake/exhaust ports, cylinder heads, valves and pistons involves interplay
and trade-offs between the volumetric and combustion efficiency, pollutant formation, packaging
considerations, materials choices and manufacturing tolerances. The ability to accurately analyze the
engine fluid dynamics plays a key role in optimizing the engine to efficiently deliver the power needed,
while meeting emissions standards and respect packaging and manufacturing constraints.

1.4.5. Design for Low Speed and Idle

The performance of engines at idle or low speed is a critical design consideration in many cases. For
passenger car engines, the engine is designed for peak power at a specific speed, which is typically
high. However, the engine will still have to perform well at lower speeds and at idle. Variable valve
timing, which allows the valves to have different lift profiles and opening and closing events for dif-
ferent engine speeds, is used in many modern engines. Here the goal is to maximize the volumetric
and combustion efficiency by producing optimal levels of swirl, tumble and turbulence at both low
and high speeds so that the combustion charge, i.e. the air/fuel mixture, is well mixed and the turbulent
flame speed is high enough for complete combustion. There are additional geometric design changes
to the ports and valves that can be made for low speed or idle conditions. For example, valve masking
and valve shrouding is used to impart additional swirl to the air flow and increase the jet velocity.

Figure 1.4: Inlet Valves Used to Induce High Swirl at Low Engine Speeds and Low Valve Lift

1.4.6. Spark and Injection Timing

During the engine cycle, the spark timing and start of injection has been optimized to provide the
desired power or torque with minimum pollutant formation. Strategies, such as  Exhaust Gas Recircu-
lation (EGR) are used to minimize the peak temperature in the engine by increasing the thermal mass
of the intake air, which reduces the NOx production, which is strongly correlated with higher temper-
atures. For diesel engines, there is tradeoff between soot production and NOx, since soot production
decreases with temperature increase and NOx increases with temperature increase. Thus designing
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high efficiency engines to meet performance and emissions standards requires tradeoffs which take
engine fluid dynamics into account.
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Chapter 2: Modeling CFD in IC Engine Design
This chapter emphasizes the role of CFD modeling in IC Engine design. The information in this chapter
is divided into the following sections:

2.1.The Role of CFD Analysis in Engine Design

2.2.Types of CFD Analysis for IC Engines

2.3.The IC Engine Analysis System: Process Compression in the Ansys Workbench

2.1. The Role of CFD Analysis in Engine Design

As described in Introduction to Internal Combustion Engines (p. 119), IC engines involve complex fluid
dynamic interactions between air flow, fuel injection, moving geometries, and combustion. Fluid dynamics
phenomena like jet formation, wall impingement with swirl and tumble, and turbulence production are
critical for high efficiency engine performance and meeting emissions criteria. The design problems
that are encountered include port-flow design, combustion chamber shape design, variable valve timing,
injection and ignition timing, and design for low or idle speeds.

There are several tools which are used in practice during the design process. These include experimental
investigation using test or flow bench setups, 1D codes, analytical models, empirical/historical data,
and finally, computational fluid dynamics (CFD). Of these, CFD has the potential for providing detailed
and useful information and insights that can be fed back into the design process. This is because in
CFD analysis, the fundamental equations that describe fluid flow are being solved directly on a mesh
that describes the 3D geometry, with sub-models for turbulence, fuel injection, chemistry, and combus-
tion. Several techniques and sub-models are used for modeling moving geometry motion and its effect
on fluid flow.

Using CFD results, the flow phenomena can be visualized on 3D geometry and analyzed numerically,
providing tremendous insight into the complex interactions that occur inside the engine. This allows
you to compare different designs and quantify the trade-offs such as soot vs NOx, swirl vs tumble and
impact on turbulence production, combustion efficiency vs pollutant formation, which helps determine
optimal designs. Hence CFD analysis is used extensively as part of the design process in automotive
engineering, power generation, and transportation. With the rise of modern and inexpensive computing
power and 3D CAD systems, it has become much easier for analysts to perform CFD analysis. In increasing
order of complexity, the CFD analyses performed can be classified into

• Port Flow Analysis (p. 132): Quantification of flow rate, swirl and tumble, with static engine
geometry at different locations during the engine cycle.

• Cold Flow Analysis (p. 133): Engine cycle with moving geometry, air flow, and no fuel injection
or reactions.

• In-Cylinder Combustion Simulation (p. 133): Power and exhaust strokes with fuel injection, ig-
nition, reactions, and pollutant prediction on moving geometry.
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• Full Cycle Simulation (p. 135): Simulation of the entire engine cycle with air flow, fuel injection,
combustion, and reactions.

However, the CFD analysis process for engines has been complex, time consuming, and error-prone.
Typically, the analyst has to go through several steps to set up the problem, and any minor error can
lead to failure of the simulation. Once the analysis has been set up, it takes many hours or days of
computation to get the solution and evaluate the results. The results are fairly complex, with large data
sets, which require time and effort to analyze and get useful information, which can be fed back to the
design stage.

Automation and process compression thus becomes a critical need. In the next section, you will further
evaluate the practical issues facing engineers in conducting a CFD analysis on IC Engines. Following
that, you will explore the solutions that are available in an integrated environment like the Ansys
Workbench and explain the rationale for the IC Engine Analysis System.

2.2. Types of CFD Analysis for IC Engines

The following sections present some practical issues in conducting a CFD analysis for IC Engines.

2.2.1. Port Flow Analysis

2.2.2. Cold Flow Analysis

2.2.3. In-Cylinder Combustion Simulation

2.2.4. Full Cycle Simulations

2.2.1. Port Flow Analysis

In port flow analysis, the geometry of the ports-valves and cylinders is "frozen" at critical points during
the engine cycle and the air flow through the ports is analyzed using CFD. The flow rate through the
engine volume, swirl and tumble in the cylinder and turbulence levels are determined. Fluid dynamics
phenomena like separation, jet formation, valve choking, wall impingement, and reattachment, as
well as the secondary motions, can be visualized and analyzed.

The results provide snapshots of the fluid dynamics throughout the engine cycle; and are used to
modify the port geometry to produce desired behavior of the air flow. Simulation validation can be
performed using the real geometry mounted on a flow bench with measurement of flow rates, velo-
cities, and turbulence levels using techniques like LDV (Laser Doppler Velocimetry). The results do
not capture dynamic phenomena such as expansion and compression of air due to piston movement
and turbulence production from swirl and tumble.

In practice, conducting port flow analysis at a single point is relatively straightforward because of the
static geometry, which fits well with the workflow and capabilities in CFD software. You start with
the port, valve and cylinder geometry at a particular position, create a mesh, specify the mass flow
rate or pressure drop for the compressible flow and a turbulence model and compute the results.
The RANS approach based turbulence models are used to compute the effect of turbulence. Since
the turbulent flow interactions with the walls are critical, mesh refinement in the near wall region is
necessary using inflation or boundary layers. Experimental data provides validation to develop con-
fidence and best practices for model setup and accuracy.

However, when the number of critical positions and hence the number of cases increases, the problem
complexity increases significantly. Setting up large numbers of static cases with identical mesh and
flow settings is time consuming, with scope for error.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.132

Modeling CFD in IC Engine Design



2.2.2. Cold Flow Analysis

Cold flow analysis involves modeling the airflow and possibly the fuel injection in the transient engine
cycle without reactions. The goal is to capture the mixture formation process by accurately accounting
for the interaction of moving geometry with the fluid dynamics of the induction process. The changing
characteristics of the air flow jet that tumbles into the cylinder with swirl via intake valves and the
exhaust jet through the exhaust valves as they open and close can be determined, along with the
turbulence production from swirl and tumble due to compression and squish.

This information is very useful to ensure that the conditions in the cylinder at the end of the compres-
sion stroke are right for combustion and flame propagation. High turbulence levels facilitate rapid
flame propagation and complete combustion during the power stroke. A well mixed and highly tur-
bulent air flow is critical to ensure the right air/fuel ratio throughout the combustion. CFD can also
assess the level of charge stratification.

However, since cold flow simulations do not include the significant thermodynamic changes that
accompany combustion, the flow characteristics during the power and exhaust strokes do not reflect
reality. In terms of validation, experimental PIV (Particle Image Velocimetry) or LDV data in cycling
engines is not easy to obtain as with port flow analysis, but transparent pistons and cylinders have
been used to gather velocity information for some engine configurations.

Setting up the CFD model for cold flow analysis involves additional work in specifying the necessary
information to compute the motion of the valves and piston in addition to the boundary conditions,
turbulence models and other parameters. This includes specifying valve and piston geometry, along
with the lift curves and engine geometric characteristics in order to calculate their position as a
function of crank angle. Since the volume in the cylinder is changing shape throughout the engine
cycle, the mesh has to change accordingly. Different approaches to automatically modify the mesh
during motion also need to be specified. The CFD calculation is an inherently transient computational
problem when involved with moving deforming or dynamic mesh. All the geometric motion is a
function of a single parameter, the position of the crankshaft in its rotation, or crank angle.

The preprocessing from geometry to solver setup is typically time consuming and challenging. Here,
you have to separate or decompose the geometry into moving and stationary parts. Typically, the
intake ports are split off from the cylinder and valves. The region between the valve margin and valve
seat, which opens and closes during valve motion may be separated. The combustion chamber and
piston region may be also decomposed or separated into smaller parts. Then each part can be meshed
accordingly for the solver setup. Any errors at this stage can lead to failures downstream during the
solution process.

The run times for solver runs can be fairly long since the motion is typically resolved with small time
steps (approximately 0.25 crank angle) to get accurate results and the simulation is run for two or
three cycles to remove the initial transients. Finally, the large volume of transient data that results
from the CFD solution needs to be postprocessed to obtain useful insight and information. Thus cold
flow analysis would also benefit from design automation and process compression.

2.2.3. In-Cylinder Combustion Simulation

Combustion simulation involves simulation of the power stroke during the engine cycle, starting from
closing of valves to the end of the compression stroke. Since the valves are closed or in the process
of closing, the combustion chamber is the chief flow domain, and the piston the sole moving part.
These simulations are also known as "in-cylinder combustion" and though multi-dimensional, are less
complicated geometrically than a port flow simulation. In addition, if the geometry is rotationally
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symmetric and has a single feature like a very high pressure spray that dominates the flow in the
calculation, the entire domain can be modeled as a sector to speed up the calculation.

Typically, the initial flow field at this stage is obtained from

• a cold flow simulation if the full geometry is used

• patching-in based on a cold flow analysis

• running the piston without combustion to obtain charge compression

As with cold flow, a moving deforming mesh model is used for the piston motion. Geometric decom-
position is not required here, since only the piston motion is included in the simulation. Hence, in-
cylinder combustion simulations typically do not include the modeling of the fluid dynamics in the
valve port region and their effect on combustion.

Models are used to account for the fuel spray, combustion and pollutant formation. For direct injection
engines, the fuel spray from the tip of the nozzle injector is introduced at the specific crank angle
and duration using a spray model. For port fueled engines, it is assumed that the combustion charge
is well mixed. A chemical mechanism describing the reaction of vapor fuel with air is used to describe
combustion, and models for turbulence-chemistry interaction are specified. Sub-models for NOx and
soot formation are used to calculate pollutant formation, which can be coupled with the combustion
calculation or calculated as a postprocessing step.

With in-cylinder combustion, the main challenge lies in the physics for spray modeling and combustion.
The spray is composed of a column of liquid entering the domain at high speed which subsequently
breaks into droplets due to aerodynamic forces. These droplets can coalesce into larger droplets or
break into even smaller droplets, all while exchanging mass with the surrounding gases. Sub-models
for coalescence and breakup, as well as heat and mass transfer, are used to capture spray dynamics.
The CFD mesh has to be sufficiently resolved to capture the coupling between the liquid droplets
and the gases in the cylinder accurately. If liquid spray impinges upon the cylinder walls, it is possible
to form a thin liquid film which undergoes its own processes of movement and vaporization and re-
quires a separate treatment.

To calculate combustion, detailed chemical mechanisms for pure fuels that constitute the components
of diesel fuel and gasoline involve hundreds of species and thousands of reactions. These reactions
are coupled with the fluid dynamics due to the similar time scales of fluid mechanical motions and
chemical reactions. The energy release from combustion increases pressures and temperatures for
the fluid flow, which affects the fluid motions inside the cylinder. A direct computation of this coupled
interaction without submodels while including detailed chemistry is staggeringly expensive in terms
of computation time and is impractical for complex geometries.

Reduced order mechanisms capture most of the essential chemistry in a narrower range of temperature
and equivalence ratio, and are used along with a submodel for turbulence-chemistry interaction. One
such model is the Probability Density Function (PDF) approach which allows an efficient computation
of turbulence-chemistry interaction. Flame propagation is modeled using a progress variable based
approach such as the Zimont model, which calculates the transient flame front speed and location.
These approaches allow computation of the combustion process on large meshes in complex geo-
metries with a reasonable computational power.

Simplified mechanisms are used to compute the NOx formation due to

• high temperatures (thermal NOx)
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• nitrogen in the fuel (fuel NOx)

• fuel reactions in the flame front (prompt NOx)

• sulfur oxides in the fuel (SOx)

• soot formation

Since these pollutants are generally a very small percentage of the total mass in the cylinder, these
calculations can be decoupled from the calculation of the main energy release. In some cases, this is
done as a postprocessing operation at the end of the simulation, but it is more accurate to include
the pollutant formation in the simulation, especially for the pollutants arising from incomplete com-
bustion that oxidize later in the cycle. In terms of automation and process compression, the problem
setup at the solver stage can benefit from automation.

2.2.4. Full Cycle Simulations

As the name indicates, full cycle simulations essentially involve all the elements from cold flow ana-
lysis and in-cylinder combustion to complete simulations of the entire engine cycle. Thus this type
of simulation is a transient computation of turbulent airflow, spray and combustion, and exhaust with
moving valves and pistons. The initial flow field is obtained from a cold flow simulation or by running
the engine without combustion for a cycle before turning on spray and combustion.

The advantage of full cycle simulations is that they provide the full picture of engine performance,
including intake and exhaust valve fluid dynamics, mixing, turbulence production, spray, combustion
and flame propagation, and pollutant formation. However, they are extremely complex to set up and
expensive to run.

The geometry preparation can include geometry from the throttle body, ports, valves, combustion
chamber, cylinder and the piston, making it difficult to perform cleanup, decomposition and meshing.
The solver setup has to include moving mesh, airflow, turbulence, spray, turbulence-chemistry and
flame propagation, and pollutant formation.

Here, the need is for process compression and automation all the way from geometry to postprocessing
to reduce the time needed for problem setup and postprocessing. In addition, accurate and efficient
models for chemistry, spray and combustion, as well as efficient solver techniques, are required to
get the solution in the shortest time possible.

2.3. The IC Engine Analysis System: Process Compression in the Ansys
Workbench

As demonstrated in the previous section, IC Engine simulations require process compression tools and
automation to reduce problem setup time, automate solution runs, and postprocessing of large data
sets. In the past, geometry and meshing, solution, and postprocessing were performed in different
software running independently, with no interaction between them. This meant that each simulation
had to be set up completely from the beginning, even when simple design changes were made. With
a complex problem setup, any simple user error at any stage has the potential to derail the entire sim-
ulation. Thus the previous process is inherently time consuming and error prone.

Process compression and automation can only be accomplished in an integrated environment where
the software at each step is aware of the overall goals of the simulation and shares a common problem
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description. Ansys Workbench provides an ideal integrated environment with powerful tools for geometry,
meshing, CFD solvers, and postprocessing available on a common platform.

In Ansys Workbench,

• Bidirectional CAD connectivity ensures that design changes from CAD are automatically
propagated into the simulation.

• The geometry tool (Design Modeler) can be linked to the meshing tool (Ansys Meshing or Forte
Sector Mesh Generator).

• Ansys Meshing in turn can be linked to Ansys Fluent or Forte and Forte Sector Mesh Generator
is linked to Forte.

• The results can be automatically sent to CFD-Post, a postprocessing tool.

• The data generated at each stage is stored in an organized structure and can be easily exchanged
between different tools.

All of these tools can be linked together in "systems" in Ansys Workbench and provide a built-in pathway
for simulation automation. In addition, each tool has built-in technological capabilities for creating
process compression tools to automate repeated tasks, such as geometry decomposition and cleanup,
meshing, solution setup and solver runs; and postprocessing. Thus Ansys Workbench has tremendous
potential as a platform for process compression and solution automation.

The IC Engine Analysis System exploits these capabilities to create process compression for performing
IC Engine simulations.

1. An Input Manager allows you to specify input parameters related to DesignModeler at the first
step, with minimum possible information. This information is used to perform automatic decom-
position and animation of engine motion in DesignModeler.

2. The geometry model is sent to Ansys Meshing or Forte Forte Sector Mesh Generator, where
the meshing parameters are setup automatically with user input and the mesh generated.

3. The mesh is sent to Ansys Fluent or Forte, which performs automatic CFD problem setup and
runs the calculation.

4. Once the results are ready, the solution data is automatically analyzed in CFD-Post and a report
generated.

You provide minimal input at each stage and have the ability to modify the inputs. Thus the IC Engine
Analysis System allows engine designers to rapidly progress from geometry to problem setup in a very
short time with attenuated scope for error. In the next few chapters, the essential elements of the system
and their working will be described.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.136

Modeling CFD in IC Engine Design



Chapter 3: Getting Started With ICE
This chapter provides information about using ICE within Ansys Workbench.

3.1. Introduction to Workbench

3.2.The Workbench Graphical User Interface

3.3. Creating an IC Engine Analysis System

3.4. Setting up an IC Engine Analysis System for IC Engine

3.5. Understanding Cell States with ICE in Workbench

Some basic information about using Workbench is provided here, but the majority of the information
about using Workbench can be found in the Workbench on-line documentation (Workbench User's
Guide).

3.1. Introduction to Workbench

Ansys Workbench combines access to Ansys applications with utilities that manage the product workflow.

This chapter provides some basic instructions for using ICE in Workbench.

Applications that can be accessed from Workbench include: Ansys DesignModeler (for geometry creation);
Ansys Meshing (for mesh generation); Ansys Fluent (for setting up and solving computational fluid dy-
namics (CFD) simulations); Ansys Ansys Forte (an additional solver system); Ansys CFD-Post (for postpro-
cessing the results). In Workbench, a project is composed of a group of systems. The project is driven
by a schematic workflow that manages the connections between the systems. From the schematic, you
can interact with workspaces that are native to Workbench, such as Design Exploration (parameters
and design points), and you can launch applications that are data-integrated with Workbench. Data-
integrated applications have separate interfaces, but their data is part of the Workbench project and is
automatically saved and shared with other applications as needed. This makes the process of creating
and running a CFD simulation more streamlined and efficient.

In addition, Workbench also allows you to copy systems in order to efficiently perform and compare
multiple similar analyses. Workbench also provides parametric modeling capabilities in conjunction with
optimization techniques to allow you to efficiently investigate the effects of input parameters on selected
output parameters.

3.2. The Workbench Graphical User Interface

The Workbench graphical user interface consists of the Toolbox, the Project Schematic, the Toolbar,
and the Menu bar. Depending on the analysis type and/or application or workspace, you may also see
other windows, tables, charts, and so on. The most common way to begin work in Workbench is to
drag an item, such as a component system (application) or an analysis system, from the Toolbox to the
Project Schematic, or to double-click on an item to initiate the default action. You will view your com-
ponent and/or analysis systems – the pieces that make up your analysis – in the Project Schematic, in-
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cluding all connections between the systems. The individual applications in which you work will display
separately from the Workbench graphical interface, but the actions you take in the applications will be
reflected in the Project Schematic.

Full details of how to use Workbench are provided in the Workbench User's Guide.

Important:

Note that IC Engine (Fluent) can be accessed in Workbench as an analysis system.

Figure 3.1: The Workbench Graphical User Interface

3.3. Creating an IC Engine Analysis System

The IC Engine system is located in the Analysis Systems toolbox of the Workbench user interface. You
create an IC Engine analysis system in Workbench by double-clicking IC Engine (Fluent) under Analysis
Systems in the Toolbox.

Important:

You can also create an IC Engine analysis system by left-clicking on IC Engine (Fluent) under
Analysis Systems in the Toolbox, and then dragging it onto the Project Schematic.
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Figure 3.2: Selecting the IC Engine Analysis System in Workbench

The new IC Engine analysis system appears in the Project Schematic as a box containing several cells.
Each cell corresponds to a typical task you would perform to complete a CFD analysis. The following
cells are available in an ICE analysis system.
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Figure 3.3: An ICE Analysis System

ICE

Opens the Properties panel where you define the parameters and controls required for the analysis.
It controls the behavior of the downstream components. For details on configuring the properties,
refer to Setting up an IC Engine Analysis System for IC Engine (p. 141).

Geometry

Opens DesignModeler where you define the geometrical constraints of your analysis or import an
existing geometry. You will prepare the geometry for decomposition (divide the geometry into
smaller volumes before meshing). For details, refer to Cold Flow Simulation: Preparing the Geo-
metry (p. 149), Port Flow Simulation: Preparing the Geometry in IC Engine  (p. 271), or Combustion
Simulation: Preparing the Geometry in IC Engine  (p. 341).

Note:

To open DesignModeler from the Geometry cell, you should set the Preferred Geometry
Editor to DesignModeler in the Geometry Import section in the Options dialog box.
The Options dialog box can be opened from the Tools → Options...menu.

Mesh

Opens Ansys Meshing and loads the current geometry defined by the Geometry cell. See Cold Flow
Simulation: Meshing (p. 185), Port Flow Simulation: Meshing in IC Engine (p. 285), or Combustion
Simulation: Meshing in IC Engine (p. 365).

ICE Solver Setup

Allows you to change or add solver settings and also select crank angles for KeyGrid simulation.
See Cold Flow Simulation: Setting Up the Analysis (p. 217),  Port Flow Simulation: Setting Up the
Analysis in IC Engine  (p. 301), or Combustion Simulation: Setting Up the Analysis in IC Engine
(p. 393).

Setup

Allows you to define the physical models, material properties, boundaries and process conditions,
and solver settings for the ICE analysis in Ansys Fluent. See Cold Flow Simulation: Setting Up the
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Analysis (p. 217),  Port Flow Simulation: Setting Up the Analysis in IC Engine  (p. 301), or Combustion
Simulation: Setting Up the Analysis in IC Engine  (p. 393).

Solution

Allows you to calculate a solution using Ansys Fluent. Right-click the Solution cell and select Update
to run the Fluent solver using the current data file for input. If you want Ansys Fluent to run in
background mode rather than the default foreground mode, before you select Update you must
first right-click the Solution cell, select Properties, and select Run in Background for the Update
Option in the Properties of Schematic A6: Solution pane that opens. For details on cold flow
solutions, see Run Calculation (p. 265). For port flow solution details refer to Run Calculation (p. 336).

Note that you can open Ansys Fluent using the context menu (by right-clicking on the Solution
cell), in order to postprocess the results of your ICE simulation.

Results

Displays and analyzes the results of the CFD analysis in Ansys CFD-Post. See Working with the
Simulation Results (p. 485).

Note:

Workbench provides visual indications of a cell’s state via icons on the right side of each cell.
Brief descriptions of the each possible state are provided below. For more information about
cell states, see Workbench User's Guide.

3.4. Setting up an IC Engine Analysis System for IC Engine

After you double-click or drag IC Engine (Fluent) under Analysis Systems in the Toolbox, the new IC
Engine (Fluent) analysis system appears in the Project Schematic. Before importing the geometry, you
have to define the parameters for your analysis. You can define the parameters in the Properties pane.
To view properties, right-click ICE and select Properties from the context menu. You can also view the
properties by enabling Properties from the View menu list.
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Properties pane displays detailed information as shown in the figure below.
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In the Properties table there are several sections, the most important of which are as follows.

General

The properties in this section are

Component ID

It is ICE.

Directory Name

It is the directory where temporary files are stored. It is named as ICE.

Simulation Type

You can select the simulation type from the drop-down list. At present there are three options.

• Cold Flow Simulation

• Port Flow Simulation

• Combustion Simulation
Depending on the selection of the simulation type, further options change.

For Combustion Simulation you can select from three subtypes.

• Sector

• Full Engine Full Cycle

• Full Engine IVC to EVO

Engine Inputs

In this section you provide specifications of the engine model. This section is available only for
Cold Flow Simulation and Combustion Simulation.

Connecting Rod Length

It is set to 200mm by default. You can enter the connecting rod length of your engine
here.
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Crank Radius

It is set to 20mm by default. You can enter the crank radius of your engine here.

Piston Offset/Wrench

It is set to a default value of 0.

The piston pin offset is generally used to reduce the stress on the reciprocating parts.
It enables these parts to be lighter, which increases the efficiency, and decreases the
power loss in the engine. It also results in higher rpm. An additional result of the piston
pin offset is reduced piston slap, due to the gradual shift between major and minor
thrust.

The piston pin offset is an off-centered mount of the connecting rod; piston wrenching
is a nonalignment of the cylinder axis and the crank shaft axis. Both the piston offset
and wrench have the same effect.

You can enter a positive or a negative value for Piston Offset/Wrench. This will depend
upon the offset:
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Minimum Lift

It is set to a default value of 0.2mm. You can enter your value here. For details, see
the explanation on minimum valve lift (p. ?).

Note:

If you enable P next to the above properties, you can create a new
parameter. Also you can set the units as required for the parameters.

Input Option for IVC and EVO

This option is present only for the Sector and Full Engine IVC to EVO subtypes of
Combustion Simulation. You can select from the two options present.

• By Lift Curve Profile

• Enter Direct Values
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Valve Lift and Piston Motion Profile

This option is present for Cold Flow Simulation, and when you select By Lift Curve
Profile for Combustion Simulation. Here you have to provide the path to the profile
file. This file essentially contains the valve lift values at different crank angles. It can
also include the piston motion profile. You can use this profile file to animate the
movement of the valves. It is also used for simulating the valve motion.

The format of the profile file is fairly simple. The file can contain an arbitrary number
of profiles. Profile names must have all lowercase letters. Here profile-name is the
name given to the type of valve. For example, it can be invalve1 or exvalve2.
The types of profile are point and transient. The mandatory field-names are
angle and lift.

Parentheses are used to delimit profiles and the fields within the profiles. Any combin-
ation of tabs, spaces, and newlines can be used to separate elements.

Important:

In the general format description below, “...” indicates a continuation of
the list.

((profile-name point m n)
  (angle  a11 a12 ... a1n
          a21 a22 ... a2n
          .
          .
          .
           am1 am2 ... amn)
(lift   l11  l12 ... l1n
        l21  l22 ... l2n
        .
        .
        .
        lm1 lm2 ... lmn)) 

IVC (Inlet Valve Closed)

Here you need to enter the IVC or inlet valve closing angle of your engine.

EVO (Exhaust Valve Open)

Here you need to enter the EVO or exhaust valve opening angle of your engine.

3.5. Understanding Cell States with ICE in Workbench

Workbench integrates multiple data-integrated (for example, IC Engine) and native applications into a
single, seamless project flow, where individual cells can obtain data from and provide data to other
cells. Workbench provides visual indications of a cell’s state via icons on the right side of each cell. Brief
descriptions of the each possible state are provided below. For more information about cell states, see
the Workbench on-line help (Workbench User's Guide).
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• Unfulfilled ( ) indicates that required upstream data does not exist. For example, when you first
create a new IC Engine analysis system, all cells downstream of the Geometry cell appear as Unful-
filled because you have not yet specified a geometry for the system.

• Refresh Required ( ) indicates that upstream data has changed since the last refresh or update.
For example, after you assign a geometry to the Geometry cell in your new IC Engine analysis system,
the Mesh cell appears as Refresh Required since the geometry data has not yet been passed from
the Geometry cell to the Mesh cell.

• Attention Required ( ) indicates that the current upstream data has been passed to the cell, however,
you must take some action to proceed. For example, after you launch IC Engine and then double
click Geometry to open DesignModeler you have to load the geometry. However, if you do not load
the geometry and close Design Modeler, then the Geometry cell appears as Attention Required
because additional data is required before you can build or create a mesh.

• Update Required ( ) indicates that local data has changed and the output of the cell needs to be
regenerated. For example, after you launch DesignModeler from the Geometry cell in an IC Engine
analysis system that has a valid geometry, the Geometry cell appears as Update Required until you
perform decomposition.

• Up to Date ( ) indicates that an update has been performed on the cell and no failures have occurred
(or an interactive calculation has been completed successfully). For example, after you perform de-
composition, the Geometry cell appears as Up to Date.

• Interrupted ( ) indicates that you have interrupted an update (or canceled an interactive calculation
that is in progress). For example, if you select the Cancel button in Ansys Fluent while it is iterating,
Ansys Fluent completes the current iteration and then the Solution cell appears as Interrupted.

• Input Changes Pending ( ) indicates that the cell is locally up-to-date, but may change when next
updated as a result of changes made to upstream cells. For example, if you change the Mesh in an
Up-to-Date IC Engine analysis system, the Setup cell appears as Refresh Required, and the Solution
and Results cells appear as Input Changes Pending.

• Pending ( ) indicates that a batch or asynchronous solution is in progress. When a cell enters the
Pending state, you can interact with the project to exit Workbench or work with other parts of the
project. If you make changes to the project that are upstream of the updating cell, then the cell will
not be in an up-to-date state when the solution completes.

If a particular action fails, Workbench provides a visual indication as well. Brief descriptions of the failure
states are described below.

• Refresh Failed, Refresh Required ( ) indicates that the last attempt to refresh cell input data failed,
and so the cell needs to be refreshed.

• Update Failed, Update Required ( ) indicates that the last attempt to update the cell and calculate
output data failed, and so the cell needs to be updated.

• Update Failed, Attention Required ( ) indicates that the last attempt to update the cell and calculate
output data failed, and so the cell requires attention.
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If an action results in a failure state, you can view any related error messages in the Messages pane by
clicking the Show Messages button on the lower right portion of Workbench.
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Chapter 4: Cold Flow Simulation: Preparing the
Geometry
The simulation of the engine starts when you import an engine geometry. The imported geometry is
divided into smaller volumes before meshing. This enables each volume to be meshed separately. De-
composition partitions a volume into sub-volumes and then the sub-volumes are meshed individually.
Each volume will be meshed into hex or tet elements, depending upon the approach.

There are certain mesh topology requirements for valves and pistons. You should have pistons at TDC
(top dead center) before the geometry is decomposed. With the piston at TDC, the volume is the
smallest. In general it is more difficult to satisfy the mesh topology requirement at TDC, but this provides
the advantage that the mesh will behave properly when the piston moves away from TDC. However,
the simulation requires a minimum valve lift between the valve and valve seat so that layered cells can
be placed at the region of minimum valve lift. This ensures that the gap between the valve and valve
seat will not disappear. A non-conformal interface is used to completely shut the valve. Even though
in theory an arbitrarily small minimum valve lift can be used, in reality a value of 0.05 mm to 0.5 mm
has been successfully used to run simulations using Ansys Fluent.

This chapter provides instructions and information about preparing the IC engine geometry for simulation:

4.1. Repair Geometry Before Decomposition

4.2. Geometry Decomposition for a Cold Flow Simulation for IC Engine

4.3. Nomenclature of Decomposed Geometry

4.4.Viewing the Bodies and Parts in IC Engine system

4.5. Animating the Valve and Piston

4.6. Moving the Piston to a Specified Crank Angle in IC Engine system

4.1. Repair Geometry Before Decomposition

You should check the geometry before decomposing so that geometrical problems can be avoided at
initial level. Verify that:

• Pistons are at the TDC position.

• Valves are not extracted from the port volume.

• Each valve is correctly aligned and positioned above the valve seat.

• There are no extra bodies in the geometry other than the port, valves, or crevice.

For more information, refer to Geometry Check (p. 517).

If the valves are extracted you need to create valves before decomposition.
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1. Click Pre Manager (  located in the IC Engine toolbar).

a. In the Details of ICPreManager1 select Create Valve from the Pre Manager Operation
drop-down list.

b. For the Valve Hole Edges select the edge of the hole where the valve should be present
and click Apply.

c. Select the faces of the valve seats for Valve Seats and click Apply.
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d. The Valve Stem Extrusion Length is automatically calculated and you can use the
default value or change it if required.

2. Click Generate (  located in the Ansys DesignModeler toolbar).

3. Click Pre Process (  located in the Ansys DesignModeler toolbar) to complete the
procedure.
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4.2. Geometry Decomposition for a Cold Flow Simulation for IC Engine

Before understanding how the geometry is decomposed into different sub-volumes, let us understand
the process of decomposition in DesignModeler.

1. Start ICE DesignModeler.

a. In Ansys Workbench, double-click or drag IC Engine (Fluent) from Analysis Systems
to the Project Schematic.
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b. Select Cold Flow Simulation from the Simulation Type drop-down list.

c. Enter the engine details under Engine Inputs in the Properties view.

d. Provide the path to the profile file for Valve Lift And Piston Motion Profile.

e. From Geometry, cell 3 in the IC Engine (Fluent) analysis system, open ICE-Design-
Modeler application.

Note:

To open DesignModeler from the Geometry cell, you should set the Pre-
ferred Geometry Editor to DesignModeler in the Geometry Import section
in the Options dialog box. The Options dialog box can be opened from the
Tools → Options...menu.
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Then you can double-click Geometry, cell 3, to open DesignModeler.

One more way to open DesignModeler is, to right-click on the Geometry
cell, and select New DesignModeler Geometry... from the context menu.
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2. Set the units, depending upon the geometry units, in ICE-DesignModeler.

3. Load the geometry file.

File → Load DesignModeler Database...

4. Set up the Input Manager by clicking Input Manager (  located in the IC
Engine toolbar).

Note:

The IC Engine toolbar is displayed in the ICE DesignModeler only after installing IC
Engine Analysis System.
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Details of InputManager

This section in the Input Manager dialog box takes the inputs of the engine to set it up for
decomposition.

• For Decomposition Position you can select the angle at which you want the geometry to
be decomposed. You can choose from:

– Specified Angle: If you choose this option then you can specify the particular angle
at which you want to decompose the geometry.

– You can set the angle at which you want the geometry to be decomposed by entering
the value in Decomposition Angle. It is set to 0 by default. When you want the

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.156

Cold Flow Simulation: Preparing the Geometry



solver to start the simulation from a specific crank angle you can do so by changing
the Decomposition Angle. If you enable FD1 next to it, a new parameter will be
created.

Note:

Setting Decomposition Angle to a value will move the piston and
valves to the specified crank angle before decomposition. For details,
see Moving the Piston to a Specified Crank Angle in IC Engine sys-
tem (p. 183).

– FTDC: This is the firing top dead center angle.

– IVC: This is the inlet valve close angle.

– IVO: This is the inlet valve open angle.

– EVC: This is the exhaust valve close angle.

– EVO: This is the exhaust valve open angle.

• Click next to Inlet Faces in the Details View of Input Manager.

Confirm that Selection Filters are set to Model Faces.

Select the inlet faces and click Apply.

Figure 4.1: Inlet Face Selection

157
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Geometry Decomposition for a Cold Flow Simulation for IC Engine



• Similarly, select the outlet faces for Outlet Faces and click Apply.

Figure 4.2: Outlet Face Selection

• Select all the faces of the engine cylinder for Cylinder Liner Faces and click Apply.

Figure 4.3: Cylindrical Liner Face Selection

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.158

Cold Flow Simulation: Preparing the Geometry



The cylinder radius and the cylinder axis are displayed in the status bar at the bottom of the
window.

Note:

Ensure that all the faces of the cylinder body are selected. If the geometry has a
crevice body, ensure that none of the crevice cylinder faces is chosen.

• After selecting the Cylinder Liner Faces the program will check for symmetry. It will accord-
ingly set Yes or No for the Symmetry Face Option. If Yes is selected you will be required
to give the symmetry faces.

Note:

You should select Yes for Symmetry Face Option if the geometry is symmetrical.
Failure to do so will result in the failure of the simulation. Also ensure to select
the faces for Symmetry Faces.

• Click next to Symmetry Faces in the Details View of Input Manager. Select the faces of the
engine about which it is symmetric and click Apply.

Note:

If the geometry has a crevice body, select the symmetry faces belonging to the
crevice body.

159
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Geometry Decomposition for a Cold Flow Simulation for IC Engine



• You can select Full Topology or Single Zone from the Topology Option drop-down list.
Full Topology will decompose the engine geometry into different parts and bodies according
to IC Engine System default decomposition process. If you select Single Zone then only a
single zone will be generated after decomposition.

• If your geometry has a crevice select Yes from the Crevice Option drop-down list.

Note:

If the geometry has a crevice, ensure that the crevice body is separated before
decomposition. For more information, see Separating the Crevice Body (p. 568).

• Select the crevice body for Crevice Bodies.

• You can select Yes or No from the Validate Compression Ratio drop-down list. If you select
Yes then a Compression Ratio option appears below it.

• Enter the value for Compression Ratio. By default it is set to 15. The program will internally
calculate the compression ratio from the geometry and give a warning if the values do not
match.
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Note:

For details on how the compression ratio is calculated internally see Calculating
Compression Ratio (p. 590).

IC Valves Data

In this section you are required to give details about the valves.

• Select InValve or ExValve as the Valve Type from the drop-down list.

• Select the valves from the figure and click Apply next to Valve Bodies.

Note:

– You can select multiple valves at a time and set them to the desired type.

– Confirm that Selection Filters are set to Bodies.

– Remember the order of selection of the valve bodies. This is important es-
pecially while using meshes from another setup for the KeyGrid option.

• Select the faces on which the valve rests for Valve Seat Faces and click Apply.
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Figure 4.4: Valve Seats Faces

The valve seat is that face of the port body which comes in contact with the valve body. The
Figure 4.5: Valve Seat Selection (p. 163) shows that the highlighted face of the valve body will
make contact with the valve seat face of the port body.
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Figure 4.5: Valve Seat Selection

Note:

Confirm that Selection Filters are set to Model Faces. Some engines might have
line contact between the valve and the valve seat. In such cases you can select
the face which is near the valve and includes the line of contact.

• Select the valve from the Valve Profile drop-down list. This will set that particular valve to
the selected valve profile.

Note:

The profile file (Valve Lift and Piston Motion Profile)  (p. 146)contains a table of
crank angle against the valve lift for different valves. Each table type has a name.
The names are loaded in the Valve Profile drop-down list.

• To create a new valve group, add section IC Valves Data by right-clicking,

and selecting Add New IC Valves Data Group. Set the details for the new group.
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IC Animation Inputs

In this section, you can give the inputs required for animating the valve motion. For details,
refer to Animating the Valve and Piston  (p. 182).

IC Advanced Options

• For V Layer Slice, you can select Yes or No from the drop-down list. By default it is set
to Yes. This will create extra slices in vlayer. For details, refer to the section on creating
extra slices (p. 175).

• V Layer Slice Angle is set to 15° by default. If the angle between two faces in any
vlayer body is less than (180–V Layer Slice Angle), then the body is split into two bodies
using the common edge of these two faces.

Note:

This option will not be displayed if the V Layer Slice is set to No.

• V Layer Approach: You can select 4 Layers or 1 Layer from the drop-down list. By default
it is set to 4 Layers, which signifies the number of layers created in the V layer.

Note:

If V Layer Approach is set to 4 Layers, while meshing inflation is created
in port region. For details, see Inflation Port (p. 207).

• You can select Yes or No from the Piston Profile Option drop-down list. If you select
Yes then a Piston Profile option appears below it.

• For Piston Profile, you can select the piston profile from the drop-down list next to it.
The profile is in the file you provided in the properties dialog box. For details, see Valve
Lift and Piston Motion Profile. (p. 146)

• Decompose Chamber can be set to Yes, Program Controlled or No.

– If you have enough squish volume to separate the chamber and piston by a layer
body, select Yes.

– If you have a straight-valve engine, select Yes to get a maximum layer mesh.

– If there is not enough squish volume to insert a layer between chamber and
piston, select No; this automatically inserts a layer mesh during solver meshing.

– If you select Program Controlled then the program automatically checks if
chamber decomposition is possible or not and proceeds accordingly.

Based on the option selected, decomposition nomenclature will vary. For more informa-
tion, refer to Nomenclature of Decomposed Geometry (p. 167).
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• When Decompose Chamber is set to Yes then Decompose Chamber Inputs is set to
Automatic by default. This option will not be displayed when Program Controlled or
No is selected from Decompose Chamber.

– When Automatic is selected, the Top Plane/Face and the Bottom Plane/Face
are automatically selected by the application.

Note:

The top plane and bottom plane are chosen for the engine automatic-
ally as the lines shown in the figure below.

Ttop is the tolerance for the top plane. It is gap between the dome
faces and the top plane.

Tbot is the tolerance for the bottom plane. It is gap between the piston
faces and the bottom plane.

Clr is the clearance between the top and bottom planes.

Following are the values for the tolerances for a straight valve:

→ Ttop = 0

→ Tbot = 0

→ Clr = S/3 (where S is the mesh size calculated from valve margin
radius)

Following are the values for the tolerances for a canted valve:

→ Ttop = 2 * S
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→ Tbot = S

→ Clr = S/3 (where S is the mesh size calculated from valve margin
radius)

– If you select Manual, then you have to provide the Top Plane/Face and the
Bottom Plane/Face.

• Top Plane/Face and Bottom Plane/Face take the input as a plane or surface; these inputs
are used to slice the engine at those positions to form different parts. Bottom Plane/Face
slices the piston bowl and separates it from the remaining volume. Top Plane/Face
slices the chamber from the remaining volume. The body remaining between these two
planes is filled with layered mesh. For canted valve engines (when the Decompose
Chamber option is set to Yes), this body will be named layer-cylinder and for straight
valve engines this body will be named fluid-ch-lower.

Note:

If you create the planes ensure that the plane created for Top Plane/Face
does not cut the valve body.

5. Click Generate (  located in the Ansys DesignModeler toolbar).

6. Click Decompose (  located in the IC Engine toolbar).

Note:

After decomposition you can see the different parts and bodies created, the different
methods used, planes, etc. in the tree. Depending upon the number of valves, cut-
plane is automatically created in the tree. In Meshing, you can observe the mesh
sliced with the cut-plane.

7. Close Ansys DesignModeler.

Note:

Even after decomposition you can change parameters like Decomposition Crank
Angle, or Engine Inputs such as Connecting Rod Length and Minimum Lift in the
properties table. After changing the parameters, you will have to update the cell to
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regenerate the geometry with the changes. If you change any other parameters you
will have to decompose the geometry again.

Important:

If the geometry is of a straight valve engine with valve pockets, then you need to do
some manual changes. For more information, refer to Decomposing a Straight Valve
Pocket Engine (p. 552).

4.3. Nomenclature of Decomposed Geometry

The geometry will be decomposed into different Parts and Bodies. Each will have a specific name. This
naming is important. Depending on the naming, each part will be meshed with different specifications.
Refer to Viewing the Bodies and Parts in IC Engine system (p. 175) for more information. Types of valves
and the naming conventions of their parts are presented in the following sections:

4.3.1. Straight Valve Geometry With Chamber Decomposition for IC Engine

4.3.2. Canted Valve Geometry With Chamber Decomposition for IC Engine

4.3.3. Any Engine Geometry Without Chamber Decomposition

4.3.1. Straight Valve Geometry With Chamber Decomposition for IC Engine

The following figures show the geometry decomposition and the corresponding zone and boundary
names specific to a straight valve engine.
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Figure 4.6: Boundary Zone Names and Mesh Requirements for Straight Valve

Boundary ZoneNo.

intf-deck-fluid-ch-lower1

intf-deck-fluid-ch-upper2

intf-int-valveID-ib-fluid-ib3

intf-int-valveID-ib-fluid-port4

intf-int-valveID-ob-fluid-port5

intf-int-valveID-ob-fluid-vlayer6

intf-valveID-ib-fluid-ib7

intf-valveID-ib-fluid-ob-quad8

intf-valveID-ib-fluid-ob-tri9

intf-valveID-ob-fluid-ch-lower10

intf-valveID-ob-fluid-ch-upper11

intf-valveID-ob-fluid-ch-valve12

intf-valveID-ob-fluid-vlayer13

valveID-seat14

valveID-ch15

valveID-ib16

valveID-ob17

piston18
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intf-piston-bowl19

intf-piston-ch20

intf-piston-valveID21

cyl-quad22

intf-piston-on-crevice23

cyl-crevice24

Figure 4.7: Fluid Zone Names and Mesh Requirements for Straight Valve

Mesh RequirementFluid Zone NameNo.

any meshfluid-piston1

layered meshfluid-ch-lower2

any meshfluid-ch-upper3

layered meshfluid-ch-valveID4

mesh with at least one layer at the topfluid-valveID-ib5

layered meshfluid-valveID-vlayer6

169
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Nomenclature of Decomposed Geometry



any meshfluid-crevice7

Note:

• valveID is a variable. It represents the valve type and number. For example, valveID
can be exvalve1, which is one of the exhaust valves, or invalve2, which can be the second
intake valve in an engine with more than one intake valve.

• Crevice zone and boundary zones are shown for your reference only. They might not
be included in every geometry.

4.3.2. Canted Valve Geometry With Chamber Decomposition for IC Engine

The following figures show the geometry decomposition and the corresponding zone and boundary
names specific to canted valve engines with the chamber decomposed.

Figure 4.8: Boundary Zone Names and Mesh Requirements for Canted Valve with Chamber
Decomposition

Boundary ZoneNo.

intf-int-valveID-ib-fluid-ib1

intf-int-valveID-ob-fluid-port2

intf-valveID-ib-fluid-ib3

intf-valveID-ib-fluid-ob-quad4
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intf-valveID-ib-fluid-ob-tri5

intf-valveID-ob-fluid-ch6

intf-valveID-ob-fluid-vlayer7

valveID-seat8

valveID-ch9

valveID-ib10

valveID-ob11

int-piston12

cyl-tri13

piston14

intf-int-valveID-ob-fluid-vlayer15

intf-int-valveID-ib-fluid-port16

cyl-quad17

cyl-piston18

interior-fluid-layer-cylinder-fluid-piston19

cyl-head20

intf-crevice-on-piston21

intf-piston-on-crevice22

cyl-crevice23
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Figure 4.9: Fluid Zone Names and Mesh Requirements for Canted Valve with Chamber
Decomposition

Mesh RequirementFluid Zone NameNo.

tetrahedron meshfluid-ch1

mesh with at least one layer at the
top

fluid-valveID-ib2

any meshfluid-valveID-port3

layered meshfluid-valveID-vlayer4

layered meshfluid-layer-cylinder5

any meshfluid-piston6

any meshfluid-crevice7

Note:

• valveID is a variable. It represents the valve type and number. For example, valveID
can be exvalve1, which is one of the exhaust valves, or invalve2, which can be the second
intake valve in an engine with more than one intake valve.

• Crevice zone and boundary zones are shown for your reference only. They might not
be included in every geometry.
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4.3.3. Any Engine Geometry Without Chamber Decomposition

The following figures show the geometry decomposition and the corresponding zone and boundary
names for canted or straight valve engines without decomposing the chamber.

Figure 4.10: Boundary Zone Names and Mesh Requirements Without Chamber Decomposition

Boundary ZoneNo.

intf-int-valveID-ib-fluid-ib1

intf-int-valveID-ob-fluid-port2

intf-valveID-ib-fluid-ib3

intf-valveID-ib-fluid-ob-quad4

intf-valveID-ib-fluid-ob-tri5

intf-valveID-ob-fluid-ch6

intf-valveID-ob-fluid-vlayer7

valveID-seat8

valveID-ch9

valveID-ib10

valveID-ob11

intf-int-valveID-ib-fluid-port12

cyl-tri13

piston14
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intf-int-valveID-ob-fluid-vlayer15

intf-crevice-on-piston16

intf-piston-on-crevice17

cyl-crevice18

Figure 4.11: Fluid Zone Names and Mesh Requirements Without Chamber Decomposition

Mesh RequirementFluid Zone NameNo.

any meshfluid-ch1

mesh with at least one layer at the
top

fluid-valveID-ib2

any meshfluid-valveID-port3

layered meshfluid-valveID-vlayer4

any meshfluid-crevice5

Note:

• valveID is a variable. It represents the valve type and number. For example, valveID
can be exvalve1, which is one of the exhaust valves, or invalve2, which can be the second
intake valve in an engine with more than one intake valve.

• Crevice zone and boundary zones are shown for your reference only. They might not
be included in every geometry.
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4.4. Viewing the Bodies and Parts in IC Engine system

This section describes in detail the different bodies and parts created after decomposition. For conveni-
ence, the engine is divided into three regions.

4.4.1.Valve Region

4.4.2. Port

4.4.3. Chamber

4.4.1. Valve Region

Following are the parts and bodies created in the valve region.

valveID-vlayer

valveID-vlayer is one of the important regions for simulation. Because there will be very high velo-
cities/jets of fluid during the initial phase of valve opening, it is essential to have a good mesh in this
region. To achieve this, the part has to be made sweepable so as to create a uniform hex mesh in
this region. You can achieve this sweepable part by separating the circular portion between the valve
and the valve seat. Valve_Margin, Valve_Margin_Slice, Valve_Mid_Radius, and Valve_Mid_Radi-
us_Slice separates the part into different rings.

Note:

If you have selected Yes for V Layer Slice in the IC Advanced Options (p. 164) in the
Input Manager, additional slicing operations are performed. This will happen if, after
separation of vlayer, there is a large angular discontinuity within this body. The bodies
are separated where there is a change in the angle/inclination of the ring. For details
on setting the angle, see the part on V Layer Slice Angle (p. 164) in the Input Manager
section.

• Valve_Margin: This is a named selection corresponding to the maximum diameter closest to
the valve seat (with a tolerance of +/- 0.1) of valve body part.
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• Valve_Margin_Slice: It separates the port body from the chamber region using the extrude
operation, along the valve axis of that valve.

• Valve_Mid_Radius: This is the top edge of the valve seat. (It corresponds to the minimum
edge diameter of the valve seat for that valve.)
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• Valve_Mid_Radius_Slice: This is an extrude operation where slicing is carried out on the port
body using the Valve_Mid_Radius, thus creating the valveID-vlayer body.
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valveID-ib-body

This part consists of four bodies. It is created by the Cylinder (Inboard) feature. This cylinder is then
sliced into two halves so as to get a layered hex mesh in this region. A top slice is created which also
has layered mesh. These bodies move with the valve and thus generate hex layers during the valve
motion.

• Cylinder: This feature creates a new part called invalve-ib-body or exvalve-ib-body under
Parts and Bodies.

Note:

ib (in board) volume should consist at least of two parts so that sweeping can
be achieved.
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4.4.2. Port

valveID-port-group

This is the part from where the fluid will enter/exit the engine. Two circular bodies are created at the
bottom of the port so as to get good sweepable mesh and mesh transition in this region.

4.4.3. Chamber

The chamber region is decomposed differently for straight and canted valves.

4.4.3.1. Canted Valve

piston-layer

In the canted valve the piston-layer part is created in the chamber region.

This part consists of three bodies: ch, layer-cylinder, and piston-body.

• ch corresponds to the chamber region. The bottom surface is formed by the Top Plane/Face.
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• layer-cylinder is the body between the Bottom Plane/Face and Top Plane/Face. Layered
mesh is created in this region.

– Bottom Plane/Face is a plane which separates the piston body from the chamber.

– Top Plane/Face is a plane which separates the chamber from the rest of the volume.

• piston-body is the body below the Bottom Plane/Face. This body does not have any spe-
cific mesh requirements.

Note:

For canted valves when the Decompose Chamber option is set to No, instead of
these three bodies only one body is created, namely fluid-ch.

4.4.3.2. Straight Valve

Following are some parts and bodies of a straight valve that have a different named selection than
that of a canted valve.

Figure 4.12: Straight Valve

• ch-lower-body
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• ch-valveID-body

• ch-upper

181
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Viewing the Bodies and Parts in IC Engine system



4.5. Animating the Valve and Piston

The Animate button ( ) in the IC Engine toolbar, will display the valve and piston movement
for the required crank angle. It will also show the spray cone in the animation.

Before animating, you need to enter all the required data in the Input Manager under IC Animation
Inputs in addition to the inputs required for decomposition as shown in Geometry Decomposition for
a Cold Flow Simulation for IC Engine (p. 152).

In the Details View under IC Animation Inputs, enter the following:

• Start Crank Angle: By default, the automatic decomposition is done at zero crank angle, where
the piston is assumed to be at TDC position. For animation purposes you can enter the crank
angle value of your interest in this field so that the animation starts from that position.

• End Crank Angle: This is the crank angle till which you require the animation to continue. It is
set to 720° by default.

• Intervals: This term signifies the crank angle intervals at which you want the display to update.
It is set to 30° by default.

• Spray Cones Option: You can select Yes or No from the drop-down list depending on whether
your engine has spray cones or not. It is set to No by default. If you select Yes, you need to give
details about the spray cones.

– You can enter the angle at which the spray starts from the cones for the Spray Crank
Angle. It is set to 440° by default.

– For the Spray Cones Data you need to enter the name and the location of the file which
contains the details about the spray cones.

The file about the spray cone contains the following details:

→numberofspraycones: The number of spray cones present.

→sprayconeaxis: The direction of each cone.
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→sprayconestime-height: A table that gives information about the spray cone
height in millimeters with respect to time in milliseconds.

The format of the file is as follows:

numberofspraycones,n
sprayconeaxis,
x1,y1,z1
x2,y2,z2
.
.
.
xn,yn,zn
sprayconestime-height,
t1,h1
t2,h2
.
.
.
tl,yl

– For the Spray Cones Origin you need to select a vertex on the geometry and click Apply.
This will be the location at which all the cones are present.

Click Animate ( ) to display the valve and piston animation.

4.6. Moving the Piston to a Specified Crank Angle in IC Engine system

When the crank angle is specified, the piston should be moved to the desired crank angle. This is based
on the assumption that the initial position of the piston is at TDC.

Figure 4.13: Piston at TDC
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Figure 4.14: Piston Moved to Desired Crank Angle

For more details, refer to How IC Engine System Moves the Piston to the Specified Crank Angle (p. 547)
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Chapter 5: Cold Flow Simulation: Meshing
The decomposed geometry is used to generate the mesh. The goal of the IC Engine meshing tool is to
minimize the effort required to generate a mesh for the IC Engine specific solver. It uses the named
selection created in the decomposition to identify different zones and creates the required mesh controls.
The information in this chapter is divided into the following sections:

5.1. Meshing Procedure for Cold Flow Simulation in IC Engine

5.2. Global Mesh Settings for Cold Flow Simulation in IC Engine

5.3. Local Mesh Settings for Cold Flow Simulation in IC Engine

5.1. Meshing Procedure for Cold Flow Simulation in IC Engine

There are two ways to generate the mesh.

Meshing directly from the Workbench Window

After decomposition is done you can then directly generate the mesh from the Workbench window
without opening the Ansys Meshing application. If you want to use the default mesh settings then
right-click on the Mesh cell and select Update from the context menu. This will first create the mesh
controls and then generate the mesh.

You can also change the mesh settings from the Workbench window.
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In the Properties box which is displayed after selecting the Mesh cell you can click on Edit Mesh Set-
tings next to the Mesh Settings property, under IC Engine. This will open a ICEngine Mesh Settings
dialog box.

You can change the settings for the parameters:

• Mesh Type

• Reference Mesh Size (mm) (This can be parametrized by enabling the check box next to it.)

• Virtual Topology

• Number of Inflation Layers

For more information on these check the section on IC Mesh Parameters (p. 187).

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.186

Cold Flow Simulation: Meshing



Meshing using Ansys Meshing Application

In this method of meshing you can check the mesh controls and settings in details.

1. Double-click the Mesh cell in the IC Engine analysis system to open the Ansys Meshing applic-
ation.

2. Click  IC Setup Mesh (  located in the IC Engine toolbar). This opens the IC Mesh Para-
meters dialog box.

a. Here you can define different mesh settings for the different parts and virtual topologies.
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In the IC Mesh Parameters dialog box you can see the default mesh settings. You can
change the settings or use the default ones.

• Mesh Type: You can select Fine, Medium, or Coarse from the drop-down list. The default
setting is Medium.

• Reference Size: This is a reference value. Some global mesh settings and local mesh
setting values are dependent on this term.
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Reference Size = (Valve margin perimeter) /100

Note:

Choosing Fine, Medium, or Coarse changes the Reference Size and thus all
other dependent parameters are also affected.

Global Mesh Settings

• Min Mesh Size: This value is set to Reference Size/3.

• Max Mesh Size: This value is set to Reference Size × 3. This can be parametrized by
enabling the check box next to it.

• Normal Angle: This value changes depending upon the chosen Mesh Type.

• Growth Rate: This value is set to 1.2.

• Create Automatic Pinch Controls: This is set to No by default.

• Pinch Tolerance: Automatic pinch controls are not created by default. If you would like
to create pinch control select Yes from the Create Automatic Pinch Controls drop-down
list. You can change the default value of 0.1.

• Number of Inflation Layers: This value changes depending upon the chosen Mesh Type.
It is set to 3 for a Medium or Coarse Mesh Type and 5 for a Fine Mesh Type.

Local Mesh Settings

• V_Layer Size: This value is set to Reference Size × (1/2).

• IB Size: This value is set to Reference Size/2.

• Chamber-V_Layer Interface Size: This value is set to Reference Size/2.

• Chamber Size: This value is set to 1.5 X Reference Size.

• Chamber Growth Rate: This value is set to 1.15 for a Fine and Medium Mesh Type. It
is set to 1.2 for a Coarse Mesh Type.

• Inflation in Chamber: This is set to No by default. If you select Yes —

– For canted valve case, inflation will be created on liner, dome, valve bottom, and
vlayer-ch interface.

– For straight valve case inflation will be created on liner.
A new inflation control for ch faces is created.

• Virtual Topology Behavior: You can select Low, Medium, High, or None from the drop-
down list. If you select None virtual topologies are not created. Once you have selected
the behavior type you will not be allowed to change the virtual topology.
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• Crevice-Piston Interface Size: This option is visible in the dialog box when the geometry
has a crevice and you select Yes for Crevice Option in the Input Manager dialog box.
The value set depends on the thickness of the crevice and is calculated internally.

• Number of Layers in Crevice: This option is visible in the dialog box when the geometry
has a crevice and you select Yes for Crevice Option in the Input Manager dialog box.
The value set changes upon the selection of the Mesh Type. It is set to 2 for Coarse, 3
for Medium, and 4 for Fine Mesh Type.

Note:

If Reference Size is changed, all the other parameters will change, depending
on their relation with it.

b. If after changing the values of the parameters you would like to go back to the default
values, click Reset.

c. Click OK to set and close the IC Mesh Parameters dialog box.

Note:

Initially when you click OK, it creates all the mesh controls and virtual topologies.
If you click OK again anytime later, it will just update the values and will not re-
create any mesh controls or virtual topologies.
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You can generate the mesh controls before opening Ansys Meshing application. To do this
enable Automatically Setup On Edit under IC Engine in the Properties box which is displayed
after selecting the Mesh cell in the Workbench window.

So after you double-click the Mesh cell to open Ansys Meshing application the mesh controls
are already set.

3. Click IC Generate Mesh (  located in the IC Engine toolbar) to generate the mesh.

Note:

The order in which you create the mesh is important. So click IC Generate Mesh

( ) instead of Generate ( ). Clicking IC Generate Mesh creates
meshes of parts in a specific order. For example, it creates a mesh of chambers first.
This order is important, so that no pyramid cells are generated.
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Note:

If you want to modify any of the mesh control parameters, you can change them even after

the mesh is generated, by clicking IC Setup Mesh( ) icon. You will have to create the
mesh again with the changed settings.

When you complete the setup through IC Setup Mesh, it does the following:

• It creates virtual topologies.

– It calls the Generate Virtual Cells command, for ports (by suppressing all other
parts).

– It creates virtual cells for vlayer, ch bodies. This will help in creating a sweep mesh.

• It makes the required changes in Global Mesh Settings. (For details, refer toGlobal Mesh Settings
for Cold Flow Simulation in IC Engine (p. 193)).

• It creates Local Mesh Settings. (For details, refer to Local Mesh Settings for Cold Flow Simulation
in IC Engine (p. 201)).

• It creates pinch controls.

• Depending upon the number of valves, cut-planes and respective views are created by default.
The Section Planes dialog box opens after meshing is completed. The number of slice planes
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created are visible in the list. By enabling a Slice Plane you can observe the mesh at that cut-
plane. Double-clicking on the respective View in the Manage Views dialog box will set the display.

Figure 5.1: Mesh at the Cut Plane

5.2. Global Mesh Settings for Cold Flow Simulation in IC Engine

IC Engine meshing tool creates Global Mesh Settings based on the information provided in the IC
Mesh Parameters (p. 187) dialog box. Following sections describe these settings:

5.2.1. Defaults Group

5.2.2. Sizing Group

5.2.3. Quality Group

5.2.4. Inflation Group

5.2.5. Advanced Group

For more information on Global Mesh Settings, see Global Mesh Controls in the Meshing User's Guide.

5.2.1. Defaults Group

Under Details of Mesh, the following are the global mesh settings defined under Defaults.
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• Physics Preference: This is set to CFD.

This option allows you to establish how Workbench will perform meshing based on the physics
of the analysis type that you specify.

• Solver Preference: Ansys Fluent is set as the solver for the mesh.

Since CFD is chosen as your Physics Preference, it causes a Solver Preference option to appear
in the Details View of the Mesh folder. The chosen value sets certain defaults that will result
in a mesh that is more favorable to the respective solver.

• Element Order: This is set to Linear. This option allows you to control whether meshes are
to be created with midside nodes (quadratic elements) or without midside nodes (linear ele-
ments). Reducing the number of midside nodes reduces the number of degrees of freedom.
Choices include Program Controlled, Linear, and Quadratic.

• Element Size: This allows you to specify the element size used for the entire model. This size
will be used for all edge, face, and body meshing.

• Export Format: This option defines the format for the mesh when exported to Ansys Fluent.
The default is Standard. You can change this to Large Model Support to export the mesh as
a cell-based Fluent mesh.

• Export Preview Surface Mesh : This option controls the export of the preview surface mesh
elements. This option can be used when the bodies have been meshed only partially, that is,
not all volumes have been filled with elements and only previewing of surface meshes was
done. The default is No, which results in export of only volume mesh elements to the Fluent
mesh file. You can change this to Yes to export both the volume mesh and the preview surface
meshes to the Fluent mesh file.

5.2.2. Sizing Group

Under the Details of Mesh, the following are the global mesh settings defined under Sizing.
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• Use Adaptive Sizing: This option refers to a 2D curvature and proximity-based refinement
approach which refines edges based on curvature and/or proximity but does not propagate
the refined mesh along the face. When set to Yes, the mesher uses the value of the element
size property to determine a starting point for the mesh size. The value of the element size
property can be set by the user or automatically computed using defaults. When meshing
begins, edges are meshed with this size initially, and then they are refined for curvature and
2D proximity. Next, mesh based defeaturing and pinch control execution occurs. The final
edge mesh is then passed into a least-squares fit size function, which guides face and volume
meshing.

• Growth Rate: It is equal to the value of Growth Rate, which is set in the IC Mesh Paramet-
ers (p. 187) dialog box.

• Max Size: It is equal to the value of Max Mesh Size set in the IC Mesh Parameters (p. 187)
dialog box.

• Mesh Defeaturing: This option automatically defeatures small features and dirty geometry
according to the Defeature Size you specify here.

• Transition: When Use Adaptive Sizing is set to Yes, this option affects the rate at which ad-
jacent elements will grow. Slow produces smooth transitions while Fast produces more abrupt
transitions.

• Span Angle Center: It is set to Fine.

When Use Adaptive Sizing is set to Yes, this option sets the goal for curvature-based refine-
ment. The mesh will subdivide in curved regions until the individual elements span this angle.
The following choices are available:

– Coarse — 91o to 60o
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– Medium — 75o to 24o

– Fine — 36o to 12o

• Initial Size Seed: When Use Adaptive Sizing is set to Yes, this option allows you to control
the initial seeding of the mesh size for each part.

• Bounding Box Diagonal: This option provides a read-only indication of the length of the as-
sembly diagonal.

• Average Surface Area: This option provides a read-only indication of the average surface area
of the model.

• Minimum Edge Length: This option provides a read-only indication of the smallest edge
length in the model.

• Capture Curvature: This option allows you to take into account curvature effects.

• Curvature Min Size: When Capture Curvature is set to Yes, this option is equal to the value
of Min Mesh Size, which is set in the IC Mesh Parameters (p. 187) dialog box.

• Curvature Normal Angle: When Capture Curvature is set to Yes, this option is set to the
value of the Normal Angle in the case of Cold Flow Simulation. This value is set in the IC
Mesh Parameters (p. 187) dialog box.

• Capture Proximity: This option allows you to account for proximity effects.

• Proximity Min Size: When Capture Proximity is set to Yes, this option allows you to specify
a global minimum size to be used in proximity sizing calculations.

• Num Cells Across Gap: When Capture Proximity is set to Yes, this option is the minimum
number of layers of elements to be generated in the gaps. You can specify a value from 1 to
100, or accept the default (3).

• Proximity Size Function Sources: When Capture Proximity is set to Yes, this option determ-
ines whether regions of proximity between faces and/or edges are considered when proximity
size function calculations are performed. You can specify Edges, Faces, or Faces and Edges.

5.2.3. Quality Group

Quality is useful for configuring mesh quality.
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• Check Mesh Quality: This option determines how the software behaves with respect to error and
warning limits

• Target Skewness: This option allows you to set a target skewness that you would like the mesh
to satisfy.

• Smoothing: This option attempts to improve element quality by moving locations of nodes with
respect to surrounding nodes and elements. The Low, Medium, or High option controls the number
of smoothing iterations along with the threshold metric where the mesher will start smoothing.

• Mesh Metric: This option allows you to view mesh metric information and thereby evaluate the
mesh quality.

When you select a mesh metric, its Min, Max, Average, and Standard Deviation values are reported
in the Details View, and a bar graph is displayed under the Geometry window. The graph is labeled
with color-coded bars for each element shape represented in the model's mesh, and can be manip-
ulated to view specific mesh statistics of interest.

5.2.4. Inflation Group

Inflation is useful for CFD boundary layer resolution.
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• Inflation Option: It is set to Last Aspect Ratio for Cold Flow Simulation. This setting determ-
ines the heights of the inflation layers.

– The Last Aspect Ratio option creates inflation layers using the values of the First
Layer Height, Maximum Layers, and Aspect Ratio (Base/Height) controls to generate
the inflation mesh.

→ First Layer Height: It is equal to (Reference Size/Number of Inflation Layers), both
of which are set in the IC Mesh Parameters (p. 187) dialog box.

This control determines the height of the first inflation layer. This first inflation layer
consists of a single layer of prism elements that is formed against the faces of the
inflation boundary. You must enter a value for this control, and it must be greater
than 0.

→ Maximum Layers: It is equal to the value of Number of Inflation Layers, which is
set in the IC Mesh Parameters (p. 187) dialog box.

This control determines the maximum number of inflation layers to be created in the
mesh. Valid values are from 1 to 1000. The default is 5 for solid bodies, and 2 for
surface bodies.

→ Aspect Ratio (Base/Height): This value is set to 10.

This is defined as the ratio of the local inflation base size to the inflation layer height.
The value should be between 0.5 and 20.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.198

Cold Flow Simulation: Meshing



• View Advanced Options: This control determines whether advanced inflation options appear
in the Details View. Choices are No and Yes. It is set to Yes for Cold Flow Simulation. When
this control is set to Yes, the following options are available:

Collision Avoidance

Maximum Height over Base

Growth Rate Type

Maximum Angle

Fillet Ratio

Use Post Smoothing

Smoothing Iterations

– Collision Avoidance: It is set to Layer Compression.

This control determines the approach that is to be taken in areas of proximity to avoid col-
lisions that may occur from marching inflated surface meshes from opposite sides into each
other.

The Layer Compression option compresses inflation layers in areas of collision. In these
areas, the defined heights and ratios are reduced to ensure the same number of layers
throughout the entire inflation region. Generally, this option is best for avoiding the creation
of pyramids in the mesh.

– Growth Rate Type: It is set to Geometric.

This control determines the height of the inflation layers, given the initial height and height
ratio.

With this option, the prism height of a particular layer is defined by

h × r(n-1)

where

h is the initial height

r is the height ratio

n is the layer number

The total height at layer n is:

h(1–rn)/(1–r)

– Maximum Angle: It is set to 180.
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The Maximum Angle control determines prism layer growth around angles, and when
prisms will adhere (project) to adjacent surfaces/walls. If the inflated mesh involves extruding
from one surface and not its neighbor, and the angle between the two surfaces is less than
the specified value, the prisms (sides) will adhere (project) to the adjacent wall.

5.2.5. Advanced Group

The Advanced group provides some advanced meshing features.

• Number of CPUs for Parallel Part Meshing: This option sets the number of processors to be used
for parallel part meshing. Using the default for specifying multiple processors will enhance meshing
performance on geometries with multiple parts. For parallel part meshing, the default is set to
Program Controlled or 0. This instructs the mesher to use all available CPU cores. The default setting
inherently limits 2 GB memory per CPU core. An explicit value can be specified between 0 and 256,
where 0 is the default.

• Straight Sided Elements: This option specifies meshing to straight edge elements when set to
Yes. This option may affect the placement of midside nodes if the Element Order option is set to
Quadratic.

• Rigid Body Behavior: This option determines whether a full mesh is generated for a rigid body,
rather than a surface contact mesh. Rigid Body Behavior is applicable to all body types. Valid
values for Rigid Body Behavior are Dimensionally Reduced (generate surface contact mesh only)
and Full Mesh (generate full mesh).

• Triangle Surface Mesher: This option determines which triangle surface meshing strategy will be
used by patch conforming meshers. In general, the advancing front algorithm provides a smoother
size variation and better results for skewness and orthogonal quality. This option is inaccessible
when an assembly meshing algorithm is selected.

• Topology Checking: This option controls what happens when a user scopes an object (such as
loads, boundary conditions, named selections and so on) to geometry (bodies, faces, edges, and
vertices) after the mesh has been generated. If Topology Checking is set to Yes (default), the
software will check to see if the scoped geometry has mesh properly associated to it. If the associ-
ations are incorrect, the scoping of the object will force the mesh to be out of date. The mesh
would need to be re-generated to get proper associations. If the associations are correct, the
scoping is performed without any change to the mesh and the mesh stays up to date. Set Topology
Checking to No to avoid the checks and always keep the mesh up to date.

• Pinch Tolerance: This is equal to the value of Pinch Tolerance, which is set in the IC Mesh Para-
meters (p. 187) dialog box.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.200

Cold Flow Simulation: Meshing



This control allows you to specify a tolerance for the Meshing application to use when it generates
automatic pinch controls.

• Generate Pinch on Refresh: This option determines whether pinch controls will be regenerated
following a change made to the geometry (such as a change made via a DesignModeler application
operation such as a merge, connect, etc.). If Generate Pinch on Refresh is set to Yes and you
change the geometry, all pinch controls that were created automatically will be deleted and recreated
based on the new geometry. If Generate Pinch on Refresh is set to No and you update the geo-
metry, all pinch controls related to the changed part will appear in the Tree Outline but will be
flagged as undefined.

5.3. Local Mesh Settings for Cold Flow Simulation in IC Engine

Based on information provided in the IC Mesh Parameters dialog box, IC Engine meshing tool creates
some mesh settings at local level. Following section describes these settings for cold flow simulation:

5.3.1.Valve Region Meshing

5.3.2. Port Region Meshing

5.3.3. Chamber Meshing

5.3.4. Crevice

For more information on Local Mesh Settings, see Local Mesh Controls in the Meshing User's Guide.

5.3.1. Valve Region Meshing

5.3.1.1. Valve Inboard

This corresponds to the part ib. Body Sizing, Edge Sizing, Sweep Method, and Face Sizing are
the sizing methods used for these body parts.

Body Sizing

When you click Body Sizing (ib) under Mesh in the Outline, you can see the details.

• Geometry: It shows the number of selected parts for that body.

• Type: It is set to Element Size.

• Element Size: It is equal to the value of IB Size, which is set in the IC Mesh Paramet-
ers (p. 187) dialog box.

• Behavior: For this body part it is set to Soft.

Edge Sizing

When you click Edge Sizing (ib) under Mesh in the Outline, you can see the details.
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• Geometry: It shows the number of selected edges. (Two edges per vlayer on ib).

• Type: It is set to Number of Divisions.

• Number of Divisions: It is set to 2.

• Behavior: For this body part it is set to Hard.

Sweep Method

When you click Sweep Method (valve-ib) under Mesh in the Outline, you can see the details. In
this method, a swept mesh is forced on the “sweepable” bodies.

• Geometry: It shows the number of selected parts for that body.

• Source: It is the face selected. Here one vertical face of ib is selected as shown in the figure.
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• Target: It is Program Controlled. This means that the program determines the target for
the body.

• Free Face Mesh Type: It is set to All Quad. This determines the shape of the elements used
to fill the swept body.

• Sweep Bias Type: It adjusts the spacing ratio of nodes on the edge. Biasing direction is
based from the source to the target.

One of the four patterns available from the Sweep Bias Type drop-down list is chosen.

• Sweep Bias: This value is set to 1. This will override the mesh gradation in the swept region.
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Face Sizing

When you click Face Sizing (in/ex valve-ib-sweep-src) under Mesh in the Outline, you can see
the details.

• Geometry: The split face of ib is selected as the input.

• Type: It is set to Element Size.

• Element Size: It is equal to the value of IB Size, which is set in the IC Mesh Paramet-
ers (p. 187) dialog box.

• Behavior: For this body part it is set to Hard.

5.3.1.2. Valve Vlayer Meshing

Edge Sizing, Body Sizing, and Sweep Method are the sizing methods used for mesh sizing control
of this body part.

Edge Sizing

This sizing is used for the vertical edge of vlayer. When you click Edge Sizing (in/exvalve-valyer-
nbLayers) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of selected edges. The circular circumferential edges are
selected for this method.

• Type: It is set to Number of Divisions.

• Number of Divisions: This will depend upon the valve lift and layer approach set in the
Input Manager. For crank angle 0, it is based on the V Layer Approach you select in the
Input Manager. For other crank angles the value is equal to (Valve Lift/Reference Size X
0.4). It controls the number of layers in the V layer at different valve lifts. For one layer ap-
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proach, only one layer is created at the lifts less than or equal to (Reference Size X 0.4). For
four layer approach, four layers of equal height are created if the lift is less than or equal to
(Reference Size X 1.6).

• Behavior: For this body part it is set to Hard.

Body Sizing

When you click Body Sizing (vlayer) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of vlayer bodies selected.

• Type: It is set to Element Size.

• Element Size: This is equal to the value of V_Layer Size, which is set in the IC Mesh Para-
meters (p. 187) dialog box.

• Behavior: For this body part it is set to Soft.

Sweep Method

In this method, a swept mesh is forced on the “sweepable” bodies. When you click Sweep Method
(in/ex valve-vlayer) under Mesh in the Outline, you can see the details.

• Geometry: All the bodies for the part are selected.

• Source: The bottom faces of vlayer are selected. (One face per body.)

• Target: It is Program Controlled. This means that the program determines the target for
the body.

• Free Face Mesh Type: It is set to All Quad. This determines the shape of the elements used
to fill the swept body.

• Sweep Bias Type: This adjusts the spacing ratio of nodes the edge. Biasing direction is based
from the source to the target.

One of the four patterns available from the Bias Type drop-down list is chosen.

• Sweep Bias: This value is set to 1. This will override the mesh gradation in the swept region.

Edge Sizing

This sizing is used for the peripheral edge of vlayer. When you click Edge Sizing (in/ex valve-
vlayer-nbdiv) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of selected edges. The top and bottom edges of vertical
faces are selected as the input.
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• Type: It is set to Number of Divisions.

• Number of Divisions: It is calculated by dividing the larger edge length by (V_Layer
Size×2/3). V_Layer Size is set in the IC Mesh Parameters (p. 187) dialog box.

• Behavior: For this body part it is set to Hard.

Edge Sizing

This sizing is used for the peripheral edge of vlayer. When you click Edge Sizing (in/ex valve-
vlayer-sizing) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of selected edges. The top and bottom edges of vertical
faces are selected as the input.

• Type: It is set to Element Size.

• Element Size: It is calculated as (V_Layer Size × 2/3). V_Layer Size is set in the IC Mesh
Parameters (p. 187) dialog box.

• Behavior: For this body part it is set to Hard.

Edge Sizing

This sizing is used for the circular edge of vlayer. When you click Edge Sizing (in/ex valve-vlayer-
cir) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of selected edges. The circular circumferential edges are
selected for this method.

• Type: It is set to Number of Divisions.

• Number of Divisions: It is calculated as( (100 × MeshSize/V_Layer Size)/2). V_Layer Size
is set in the IC Mesh Parameters (p. 187) dialog box.

Note:

MeshSize is obtained from CAD Attributes in the Details dialog box of
piston-layer.

• Behavior: For this body part it is set to Hard.

5.3.2. Port Region Meshing

5.3.2.1. Port

When you click Inflation (port) under Mesh in the Outline, you can see the details.

• Boundary Scooping Method: It is set to Geometry Selection.
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• Inflation Option: It is set to Last Aspect Ratio. This setting determines the heights of the
inflation layers.

– First Layer Height: It is equal to (Reference Size/2 * Number of Inflation Layers) both
of which are set in the IC Mesh Parameters (p. 187) dialog box. This control determines
the height of the first inflation layer. This first inflation layer consists of a single layer of
prism elements that is formed against the faces of the inflation boundary. You must enter
a value for this control, and it must be greater than 0.

– Maximum Layers: It is equal to Number of Inflation Layers set in the IC Mesh Paramet-
ers (p. 187) dialog box. This control determines the maximum number of inflation layers
to be created in the mesh.

– Aspect Ratio: Here this value is set to 5.

• Inflation Algorithm: It is set to Pre.

5.3.2.2. Inflation Port

When you click Edge Sizing (inflation-port) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of the selected edges. The edges from port bottom sweep
bodies are selected.

• Type: It is set to Number of Divisions.

• Number of Divisions: It is equal to Number of Inflation Layers set in the IC Mesh Para-
meters (p. 187) dialog box.

• Behavior: For this body part it is set to Hard.

Note:

This part will only be created if V Layer Approach (p. 164) is set to 4 Layers in the
Input Manager.

5.3.2.3. Valve Port

Sweep Method and Face Sizing are the sizing methods used for mesh sizing control of the body
part.

Sweep Method

When you click Sweep Method (in/ex valve-port) under Mesh in the Outline, you can see the
details. In this method, a swept mesh is forced on the “sweepable” bodies.

• Source: One vertical face is selected as the source.

• Free Face Mesh Type: It is set to Quad/Tri. This determines the shape of the elements used
to fill the swept body.
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• Sweep Element Size: It is equal to V_Layer Size as set in IC Mesh Parameters (p. 187) dialog
box).

• Sweep Bias Type: It adjusts the spacing ratio of nodes on the edge. Biasing direction is
based from the source to the target.

One of the four patterns available from the Bias Type drop-down list is chosen.

• Sweep Bias: This value is set to 1. This will override the mesh gradation in the swept region.

Note:

If during mesh generation the sweep mesh fails, then a tet mesh is grown
for this region. In such a case the sweep method is suppressed.

Face Sizing

When you click Face Sizing (in/ex valve-port-sweep-src) under Mesh in the Outline, you can see
the details.

• Geometry: The face from the port bottom is selected as the input.

• Type: It is set to Element Size.

• Element Size: It is set to Reference Size/4. (Reference Size is set in the IC Mesh Paramet-
ers (p. 187) dialog box).

• Behavior: For this part it is set to Hard.

5.3.2.4. Interface Between Port and Inboard

Face Sizing method is used for this part. When you click Face Sizing (intf-port-ibVlayer) under
Mesh in the Outline, you can see the details.

• Geometry: The inside lower faces of Vlayer and ib are selected as the input.

• Type: It is set to Element Size.

• Element Size: It is equal to the value of V_Layer Size, set in the IC Mesh Parameters (p. 187)
dialog box.

• Behavior: For this part it is set to Soft.
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5.3.3. Chamber Meshing

When Inflation in Chamber is set to Yes in the IC Mesh Parameters (p. 187) dialog box, the inflation
is created in the chamber.

• For canted valve case, inflation will be created on liner, dome, valve bottom, and vlayer-ch
interface.

• For straight valve case inflation will be created on liner.

A new inflation control for ch faces is created.

Inflation (ch)

When you click Inflation (ch) under Mesh in the Outline, you can see the details.

• Boundary Scooping Method: It is set to Geometry Selection.

• Inflation Option: It is set to Last Aspect Ratio. This setting determines the heights of the in-
flation layers.

– First Layer Height: It is equal to (Reference Size/4 * Number of Inflation Layers) both of
which are set in the IC Mesh Parameters (p. 187) dialog box. This control determines the
height of the first inflation layer. This first inflation layer consists of a single layer of prism
elements that is formed against the faces of the inflation boundary. You must enter a value
for this control, and it must be greater than 0.

– Maximum Layers: It is equal to Number of Inflation Layers set in the IC Mesh Paramet-
ers (p. 187) dialog box. This control determines the maximum number of inflation layers to
be created in the mesh.

– Aspect Ratio: Here this value is set to 5.

• Inflation Algorithm: It is set to Pre.

Other than inflation, the approach for meshing the chamber region for straight and canted valves is
different.

5.3.3.1. Straight Valve

A straight valve has additional parts and bodies. This section shows the automatic settings performed
for them.

5.3.3.1.1. Chamber Upper Meshing

Interface Between Chamber Upper

Face Sizing is the sizing method used for this part. When you click Face Sizing (intf-ch-upper)
under Mesh in the Outline, you can see the details.

• Geometry: The ch-upper faces are selected as the input.

• Type: It is set to Element Size.
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• Element Size: It is equal to Reference Size/2. Reference Size is set in the IC Mesh
Parameters (p. 187) dialog box.

• Behavior: For this body part it is set to Soft.

ch lower,upper,valve

When you click Body Sizing (ch lower,upper,valve) under Mesh in the Outline, you can see
the details.

• Geometry: This shows the number of bodies selected (ch-upper, ch-lower, ch-in-
valve1–body, ch-exvalve1–body).

• Type: It is set to Element Size.

• Element Size: It is equal to Reference Size, which is set in the IC Mesh Parameters (p. 187)
dialog box.

• Behavior: For this body part it is set to Soft.

5.3.3.1.2. Chamber Lower Meshing

ch-lower

For this body part Sweep Method is used. Click Sweep Method (ch-lower) under Mesh in the
Outline, to see the details.

• Geometry: ch-lower body part is used as the input.

• Source: The upper face of ch-lower is used.

• Target: It is Program Controlled. This means that the program determines the target for
the body.

• Free Face Mesh Type: It is set to All Quad. This determines the shape of the elements
used to fill the swept body.

• Sweep Bias Type: This adjusts the spacing ratio of nodes on the edge. Biasing direction
is based from the source to the target.

One of the four patterns available from the Bias Type drop-down list is chosen.

• Sweep Bias: This value is set to 1. This will override the mesh gradation in the swept region.

ch-valve

For this body part Sweep Method is used. Click Sweep Method (ch-valve) under Mesh in the
Outline, to see the details.
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• Geometry: ch-valve body part is used as the input.

• Source: The upper face of ch-valve is used.

• Target: It is Program Controlled. This means that the program determines the target for
the body.

• Free Face Mesh Type: It is set to All Quad. This determines the shape of the elements
used to fill the swept body.

• Sweep Bias Type: It adjusts the spacing ratio of nodes on the edge. Biasing direction is
based from the source to the target.

One of the four patterns available from the Bias Type drop-down list is chosen.

• Sweep Bias: This value is set to 1. This will override the mesh gradation in the swept region.

Interface Between Piston And Chamber

Face Sizing is the sizing method used for this part. When you click Face Sizing (intf-piston-ch)
under Mesh in the Outline, you can see the details.

• Geometry: The upper face of the piston body is selected as the input.

• Type: It is set to Element Size.

• Element Size: It is equal to Reference Size, which is set in the IC Mesh Parameters (p. 187)
dialog box.

• Behavior: For this body part it is set to Hard.

5.3.3.1.3. Chamber Valves

Face Sizing is the sizing method used for this part. When you click Face Sizing (ch-sweep-source)
under Mesh in the Outline, you can see the details.

• Geometry: The upper faces of ch-invalve, ch-exvalve, and ch-upper are selected as the
input.

• Type: It is set to Element Size.

• Element Size: It is equal to Reference Size, which is set in the IC Mesh Parameters (p. 187)
dialog box.

• Behavior: For this body part it is set to Hard.

5.3.3.2. Canted Valve

This section shows the chamber region meshing performed for canted valves.
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layer-cylinder

Click Sweep Method (layer-cylinder) under Mesh in the Outline, to see the details.

• Geometry: layer-cylinder body part is used as the input.

• Source: It is Program Controlled.

• Target: It is Program Controlled. This means that the program determines the target for
the body.

• Free Face Mesh Type: It is set to All Quad. This determines the shape of the elements used
to fill the swept body.

• Sweep Bias Type: It adjusts the spacing ratio of nodes on the edge. Biasing direction is
based from the source to the target.

One of the four patterns available from the Bias Type drop-down list is chosen.

• Sweep Bias: This value is set to 1. This will override the mesh gradation in the swept region.

valves-bottom

Click Face Sizing(valves-bottom) under Mesh in the Outline, to see the details.

• Type: It is set to Element Size.

• Element Size: It is equal to V_Layer Size, which is set in the IC Mesh Parameters (p. 187) dialog
box.

• Behavior: For this body part it is set to Soft.

5.3.3.2.1. Interface Between Chamber and Vlayer

For engines without chamber decomposition only intf-vlayer-ch part is present.

intf-vlayer-ch

Face Sizing is the sizing method used for this part. When you click Face Sizing (intf-vlayer-ch)
under Mesh in the Outline, you can see the details.

• Geometry: The faces created by Valve_Margin_Slice are selected as the input.

• Type: It is set to Element Size.

• Element Size: It is equal to Chamber-V_Layer Interface Size, which is set in the IC Mesh
Parameters (p. 187) dialog box.

• Behavior: For this body part it is set to Soft.
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intf-ch-vlayer-top-edges

Edge Sizing is the sizing method used for this part. When you click Edge Sizing (intf-ch-vlayer-
top-edges) under Mesh in the Outline, you can see the details.

• Geometry: Top edges of Valve_Margin_Slice are selected as the input for Geometry.

• Type: It is set to Element Size.

• Element Size: It is equal to (0.6 X Minimum Lift) as defined in the Properties of
Schematic (p. 141) window of IC Engine System.

• Behavior: For this body part it is set to Hard.

5.3.3.2.2. layer-cylinder

For this body part either one of Sweep Method or MultiZone, and Body Sizing methods are
used. If the number of faces in the int-piston named selection is greater than one, then the
method set is MultiZone, else it is Sweep Method.

Sweep Method / MultiZone

If MultiZone method is used, then selecting MultiZone (layer-cylinder) under Mesh in the
Outline, you can see the details.

• Geometry: This shows the body selected.

• Method: MultiZone is the method selected.
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If Sweep Method is used, then selecting Sweep Method (layer-cylinder) under Mesh in the
Outline, you can see the details.

• Geometry: This shows the body selected.

• Method: Sweep is the method selected.

Body Sizing

When you click Body Sizing (layer-cylinder) under Mesh in the Outline, you can see the details.

• Geometry: This shows the body selected.

• Type: It is set to Element Size.

• Element Size: It is equal to ( 1.5 X Reference Size), which is set in the IC Mesh Paramet-
ers (p. 187) dialog box.

• Behavior: For this body part is it set to Soft.

5.3.3.2.3. Piston

When you click Body Sizing (piston) under Mesh in the Outline, you can see the details.

• Geometry: This shows the body selected.

• Type: It is set to Element Size.

• Element Size: It is equal to Chamber Size, which is set in the IC Mesh Parameters (p. 187)
dialog box.

• Behavior: For this body part is it set to Soft.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.214

Cold Flow Simulation: Meshing



5.3.4. Crevice

When the geometry has a crevice and you select Yes for Crevice Option in the Input Manager dialog
box then some mesh controls are created for the crevice.

CylCrevice

When you click Face Sizing(CylCrevice) under Mesh in the Outline, you can see the details.

• Geometry: This shows the face selected of the crevice.

• Type: It is set to Element Size.

• Behavior: For this body part is it set to Hard.

crevice

Click Sweep Method (crevice) under Mesh in the Outline, to see the details.

• Geometry: crevice body part is used as the input.

• Source: It is Program Controlled.

• Free Face Mesh Type: It is set to Quad/Tri. This determines the shape of the elements used
to fill the swept body.

• Sweep Num Divs: It is equal to the Number of Layers Crevice which is set in the IC Mesh
Parameters (p. 187) dialog box.

intf-crevcie-piston

When you click Face Sizing(intf-crevcie-piston) under Mesh in the Outline, you can see the details.

• Geometry: This shows the face selected.

• Type: It is set to Element Size.

• Element Size: It is equal to Crevice-Piston Interface Size, which is set in the IC Mesh Para-
meters (p. 187) dialog box.

• Behavior: For this body part is it set to Hard.
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Chapter 6: Cold Flow Simulation: Setting Up the
Analysis
This chapter describes how to configure the analysis for a cold flow simulation.

In the IC Engine (Fluent) analysis system, the boundary conditions and solver parameters are set as
per the Decomposition Crank Angle set in the Input Manager. All the settings described in this chapter
are done automatically, but you can change them by accessing the Solver Settings dialog box or the
task pages and the dialog boxes in Ansys Fluent.

Note:

The piston should be at TDC while decomposing even though you want to start the
simulation from an angle other than zero.

After meshing you can set up the solver. In the Properties pane of the ICE Solver Setup cell you can
make changes to the solver settings or set the keygrid crank angles.

6.1. ICE Solver Settings in IC Engine

6.2. Solver Default Settings for IC Engine

6.1. ICE Solver Settings in IC Engine

Click Edit Solver Settings to open the Solver Settings dialog box.
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6.1.1. Basic Settings

6.1.2. Boundary Conditions

6.1.3. Monitor Definitions

6.1.4. Initialization

6.1.5. Solution Control

6.1.6. Postprocessing
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6.1.1. Basic Settings

In the Basic Settings tab you have the following settings:

Solution Type

shows the Solution Type you have selected in the Properties pane of the ICE cell. You
cannot make any changes here.

Initialize Flow

is set to Yes  by default. This will initialize the flow. To check the initialization settings see
the Solution Initialization task page in Ansys Fluent.
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Set Default Models

is set to Yes  by default. For cold flow simulation some models of Ansys Fluent have been
chosen as default for better results. These are the Energy model, and the Standard k-epsilon
model from the list of Viscous models with Standard Wall Functions. You can check them
at the Models  (p. 245) task page of Ansys Fluent.

Auto Save Type

is set to Crank Angle by default. This means that the intermediate case and data files will
be saved at the entered frequency crank angles. You can also select Time from the drop-
down menu if you want to save the case and data files at a specific frequency of time steps.

Auto Save Frequency

shows the number of crank angle or time steps, after which the case and data file will be
saved in Ansys Fluent. This will depend upon your selection of Auto Save Type. Here the
default value is 30.

Engine Speed(rpm)

It is set to a default value of 1800. The engine speed is used along with the crank angle step
size to calculate the time step size. You can enter the speed of your engine here. You can
enable the check box next to it to parameterize it.

Number of CA to run

is set to 720 by default. This corresponds to a full cycle. You can enter the number of crank
angles you want to run the simulation

Read Profile File

allows you to read multiple profile files. Clicking on Read Profile File opens Browse profile
file dialog box. In the browsing window three types of file extensions will be supported
.prof (profile file), .ttab (transient table), and .csv. All Files option is also present if you
have a file extension which does not match with either of the given extensions. In this case
the file type will be automatically identified, and an error will be thrown if the format is not
supported.
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If you select a .csv file and click Open, then a Read CSV File dialog box opens.

• You need to enter a name for Profile Name. This name will appear in the drop-down
list of Profiles in the Profile Editor dialog box.
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• If you retain the default setting of Yes for Read CSV Titles then the quantity or variable
names will be as per the names in the CSV file.

• If you choose No for Read CSV Titles then you have to specify the No. of Columns
of the CSV file you want to read. For each column you have to select a different variable
name from the drop-down list. In this case the titles of the CSV columns will not be
read. Your selections for the columns will be the titles.

Important:

– All the columns in CSV should have same number of values. Variable
number of values and interpolation is not supported in the current
version.

– Ensure that there are no empty spaces in the titles.

The format of the standard profile file is

 ((profile-name transient n periodic?)
 (field_name-1 a1 a2 a3 .... an)
 (field_name-2 b1 b2 b3 .... bn)
 .
 .
 .
 .
 (field_name-r r1 r2 r3 .... rn)) 

The profile name as well as the field names have to be shorter than 64 characters.
One of the field_name should be used for the time field, and the time field section
must be in ascending order. n is the number of entries per field. The periodic?
entry indicates whether or not the profile is time-periodic. Set it to 1 for a time-peri-
odic profile, or 0 if the profile is not time-periodic.

An example is shown below:

((sampleprofile transient 8 0 0)
(angle
4.400000e+02 4.412000e+02
4.644900e+02 4.656900e+02
6.400000e+02
6.412000e+02 6.480800e+02 6.492800e+02)
(mass-flow
0.000000e+00 2.450040e-03 2.450040e-03 0.000000e+00 0.000000e+00
2.475870e-03 2.475870e-03 0.000000e+00)
(velocity
0.000000e+00 1.941520e+02 1.941520e+02 0.000000e+00 0.000000e+00
1.922430e+02 1.922430e+02 0.000000e+00)
)

Important:

All quantities, including coordinate values, must be specified in SI units
because Ansys Fluent does not perform unit conversion when reading
profile files. Also, profile names must have all lowercase letters (for example,
name). Uppercase letters in profile names are not acceptable.
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The format of the transient table file is

 profile-name n_field n_data periodic?
 field-name-1 field-name-2 field-name-3 .... field-name-n_field 
 v-1-1  v-2-1... ... ... ... v-n_field-1 
 v-1-2  v-2-2... ... ... ... v-n_field-2
 .
 .
 .
 .
 .
 v-1-n_data v-2-n_data ... ... ... ... v-n_field-n_data 

The first field name (for example field-name-1) should be used for the time field, and
the time field section, which represents the flow time, must be in ascending order. The
periodic? entry indicates whether or not the profile is time-periodic. Set it to 1 for a time-
periodic profile, or 0 if the profile is not time-periodic.

An example is shown below:

sampletprofile 3 8 0
angle        mass-flow    velocity
440          0.0          0.0
441.2        0.00245004   194.152
464.49       0.00245004   194.152
465.69       0.0          0.0
640          0.0          0.0
641.2        0.00247587   192.243
648.08       0.00247587   192.243
649.28       0.0           0.0

This file defines the same transient profile as the standard profile example above.

Important:

All quantities, including coordinate values, must be specified in SI units because
Ansys Fluent does not perform unit conversion when reading profile files. Also,
profile names must have all lowercase letters (for example, name). Uppercase letters
in profile names are not acceptable. When choosing the field names, spaces or
parentheses should not be included.

After reading the files the profiles will be available in the boundary condition drop-down
lists.

Profile Editor

allows you to view the plot of the profiles.
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• Select a profile from the drop-down list of Profiles. The TIMESTEP profile is added to the
list by default.

• When a particular profile is selected all corresponding variables will be displayed in the X
Axis and Y Axis drop-down lists.

• Select the variable for X Axis and Y Axis and click Plot. The plot will be displayed in the
area of Profile Chart.

• You can select the type of chart to be displayed from the Chart Style drop-down list.
Options of Spline, Step and Line are provided.

• You can also read a profile by clicking on Read File.

• The read profile which is presently selected can be deleted from the list by clicking on
Remove Profile.
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• You can make changes to the values in the profile table displayed. Click Plot to view the
Profile Chart with the changed values. You can save the profile with the edited values by
clicking on Save.

• To manipulate the chart:

Table 6.1: Chart Manipulation

Operation

ZoomRotate Middle Mouse

ZoomShift + Middle Mouse

PanCtrl + Middle Mouse

Box ZoomDrag Right Mouse

Fit to WindowF key
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6.1.2. Boundary Conditions

In the Boundary Conditions tab you can see the boundary conditions set for two zones. Select each
zone and click Edit to check the details.

• ice-outlet-exvalve-1–port is set to Type pressure-outlet.
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The Gauge Pressure is set to 0, and the Temperature is set to 300.

• Similarly the zone ice-inlet-invalve-1–port is set to Type pressure-inlet.

You can check the detailed settings in the Boundary Conditions  (p. 247) task page in Ansys Fluent.
You can also create additional boundary conditions by clicking Create.
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In the Create Boundary Conditions dialog box select the zone to which you like to apply the
boundary conditions to from the list under Zones. Then select Type and enter the required values
for the variables, either a constant value or a variable profile from the drop-down list. You can select
a profile in case you have read a profile before, or you can select PROFILE EDITOR option which will
open the Profile Editor dialog box where you can check the plot of the profile or read a new profile.
After you click OK you can see the zone name and the details in the Boundary Conditions tab.

You can use the Copy button to copy the boundary conditions to other multiple zones.

• Select the boundary condition of interest in the Boundary Conditions tab.

• Click Copy.

• Select the zone(s) to which you want to copy the boundary conditions and click OK.

• The zones to which you have copied the boundary conditions appear in the list.

For the boundary conditions, you can parameterize the quantity by enabling the check box next to
it.
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6.1.3. Monitor Definitions

In the Monitor Definitions tab you can see that four volume monitors have been set. Select each
monitor and click Edit to check the details.

• mesh-skewness-mon is a volume monitor which monitors the Volume-Average of Cell
Equivolume Skewness on the zones fluid-ch, fluid-layer-cylinder, and fluid-piston.

• mass-avg-tke-mon is a volume monitor which monitors the Mass-Average of Turbulent
Kinetic Energy on the zones fluid-ch, fluid-layer-cylinder, and fluid-piston.

• Similarly mass-avg-temp-mon is one more volume monitor.
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It plots the Mass-Average of Temperature on the zones fluid-ch, fluid-layer-cylinder, and
fluid-piston. This monitor is automatically set for a cold flow simulation.

• The fourth volume monitor mass-avg-press-mon, monitors the Mass-Average of Pressure
on the zones fluid-ch, fluid-layer-cylinder, and fluid-piston.

You can change the settings here in the Monitor Definition dialog box.

You can see additional details in the Monitors  (p. 262) task page in Ansys Fluent. You can create
additional monitors by clicking Create.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.230

Cold Flow Simulation: Setting Up the Analysis



Then select the Type, Report Type, and the Field Variable from the respective drop-down lists.

You can select Volume, Surface, or Probe from the Type drop-down list. If you select Probe you
can create a point or surface on which you can monitor a variable.

You need to enter the values (in meters) for Point X, Point Y, and Point Z to position the point. If
you retain the value of 0 for Radius then a point monitor is created. If you enter a value for Radius
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then a circular surface with the given Radius and the center as the given Point is created. You can
monitor the variables of your choice on this surface or point.

You can select New Variable from the Field Variable drop-down list. This opens the Add Quant-
ity/Variable dialog box.

You can select the variable by selecting from the options under the Quantity and Quantity Subtype
drop-down lists. You also have an option of User Defined under the Quantity drop-down list.

Here you can add the quantity or variable of your choice of which you would like postprocessing
images, in the User Defined text box. You will have to check Fluent if the term is valid for the simu-
lation. After you click OK this quantity will be available in the drop-down list of Field Variable.

The Name will be set according to your selections. You can enter a name of your choice. Click Create
to create the monitor. It will now appear in the list in the Monitor Definitions tab.

6.1.4. Initialization

In the Initialization tab you can see the default set values for the various parameters.
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• Gauge Pressure, X Velocity, Y Velocity, and Z Velocity are all set to 0 by default.

• Temperature is set to 300.

• Turbulent Kinetic Energy and Turbulent Dissipation Rate are set to 1 by default.

You can change the values as per your settings.

Patching

Click Patch to open the Patching Zones dialog box.
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Here you can patch zones if required. You need to select the zones(s) from the list of Zone, a Variable,
and enter the patching value under Value. Then click Create and the setting will be displayed in the
list of Patched Zones.
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6.1.5. Solution Control

In the Solution Control tab you can set additional specific Crank Angles at which the case and data
files should be saved and also set the starting and ending crank angles for activating the equations.

6.1.5.1. Solution Control

Save Case/Data

The case and data are saved at a specific frequency which you have entered in the Basic Settings
(p. 396) tab. In the Save Case/Data list you can see the additional crank angles at which the case
and data are saved while running the solution. These are at the events of valve opening, valve
closing, TDC, etc. You can change these angles. In the Comment column you can see the event or
definition for the crank angle. You can enter your own definition for the comment column. If you
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right-click on the list you get options of Insert Row Below, Insert Row Above, and Delete Row.
You can use these options to customize your solution.

Equation Events

As per your selection of the combustion models the list of Equations Events will change. Here you
can enter the starting and ending crank angles for which you want the specific equations activated.
The starting crank angle (Start SA) is set to the decomposition crank angle by default. If you do
not enter anything for the ending crank angle (End CA) then the equation will be activated
throughout the simulation cycle. To reset the Equations Events settings to default values click
Reset Equation Events.

Adaptive Time Step

By using the options provided under Adaptive Time Step you can control how the solver changes
the time step size within the specified limits based on convergence criteria. This will help in
achieving a better and faster convergence of the solution.

During the solution run, if for one time step the maximum number of iterations are used to converge
then it means that the solution is far from converging. In this case the solution will execute the
number of time steps according to the crank angle size specified as Max CA Before Decreasing
Step Size and then reduce the time step by half of the present value. If the solution still uses the
maximum number of iterations in the time step then it will again reduce the time step by half. This
will go on until Min CA Step Size is reached.

On the other hand if the solution is converging in less than half of the maximum number of iterations
in the time step, then the time step is doubled after executing the number of time steps according
to the crank angle size specified as Max CA Before Increasing Step Size. This will go on until Max
CA Step Size is reached.

In case there is an event of KeyGrid replacement then the time step is reduced such that the event
is within the tolerance limit of Min CA Step Size. This will take priority over any other criteria which
will try to increase the time step. After the KeyGrid replacement the solution will go back to run
on the settings of Adaptive Time Step.

Also, if there are any direct events which try to change time step size, the program will respect
them but from next time step the Adaptive Time Step criteria will control the solution.

• For using the option select Yes from the Enable Adaptive Timestep drop-down list.

• When the solution starts to converge you can increase the time step size. Enter the crank
angle step size to which it can increase in Max CA Step Size.

• Similarly if the solution reaches the maximum iterations in a time step then the time step
size is decreased. Enter the crank angle step size to which the time step can decrease in Min
CA Step Size.

• The number of angles the solution will wait before increasing the step size is entered for
Max CA Before Increasing Step Size.

• The number of angles the solution will wait before decreasing the step size is entered for
Max CA Before Decreasing Step Size.
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6.1.5.2. Solution Summary

In this group box you can view different profiles overlapping each other. You can enable the profiles
you would like to see on the chart from the list on the left hand side. All the profiles are plotted
on the base of crank angles. The Summary Chart gives a graphic view of the valve profiles, piston
profiles, timesteps, etc. Observing the chart gives you an account of the position of the piston and
valve at the injection time. This will help if you want to manipulate the default time step settings,
or any other events. The chart can be manipulated using the following table.

Table 6.2: Chart Manipulation

Operation

237
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

ICE Solver Settings in IC Engine



ZoomRotate Middle Mouse

ZoomShift + Middle Mouse

PanCtrl + Middle Mouse

Box ZoomDrag Right Mouse

Fit to WindowF key

6.1.6. Postprocessing

In the Post Processing tab you can see that image1 is being automatically saved. Click Edit to check
the details.
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• image1 is plotted on surface ice_cutplane_1.

• The image is captured at a saved view, ice_cutplane_1–view.

• velocity-magnitude contours are displayed.

• Images are saved from the Start Crank Angle  of 0 to the End Crank Angle  of 720 at a
Frequency of every 4 time-steps.

• Animation is set to Yes, signifying that animation of the velocity contour images will be created
at the end of the simulation.

• Overlay With Vectors is set to No.

• Table is set to Yes, signifying that the saved images will be displayed in the report in a table
5 Rows and 3 Columns.

In the Edit Image dialog box you can change the settings and values as required. To create additional
postprocessing images click Create.
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1. Select the Surfaces on which you want to plot the contours.

2. Select a view from the View drop-down list.

3. Select the parameter from the Quantity drop-down list. You can select New Variable from
the Quantity drop-down list. This opens the Add Quantity/Variable dialog box.

You also have an option of User Defined under the Quantity drop-down list.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.240

Cold Flow Simulation: Setting Up the Analysis



Here you can add the quantity or variable of your choice of which you would like postpro-
cessing images, in the User Defined text box. You will have to check Fluent if the term is
valid for the simulation.

4. Enter the Start Crank Angle and End Crank Angle. The images will be saved only within
these two crank angles.

5. Enter a value for Frequency. The images will be captured at the entered frequency.

6. If you need to create an animation from the saved images you can select Yes from the An-
imation drop-down list.

7. The option Overlay With Vectors is by default set to No. You can set it to Yes if you want
the vectors to overlap the contour images.

8. If you want the saved images to be displayed in the report in a table format select Yes from
the Table drop-down list.

9. Enter the values for Rows and Columns depending on how you want to format the table.

10. You can add a tag for the image. You can use this Tag if you want only the final images of
different surfaces in a single table. In this case you have to provide the same tag to all the
images.

11. Click Add Iso Surface if you want to create an iso-surfaces. These surfaces are isovalued
sections of the entire domain.
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a. Enter a name for the isosurface you want to create at Surface Name.

b. Select the Quantity from the drop-down list. You can select a quantity from the list or
create a new variable by selecting New Variable.

c. From the Iso Value Input drop-down list you can select either of Absolute Value or
Percentage of Range.

• Absolute Value: If you select this from the drop-down options, you can enter a
value for Absolute Value. The iso-surface created will be of this value.

• Percentage of Range: If you select this from the drop-down options, then you
need to enter a percentage value for Percentage of Range. The iso-surface created
will be of the percentage value of the minimum and maximum values obtained
of the quantity.

An iso-surface of the given name and of the selected quantity will be created and appear in
the list of Surfaces. This isosurface will be of the Absolute Value entered or of the percentage
of the minimum and maximum values of the quantity. You can select this isosurface to create
images in postprocessing.

12. Click Create to create the image.

13. Click Close to close the Create Image dialog box.

Once the changes are done in the Solver Settings dialog box you can close it and then update the
ICE Solver Setup cell by choosing Update from the context menu.

6.2. Solver Default Settings for IC Engine

When you double-click the Setup cell, FLUENT Launcher opens.

Note:

Depending upon your machine configuration you may be able to increase the Number
of Processes to decrease the time taken to arrive at a solution. A reasonable value for
the Number of Processes is the number of cores on your machine.
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When you click OK, Ansys Fluent reads the mesh file and sets up the IC Engine case. It will:

• Read the valve and piston profile.

• Create various dynamic mesh zones.

• Create interfaces required for dynamic mesh setup.

• Set up the dynamic mesh parameters.

• Set up the required models.

• Set up the default boundary conditions and material.

• Create all the required events, to model opening and closing of valves, and corresponding modifications
in solver settings and under-relaxations factors.

• Set up the default monitors.

• Initialize and patch the solution.

In the Ansys Fluent application, you can check the default settings by highlighting the items in the
navigation pane.
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Figure 6.1: The Ansys Fluent Navigation Pane

The details about the settings in the different task pages are described in the following sections:

6.2.1. Solver General Settings

6.2.2. Models Set in Solver

6.2.3. Materials Set in Solver

6.2.4. Boundary Condition Settings in Solver

6.2.5. Dynamic Mesh Settings in Solver

6.2.6. Events Set in Solver

6.2.7. Solution Methods Set in Solver

6.2.8. Solution Controls Set in Solver

6.2.9. Monitors Set in Solver

6.2.10. Run Calculation

6.2.1. Solver General Settings

In the General task page the following settings are done:
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• Solver Type is set to Pressure-Based.

• Solver Time is set to Transient.

6.2.2. Models Set in Solver

The following models are selected for the analysis:

• The Energy model is enabled.

• From the Viscous models, the Standard k-epsilon model is selected, with Standard Wall
Functions as Near-Wall Treatment.
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6.2.3. Materials Set in Solver

• Air is set as the material.

• The Density of air is set to ideal-gas.

• The Specific Heat (Cp) of air is set to temperature dependent.

6.2.4. Boundary Condition Settings in Solver

You can check the boundary conditions and monitors settings for cold flow simulation in the icBC-
Settings file.

• For the ice-inlet-invalve-1-port boundary conditions, the following settings are done in the
Pressure Inlet dialog box:
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– Gauge Total Pressure is set to 0 Pa.

– The Total Temperature is set to 300 K, assuming that the engine is naturally aspirated.

– The Specification Method in the Turbulence group box is set to Intensity and Hy-
draulic Diameter.

Note:

The Specification Method can also be set to, Intensity and Viscosity
Ratio.

– Turbulent Intensity is set to 2%, and Hydraulic Diameter is automatically calculated.

• For the ice-outlet-exvalve-1-port boundary condition the following settings are done in the
Pressure Outlet dialog box:
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– Gauge Pressure is set to 0 Pa.

– Backflow Total Temperature is set to 300 K.

• For the wall boundary condition Temperature is set to 300 k.
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6.2.5. Dynamic Mesh Settings in Solver

In the Dynamic Mesh dialog box you can check the mesh methods and their settings. Click Settings...
in the Mesh Methods group box to open the Mesh Method Settings dialog box.
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In the Smoothing tab the method is set to Spring/Laplace/Boundary Layer. The Parameters are
set by default. For more information, refer to Smoothing Methods in the Fluent User's Guide.

In the Layering tab Ratio Based is chosen from the Options group box. You can control how a cell
layer is split by specifying either Height Based or Ratio Based. The Split Factor and Collapse Factor
are the factors that determine when a layer of cells that is next to a moving boundary is split or
merged with the adjacent cell layer, respectively. For more information, refer to Dynamic Layering in
the Fluent User's Guide.

Click the Remeshing tab to check the methods and parameters. For details, see Remeshing Methods
in the Fluent User's Guide. In the Parameters group box, the following parameters are set:

• Maximum Length Scale = 0.4 X Average length scale of fluid-ch.

• Minimum Length Scale = 1.4 X Average length scale of fluid-ch.

• By default, the Maximum Cell Skewness is set to 0.9 for 3D simulations.

• Size Remeshing Interval is set to 1.

For details, see Local Remeshing Method in the Fluent User's Guide.
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You can also see the dynamic mesh zones created and the type to which each zone is set. The zones
created differ for a straight and canted valve.

Refer to Straight Valve Geometry With Chamber Decomposition for IC Engine (p. 167) for the zones
created for a straight valve. The Table 6.3: Dynamic Mesh Zones for a Straight Valve (p. 253) shows the
dynamic mesh zones created and the type each zone is set to for a straight valve.

Table 6.3: Dynamic Mesh Zones for a Straight Valve

TypeDynamic Mesh Zones

Rigid Bodyfluid-ch-invalve1

Rigid Bodyfluid-ch-invalve2

Rigid Bodyfluid-ch-lower

Rigid Bodyfluid-invalve1-ib

Rigid Bodyfluid-invalve1-vlayer

Rigid Bodyfluid-invalve2-vlayer

Rigid Bodyfluid-invalve2-vlayer

Rigid Bodyfluid-piston

Stationaryintf-deck-fluid-ch-lower

Stationaryintf-int-invalve1-ib-fluid-ib
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Stationaryintf-int-invalve1-ob-fluid-vlayer

Stationaryintf-int-invalve2-ib-fluid-ib

Stationaryintf-int-invalve2-ob-fluid-vlayer

Rigid Bodyintf-piston-ch

Rigid Bodyinvalve1-ch

Rigid Bodyinvalve1-ib

Rigid Bodyinvalve1-ob

Stationaryinvalve1-seat

Rigid Bodyinvalve2-ch

Rigid Bodyinvalve2-ib

Rigid Bodyinvalve2-ob

Stationaryinvalve2-seat

Rigid Bodypiston

For checking zones created for a canted valve with the chamber decomposed, refer to Canted Valve
Geometry With Chamber Decomposition for IC Engine (p. 170). The Table 6.4: Dynamic Mesh Zones
for a Canted Valve With Chamber Decomposition (p. 254) shows the dynamic mesh zones created and
the type each zone is set to for a canted valve with the chamber decomposed.

Table 6.4: Dynamic Mesh Zones for a Canted Valve With Chamber Decomposition

TypeDynamic Mesh Zones

Rigid Bodycyl-piston

Rigid Bodycyl-quad

Deformingcyl-tri

Rigid Bodyexvalve1-ch

Rigid Bodyexvalve1-ib

Rigid Bodyexvalve1-ob

Stationaryexvalve1-seat

Rigid Bodyfluid-exvalve1-ib

Rigid Bodyfluid-exvalve1-vlayer

Rigid Bodyfluid-invalve1-ib

Rigid Bodyfluid-invalve1-vlayer

Rigid Bodyfluid-layer-cylinder

Rigid Bodyfluid-piston

Rigid Bodyint-piston

Deformingintf-exvalve1-ob-fluid-ch

Stationaryintf-int-exvalve1-ib-fluid-ib

Stationaryintf-int-exvalve1-ob-fluid-vlayer

Stationaryintf-int-invalve1-ib-fluid-ib

Stationaryintf-int-invalve1-ob-fluid-vlayer
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Deformingintf-invalve1-ob-fluid-ch

Rigid Bodyinvalve1-ch

Rigid Bodyinvalve1-ib

Rigid Bodyinvalve1-ob

Stationaryinvalve1-seat

Rigid Bodypiston

Deformingsymm-cyl-tri

For checking zones created for a canted valve without chamber decomposition, refer to Any Engine
Geometry Without Chamber Decomposition (p. 173). The Table 6.5: Dynamic Mesh Zones for a Canted
Valve Without Chamber Decomposition (p. 255) shows the dynamic mesh zones created and the type
each zone is set to for a canted valve without chamber decomposition:

Table 6.5: Dynamic Mesh Zones for a Canted Valve Without Chamber Decomposition

TypeDynamic Mesh Zones

Deformingcyl-tri

Rigid Bodyfluid-invalve1-ib

Rigid Bodyfluid-invalve1-vlayer

Rigid Bodyfluid-exvalve1-ib

Rigid Bodyfluid-exvalve1-vlayer

Stationaryintf-int-invalve1-ib-fluid-ib

Stationaryintf-int-invalve1-ob-fluid-valyer

Stationaryintf-int-exvalve1-ib-fluid-ib

Stationaryintf-int-exvalve1-ob-fluid-valyer

Deformingintf-invalve1-ob-fluid-ch

Deformingintf-exvalve1-ob-fluid-ch

Rigid Bodyinvalve1-ch

Rigid Bodyinvalve1-ib

Rigid Bodyinvalve1-ob

Stationaryinvalve1-seat

Rigid Bodyexvalve1-ch

Rigid Bodyexvalve1-ib

Rigid Bodyexvalve1-ob

Stationaryexvalve1-seat

Rigid Bodypiston

Deformingsymm-cyl-tri

You can click Display Zone Motion... to check the zone motion preview.
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Select the Dynamic Face Zones and then click Preview.

6.2.6. Events Set in Solver

Events are used to model opening and closing of the valves. This is done by making and breaking
some non-conformal interfaces. Since you can observe sharp flow gradients around the time when
the valves open and close, it is a good practice to reduce the time step size from the default 0.25
crank angle to 0.125 crank angle. Also the URF changes can be synchronized according to the valve
opening and closing events. When the dynamic mesh is set up, some events are set to change the
time step depending upon the valve opening.

The events are specified for one complete engine cycle. In the subsequent cycles, the events are ex-
ecuted whenever

(6.1)

where  is the event crank angle,  is the current crank angle,  is the crank angle period

for one cycle, and  is some integer.

As an example, for in-cylinder simulations, events may not execute at the exact event angle. Ansys
Fluent will execute an event if the current crank angle is between

(6.2)
where  is the equivalent change in crank angle for the time step. For example, check the report
of Ansys Fluent in the following text window.

 Execute Event: open-exvalve1 (defined at: 160.3000, current angle: 160.2500)
 Execute Event: open-invalve1 (defined at: 324.2000, current angle: 324.2500)
 Execute Event: close-exvalve1 (defined at: 402.3000, current angle: 402.2500)
 Execute Event: close-invalve1 (defined at: 563.0000, current angle: 563.0000)

Notice that event defined at 160.3 is executed at 160.25. Similarly event defined at 324.2 is ex-
ecuted at 324.25. This is because they satisfy the condition of Equation 6.2 (p. 256).

If you click Events in the Dynamic Mesh task page, you can see these events.
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Some general events are as follows:

• The time step is set to 0.25 degrees for the simulation.

• When valves open, the time-step changes from:

– 0.25 to 0.125 at valve opening crank angle

– 0.125 to 0.25 at least 5 degree after valve opening

• When valves close, the time-step changes from

– 0.25 to 0.125 at least 5 degrees before the valve closing

– 0.125 to 0.25 at valve closing crank angle

Note:

The change in time-step size from 0.25 to 0.125 is not made exactly at valve
opening or closing, but a few degrees before and after that.

• The number of iterations per time step is set to 30.
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• In case of chamber without decomposition two additional events will be automatically created:
one for layer insertion and other for layer deletion.

Note:

If you are changing the time step size and/or layer height of the cylinder, ensure
that at the time of layer deletion there is only one layer. If there are more than one
cell layers, delete layer will fail. If all the layers collapse by the time delete layer
event is called, negative volume error will occur.

You can check the events by clicking Define, next to each event name.

Note:

The calculated valve opening and closing angles are different from the actual angles. For
more information, refer to How IC Engine System Calculates Valve Opening and Closing
Angles (p. 549).
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6.2.7. Solution Methods Set in Solver
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• The Scheme for the analysis is set to PISO in the Pressure-Velocity Coupling group box.

Note:

This scheme is recommended for all the transient solutions, especially when
larger time steps have to be used. Also, PISO with neighbor correction and
skewness correction will be used for highly distorted meshes.

• Skewness Correction is set to 1.

Note:

By default this value is 0 but considering that due to MDM the mesh quality deteri-
orates, it is good practice to set the skewness correction to 1.

• Neighbor Correction is set to 1.

• Skewness-Neighbor Coupling is disabled.

Note:

For highly distorted meshes, disabling this is recommended.

• The Gradient in the Spatial Discretization group box is set to Green Gauss Node Based.

Note:

For tet meshes it is good to use this gradient option. Least Square Cell Based
can be another good option to use.

• Pressure is set to PRESTO!.

• Density, Momentum, Turbulent Kinetic Energy, and Energy, are all set to Second Order
Upwind.

• Turbulent Dissipation Rate is set to First Order Upwind.
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6.2.8. Solution Controls Set in Solver

At the beginning of the solution the Under-Relaxation Factors are set as following:

• Pressure: 0.3

• Momentum: 0.5

• Turbulent Kinetic Energy and Turbulent Dissipation Rate: 0.4

• Turbulent Viscosity: 1

• Density, Body Force, and Energy are all set to 1

Five degrees before the valve opens/closes and till five degrees after the valve opens/closes, the fol-
lowing will be the Under-Relaxation Factors:

• Pressure: 0.2

• Momentum: 0.4
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• Turbulent Kinetic Energy and Turbulent Dissipation Rate: 0.2

• Turbulent Viscosity: 1

• Density, Body Force, and Energy are all set to 1

Note:

After the valve opens/closes to more than five degrees, all the Under-Relaxation
Factors are reset to the settings at the beginning of the solution (p. 261).

• Solution Limits for pressure and temperature are set as shown below:

– Minimum Absolute Pressure (pascal) is set to 1000.

– Maximum Absolute Pressure (pascal) is set to 5e+07.

– Minimum Static Temperature (k) is set to 150.

– Maximum Static Temperature (k) is set to 2000.

Note:

The temperature and pressure limits are restricted as indicated above
because the values of these variables should not cross this specified
range in some cells, typically in cold-flow simulations. However, if you
are modeling combustion or gas exchange, or if you know that these
limits are too aggressive for your case, then you can modify them ap-
propriately.

6.2.9. Monitors Set in Solver

To check the output results of the parameters, some monitors have been created.
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The monitors defined by default are Volume Report Definitions. The variables they plot are

• Mass Average of temperature

• Mass Average of pressure

• Volume Average of cell skewness

• Mass Average of turbulent kinetic energy.

These monitors are defined on fluid-ch, fluid-layer-cylinder, fluid-piston cell zones.

You can create your own Surface Monitors or Volume Monitors from the Monitors task page. Enable
Write so that an output file is written, which can be loaded and viewed later. The monitor settings
which are done by default can be seen in the icBcSettings.txt file.

The swirl ratio and tumble about x-axis in the chamber region is also plotted. A file ice-incylin-
der-output.txt, is written in the Fluent directory of the project. Details of the quantities written
to the file are as follows:

CA = Crank Angle

263
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Solver Default Settings for IC Engine



L = Angular momentum vector of fluid mass contained in selected cell zones with respect to the
swirl center

 = Magnitude of angular momentum of fluid

 = Swirl Axis

 = Tumble Axis

 = Cross Tumble Axis

I  = Moment of inertia of the fluid mass about Swirl axis

I  = Moment of inertia of the fluid mass about Tumble Axis

I  = Moment of inertia of the fluid mass about Cross Tumble Axis

 = Dot product between two vectors

Altogether, the previous quantities are combined to yield eight columns of data in the output file,
as shown in the figure that follows:

The swirl ratio can be deduced from the IC output file using the following expression:

(6.3)

Similarly the tumble ratio can be computed as follows:

(6.4)

For more information refer to, In-Cylinder Settings in the Fluent User's Guide.
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6.2.10. Run Calculation

You can enter the Number of Time Steps you want. By default it is set to a calculated value from
the Number of CA to Run which you set in the Basic Settings tab of ICE Solver Settings dialog
box. Click Calculate to run the simulation.

Note:

If time-step size is 0.25 CA and there are no changes in it through events, one cycle which
is 720 degrees would mean 2880 time-steps. If you are reducing the time-step size during
valve closing and opening through events, you will have to account for that also.

Running the Calculation from Windows on Remote Linux Machines

To run the simulation on Linux, some changes in the setup are required.
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1. Click Show More Options.

2. Click the Parallel Settings tab.
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Select the Run Types from the list.

Note:

If you selected Distributed Memory on a Cluster, then you have to provide
the Machine Names.

3. Click the Remote tab.
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a. Enable Use Remote Linux Nodes option.

b. Enter the path for Remote FLUENT Root Path. It is the root directory of Fluent in-
stallation.

c. Select your choice from the list of Remote Spawn Command.

Note:

For SSH, you need to set up a password-less connection before running
the solution remotely.

d. Enable Use Remote Cluster Head Node and provide the node.
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e. Enter the number for Number of Processes under Processing Options.

Note:

When the node for Use Remote Cluster Head Node is specified, then
that name will be reflected under Processing Options.

When the remote connection is set, it will use the nodes of the remote Linux machine. The details
are displayed in the Fluent console.

All the files will be saved in the working directory. Once the solution is completed, the project is up-
dated and you can proceed with your postprocessing.

For details see Setting Additional Options When Running on Remote Linux Machines in the Fluent
User's Guide.

Note:

You can also submit the run on different Linux machines though RSM.

Running on Standalone Fluent

1. Open Fluent and read the case and data file from the ~project-
name_files\dp0\ICE\Fluent directory.

File Read Case & Data...

2. In Calculation Activities task page click Edit.... next to Autosave Every (Time Steps) and check
if that the name and path under File Name is correct.
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3. In Run Calculation task page enter the required Number of Time Steps and click Calculate.

Note:

If the case is setup in the previously released versions, then you might have to read
the scheme file, (WB-ICE-Solver-Setup.scm) from ~ANSYS
Inc\v150\Addins\ICEngine\CustomizationFiles folder in the mapped
directory before running it in the present version.

Note:

If you want the generate the report from IC Engine System report template, then you need
to first make sure that Solution cell is updated. This can be done by running the solution
for 1 timestep. Then, copy all the files generated by your standalone run into the Fluent
directory and update the Results cell.
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Chapter 7: Port Flow Simulation: Preparing the
Geometry in IC Engine
This chapter provides instructions and information about preparing the IC engine geometry for port
flow simulation.

7.1. Geometry Decomposition for Port Flow Simulation

7.2.Viewing the Bodies and Parts

Once you have selected Port Flow Simulation from the Simulation Type drop-down list in the Prop-
erties view, you can open DesignModeler from the Geometry cell in the IC Engine analysis system.

Note:

To open DesignModeler from the Geometry cell, you should set the Preferred Geometry
Editor to DesignModeler in the Geometry Import section in the Options dialog box. The
Options dialog box can be opened from the Tools Options...menu.

Then you can double-click Geometry, cell 3, to open DesignModeler.
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One more way to open DesignModeler is, to right-click on the Geometry cell, and select
New DesignModeler Geometry... from the context menu.

7.1. Geometry Decomposition for Port Flow Simulation

Note:

It is a good practice to check the geometry before decomposing; there are a few things that
you should verify so that fewer problems occur later on. For more information, see Geometry
Check (p. 517).

1. Set the units, depending upon the geometry units, in ICE-DesignModeler.

2. Load the geometry file.

File Import External Geometry File...

3. Click Generate  to complete the import.
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4. Set up the Input Manager by clicking Input Manager (  located in the IC
Engine toolbar).

Note:

The IC Engine toolbar is displayed in the ICE DesignModeler only after installing IC
Engine Analysis System.

Details of InputManager

This section in the Input Manager dialog box takes inputs of the engine to set it up for decom-
position.

• Select all the faces of the engine cylinder for Cylinder Liner Faces and click Apply.
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Figure 7.1: Cylindrical Face Selection

The cylinder radius and the cylinder axis are displayed in the status bar at the bottom of the
window.

Note:

Ensure that all the faces of the cylinder body are selected.

• After selecting the Cylinder Liner Faces the program will check for symmetry. It will accord-
ingly set Yes or No for the Symmetry Face Option. If Yes is selected you will be required
to give the symmetry faces.

Note:

You should select Yes for Symmetry Face Option if the geometry is symmetrical.
Failure to do so will result in the failure of the simulation. Also ensure to select
the faces for Symmetry Faces.

• Click next to Symmetry Faces in the Details View of Input Manager. Select the faces of the
engine about which it is symmetric and click Apply.
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• For Post Planes Dist. From Ref. you can enter the distance from the reference plane at
which you would like to have the postprocessing planes. These planes are required for creating
swirl monitors in Fluent. If you do not provide any distance, a default plane is created below
the valve at an approximate distance of (4 X Reference Size  (p. 288)) from the Reference
Plane. This helps in creating sweep mesh in the cylinder and plenum.
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The Reference Plane is created near the top of the cylinder, where the cylinder meets the
dome. For multiple planes separate the distances by a semicolon (;). For example,
12.0;17.1;25.0;33.3 (mm). The distances will be sorted in the ascending order auto-
matically. The planes are visible in the geometry after you enter the distances.

For information on how the swirl ratio is monitored on the swirl planes see the section on
swirl definition (p. 582).

IC Valves Data

In this section you are required to give details about the valves.

• Select InValve or ExValve as the Valve Type from the drop-down list.

• Select the valve from the figure and click Apply next to Valve Bodies.

Note:

– You can select multiple valves at a time and set them to the desired type.

– Confirm that Selection Filters are set to Bodies.
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• Select the faces on which the valves rests for Valve Seat Faces and click Apply.

Figure 7.2: Valve Seat Faces

The valve seat is that face of the port body which comes in contact with the valve body. The
Figure 4.5: Valve Seat Selection (p. 163) shows that the highlighted face of the valve body will
make contact with the valve seat face of the port body.
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Figure 7.3: Valve Seat Selection

Note:

Confirm that Selection Filters are set to Model Faces. Some engines might have
line contact between the valve and the valve seat. In such cases you can select
the face which is near the valve and includes the line of contact.

• Enter a value for Valve Lift. This will be the distance to which you want the valves to be
moved. If you retain the default value of 0 then the valve is closed and the selected ports
will be deactivated.

• To create a new valve group, add the section IC Valves Data by right-clicking,

and selecting Add New IC Valves Data Group. Set the details for the new group.

IC Inlet Plenum

In this section, you give the inputs required for constructing the inlet plenum.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.278

Port Flow Simulation: Preparing the Geometry in IC Engine



• Select the inlet face where the inlet plenum is created for Inlet/(Plenum Inlet) Faces.
If the plenum is already created, select its inlet face for this option. When the face is
selected, the hydraulic diameter is displayed in the status bar.

• You can select the shape of the plenum from the Plenum Type drop-down list. You
have four options to choose from:

– None

– Hemisphere

– Cylinder

– Box
On selection of either of Hemisphere, Cylinder, or Box you will have to provide details
for the location of the plenum and its size. If you select None it is assumed that the
geometry includes the inlet plenum.

• Enter a value for Inlet Extension Length. This value is the distance at which the inlet
plenum is created from inlet face. By default it is set to 1.5 times the hydraulic diameter
of the inlet.

• Enter a value for Plenum Size. This value is a set by default to 5.5 times the size of the
hydraulic diameter of the inlet. .

The size of the input plenum will be as per the Plenum Size and the shape as per the
selection of Plenum Type.

• Enter a value for Plenum Blend Rad. This will create a curve of the given radius which
will help to guide the flow. This values defines the curvature of the fillet.

• To create a new inlet plenum group, add the section IC Inlet Plenum by right-clicking
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and selecting Add New IC Inlet Plenum Group. Set the details for the new group.

Note:

The significance of a group is to create a common plenum for all the faces
of the group. For example, If you have two separate inlet faces, and if you
select both of them in a single group, then it will create a single plenum
joining these faces. On the other hand if for the same input faces, you create
two different inlet plenum groups, then disconnected plenums are created.

IC Outlet Plenum

In this section, you give the inputs required for constructing the outlet plenum.

• You can select Yes or No from the Outlet Plenum Option drop-down list.

– If you select No it is assumed that you have provided the outlet pleum in the
geometry. In this case you will have to provide the outlet face of the plenum for
Outlet Plenum Faces.

– If you select Yes you can create the outlet plenum.

• Enter a value for Cylinder Extension Length, the length to which the cylinder is extended
from the present position. This value is set by default to three times the cylinder diameter.

You can select the shape of the plenum from the drop-down list of Plenum Type.

You have four options to choose from:

– Hemisphere

– Cylinder

– Box

– None

Note:

If you select the option None from the Plenum Type drop-down list,
then you can extend the cylinder without creating an outlet plenum.
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• Enter a value for Plenum Size. It is set by default to 3.5 times the cylinder diameter.

The size of the output plenum will be as per the Plenum Size and the shape as per the
selection of Plenum Type.

5. Click Generate (  located in the Ansys DesignModeler toolbar).

6. Click Decompose (  located in the IC Engine toolbar).

7. Close the Ansys DesignModeler.

Note:

Even after decomposition you can change the parameters like Valve Lift, Inlet Ex-
tension Length, Plenum Size, Plenum Blend Rad, or Cylinder Extension Length
in the Input Manager. After changing the parameters you will have to update the
cell to regenerate the geometry with the changed parameters. For Post Planes Dist.
From Ref. you can change the plane distances but the number of postprocessing
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planes added the first time should remain the same. If you change any other para-
meters you will have to decompose the geometry again.

7.2. Viewing the Bodies and Parts

After decomposition the engine is divided into one part, Port and several bodies.

• Outplenum: The plenum created at the outlet.

• Inplenum: The plenum created at the inlet.

• Chamber: The chamber is divided into parts depending upon the number of postprocessing
planes.

• Invalve-Port: Depending upon the number of inlet valves in the geometry, Invalve-Port is created.

• Exvalve-Port: Depending upon the number of inlet valves in the geometry, Exvalve-Port is
created.
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Chapter 8: Port Flow Simulation: Meshing in IC Engine
The decomposed geometry is used to generate the mesh. The goal of the IC Engine meshing tool is to
minimize the effort required to generate a mesh for the IC Engine specific solver. It uses the named
selection created in the decomposition to identify different zones and creates the required mesh controls.
The information in this chapter is divided into the following sections:

8.1. Meshing Procedure for Port Flow Simulation

8.2. Global Mesh Settings for Port Flow Simulation

8.3. Local Mesh Settings for Port Flow Simulation

8.1. Meshing Procedure for Port Flow Simulation

There are two ways to generate the mesh.

Meshing directly from the Workbench Window

After decomposition is done you can then directly generate the mesh from the Workbench window
without opening the Ansys Meshing application. If you want to use the default mesh settings then
right-click on the Mesh cell and select Update from the context menu. This will first create the mesh
controls and then generate the mesh.

You can also change the mesh settings from the Workbench window.
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In the Properties box which is displayed after selecting the Mesh cell you can click on Edit Mesh Set-
tings next to the Mesh Settings property, under IC Engine. This will open a ICEngine Mesh Settings
dialog box.

You can change the settings for the parameters:

• Mesh Type

• Reference Mesh Size (mm) (This can be parametrized by enabling the check box next to it.)

• Number of Inflation Layers

For more information on these check the section on IC Mesh Parameters (p. 187).
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Meshing using Ansys Meshing Application

In this method of meshing you can check the mesh controls and settings in details.

1. Double-click the Mesh cell in the IC Engine analysis system to open the Ansys Meshing applic-
ation.

2. Click  IC Setup Mesh (  located in the IC Engine toolbar). This opens the IC Mesh Para-
meters dialog box.

a. Here you can define different mesh settings for the different parts and virtual topologies.
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In the IC Port Mesh Parameters dialog box you can see the default mesh settings. You can
change the settings or use the default ones.

• Mesh Type: You can select Hybrid or CutCell from the drop-down list.

• Reference Size: This is a reference value. Some global mesh settings and local mesh
setting values are dependent on this term.

Reference Size = (Valve margin perimeter) /100

Global Mesh Settings

• Min Mesh Size: This value is set to Reference Size/2 for Hybrid mesh type and Reference
Size/3 for CutCell mesh type.

• Proximity Min Size: This value is set to Reference Size/3.
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• Max Mesh Size: This value is set to Reference Size × 5 for Hybrid mesh type. For CutCell
mesh type it is set to (Proximity Min Size × 16) or (Min Mesh Size × 16) whichever is
lesser.

• Curvature Normal Angle: This value changes depending upon the chosen Mesh Type.
It is 30 for Hybrid mesh type and 18 for CutCell mesh type.

• Num Cells Across Gap: This value is set to 3 for Hybrid mesh type and 5 for CutCell
mesh type.

• Growth Rate: This value is set to 1.2 for Hybrid mesh type and 1.05 for CutCell mesh
type.

• Pinch Tolerance: This value is set to 0.1 for Hybrid mesh type. It is not valid for CutCell
mesh type.

• Number of Inflation Layers: This value is set to 8.

Local Mesh Settings

• Chamber Size: This value is set to Reference Size × 1.5.

• Chamber Growth Rate: This value is set to 1.15 for Hybrid mesh type and 1.05 for
CutCell mesh type.

Note:

Chamber Growth Rate should be less than Growth Rate.

• Valve Proximity Faces Size: This value is set to (least value among valve lifts/8). The
minimum limit is Reference Size/8 and maximum limit is Reference Size.

Note:

If Reference Size is changed, all the other parameters will change, depending
on their relation with it.

b. If after changing the values of the parameters you would like to go back to the default
values, click Reset.

c. Click OK to set and close the IC Port Mesh Parameters dialog box.

You can generate the mesh controls before opening Ansys Meshing application. To do this
enable Automatically Setup On Edit under IC Engine in the Properties box which is displayed
after selecting the Mesh cell in the Workbench window.
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So after you double-click the Mesh cell to open Ansys Meshing application the mesh controls
are already set.

3. Click IC Generate Mesh (  located in the IC Engine toolbar) to generate the mesh.
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When you complete the setup through IC Setup Mesh, it does the following:

• It makes the required changes in Global Mesh Settings. (For details refer to, Global Mesh Settings
for Port Flow Simulation (p. 291)).

• It creates Local Mesh Settings. (For details refer to Local Mesh Settings for Port Flow Simula-
tion (p. 297)).

• It creates pinch controls (for hybrid mesh).

• It defines the “Worksheet” for controlling the order of meshing bodies (for hybrid mesh).

8.2. Global Mesh Settings for Port Flow Simulation

IC Engine meshing tool creates Global Mesh Settings based on the information provided in the IC
Port Mesh Parameters (p. 287) dialog box. Following sections describe these settings:

8.2.1. Defaults Group

8.2.2. Sizing Group
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8.2.3. Quality Group

8.2.4. Inflation Group

8.2.5. Advanced Group

For more information on Global Mesh Settings, see Global Mesh Controls in the Meshing User's Guide.

8.2.1. Defaults Group

Under Details of Mesh, the following are the global mesh settings defined under Defaults.

• Physics Preference: This is set to CFD.

This option allows you to establish how Workbench will perform meshing based on the physics
of the analysis type that you specify.

• Solver Preference: Ansys Fluent is set as the solver for the mesh.

Since CFD is chosen as your Physics Preference, it causes a Solver Preference option to appear
in the Details View of the Mesh folder. The chosen value sets certain defaults that will result
in a mesh that is more favorable to the respective solver.

• Element Order: This is set to Linear. This option allows you to control whether meshes are
to be created with midside nodes (quadratic elements) or without midside nodes (linear ele-
ments). Reducing the number of midside nodes reduces the number of degrees of freedom.
Choices include Program Controlled, Linear, and Quadratic.

• Element Size: This allows you to specify the element size used for the entire model. This size
will be used for all edge, face, and body meshing.

• Export Format: This option defines the format for the mesh when exported to Ansys Fluent.
The default is Standard. You can change this to Large Model Support to export the mesh as
a cell-based Fluent mesh.
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• Export Preview Surface Mesh : This option controls the export of the preview surface mesh
elements. This option can be used when the bodies have been meshed only partially, that is,
not all volumes have been filled with elements and only previewing of surface meshes was
done. The default is No, which results in export of only volume mesh elements to the Fluent
mesh file. You can change this to Yes to export both the volume mesh and the preview surface
meshes to the Fluent mesh file.

8.2.2. Sizing Group

Under the Details of Mesh, the following are the global mesh settings defined under Sizing.

• Use Adaptive Sizing: This option refers to a 2D curvature and proximity-based refinement
approach which refines edges based on curvature and/or proximity but does not propagate
the refined mesh along the face. When set to Yes, the mesher uses the value of the element
size property to determine a starting point for the mesh size. The value of the element size
property can be set by the user or automatically computed using defaults. When meshing
begins, edges are meshed with this size initially, and then they are refined for curvature and
2D proximity. Next, mesh based defeaturing and pinch control execution occurs. The final
edge mesh is then passed into a least-squares fit size function, which guides face and volume
meshing.

• Growth Rate: It is equal to the value of Growth Rate, which is set in the IC Port Mesh Para-
meters (p. 287) dialog box.

• Max Size: It is equal to the value of Max Mesh Size, which is set in the IC Port Mesh Para-
meters (p. 287) dialog box.

• Mesh Defeaturing: This option automatically defeatures small features and dirty geometry
according to the Defeature Size you specify here.
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• Transition: When Use Adaptive Sizing is set to Yes, this option affects the rate at which ad-
jacent elements will grow. Slow produces smooth transitions while Fast produces more abrupt
transitions.

• Span Angle Center: It is set to Fine.

When Use Adaptive Sizing is set to Yes, this option sets the goal for curvature based refine-
ment. The mesh will subdivide in curved regions until the individual elements span this angle.
The following choices are available:

– Coarse — 91o to 60o

– Medium — 75o to 24o

– Fine — 36o to 12o

• Capture Curvature: This option allows you to take into account curvature effects.

• Curvature Min Size: When Capture Curvature is set to Yes, this option is equal to the value
of Min Mesh Size, which is set in the IC Port Mesh Parameters (p. 287) dialog box.

• Curvature Normal Angle: When Capture Curvature is set to Yes, this option is set to the
value of the Normal Angle in the case of Cold Flow Simulation. This value is set in the IC
Port Mesh Parameters (p. 287) dialog box.

• Capture Proximity: This option allows you to account for proximity effects.

• Proximity Min Size: When Capture Proximity is set to Yes, this option is equal to the value
of Proximity Min Size, which is set in the IC Port Mesh Parameters (p. 287) dialog box.

• Num Cells Across Gap: It is set to the value of Num Cells Across Gap in the IC Port Mesh
Parameters (p. 287) dialog box. When Capture Proximity is set to Yes, this option is the
minimum number of layers of elements to be generated in the gaps.

• Proximity Size Function Sources: When Capture Proximity is set to Yes, this parameter is
set to Faces and Edges.

8.2.3. Quality Group

Quality is useful for configuring mesh quality.
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• Check Mesh Quality: This option determines how the software behaves with respect to error and
warning limits

• Target Skewness: This option allows you to set a target skewness that you would like the mesh
to satisfy.

• Smoothing: This option attempts to improve element quality by moving locations of nodes with
respect to surrounding nodes and elements. The Low, Medium, or High option controls the number
of smoothing iterations along with the threshold metric where the mesher will start smoothing.

• Mesh Metric: This option allows you to view mesh metric information and thereby evaluate the
mesh quality.

When you select a mesh metric, its Min, Max, Average, and Standard Deviation values are reported
in the Details View, and a bar graph is displayed under the Geometry window. The graph is labeled
with color-coded bars for each element shape represented in the model's mesh, and can be manip-
ulated to view specific mesh statistics of interest.

8.2.4. Inflation Group

Inflation is useful for CFD boundary layer resolution.

• Use Automatic Inflation: It is set to None for Port Flow Simulation.

• Inflation Option: It is set to Last Aspect Ratio for Port Flow Simulation. This setting determ-
ines the heights of the inflation layers.
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– The Last Aspect Ratio option creates inflation layers using the values of the First
Layer Height, Maximum Layers, and Aspect Ratio (Base/Height) controls to generate
the inflation mesh.

→ First Layer Height: It is equal to (Reference Size/70), for Hybrid Mesh Type and
(Reference Size/20), for CutCell Mesh Type.

This control determines the height of the first inflation layer. This first inflation layer
consists of a single layer of prism elements that is formed against the faces of the
inflation boundary. You must enter a value for this control, and it must be greater
than 0.

→ Maximum Layers: It is equal to the value of Number of Inflation Layers, which is
set in the IC Mesh Parameters (p. 187) dialog box.

This control determines the maximum number of inflation layers to be created in the
mesh. Valid values are from 1 to 1000.

→ Aspect Ratio (Base/Height): This value is set to 3.

This is defined as the ratio of the local inflation base size to the inflation layer height.
The value should be between 0.5 and 20.

• View Advanced Options: This control determines whether advanced inflation options appear
in the Details View. Choices are No and Yes. It is set to No for Port Flow Simulation.

8.2.5. Advanced Group

These options are valid only when Hybrid is selected from the Mesh Type drop-down list.

The Advanced group allows you to use the following features and controls:

• Number of CPUs for Parallel Part Meshing: This option sets the number of processors to be used
for parallel part meshing. Using the default for specifying multiple processors will enhance meshing
performance on geometries with multiple parts. For parallel part meshing, the default is set to

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.296

Port Flow Simulation: Meshing in IC Engine



Program Controlled or 0. This instructs the mesher to use all available CPU cores. The default setting
inherently limits 2 GB memory per CPU core. An explicit value can be specified between 0 and 256,
where 0 is the default.

• Straight Sided Elements: This option specifies meshing to straight edge elements when set to
Yes. This option may affect the placement of midside nodes if the Element Order option is set to
Quadratic.

• Rigid Body Behavior: This option determines whether a full mesh is generated for a rigid body,
rather than a surface contact mesh. Rigid Body Behavior is applicable to all body types. Valid
values for Rigid Body Behavior are Dimensionally Reduced (generate surface contact mesh only)
and Full Mesh (generate full mesh).

• Triangle Surface Mesher: This option determines which triangle surface meshing strategy will be
used by patch conforming meshers. In general, the advancing front algorithm provides a smoother
size variation and better results for skewness and orthogonal quality. This option is inaccessible
when an assembly meshing algorithm is selected.

• Topology Checking: This option controls what happens when a user scopes an object (such as
loads, boundary conditions, named selections and so on) to geometry (bodies, faces, edges, and
vertices) after the mesh has been generated. If Topology Checking is set to Yes (default), the
software will check to see if the scoped geometry has mesh properly associated to it. If the associ-
ations are incorrect, the scoping of the object will force the mesh to be out of date. The mesh
would need to be re-generated to get proper associations. If the associations are correct, the
scoping is performed without any change to the mesh and the mesh stays up to date. Set Topology
Checking to No to avoid the checks and always keep the mesh up to date.

• Pinch Tolerance: This is equal to the value of Pinch Tolerance, which is set in the IC Port Mesh
Parameters (p. 287) dialog box.

This control allows you to specify a tolerance for the Meshing application to use when it generates
automatic pinch controls.

• Generate Pinch on Refresh: This option determines whether pinch controls will be regenerated
following a change made to the geometry (such as a change made via a DesignModeler application
operation such as a merge, connect, etc.). If Generate Pinch on Refresh is set to Yes and you
change the geometry, all pinch controls that were created automatically will be deleted and recreated
based on the new geometry. If Generate Pinch on Refresh is set to No and you update the geo-
metry, all pinch controls related to the changed part will appear in the Tree Outline but will be
flagged as undefined.

8.3. Local Mesh Settings for Port Flow Simulation

Based on information provided in the IC Port Mesh Parameters dialog box, IC Engine meshing tool
creates some mesh settings at local level. Following section describes these settings for port flow sim-
ulation:

Face Sizing on Valve Proximity Faces

When you click Face Sizing (valve-proximity-faces) under Mesh in the Outline, you can see the details.
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• Type: It is set to Element Size.

• Element Size: It is equal to Valve Proximity Faces Size, which is set in the IC Port Mesh
Parameters (p. 287) dialog box.

• Behavior: For this body part it is set to Hard.

Note:

This setting will be present in the tree only for hybrid meshing.

Face Sizing on Cylinder Faces of Outlet Plenum

When you click Face Sizing (Outplenum-cyl) under Mesh in the Outline, you can see the details.

• Type: It is set to Element Size.

• Element Size: It is equal to Reference Size × 1.5, which is set in the IC Port Mesh Paramet-
ers (p. 287) dialog box.

• Behavior: For this body part it is set to Soft.

Body Sizing for Chamber

When you click Body Sizing (Chamber) under Mesh in the Outline, you can see the details.

• Geometry: This shows the body selected.

• Type: It is set to Element Size.

• Element Size: It is equal to Chamber Size which is set in the IC Port Mesh Parameters (p. 287)
dialog box.

• Behavior: For this body part is it set to Soft.

• Growth Rate: It is equal to the Growth Rate which is set in the IC Port Mesh Parameters (p. 287)
dialog box.

MultiZone

When you click MultiZone(Outplenum) under Mesh in the Outline, you can see the details.

• Geometry: This shows the body selected.

• Method: MultiZone is the method selected.
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• Mapped Mesh Type: Hexa/Prism is selected from the drop-down list.

• Src/Trg Selection: Manual Source is selected from the drop-down list.

• Source: This shows the faces selected. The faces, ice-slipwall-outletplenum and int-ch-* are
selected.

Note:

This setting will be present in the tree only for hybrid meshing.

Sweep Method for Chamber

Click Sweep Method (Chamber) under Mesh in the Outline, to see the details.

• Geometry: The chamber body part is used as input.

• Source: It is Program Controlled.

• Target: It is Program Controlled. This means that the program determines the target for the
body.

• Free Face Mesh Type: It is set to All Quad. This determines the shape of the elements used to
fill the swept body.

• Sweep Num Divs: It is equal to — (The length of the chamber body/Reference Size).

• Sweep Bias Type: It adjusts the spacing ratio of nodes on the edge. Biasing direction is based
from the source to the target.

One of the four patterns available from the Bias Type drop-down list is chosen.

• Sweep Bias: This value is set to 1. This will override the mesh gradation in the swept region.

Note:

This setting will be present in the tree only for hybrid meshing.

Inflation For All Faces

Click Inflation (all-faces) under Mesh in the Outline, to see the details.

• Boundary: For this all the faces of the geometry except the inlet faces, symmetry faces, and the
outlet faces are selected.
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• Inflation Option: It is set to Smooth Transition. This setting determines the heights of the in-
flation layers.

– The Smooth Transition option uses the local tetrahedral element size to compute each
local initial height and total height so that the rate of volume change is smooth. Each
triangle that is being inflated will have an initial height that is computed with respect to
its area, averaged at the nodes. This means that, for a uniform mesh, the initial heights
will be roughly the same, while for a varying mesh, the initial heights will vary.

→ Transition Ratio: It is set to 0.272. This control determines the rate at which adjacent
elements grow. This is the default value when Physics Preference is set to CFD and
when Solver Preference is set to Fluent.

→ Number of Layers: It is equal to the Number of Inflation Layers as specified in the
IC Port Mesh Parameters (p. 287) dialog box. This control determines the maximum
number of inflation layers to be created in the mesh. The default is 5 for solid bodies.

→ Growth Rate: It is set to 1.1. This control determines the relative thickness of adjacent
inflation layers. As you move away from the face to which the inflation control is applied,
each successive layer is approximately one growth rate factor thicker than the previous
one.

→ Inflation Algorithm: It is set to Pre for hybrid meshing. For the CutCell algorithm, in-
flation is neither Pre nor Post. Rather, it may be considered a hybrid of the two, in that
the technology used is like that of the Pre algorithm, but inflation occurs Post mesh
generation.
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Chapter 9: Port Flow Simulation: Setting Up the
Analysis in IC Engine
This chapter describes how to configure the analysis for a port flow simulation. All the settings described
in this chapter are done automatically, but you can change them by accessing the Solver Settings
dialog box or the task pages and the dialog boxes in Ansys Fluent.

After meshing you can set up the solver. In the Properties pane of the ICE Solver Setup cell you can
make changes to the solver settings.

9.1. ICE Solver Settings

9.2. Solver Default Settings

9.1. ICE Solver Settings

Click Edit Solver Settings to open the Solver Settings dialog box.
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9.1.1. Basic Solver Settings

9.1.2. Boundary Conditions

9.1.3. Monitor Definitions

9.1.4. Initialization

9.1.5. Postprocessing
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9.1.1. Basic Solver Settings

In the Basic Settings tab you have the following settings:

Solution Type

shows the Solution Type as Port Flow which you have selected in the Properties pane of
the ICE cell. You cannot make any changes here.

Initialize Flow

is set to Yes  by default. This will initialize the flow. To check the initialization settings see
the Solution Initialization task page in Ansys Fluent.
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Set Default Models

is set to Yes  by default. For port flow simulation some models of Ansys Fluent have been
chosen as default for better results. These are the Energy model, and the Standard k-omega
model from the list of Viscous models. You can check them at the Models  (p. 324) task page
of Ansys Fluent.

Initialize FMG

is set to Yes  by default. This will use FMG initialization. For more information see Full Multigrid
(FMG) Initialization in the Fluent Theory Guide.

Read Profile File

allows you to read multiple profile files. Clicking on Read Profile File opens Browse profile
file dialog box. In the browsing window three types of file extensions will be supported
.prof (profile file), .ttab (transient table), and .csv. All Files option is also present if you
have a file extension which does not match with either of the given extensions. In this case
the file type will be automatically identified, and an error will be thrown if the format is not
supported.

If you select a .csv file and click Open, then a Read CSV File dialog box opens.
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• You need to enter a name for Profile Name. This name will appear in the drop-down
list of Profiles in the Profile Editor dialog box.

• If you retain the default setting of Yes for Read CSV Titles then the quantity or variable
names will be as per the names in the CSV file.

• If you choose No for Read CSV Titles then you have to specify the No. of Columns
of the CSV file you want to read. For each column you have to select a different variable
name from the drop-down list. In this case the titles of the CSV columns will not be
read. Your selections for the columns will be the titles.

Important:

– All the columns in CSV should have same number of values. Variable
number of values and interpolation is not supported in the current
version.

– Ensure that there are no empty spaces in the titles.

The format of the standard profile file is

 ((profile-name transient n periodic?)
 (field_name-1 a1 a2 a3 .... an)
 (field_name-2 b1 b2 b3 .... bn)
 .
 .
 .
 .
 (field_name-r r1 r2 r3 .... rn)) 
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The profile name as well as the field names have to be shorter than 64 characters.
One of the field_name should be used for the time field, and the time field section
must be in ascending order. n is the number of entries per field. The periodic?
entry indicates whether or not the profile is time-periodic. Set it to 1 for a time-peri-
odic profile, or 0 if the profile is not time-periodic.

An example is shown below:

((sampleprofile transient 8 0 0)
(angle
4.400000e+02 4.412000e+02
4.644900e+02 4.656900e+02
6.400000e+02
6.412000e+02 6.480800e+02 6.492800e+02)
(mass-flow
0.000000e+00 2.450040e-03 2.450040e-03 0.000000e+00 0.000000e+00
2.475870e-03 2.475870e-03 0.000000e+00)
(velocity
0.000000e+00 1.941520e+02 1.941520e+02 0.000000e+00 0.000000e+00
1.922430e+02 1.922430e+02 0.000000e+00)
)

Important:

All quantities, including coordinate values, must be specified in SI units
because Ansys Fluent does not perform unit conversion when reading
profile files. Also, profile names must have all lowercase letters (for example,
name). Uppercase letters in profile names are not acceptable.

The format of the transient table file is

 profile-name n_field n_data periodic?
 field-name-1 field-name-2 field-name-3 .... field-name-n_field 
 v-1-1  v-2-1... ... ... ... v-n_field-1 
 v-1-2  v-2-2... ... ... ... v-n_field-2
 .
 .
 .
 .
 .
 v-1-n_data v-2-n_data ... ... ... ... v-n_field-n_data 

The first field name (for example field-name-1) should be used for the time field, and
the time field section, which represents the flow time, must be in ascending order. The
periodic? entry indicates whether or not the profile is time-periodic. Set it to 1 for a time-
periodic profile, or 0 if the profile is not time-periodic.

An example is shown below:

sampletprofile 3 8 0
angle        mass-flow    velocity
440          0.0          0.0
441.2        0.00245004   194.152
464.49       0.00245004   194.152
465.69       0.0          0.0
640          0.0          0.0
641.2        0.00247587   192.243
648.08       0.00247587   192.243
649.28       0.0           0.0
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This file defines the same transient profile as the standard profile example above.

Important:

All quantities, including coordinate values, must be specified in SI units because
Ansys Fluent does not perform unit conversion when reading profile files. Also,
profile names must have all lowercase letters (for example, name). Uppercase letters
in profile names are not acceptable. When choosing the field names, spaces or
parentheses should not be included.

After reading the files the profiles will be available in the boundary condition drop-down
lists.

Profile Editor

allows you to view the plot of the profiles.
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• Select a profile from the drop-down list of Profiles.

• When a particular profile is selected all corresponding variables will be displayed in the X
Axis and Y Axis drop-down lists.

• Select the variable for X Axis and Y Axis and click Plot. The plot will be displayed in the
area of Profile Chart.

• You can also read a profile by clicking on Read File.

• The read profile which is presently selected can be deleted from the list by clicking on
Remove Profile.

• You can make changes to the values in the profile table displayed. Click Plot to view the
Profile Chart with the changed values. You can save the profile with the edited values by
clicking on Save.

• To manipulate the chart:

Table 9.1: Chart Manipulation

Operation

ZoomRotate Middle Mouse

ZoomShift + Middle Mouse

PanCtrl + Middle Mouse

Box ZoomDrag Right Mouse

Fit to WindowF key
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9.1.2. Boundary Conditions

In the Boundary Conditions tab you can see boundary conditions set for four zones. Select each
zone and click Edit to check the details.

• ice-slipwall-outplenum is set to Type wall.
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The wall is set as slipwall and the Temperature is set to 300.

• Similar conditions are set for ice-slipwall_inplenum1.

• ice-outlet is set as Pressure Outlet with Gauge Pressure set to –5000 and Temperature set
to 300.

• ice-inlet-inplenum1 is set as Pressure Inlet with Gauge Pressure set to 0 and Temperature
set to 300.

You can check the detailed settings in the Boundary Conditions  (p. 327) task page in Ansys Fluent.
You can also create additional boundary conditions by clicking Create.
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In the Create Boundary Conditions dialog box select the zone to which you like to apply the
boundary conditions to from the list under Zones. Then select Type and enter the required values
for the variables, either a constant value or a variable profile from the drop-down list. You can select
a profile in case you have read a profile before, or you can select PROFILE EDITOR option which will
open the Profile Editor dialog box where you can check the plot of the profile or read a new profile.
After you click OK you can see the zone name and the details in the Boundary Conditions tab.

You can use the Copy button to copy the boundary conditions to other multiple zones.

• Select the boundary condition of interest in the Boundary Conditions tab.

• Click Copy.
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• Select the zone(s) to which you want to copy the boundary conditions and click OK.

• The zones to which you have copied the boundary conditions appear in the list.

For the boundary conditions, you can parametrize the quantity by enabling the check box next to it.
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9.1.3. Monitor Definitions

In the Monitor Definitions tab you can see that at least one surface monitor has been set by default.
It plots the variable Mass Flow Rate at the inlet and outlet. Depending upon the number of postpro-
cessing planes (defined by Post Planes Dist. From Ref. in the Input Manager) those many swirl
monitors will be created. Select each monitor and click Edit to check the details.

For information on how the swirl ratio is monitored on the swirl planes see the section on swirl
definition (p. 582).

• mass-flow-rate-mon is a surface monitor.
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It plots the Mass Flow Rate on ice-inlet-inplenum1 and ice-outlet. This monitor is automat-
ically set for a port flow simulation. You can change the settings here in the Monitor Definition
dialog box.

You can see additional details in the Monitors  (p. 334) task page in Ansys Fluent. You can create
additional monitors by clicking Create. Then select the Type, Report Type, and the Field Variable
from the respective drop-down lists.

You can select Volume, Surface, or Probe from the Type drop-down list. If you select Probe you
can create a point or surface on which you can monitor a variable.
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You need to enter values for Point X, Point Y, and Point Z to position the point. If you retain the
value of 0 for Radius then a point monitor is created. If you enter a value for Radius then a circular
surface with the given Radius and the center as the given Point is created. You can monitor the
variables of your choice on this surface or point.

You can select New Variable from the Field Variable drop-down list. This opens the Add Quant-
ity/Variable dialog box.

You can select the variable by selecting from the options under the Quantity and Quantity Subtype
drop-down lists. You also have an option of User Defined under the Quantity drop-down list.
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Here you can add the quantity or variable of your choice of which you would like postprocessing
images, in the User Defined text box. You will have to check Fluent if the term is valid for the simu-
lation. After you click OK this quantity will be available in the drop-down list of Field Variable.

The Name will be set according to your selections of monitor type and variable. You can override
the proposed name. Click Create to create the monitor. It will now appear in the list in the Monitor
Definitions tab.

9.1.4. Initialization

In the Initialization tab you can see the default set values for the various parameters.

• Gauge Pressure, X Velocity, Y Velocity, and Z Velocity are all set to 0 by default.

• Temperature is set to 300.
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• Turbulent Kinetic Energy and Turbulent Dissipation Rate are set to 1 by default.

You can change the values as per your settings. Click Patch to open the Patching Zones dialog box.
You can patch the various listed variables at your desired values to the ice-fluid-port zone.
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9.1.5. Postprocessing

In the Post Processing tab you can see that one image is being automatically saved of the velocity
contours plotted on the cut-plane surface. Additional images of swirl plotted on the swirl planes are
saved. These will depending upon the number of Post Planes Dist. From Ref. you have defined in
the Input Manager.
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• The image is plotted on surface ice_cutplane_1.

• The image is captured at a saved view, ice_cutplane_1–view.

• Velocity-Magnitude contours are displayed.

• Start Iteration and Stop Iteration are set to 0 by default.

• Images are saved at a Frequency of 50 iterations.

• Animation is set to Yes signifying that animation of the saved velocity contour images will
be created at the end of the simulation.

• Overlay With Vectors is set to No.

• Table is set to Yes signifying that the saved images will be displayed in the report in a table
of 5 Rows and 3 Columns.

• Tag shows the name tag for the images.
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In the Edit Image dialog box you can change the settings and values as required. To create additional
postprocessing images click Create.

1. Select the Surfaces on which you want to plot the contours.

2. Select a view from the View drop-down list.

3. Select the parameter from the Quantity drop-down list. You can select New Variable from
the Quantity drop-down list. This opens the Add Quantity/Variable dialog box.

Here you can add the quantity or variable of your choice of which you would like postpro-
cessing images. You will have to check Fluent if the term is valid for the simulation.
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4. Enter the Start Iteration and End Iteration. The images will be saved only within these
points.

5. Enter a value for Frequency. The images will be captured at the entered frequency.

6. If you need to create an animation from the saved images you can select Yes from the An-
imation drop-down list.

7. The option Overlay With Vectors is by default set to No. You can set it to Yes if you want
the vectors to overlap the contour images.

8. If you want the saved images to be displayed in the report in a table format select Yes from
the Table drop-down list.

9. Enter the values for Rows and Columns depending on how you want to format the table.

10. You can add a tag for the image. You can use this Tag if you want only the final images of
different surfaces in a single table. In this case you have to provide the same tag to all the
images.

11. Click Add Iso Surface if you want to create an iso-surfaces. These surfaces are isovalued
sections of the entire domain.

a. Enter a name for the isosurface you want to create at Surface Name.

b. Select the Quantity from the drop-down list. You can select a quantity from the list or
create a new variable by selecting New Variable.

c. From the Iso Value Input drop-down list you can select either of Absolute Value or
Percentage of Range.

• Absolute Value: If you select this from the drop-down options, you can enter a
value for Absolute Value. The iso-surafce created will be of this value.

• Percentage of Range: If you select this from the drop-down options, then you
need to enter a percentage value for Percentage of Range. The iso-surface created
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will be of the percentage value of the minimum and maximum values obtained
of the quantity.

An iso-surface of the given name and of the selected quantity will be created and appear in
the list of Surfaces. This isosurface will be of the Absolute Value entered or of the percentage
of the minimum and maximum values of the quantity. You can select this isosurface to create
images in postprocessing.

12. Click Create to create the image.

13. Click Close to close the Create Image dialog box.

Once the changes are done in the Solver Settings dialog box you can close it and then update the
ICE Solver Setup  cell by choosing Update from the context menu.

9.2. Solver Default Settings

When you double-click the Setup cell, FLUENT Launcher opens.

Note:

Depending on your machine configuration, you may be able to increase the Number of
Processes to decrease the time taken to arrive at a solution. A reasonable value for the
Number of Processes is the number of cores on your machine.

When you click OK, Ansys Fluent reads the mesh file and sets up the IC Engine case. It will:
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• Set up the required models.

• Set up the default boundary conditions and material.

• Set up the default monitors.

• Use Full Multigrid (FMG) initialization. For more information, refer to Full Multigrid (FMG) Initialization
in the Fluent Theory Guide.

In the Ansys Fluent application, you can check the default settings by highlighting the items in the
navigation pane.

Figure 9.1: The Ansys Fluent Navigation Pane

The details about the settings in the different task pages are described in the following sections:

9.2.1. General Settings

9.2.2. Models

9.2.3. Materials

9.2.4. Boundary Conditions
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9.2.5. Solution Methods

9.2.6. Solution Controls

9.2.7. Monitors

9.2.8. Solution Initialization

9.2.9. Run Calculation

9.2.1. General Settings

The General task page has the following settings:

• c

• Solver Type is set to Pressure-Based.

• Solver Time is set to Steady.

9.2.2. Models

The following models are selected for the analysis:

• The Energy model is enabled.
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• From the Viscous models, the Standard k-omega model is selected. By default Compressib-
ility Effects and Shear Flow Corrections are enabled.

Note:

The  k-omega model internally adjusts the wall treatment based on mesh re-
finement near the walls. Validation tests have determined that this model is
more stable and predicts correct results for port flow analyses. For more details
about the k-omega model, refer to Standard and SST k- ω Models in the Fluent
Theory Guide.
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9.2.3. Materials

• Air is set as the material.

• The Density of air is set to ideal-gas.

• The Specific Heat (Cp) of air is set to constant.

9.2.4. Boundary Conditions

You can check the boundary conditions and monitors settings for port flow simulation in the icBC-
Settings file. The values shown for the boundary conditions are the defaults set by the IC Engine
System. If any of these values are different for your problem, you can change them in Fluent or you
can edit the icUserSettings.txt file before launching Fluent to set the new default values.

• For the ice-inlet-inplenum1 boundary conditions, the following settings are done in the
Pressure Inlet dialog box:
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– Gauge Total Pressure is set to 0 Pa.

– The Specification Method in the Turbulence group box is set to Intensity and Hy-
draulic Diameter.

Note:

The Specification Method can also be set to Intensity and Viscosity
Ratio.

– Turbulent Intensity is set to 2%, and Hydraulic Diameter is automatically calculated.

• For the ice-outlet boundary condition the following settings are done in the Pressure Outlet
dialog box.
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– Gauge Pressure is set to -5000 Pa.

Note:

This is set based on the assumption that inlet and outlet pressure difference
is 5000 Pa. If you have data on the actual values you can change the settings.

– Backflow Total Temperature is set to 300 K.

• For the wall boundary condition Specified Shear is selected from the Shear Condition group
box. In the Thermal tab Temperature is set to 300 K.
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9.2.5. Solution Methods

The Solution Methods are set differently for Hybrid and CutCell mesh type. The following are the
settings for Hybrid mesh type.
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Figure 9.2: Solution Methods for Hybrid Mesh Type

• The Scheme for the analysis is set to Coupled in the Pressure-Velocity Coupling group box.

• The Gradient in the Spatial Discretization group box is set to Least Squares Cell Based.

• Pressure is set to Standard.

• Density, Momentum, and Energy are all set to Second Order Upwind.

• Turbulent Kinetic Energy and Specific Dissipation Rate are set to First Order Upwind.
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• Pseudo Transient is enabled. This increases the robustness and speed of solution convergence.
For more information about this option refer to, Solving Pseudo-Transient Flow in the Fluent
Theory Guide.

The following are the settings for Cutcell mesh type.

Figure 9.3: Solution Methods for CutCell Mesh Type

• The Scheme for the analysis is set to Coupled in the Pressure-Velocity Coupling group box.

• The Gradient in the Spatial Discretization group box is set to Least Squares Cell Based.

• Pressure is set to Presto!.

• Density and Specific Dissipation Rate are set to Second Order Upwind.

• Momentum, Turbulent Kinetic Energy and Energy are all set to QUICK.

• Pseudo Transient is enabled. This increases the robustness and speed of solution convergence.
For more information about this option refer to, Solving Pseudo-Transient Flow in the Fluent
User's Guide.
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9.2.6. Solution Controls

The Under-Relaxation Factors are set as following:

• Pressure: 0.5

• Momentum: 0.5

• Density, Body Forces, and Turbulent Viscosity are all set to 1.

• Turbulent Kinetic Energy, Specific Dissipation Rate, and Energy are set to 0.75.

• Solution Limits for pressure and temperature are set as shown below:
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– Minimum Absolute Pressure (pascal) is set to 1.

– Maximum Absolute Pressure (pascal) is set to 5e+10.

– Minimum Static Temperature (k) is set to 1.

– Maximum Static Temperature (k) is set to 5000.

Note:

The temperature and pressure limits are restricted as indicated above
because the values of these variables should not cross this specified
range in some cells. However, if you are modeling combustion or gas
exchange, or if you know that these limits are too aggressive for your
case, then you can modify them appropriately.

9.2.7. Monitors

To check the output results of the parameters, some monitors have been created.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.334

Port Flow Simulation: Setting Up the Analysis in IC Engine



One monitor defined by default is a Surface Monitor. It plots the variable Mass Flow Rate at the
inlet and outlet.

You can create your own Surface Monitors or Volume Monitors from the Monitors task page. Enable
Write so that an output file is written, which can be loaded and viewed later. You can see the mon-
itor settings that are done by default in the icBcSettings.txt file.

9.2.8. Solution Initialization

Initially Standard Initialization method is used for initialization and then an FMG initialization is
performed.
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9.2.9. Run Calculation

Note:

For more information on the settings done in the Pseudo Transient group box, refer
to Solving Pseudo-Transient Flow in the Fluent User's Guide.

You can enter the Number of Iterations you want.

Click Calculate to run the simulation.

Running the Calculation from Windows on Remote Linux Machines

To run the simulation on Linux, some changes in the setup are required.
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1. Set the number of Solver Processes in the FLUENT Launcher.

2. Click Show More Options to display the tabs.

3. Click the Parallel Settings tab.
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a. Select the Run Types from the list.

Note:

If you selected Distributed Memory on a Cluster, then you have to
provide the Machine Names.

4. Click the Remote tab.
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a. Enable Use Remote Linux Nodes.

b. Enter the path for Remote FLUENT Root Path. It is the root directory of Fluent in-
stallation.

c. Select your choice from the list of Remote Spawn Command.

Note:

For SSH, you need to set up a password-less connection before running
the solution remotely.

d. Enable Use Remote Cluster Head Node and provide the node.

e. Enter the number for Solver Processes.
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When the remote connection is set, it will use the nodes of the remote Linux machine. The details
are displayed in the Fluent console.

All the files will be saved in the working directory. Once the solution is completed, the project is up-
dated and you can proceed with your postprocessing.

For details, see Setting Additional Options When Running on Remote Linux Machines in the Fluent
User's Guide.

Note:

You can also submit the run on different Linux machines though RSM.

Running on Standalone Fluent

1. Open Fluent and read the case and data file from the ~project-
name_files\dp0\ICE\Fluent directory.

File Read Case & Data...

Note:

If the case is setup in the previously released versions, then you might have to read
the scheme file, (WB-ICE-Solver-Setup.scm) from ~ANSYS
Inc\v150\Addins\ICEngine\CustomizationFiles folder in the mapped
directory before running it in the present version.

2. In Run Calculation task page enter the required Number of Time Steps and click Calculate.

Note:

If you want the generate the report from IC Engine System report template, then you need
to first make sure that Solution cell is updated. This can be done by running the solution
for 1 timestep. Then, copy all the files generated by your standalone run into the Fluent
directory and update the Results cell.
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Chapter 10: Combustion Simulation: Preparing the
Geometry in IC Engine
This chapter provides instructions and information about preparing the IC engine geometry for combus-
tion simulations.

10.1. Geometry Decomposition for Sector Combustion Simulation

10.2.Viewing the Bodies and Parts

10.3. Geometry Decomposition for Full Engine Full Cycle

10.4. Geometry Decomposition for Full Engine IVC to EVO

For combustion simulation you need to select Combustion Simulation from the Simulation Type
drop-down list in the Properties pane.

After selection of Combustion Simulation you need to select the subtype from the list of:

• Sector (Simulation of a sector of an engine),

• Full Engine Full Cycle (Simulation of complete engine during complete cycle), or

• Full Engine IVC to EVO (Simulation of complete engine during compression phase).

Then you are required to fill all the necessary information about the engine under Engine Inputs. After
that you can open DesignModeler from Geometry, cell 3 in the IC Engine (Fluent) analysis system.

Note:

To open DesignModeler from the Geometry cell, you should set the Preferred Geometry
Editor to DesignModeler in the Geometry Import section in the Options dialog box. The
Options dialog box can be opened from the Tools Options...menu.
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Then you can double-click Geometry, cell 3, to open DesignModeler.

One more way to open DesignModeler is, to right-click on the Geometry cell, and select
New DesignModeler Geometry... from the context menu.
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10.1. Geometry Decomposition for Sector Combustion Simulation

Note:

It is a good practice to check the geometry before decomposing; there are a few things that
you should verify so that fewer problems occur later on. For more information, see Geometry
Check (p. 517).

Selection of Sector is recommended for engines with axisymmetric piston. The shape of the dome
geometry or the valve seats is not important as they will be trimmed later. It is also recommended for
CI (compression ignition) engines as they do not contain a spark plug geometry. Sector selection can
be used for SI engines if the spark plug is defined as a single point and is not represented in the geo-
metry.

1. Set the units, depending upon the geometry units, in ICE-DesignModeler.

2. Load the geometry file.

File Import External Geometry File...

3. Click Generate  to complete the import.
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4. Set up the Input Manager by clicking Input Manager (  located in the IC
Engine toolbar).

Note:

The IC Engine toolbar is displayed in the ICE DesignModeler only after installing IC
Engine Analysis System.
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Details of InputManager

This section in the Input Manager dialog box takes inputs of the engine to set it up for decom-
position.

• For Decomposition Position you can select the angle at which you want the geometry to
be decomposed. You can choose from:

– Specified Angle: If you choose this option then you can specify the particular angle
at which you want to decompose the geometry.

– You can set the angle at which you want the geometry to be decomposed by entering
the value in Decomposition Angle. It is set to 0 by default. When you want the
solver to start the simulation from a specific crank angle you can do so by changing
the Decomposition Angle. If you enable FD1 next to it, a new parameter will be
created.

Note:

Setting Decomposition Angle to a value will move the piston and
valves to the specified crank angle before decomposition. For details,
see Moving the Piston to a Specified Crank Angle (p. 183).

– FTDC: This is the firing top dead center angle.

– IVC: This is the inlet valve close angle.

• From the Sector Decomposition Type drop-down list, you can select

– Complete Geometry, or

– Sector Geometry

Complete Geometry is selected when the input geometry is a complete geometry, including
one flow volume and solid valves.

Sector Geometry is selected when the input geometry is a sector.

Depending upon your selection further options will be available.

• Select all the faces of the engine cylinder for Cylinder Liner Faces and click Apply.
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Figure 10.1: Cylinder Face Selection for a Complete Geometry

The cylinder radius and the cylinder axis are displayed in the status bar at the bottom of the
window.
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Figure 10.2: Cylinder Face Selection for a Sector Geometry

• Select the face at the top of the sector for Sector Top Face and click Apply.
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This option is present only when you select Sector Geometry from Sector Decomposition
Type drop-down list.

• Select the faces at the sides of the sector for Sector Periodic Faces and click Apply.

This option is also present only when you select Sector Geometry from Sector Decomposition
Type drop-down list.

• Select Yes or No for Crevice Option depending up on whether the imported geometry has
a crevice or not. If a crevice is present then the tool will calculate the appropriate sizes for
meshing the crevice. This option is present only if you select Sector Geometry from Sector
Decomposition Type drop-down list in the Input Manager or if you select Full Engine Full
Cycle or Full Engine IVC to EVO from the Combustion Simulation Type drop down list in
the Properties dialog box

• Enter the angle of the sector to be formed for Sector Angle.

• You can select Yes or No from the Validate Compression Ratio drop-down list. If you select
Yes then a Compression Ratio option appears below it.

• Enter the value for Compression Ratio. By default it is set to 15. The program will internally
calculate the compression ratio from the geometry and give a warning if the values do not
match.
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Note:

For details on how the compression ratio is calculated internally see Calculating
Compression Ratio (p. 590).

The warning will also allow you to compensate for the difference in the compression ratio
by clicking Yes. The program will try to increase the crevice volume for a lower user value
of compression ratio and vice versa. But if the user value is too high and the crevice volume
reduction is calculated in negative volume then another warning is given and no correction
is made.

• Crevice H/T Ratio option is present when you select Complete Geometry from the Sector
Decomposition Type drop down list. After decomposition some dome bodies are deleted.
To maintain the clearance volume at TDC a crevice is added at the outer edge of the sector.
Here you can specify the height to thickness ratio of the crevice which will be created. By
default it is set to 3.

• You can select points on the geometry in the graphic window for the Spark Points option.

IC Valves Data1

Note:

This option is not present only when you select Sector from Sector Decomposition
Type drop-down list.
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In this section you are required to give details about the valves.

• Select InValve  or ExValve as the Valve Type from the drop-down list.

• Select the valves from the figure and click Apply next to Valve Bodies.

Note:

– You can select multiple valves at a time and set them to the desired type.

– Confirm that Selection Filters are set to Bodies.

– Remember the order of selection of the valve bodies. This is important es-
pecially while using meshes from another setup for the KeyGrid option.

• Select the faces on which the valves rest for Valve Seat Faces and click Apply.

Figure 10.3: Valve Seats

The valve seat is that face of the port body which comes in contact with the valve body. The
Figure 10.4: Valve Seat Selection (p. 351) shows that the highlighted face of the valve body
will make contact with the valve seat face of the port body.
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Figure 10.4: Valve Seat Selection

Note:

Confirm that Selection Filters are set to Model Faces. Some engines might have
line contact between the valve and the valve seat. In such cases you can select
the face which is near the valve and includes the line of contact.

• Select the valve from the Valve Profile drop-down list. This will set that particular valve to
the selected valve profile.

Note:

The profile file (Valve Lift and Piston Motion Profile) (p. 146) contains a table of
crank angle against the valve lift for different valves. Each table type has a name.
The names are loaded in the Valve Profile drop-down list. This term is valid only
when you select By Lift Curve Profile for Input option for IVC and EVO in the
Properties pane.
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IC Injection 1

In this section you are required to give details about the injection. If you choose Multiple from
the No. of Injection Rows drop-down list, then you can add injection groups by right-clicking
on IC Injection 1 and selecting Add New IC Injection Group.

• For Spray Location Option you can choose from either of:

– Height and Radius

– Coordinates

– Select Point

– Beam Origin, Footprint: This will be available only for Full Engine Full Cycle
from the drop-down list. After selection of each, different options are available.

– When you choose Height and Radius option, you will have to provide the follow-
ing inputs.

→ Spray Location, Height: The location of the spray in terms of its height
from the chamber top

→ Spray Location, Radius: The distance of the spray from the cylinder axis.

Figure 10.5: Spray Location from Height and Radius
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→ Enter the value for the Offset Angle, which is the angle for which you
would like to form a sector which can be further used for solving the
simulation. It should ideally be (360 degrees / Number of nozzles). Internal
calculations are done assuming you have entered the sector angle accord-
ingly. This option is present only when you select Complete Geometry
from Sector Decomposition Type drop-down list.

→ You can select a plane or a face as the Offset Angle Reference Plane/Face.
This option will be present only when you have selected Height and Ra-
dius from the Spray Location Option drop-down list and more than one
injection group is present. This reference plane should contain the cylinder
axis. The injection positions are given with reference to this plane. If you
do not select a face or plane, then the Offset Angle Reference Plane/Face
will be auto created during decomposition.

Note:

When a sector is imported then one of the Sector Periodic
Faces will be selected as the Offset Angle Reference
Plane/Face if you have not selected any.

For multiple groups of Height and Radius the Offset Angle
Reference Plane/Face will be the same. So you can select in
any one group and it will be reflected in the rest.

→ Offset Angle gives the location of the injection from the Reference
Plane/Face.
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As shown in the figure, the Offset Angle is calculated in an anti-clockwise
direction from the Reference Plane/Face, in the opposite direction of the
normal. Generally, the normal is the Z axis in the local coordinate system.
So the Y axis is on the Reference Plane/Face. Thus, the Offset Angle is
the angle of the injection from the Y axis of the local coordinate system.
This angle is also known as the azimuthal angle. This term is present only
if Multiple is chosen for No. of Injection Rows.

• When you choose Coordinates  option, you will have to provide the location of the
spray in terms of coordinates.
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– Spray Location, X

– Spray Location, Y

– Spray Location, Z

• For Select Point you can select the point in the geometry.

• You can choose Spray Angle or Vector for Spray Direction Option. The Spray Angle
is the angle between the direction of spray and the cylinder axis. If you select and enter
the Spray Angle then direction vector is automatically calculated.

Figure 10.6: Spray Angle

You can also provide the spray direction in terms of Vector.
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To observe the spray position and cone in the graphics window after entering the values

click Generate  and then click the button Show Spray Cone

 on the IC Engine toolbar. This button is a toggle button.

After decomposition injection planes are created, which pass through the injection. You
can use these to observe and plot variables.

Note:

All the injections provided should lie within the sector domain. You will get a
warning if the program calculates that the injections you entered are outside
the domain.

If your simulation does not include injections then delete the IC Injection (RMB)
group.
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Click Generate (  located in the Ansys DesignModeler toolbar).

5. Click Decompose (  located in the IC Engine toolbar).

6. Close the Ansys DesignModeler.

10.2. Viewing the Bodies and Parts

After decomposition the engine is divided into one part, Port and several bodies. Some dome bodies
are deleted during decomposition of the geometry into a sector. To maintain the clearance volume at
TDC a crevice is added at the outer edge of the sector.
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Figure 10.7: Crevice Formation

The volume of the crevice is equal to the volume of the dome bodies or the clearance volume deleted
during decomposition.

• Piston-Outer: Body created at the outer edge of the sector. It includes the crevice.
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• Chamber-Outer-Bottom: Its height is equal to (Mesh Size/3).This body will have layered mesh.

• Chamber-Inner-Bottom: Its height is equal to (Mesh Size/3).This body will have layered mesh.
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• Piston-Inflation: This body is created for prism layers.

• Piston-Inner: The radius of this body is equal to 0.4 times the cylinder radius.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.360

Combustion Simulation: Preparing the Geometry in IC Engine



• Chamber-Outer-Top: This body is created for prism layers only when there is enough space.

• Chamber-Inner-Top: This body is created for prism layers only when there is enough space.
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10.3. Geometry Decomposition for Full Engine Full Cycle

When Full Engine Full Cycle option is chosen from the Combustion Simulation Type drop-down list
the decomposition and meshing process is same as for a cold flow simulation. The injection inputs
taken are similar to the Sector Decomposition Type.

For Spray Location Option one more choice is available — Beam Origin, Footprint. For  this option
you have to select two or more points. These points should be defined before invoking the InputMan-
ager.
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• Injection Beam Origin: It is assumed that all the spay beams start at one point. This is the Injec-
tion Beam Origin. This is the single point from which multiple injections points are assumed to
start. It is required for the projection of the Footprint Points on the chamber body.

• Footprint Points: These points are the footprints of spray on any plane. It is required to define
spray axis. If Injection Beam Origin point is outside the domain, multiple injection points are
projected on cylinder head along the direction of footprint points. If the Injection Beam Origin
point is inside the chamber then it will be taken as the spray location without projection.

The Footprint Points have to be created relative to the Injection Beam Origin point. You have
to create a coordinate system while importing a footprint file. You can use a local plane or a
global plane to import Footprint Points.

From these points the spray location and direction will be transferred to further components.

The term, No. of Holes per Injection Row is added for Full Engine Full Cycle and Full Engine IVC
to EVO in the Input Manager.
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Since it is expected for a sector to have only one injection per injection row this term is not present
for Sector Combustion Simulation. This term decides the number of injections in a row and is used
to find the periodic angle. Periodic angle is the angle between two consecutive injections in the same
row.

For more information about the other terms in Input Manager see Cold Flow Simulation: Preparing
the Geometry (p. 149). For terms related to injection see Geometry Decomposition for Sector Combustion
Simulation (p. 343). For information related to meshing see Cold Flow Simulation: Meshing (p. 185).

10.4. Geometry Decomposition for Full Engine IVC to EVO

When Full Engine IVC to EVO option is chosen from the Combustion Simulation Type drop-down
list the decomposition process is similar to that for a cold flow simulation. The only difference is that
valve and port regions are removed. So only the chamber portion of the geometry remains. For more
information see the Chamber (p. 179) section in the Cold Flow Simulation: Preparing the Geometry (p. 149)
chapter.

The injection inputs taken are similar to the Full Engine Full Cycle Decomposition Type, see Geometry
Decomposition for Full Engine Full Cycle (p. 362). For more information about the other terms in Input
Manager see Cold Flow Simulation: Preparing the Geometry (p. 149). For terms related to injection see
Geometry Decomposition for Sector Combustion Simulation (p. 343). For information related to meshing
see Cold Flow Simulation: Meshing (p. 185).
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Chapter 11: Combustion Simulation: Meshing in IC
Engine
The decomposed geometry is used to generate the mesh. The goal of the IC Engine meshing tool is to
minimize the effort required to generate a mesh for the IC Engine specific solver. It uses the named
selection created in the decomposition to identify different zones and creates the required mesh controls.
Since you can choose different types for combustion simulation the meshing process for each type also
differs.

• This chapter explains the meshing process when Sector is chosen from the Combustion Simu-
lation Type (p. 143) drop-down list.

• When Full Engine Full Cycle is chosen from the Combustion Simulation Type (p. 143) drop-
down list, the decomposition (p. 149) and meshing (p. 185) process is the same as for cold flow
simulation.

• When Full Engine IVC to EVO is chosen from the Combustion Simulation Type (p. 143) drop-
down list, the decomposition is similar as for cold flow simulation. The valve and port regions
are removed. Only the chamber portion of the geometry is retained. Meshing process therefore
has slight differences from the cold flow meshing process. The differences will be explained in
Meshing for Full Engine IVC to EVO Combustion Simulation (p. 389) section.

The information in this chapter is divided into the following sections:

11.1. Meshing Procedure for Sector Combustion Simulation

11.2. Global Mesh Settings for Sector Combustion Simulation

11.3. Local Mesh Settings for Sector Combustion Simulation

11.4. Meshing for Full Engine Full Cycle Combustion Simulation

11.5. Meshing for Full Engine IVC to EVO Combustion Simulation

11.1. Meshing Procedure for Sector Combustion Simulation

There are two ways to generate the mesh.

Meshing directly from the Workbench Window

After decomposition is done you can then directly generate the mesh from the Workbench window
without opening the Ansys Meshing application. If you want to use the default mesh settings then
right-click on the Mesh cell and select Update from the context menu. This will first create the mesh
controls and then generate the mesh.

You can also change the mesh settings from the Workbench window.
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In the Properties box which is displayed after selecting the Mesh cell you can click on Edit Mesh Set-
tings next to the Mesh Settings property, under IC Engine. This will open a ICEngine Mesh Settings
dialog box.

You can change the settings for the parameters:

• Mesh Type

• Reference Mesh Size (mm) (This can be parametrized by enabling the check box next to it.)

• Number of Inflation Layers

For more information on these check the section on IC Mesh Parameters (p. 187).
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Meshing using Ansys Meshing Application

In this method of meshing you can check the mesh controls and settings in details.

1. Double-click the Mesh cell in the IC Engine analysis system to open the Ansys Meshing applic-
ation.

2. Click  IC Setup Mesh (  located in the IC Engine toolbar). This opens the IC Sector Mesh
Parameters dialog box.

a. Here you can define different mesh settings for the different parts and virtual topologies.
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In the IC Sector Mesh Parameters dialog box you can see the default mesh settings. You
can change the settings or use the default ones.

• Mesh Type: You can select Coarse or Fine from the drop-down list.

• Reference Size: This is a reference value. Some global mesh settings and local mesh
setting values are dependent on this term. The value changes depending upon the selec-
tion of the Mesh Type.

Reference Size = (Valve margin perimeter) /100

• Min Mesh Size: This value is set to Reference Size/5.

• Max Mesh Size: This value is set equal to the Reference Size/2.

• Chamber Body Mesh Size: This value is set to the 0.633 mm by default.

• Inflation Behavior: It is set to Yes by default.

• No. of Inflation Layers: This value is set to 3 by default.

Note:

If Reference Size is changed, all the other parameters will change, depending
on their relation with it.

b. If after changing the values of the parameters you would like to go back to the default
values, click Reset.

c. Click OK to set and close the IC Sector Mesh Parameters dialog box.
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You can generate the mesh controls before opening Ansys Meshing application. To do this
enable Automatically Setup On Edit under IC Engine in the Properties box which is displayed
after selecting the Mesh cell in the Workbench window.

So after you double-click the Mesh cell to open Ansys Meshing application the mesh controls
are already set.

3. Click IC Generate Mesh (  located in the IC Engine toolbar) to generate the mesh.
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When you complete the setup through IC Setup Mesh, it does the following:

• It creates virtual topologies for the Piston-Inner body.

• It makes the required changes in Global Mesh Settings.

• It creates Local Mesh Settings.

11.2. Global Mesh Settings for Sector Combustion Simulation

IC Engine meshing tool creates Global Mesh Settings based on the information provided in the IC
Sector Mesh Parameters (p. 367) dialog box. Following sections describe these settings:

Defaults Group

Under Details of Mesh, the following are the global mesh settings defined under Defaults.
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• Physics Preference: This is set to CFD.

This option allows you to establish how Workbench will perform meshing based on the physics
of the analysis type that you specify.

• Solver Preference: Ansys Fluent is set as the solver for the simulation.

Since CFD is chosen as your Physics Preference, it causes a Solver Preference option to appear
in the Details View of the Mesh folder. The chosen value sets certain defaults that will result in
a mesh that is more favorable to the respective solver.

• Element Order: This is set to Linear. This option allows you to control whether meshes are to
be created with midside nodes (quadratic elements) or without midside nodes (linear elements).
Reducing the number of midside nodes reduces the number of degrees of freedom. Choices in-
clude Program Controlled, Linear, and Quadratic.

• Element Size: This allows you to specify the element size used for the entire model. This size
will be used for all edge, face, and body meshing.

• Export Format: This option defines the format for the mesh when exported to Ansys Fluent.
The default is Standard. You can change this to Large Model Support to export the mesh as
a cell-based Fluent mesh.

• Export Preview Surface Mesh : This option controls the export of the preview surface mesh
elements. This option can be used when the bodies have been meshed only partially, that is,
not all volumes have been filled with elements and only previewing of surface meshes was done.
The default is No, which results in export of only volume mesh elements to the Fluent mesh file.
You can change this to Yes to export both the volume mesh and the preview surface meshes
to the Fluent mesh file.

Sizing Group

Under the Details of Mesh, the following are the global mesh settings defined under Sizing.
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• Use Adaptive Sizing: This option refers to a 2D curvature and proximity-based refinement ap-
proach which refines edges based on curvature and/or proximity but does not propagate the
refined mesh along the face. When set to Yes, the mesher uses the value of the element size
property to determine a starting point for the mesh size. The value of the element size property
can be set by the user or automatically computed using defaults. When meshing begins, edges
are meshed with this size initially, and then they are refined for curvature and 2D proximity.
Next, mesh based defeaturing and pinch control execution occurs. The final edge mesh is then
passed into a least-squares fit size function, which guides face and volume meshing.

• Growth Rate: It is equal to default value of 1.20.

• Max Size: It is equal to the value of Max Mesh Size, which is set in the IC Sector Mesh Para-
meters (p. 187) dialog box.

• Mesh Defeaturing: This option automatically defeatures small features and dirty geometry ac-
cording to the Defeature Size you specify here.

• Transition: When Use Adaptive Sizing is set to Yes, this option affects the rate at which adjacent
elements will grow. Slow produces smooth transitions while Fast produces more abrupt trans-
itions.

• Span Angle Center: It is set to Fine.

When Use Adaptive Sizing is set to Yes, this option sets the goal for curvature based refinement.
The mesh will subdivide in curved regions until the individual elements span this angle. The
following choices are available:

– Coarse — 91o to 60o

– Medium — 75o to 24o
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– Fine — 36o to 12o

• Initial Size Seed: When Use Adaptive Sizing is set to Yes, this option allows you to control the
initial seeding of the mesh size for each part.

• Bounding Box Diagonal: This option provides a read-only indication of the length of the assembly
diagonal.

• Average Surface Area: This option provides a read-only indication of the average surface area
of the model.

• Minimum Edge Length: This option provides a read-only indication of the smallest edge length
in the model.

• Capture Curvature: This option allows you to take into account curvature effects.

• Curvature Min Size: When Capture Curvature is set to Yes, this option is equal to the value of
Min Mesh Size, which is set in the IC Sector Mesh Parameters (p. 187) dialog box.

• Curvature Normal Angle: When Capture Curvature is set to Yes, this option is set to the value
of the Normal Angle.

• Capture Proximity: This option allows you to account for proximity effects.

• Proximity Min Size: When Capture Proximity is set to Yes, this option allows you to specify a
global minimum size to be used in proximity sizing calculations.

• Num Cells Across Gap: When Capture Proximity is set to Yes, this option is the minimum
number of layers of elements to be generated in the gaps. You can specify a value from 1 to
100, or accept the default (3).

• Proximity Size Function Sources: When Capture Proximity is set to Yes, this option determines
whether regions of proximity between faces and/or edges are considered when proximity size
function calculations are performed. You can specify Edges, Faces, or Faces and Edges.

Quality Group

Quality is useful for configuring mesh quality.
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• Check Mesh Quality: This option determines how the software behaves with respect to error
and warning limits

• Target Skewness: This option allows you to set a target skewness that you would like the mesh
to satisfy.

• Smoothing: This option attempts to improve element quality by moving locations of nodes with
respect to surrounding nodes and elements. The Low, Medium, or High option controls the
number of smoothing iterations along with the threshold metric where the mesher will start
smoothing.

• Mesh Metric: This option allows you to view mesh metric information and thereby evaluate the
mesh quality.

When you select a mesh metric, its Min, Max, Average, and Standard Deviation values are re-
ported in the Details View, and a bar graph is displayed under the Geometry window. The graph
is labeled with color-coded bars for each element shape represented in the model's mesh, and
can be manipulated to view specific mesh statistics of interest.

Inflation Group

Inflation is useful for CFD boundary layer resolution.
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• Use Automatic Inflation: It is set to None for Combustion Simulation.

• Inflation Option: It is set to Total Thickness.

– Number of Layers: It is set to 3 which is equal to the No. of Inflation Layers set in the
IC Sector Mesh Parameters dialog box.

– Growth Rate: This value is set to 1.2.

– Growth Rate: This value is approximately equal to the Min Mesh Size.

• Inflation Algorithm is set to Pre.

• View Advanced Options: This control determines whether advanced inflation options appear
in the Details View. Choices are No and Yes. It is set to No for Combustion Simulation.

Assembly Meshing

Method  is set to None.

Advanced Group

The Advanced group allows you to use the following features and controls:

Pinch Tolerance

• Number of CPUs for Parallel Part Meshing: This option sets the number of processors to be used
for parallel part meshing. Using the default for specifying multiple processors will enhance meshing
performance on geometries with multiple parts. For parallel part meshing, the default is set to Program
Controlled or 0. This instructs the mesher to use all available CPU cores. The default setting inherently
limits 2 GB memory per CPU core. An explicit value can be specified between 0 and 256, where 0 is
the default.
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• Straight Sided Elements: This option specifies meshing to straight edge elements when set to Yes.
This option may affect the placement of midside nodes if the Element Order option is set to Quad-
ratic.

• Rigid Body Behavior: This option determines whether a full mesh is generated for a rigid body,
rather than a surface contact mesh. Rigid Body Behavior is applicable to all body types. Valid values
for Rigid Body Behavior are Dimensionally Reduced (generate surface contact mesh only) and Full
Mesh (generate full mesh).

• Triangle Surface Mesher: This option determines which triangle surface meshing strategy will be
used by patch conforming meshers. In general, the advancing front algorithm provides a smoother
size variation and better results for skewness and orthogonal quality. This option is inaccessible when
an assembly meshing algorithm is selected.

• Topology Checking: This option controls what happens when a user scopes an object (such as loads,
boundary conditions, named selections and so on) to geometry (bodies, faces, edges, and vertices)
after the mesh has been generated. If Topology Checking is set to Yes (default), the software will
check to see if the scoped geometry has mesh properly associated to it. If the associations are incorrect,
the scoping of the object will force the mesh to be out of date. The mesh would need to be re-gen-
erated to get proper associations. If the associations are correct, the scoping is performed without
any change to the mesh and the mesh stays up to date. Set Topology Checking to No to avoid the
checks and always keep the mesh up to date.

• Pinch Tolerance: This is set to the default value.

This control allows you to specify a tolerance for the Meshing application to use when it generates
automatic pinch controls.

• Generate Pinch on Refresh: This option determines whether pinch controls will be regenerated fol-
lowing a change made to the geometry (such as a change made via a DesignModeler application
operation such as a merge, connect, etc.). If Generate Pinch on Refresh is set to Yes and you change
the geometry, all pinch controls that were created automatically will be deleted and recreated based
on the new geometry. If Generate Pinch on Refresh is set to No and you update the geometry, all
pinch controls related to the changed part will appear in the Tree Outline but will be flagged as un-
defined.

11.3. Local Mesh Settings for Sector Combustion Simulation

Based on information provided in the IC Sector Mesh Parameters dialog box, IC Engine meshing tool
creates some mesh settings at local level. Following section describes these settings for combustion
simulation:

11.3.1. Sweep Method (Piston-Outer)

11.3.2. Sweep Method (Chamber-Bottom)

11.3.3. Sweep Method (Piston-Inner)

For more information on Local Mesh Settings, see Local Mesh Controls in the Meshing User's Guide.
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11.3.1. Sweep Method (Piston-Outer)

When you click Sweep Method (Piston-Outer) under Mesh in the Outline, you can see the details.
In this method, a swept mesh is forced on the “sweepable” bodies.

• Geometry: It shows the selected body.

• Manual Source is chosen from the Src/Trg Selection drop-down list.

• Source: It is the face selected as shown in the figure.

• Target: It is Program Controlled. This means that the program determines the target for the
body.
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• Free Face Mesh Type: It is set to Quad/Tri. This determines the shape of the elements used
to fill the swept body.

• Sweep Bias Type: It adjusts the spacing ratio of nodes on the edge. No Bias is chosen from
the drop-down list.

11.3.2. Sweep Method (Chamber-Bottom)

When you click Sweep Method (Chamber-Bottom) under Mesh in the Outline, you can see the
details. Settings are almost similar to Piston-Outer.

11.3.3. Sweep Method (Piston-Inner)

When you click Sweep Method (Piston-Inner) under Mesh in the Outline, you can see the details.
Settings are same as for Piston-Outer.
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11.3.3.1. Sweep Method (Piston-Inflation)

When you click Sweep Method (Piston-Inflation) under Mesh in the Outline, you can see the
details. Settings are same as for Piston-Outer.

11.3.3.2. Sweep Method (Chamber-Top)

When you click Sweep Method (Chamber-Top) under Mesh in the Outline, you can see the details.
In this method, a swept mesh is forced on the “sweepable” bodies.
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• Geometry: It shows the selected bodies.

• Manual Source is chosen from the Src/Trg Selection drop-down list.

• Source: The faces selected are as shown in the figure.
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• Target: It is Program Controlled. This means that the program determines the target for
the body.

• Free Face Mesh Type: It is set to Quad/Tri. This determines the shape of the elements used
to fill the swept body.

• Sweep Bias Type: It adjusts the spacing ratio of nodes on the edge. No Bias is chosen from
the drop-down list.

11.3.3.3. Face Sizing(Src-PistonOuter)

When you click Face Sizing (Src-PistonOuter) under Mesh in the Outline, you can see the details.

• Geometry: This shows the selected face.

• Type: It is set to Element Size.

• Element Size: This is approximately equal to Chamber Body Mesh Size as set in the IC
Sector Mesh Parameters dialog box.

• Behavior: For this body part it is set to Soft.

11.3.3.4. Face Sizing(Src-PistonInflation)

When you click Face Sizing (Src-PistonInflation) under Mesh in the Outline, you can see the details.

• Geometry: This shows the selected face.
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• Type: It is set to Element Size.

• Element Size: This is approximately equal to Max Mesh Size as set in the IC Sector Mesh
Parameters dialog box.

• Behavior: For this body part it is set to Hard.

11.3.3.5. Edge Sizing(Piston-Outer)

When you click Edge Sizing (Piston-Outer) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of selected edges.

• Type: It is set to Element Size.

• Element Size: This is approximately equal to crevice thickness/3.

• Behavior: For this body part it is set to Hard.
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11.3.3.6. Edge Sizing(Srcedges-PistonInflation)

When you click Edge Sizing (Piston-Outer) under Mesh in the Outline, you can see the details.

• Geometry: This shows the number of selected edges.

• Type: It is set to Element Size.

• Element Size: This is approximately equal to crevice thickness/3.

• Behavior: For this body part it is set to Hard.

11.3.3.7. Inflation(Piston-Outer)

When you click Inflation (Piston-Outer) under Mesh in the Outline, you can see the details.
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• Geometry: This shows the selected face.

• Boundary: This shows the selected edges.

• Inflation Option: it is set to Total Thickness.

11.3.3.8. Edge Sizing(SrcEdges-Chamber)

When you click Edge Sizing(SrcEdges-Chamber) under Mesh in the Outline, you can see the details.
Settings are same as for SrceEdges-PistonInflation.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.384

Combustion Simulation: Meshing in IC Engine



11.3.3.9. Edge Sizing(PistonInflationOuter)

When you click Edge Sizing(PistonInflationOuter) under Mesh in the Outline, you can see the
details. Settings are same as for SrcEdges-PistonInflation.
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11.4. Meshing for Full Engine Full Cycle Combustion Simulation

The meshing process for Full Engine Full Cycle combustion simulation is almost similar to the cold
flow meshing process. Since combustion can involve spark, some additional spark refinement options
are present in meshing.

When Spark Points are selected in the Input Manager then the following spark related options will
be additionally visible in the IC Mesh Parameters dialog box.

• Local Refinement Around Spark: You can select Yes or No from the drop-down list. The default
selection will be Yes only if the crank angle is between IVC and (TDC+10). Spark refinement for
the mesh will only be done if Yes is selected for Local Refinement Around Spark.
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Figure 11.1: Local Refinement Around Spark
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Figure 11.2: Closer Look at Spark Refinement

• Refinement Radius: By default this value is set to 3.3 X Reference Size.

The following mesh control will be defined under Mesh in the tree.

The Element Size is set equal to Reference Size/5.

For details about the mesh settings see the sections about mesh settings in Cold Flow Simulation:
Meshing (p. 185) chapter.
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11.5. Meshing for Full Engine IVC to EVO Combustion Simulation

The meshing process for Full Engine IVC to EVO combustion simulation is almost similar to the cold
flow meshing process. Since only the chamber part needs to be meshed the mesh settings are slightly
different.

• Mesh Type: You can select Fine, Medium, or Coarse from the drop-down list. By default it is
set to Medium.

• Reference Size: This is a reference value. Some global mesh settings and local mesh setting
values are dependent on this term.

Reference Size = (Valve margin perimeter) /100

Note:

Choosing Fine, Medium, or Coarse changes the Reference Size and thus all other
dependent parameters are also affected.
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• Min Mesh Size: This value is set to Reference Size/3.

• Max Mesh Size: This value is set to Reference Size × 3.

• Normal Angle: This value changes depending upon the chosen Mesh Type.

• Growth Rate: This value is set to 1.2.

• Create Automatic Pinch Controls: This is set to No by default.

• Pinch Tolerance: Automatic pinch controls are not created by default. If you would like to create
pinch control select Yes from the Create Automatic Pinch Controls drop-down list. You can
change the default value of 0.1.

• Chamber-V_Layer Interface Size: This value is set to Reference Size/2.

• Chamber Size: This value is set to Reference Size.

• Chamber Growth Rate: This value is set to 1.15.

• Inflation in Chamber: This is set to No by default. If you select Yes —

– For canted valve case, inflation will be created on liner, dome, valve bottom, and vlayer-
ch interface.

– For straight valve case inflation will be created on liner.
A new inflation control for ch faces is created.

• Local Refinement Around Spark:The default selection will be Yes only if the crank angle is
between IVC and (TDC+10). You can select Yes or No from the drop-down list. Spark refinement
for the mesh will only be done if Yes is selected for Local Refinement Around Spark. When
Spark Points are selected in the Input Manager then the spark related options will be additionally
visible in the IC Mesh Parameters dialog box.

• Refinement Radius: By default this value is set to 3.3 X Reference Size. You can edit this value.
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For details about the mesh settings see the sections about chamber meshing (p. 209) in Cold Flow
Simulation: Meshing (p. 185) chapter.
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Chapter 12: Combustion Simulation: Setting Up the
Analysis in IC Engine
This chapter describes how to configure the analysis for a combustion sector simulation. The boundary
conditions and solver parameters are set as per the Decomposition Crank Angle set in the Input
Manager. All the settings described in this chapter are done automatically, but you can change them
by accessing the dialog boxes and task pages.

Note:

The piston should be at TDC while decomposing even though you want to start the simulation
from an angle other than zero.

After meshing you can set up the solver. In the Properties pane of the ICE Solver Setup cell you can
make changes to the solver settings or set the keygrid crank angles.

Click Edit Solver Settings to open the Solver Settings dialog box where you can check the default
settings and change any if required.

12.1. ICE Solver Settings

12.2. Solver Default Settings

12.1. ICE Solver Settings

Click Edit Solver Settings to open the Solver Settings dialog box.
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12.1.1. Basic Settings

12.1.2. Physics Settings

12.1.3. Boundary Conditions

12.1.4. Monitor Definitions

12.1.5. Initialization

12.1.6. Solution Control

12.1.7. Postprocessing
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12.1.1. Basic Settings

In the Basic Settings tab you have the following settings:

Solution Type

shows the Solution Type you have selected in the Properties pane of the ICE cell. For the
present case it is Combustion. You cannot make any changes here.

Combustion Simulation Type

shows the type of combustion simulation you have selected. You cannot make any changes
here.
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Initialize Flow

is set to Yes  by default. This will initialize the flow. To check the initialization settings see
the Solution Initialization  (p. 454) task page in Ansys Fluent.

Set Default Models

is set to Yes  by default. Some models of Ansys Fluent have been chosen as default for better
results. These are the Energy model, and the Standard k-epsilon model from the list of
Viscous models with Standard Wall Functions. You can check them at the Models  (p. 438)
task page of Ansys Fluent. Additional models will be selected on the basis of further selection
of options.

Data Sampling

is set to Yes  by default. This enables Data Sampling for Time Statistics in the Run Calcu-
lation task page of Ansys Fluent. It will enable the sampling of data during the unsteady
calculation. See the Run Calculation  (p. 455) task page of Ansys Fluent.

Auto Save Type

is set to Crank Angle by default. This means that the intermediate case and data files will
be saved at the entered frequency crank angles. You can also select Time from the drop-
down menu if you want to save the case and data files at a specific frequency of time steps.

Auto Save Frequency

shows the number of crank angles or time steps, after which the case and data file will be
saved in Ansys Fluent. Here the default value is 30.

Engine Speed

It is set to a default value of 1800rpm. The engine speed is used along with the crank angle
step size to calculate the time step size. You can enter the speed of your engine here. You
can enable the check box next to it to parameterize it.

Number of CA to run

is set to 720 by default. This corresponds to a full cycle. You can enter the number of crank
angles you want to run the simulation

ICE Swirl Number

is used to patch the velocities in the chamber when you start the simulation at angles other
than TDC. Here the default value is 1.3. The following equations show how the swirl number
is calculated.

 =  x 

where

 = velocity

 = radial distance
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Read Profile File

allows you to read multiple profile files. Clicking on Read Profile File opens Browse profile
file dialog box. In the browsing window three types of file extensions will be supported
.prof (profile file), .ttab (transient table), and .csv. All Files option is also present if you
have a file extension which does not match with either of the given extensions. In this case
the file type will be automatically identified, and an error will be thrown if the format is not
supported.

If you select a .csv file and click Open, then a Read CSV File dialog box opens.
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• You need to enter a name for Profile Name. This name will appear in the drop-down
list of Profiles in the Profile Editor dialog box.

• If you retain the default setting of Yes for Read CSV Titles then the quantity or variable
names will be as per the names in the CSV file.

• If you choose No for Read CSV Titles then you have to specify the No. of Columns
of the CSV file you want to read. For each column you have to select a different variable
name from the drop-down list. In this case the titles of the CSV columns will not be
read. Your selections for the columns will be the titles.

Important:

– All the columns in CSV should have same number of values. Variable
number of values and interpolation is not supported in the current
version.

– Ensure that there are no empty spaces in the titles.

The format of the standard profile file is

 ((profile-name transient n periodic?)
 (field_name-1 a1 a2 a3 .... an)
 (field_name-2 b1 b2 b3 .... bn)
 .
 .
 .
 .
 (field_name-r r1 r2 r3 .... rn)) 
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The profile name as well as the field names have to be shorter than 64 characters.
One of the field_name should be used for the time field, and the time field section
must be in ascending order. n is the number of entries per field. The periodic?
entry indicates whether or not the profile is time-periodic. Set it to 1 for a time-peri-
odic profile, or 0 if the profile is not time-periodic.

An example is shown below:

((sampleprofile transient 8 0 0)
(angle
4.400000e+02 4.412000e+02
4.644900e+02 4.656900e+02
6.400000e+02
6.412000e+02 6.480800e+02 6.492800e+02)
(mass-flow
0.000000e+00 2.450040e-03 2.450040e-03 0.000000e+00 0.000000e+00
2.475870e-03 2.475870e-03 0.000000e+00)
(velocity
0.000000e+00 1.941520e+02 1.941520e+02 0.000000e+00 0.000000e+00
1.922430e+02 1.922430e+02 0.000000e+00)
)

Important:

All quantities, including coordinate values, must be specified in SI units
because Ansys Fluent does not perform unit conversion when reading
profile files. Also, profile names must have all lowercase letters (for example,
name). Uppercase letters in profile names are not acceptable.

The format of the transient table file is

 profile-name n_field n_data periodic?
 field-name-1 field-name-2 field-name-3 .... field-name-n_field 
 v-1-1  v-2-1... ... ... ... v-n_field-1 
 v-1-2  v-2-2... ... ... ... v-n_field-2
 .
 .
 .
 .
 .
 v-1-n_data v-2-n_data ... ... ... ... v-n_field-n_data 

The first field name (for example field-name-1) should be used for the time field, and
the time field section, which represents the flow time, must be in ascending order. The
periodic? entry indicates whether or not the profile is time-periodic. Set it to 1 for a time-
periodic profile, or 0 if the profile is not time-periodic.

An example is shown below:

sampletprofile 3 8 0
angle        mass-flow    velocity
440          0.0          0.0
441.2        0.00245004   194.152
464.49       0.00245004   194.152
465.69       0.0          0.0
640          0.0          0.0
641.2        0.00247587   192.243
648.08       0.00247587   192.243
649.28       0.0           0.0
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This file defines the same transient profile as the standard profile example above.

Important:

All quantities, including coordinate values, must be specified in SI units because
Ansys Fluent does not perform unit conversion when reading profile files. Also,
profile names must have all lowercase letters (for example, name). Uppercase letters
in profile names are not acceptable. When choosing the field names, spaces or
parentheses should not be included.

Note:

The independent variable or field-name–1 for all the types of profile files should
be either angle or x or y or z coordinate.

After reading the files the profiles will be available in the boundary condition drop-down
lists.

Profile Editor

allows you to view the plot of the profiles.
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• Select a profile from the drop-down list of Profiles. The TIMESTEP profile is added to the
list by default.

• When a particular profile is selected all corresponding variables will be displayed in the X
Axis and Y Axis drop-down lists.

• Select the variable for X Axis and Y Axis and click Plot. The plot will be displayed in the
area of Profile Chart.

• You can select the type of chart to be displayed from the Chart Style drop-down list.
Options of Spline, Step and Line are provided.

• You can also read a profile by clicking on Read File.

• The read profile which is presently selected can be deleted from the list by clicking on
Remove Profile.
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• You can make changes to the values in the profile table displayed. Click Plot to view the
Profile Chart with the changed values. You can save the profile with the edited values by
clicking on Save.

• To manipulate the chart:

Table 12.1: Chart Manipulation

Operation

ZoomRotate Middle Mouse

ZoomShift + Middle Mouse

PanCtrl + Middle Mouse

Box ZoomDrag Right Mouse

Fit to WindowF key

12.1.2. Physics Settings

The Physics Settings tab is present only for combustion simulation.
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Combustion Model

Engine Type

If you select  Full Engine Full Cycle  (p. 143) from the Combustion Simulation Type in the
Properties pane of ICE cell, then you can select the Engine Type as CI Engine or SI Engine.
Else, if you select Sector or Full Engine IVC to EVO the Engine Type selected by default is
CI Engine.

Species Model

Depending upon the selection of the Engine Type the choice for Species Model changes.
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• Laminar Finite Rate option is present for CI Engine as well as for SI Engine. For more
information about this model see The Laminar Finite-Rate Model in the Fluent Theory
Guide.

• Diesel Unsteady Flamelet option is present only for CI Engine. For more information
about this model see Using the Diesel Unsteady Laminar Flamelet Model in the Fluent
User’s Guide.

• Partially Premixed option is present only for SI Engine. For more information about
this model see the chapter on Modeling Partially Premixed Combustion in the Fluent
User’s Guide. Details are also present in the chapter Partially Premixed Combustion
in the Fluent Theory Guide.

Depending upon your selection of the Engine Type and Species Model, the tabs activated in the
lower half of the Physics Settings tab differ.

Chemistry

In the Chemistry tab you can set the Mixture Properties.

Material Input

For Laminar Finite Rate you can choose Fluent or Chemkin\Thermal Data File from the
drop-down list. Else the default selection is Chemkin\Thermal Data File which you cannot
modify.

Mixture Material

If you choose Fluent then a few mixture materials that have been chosen from the Fluent
materials database will be available to choose from in the Mixture Material drop-down list.

Chemkin File

This allows you to read a chemkin file in which you can provide your own mixture material.
This option is available when you choose Chemkin File from the Material Input drop-down
list. Click Browse to read the file.

Thermal Data File

This allows you to read a thermodynamic data file. This option is available when you choose
Chemkin File from the Material Input drop-down list or when the Species Model is set to
Partially Premixed. By default the Thermal Data File from the Fluent installation is
chosen. Click Browse to change the file name.

Depending upon the choices you have made for the Mixture Properties, the list in the Initialization
tab changes.

Boundary

In this tab you can set the chemical boundary species in consideration. This tab is activated only for
the following combinations:
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• Selection of CI Engine from Engine Type drop-down list and selection of Diesel Unsteady
Flamelet  from the Species Model drop-down list.

• Selection of SI Engine from Engine Type drop-down list and selection of Partial Premixed
from the Species Model drop-down list.

Depending upon your selections in the Chemistry tab the species will be displayed in the Boundary
tab. If you have chosen Fluent then the species of the selected Mixture Material will be displayed
along with their set Fuel and Oxid values. For a Chemkin file you will have to set the values.

Premix

The Premix tab is activated when you select Partial Premixed from the Species Model drop-down
list for SI Engine.
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Premixed Model

You can select C Equation or G Equation in the Premixed Model group box.

Flame Speed Model

In the Flame Speed Model group box you can choose the turbulent flame speed model.
Depending upon the choice the further options change.

Flame Speed Model

choose from Peters or Zimont  from the drop-down list.
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Ewald Corrector

is set to Yes by default and described in Peters Flame Speed Model in the Fluent Theory
Guide. This option is present only when Peters is selected form the Flame Speed Model
drop-down list.

Blind Modifier

is set to No by default. This term is present only for Peters Flame Speed Model.

Flame Curvature

is set to No by default. If it is set to Yes only then the curvature source term in the G-
Equation is included. For details check G-Equation Model Theory in Fluent Theory Guide.
This term is present only for Peters Flame Speed Model.

Turbulent Length Scale Constant

value is set to 0.37 by default. This term is present only for Zimont Flame Speed Model.

Turbulent Flame Speed Constant

value is set to 0.52 by default. This term is present only for Zimont Flame Speed Model.

Stretch Factor Coefficient

value is set to 0.26 by default. This term is present only for Zimont Flame Speed Model.

Wall Damping Coefficient

value is set to 1  by default.

Turbulent Schmidt Number

value is set to 0.7 by default.

Injection

In the Injection tab you can see that an injection has been setup. Select injection-0 and click Edit
to check the injection properties and settings. For more details on the injection settings check the
Set Injection Properties (p. 441) dialog box in Ansys Fluent.
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Material

indicates the material for the particles. You can choose from the drop-down menu. If this is
the first time you select a particle of this type, you can choose from all of the materials by
copying them from the database or creating them from scratch. diesel-liquid is the material
chosen by default.
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Diameter Distribution

allows you to change from uniform method used to determine the size of the particles in a
surface injection, to the rosin-rammler method.

X, Y, and Z Position

indicates the x, y and z position of the injection source/nozzle tip.

X, Y, and Z Axes

indicates the x, y and z components of the vector defining the cone’s axis.

Evaporating Species

(for droplet particles) specifies the gas-phase species created by the vaporization and boiling
laws.

Temperature

indicates the initial (absolute) temperature of the injected particle stream.

Start CA

indicates the crank angle at which the injection will start.

End CA

indicates the crank angle at which the injection will stop.

Cone Angle

indicates half of the spray cone angle.

Cone Radius

indicates a non-zero inner radius to model injectors that do not emanate from a single point.
The particles will be distributed about the axis with the specified radius.

Total Flow Rate

is the total mass flow rate of all the streams in the group.

Velocity Magnitude

is the velocity magnitude of the particle streams that will be oriented along the specified
spray cone.

Min. Diameter

is the smallest diameter to be considered in the size distribution.

Max. Diameter

is the largest diameter to be considered in the size distribution.
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Mean Diameter

is the size parameter in the Rosin-Rammler equation.

Spread Parameter

This is the exponential parameter, n, in the Rosin-Rammler equation.

Number of Diameter

indicates the number of diameters in each distribution (that is, the number of different dia-
meters in the stream injected from each face of the surface).

If you have read a profile before then you can select the profile from the drop-down list while setting
some of the variables like Cone Angle, Total Flow Rate, and Velocity Magnitude. You can also select
PROFILE EDITOR option which will open the Profile Editor dialog box where you can check the plot
of the profile or read a new profile.

Default injection is defined based on the geometry information provided in the DesignModeler. For
creating additional injections for the simulation use the Create or Copy options. Use Edit to change
the properties of the injection.

Note:

If you need to edit multiple injections, you can select them all in the tab and click Edit.
This will open up the Injection Properties dialog box which will allow you to edit the
properties of all the selected injections at once. Other than the position of the injections
all other properties can be edited together.

Flamelet

For the Diesel Unsteady Flamelet species model you will set the flamelet parameters in the Flamelet
tab.

• One flamelet is set by default. You can set the Number of Unsteady Flamelets that will be
generated during simulation.
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• Ansys Fluent automatically sets the start time for the first flamelet, but you must set the start
time for each consecutive flamelet using the Unsteady Flamelet Parameters dialog box. Open
it by clicking Set Flamelet Parameter and enter the start time for each flamelet in crank
angles.

Ansys Fluent starts simulation with only one flamelet, and then it automatically introduces
new flamelets into the reacting domain at the times you have specified.

Whenever injection is added/edited/deleted flamelet parameters will change. Flamelet will be
created for each injection start angle (non repeating start crank angles when there are multiple
injections).

• Specify the flamelet fluid zones. Ansys Fluent calculates diesel unsteady flamelets using the
zone-averaged pressure and scalar dissipation at every time step. By default, the averaging is
performed over all fluid zones in the domain, but you can also select and/or deselect the fluid
zones using the Set Flamelet Zones dialog box. Open this dialog box by clicking Set Flamelet
Fluid Zone and select the fluid zones to be used for calculating average pressure and scalar
dissipation.

If no fluid zone is selected, Ansys Fluent will compute domain average pressure and scalar
dissipation using all fluid zones.
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Spark

This tab is present only when SI Engine is selected from the Engine Type drop-down list. It allows
you to define multiple sparks. Click Create to open the Spark Properties dialog box where you can
enter the details required for the spark.

Name

displays the name of the spark being defined.

X, Y, and Z-Center

specifies x, y, and z coordinates of the spark center. These parameters are needed to define
the location of the spark.

Initial Radius

specifies the initial spark radius. You can parameterize it by enabling the check box next to
it.

Fixed Transition Radius

is set by default to Yes. This will allow you to specify the Transition Radius.

If you select No then Ansys Fluent will compute the transition radius. For more information
see equation 13–1 and 13–2 in Spark Model Theory in the Fluent Theory Guide
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Transition Radius

is set to a value here. When the radius reaches this value, Ansys Fluent automatically switches
the spark flame speed model off, so that the flame speed is modeled using the flame speed
model that you have selected in the Premix tab. You can parameterize it by enabling the
check box next to it.

Start Crank Angle

is the time of spark ignition initialization in crank angle degrees. You can parameterize it by
enabling the check box next to it.

Duration

is used to calculate the rate of spark energy input and the time when this input ceases. You
can parameterize it by enabling the check box next to it.

Energy

contains the total energy input by the spark. The default energy value is 0. A positive value
for energy will cause the temperature of the spark kernel to rise above the combustion process
temperature. You can parameterize it by enabling the check box next to it.

Flame Speed Model

allows you to select the turbulent flame speed model for controlling the rate at which the
flame front moves.

Turbulent Curvature

includes the effect of flame curvature as specified in Turbulent Curvature in the
Fluent Theory Guide.

Turbulent Length

neglects the effects of flame curvature on the flame speed as described in Turbulent
Length in the Fluent Theory Guide.

Herweg-Maly

calculates the turbulent flame speed using Herweg-Maly model. See Herweg-Maly
in the Fluent Theory Guide.

Laminar

specifies the turbulent flame speed as the laminar flame speed.

Inert

The Inert tab is activated for Partially Premixed and Diesel Unsteady Flamelet Species Model.
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In the Inert tab you have three options to choose from the Inert Model drop-down list.

Off

Inert Model is not activated.

Fixed H/C Ratio

Select this option if the hydrogen to carbon ratio is known. For example, for methane (CH4)

enter 4 for Fixed H/C Ratio.
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Setting the H/C Ratio assumes that the burned gas resulted from the complete, stoichiometric
combustion of that hydrocarbon fuel with air, and the only products of the combustion are
CO2, H2) and N2.

User Specified

Select this option if you want to specify an arbitrary composition for the inert stream. You
can specify the mass fraction for the four species in the default list: CO2, H2O, N2, and O2.

Ensure that the sum of the mass fractions add up to 1.

You will need to set appropriate boundary conditions at flow inlets and exits for the inert tracer
mass fraction. The tracer species mass fraction must be between zero and one, with the value
of one meaning that all of the material entering the domain comes from the inert stream.
The values for flow boundaries are set in the Inert Stream field. This is under the Species
tab of the inlet or outlet boundary condition dialog box which can be accessed in the
Boundary Conditions  tab.

You will also need to initialize the Inert Variable in the Initialization tab. For details check
Initializing the Inert Stream in Fluent User’s Guide.
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You can also patch the inert mass fraction by entering an appropriate value. The Inert Variable
is available under the Variable list in the Patching Zones dialog box. For details check Inert
Fraction in Fluent User’s Guide.

Ansys Fluent allows burned gases to be converted to an inert gas. This has been designed
with in-cylinder combustion in mind to aid the simulation of multiple cycles of such engines
using the partially-premixed combustion model with exhaust gas recirculation (EGR). At the
end of a combustion stroke, the premixed progress variable of the burnt gases is unity. When
fresh charge, with progress variable of zero, is mixed with the burnt trapped gases, combustion
will be initiated unless these trapped gases are converted to inert.

This facility is accessed via the Dynamic Mesh Events. There, you will need to set the crank
angle at which the event occurs (usually shortly before the inlet valves open) and at the fluid
zones (usually the combustion chamber) where the burnt gases are converted to inert.

In Fluent in Dynamic Mesh Events an Inert EGR Reset  (p. 450) event is added. The event
is set before IVO. When multiple invalves are present then this event is set for the invalve
whose opening crank angle comes first. The Zones set for this event are the chamber zones.
For more information go to Resetting Inert EGR in Fluent User’s Guide.

Pollutant

In the Pollutant tab you can use the Nox and Soot Model for modeling Soot formation. Under the
Pollutant tab are two tabs: Nox and Soot.

Nox

Nox concentrations generated in combustion systems are generally low. As a result, chemistry
has negligible influence on the predicted flow field, temperature, and major combustion
product concentrations. It follows that the most efficient way to use the Nox model is as a
postprocessor to the main combustion calculation.
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Thermal

To enable thermal Nox select Yes from the Thermal drop-down list.

Prompt

To enable prompt Nox select Yes from the Prompt drop-down list.

• Set the Fuel Carbon Number to specify the number of carbon atoms per fuel molecule.

• Set the Equivalence Ratio as follows:

(12.1)

Number of Post Iterations

When either of Thermal or Prompt is enabled then the Number of Post Iterations is
set to 10. This will be set in the Ansys Fluent Run Calculation task page.

Soot

When the mass fraction of soot is relatively large (for example, 10%) the soot formation
should be computed as part of the main combustion solution and not through postprocessing.

Soot Model

You can enable and set up the Moss-Brookes soot formation models by selecting
Moss-Brookes from the Soot Model drop-down list.

Fuel

Select the fuel from the Fuel drop-down list. If you are using the non-premixed
model for the combustion calculation and your fuel stream consists of a mixture of
components, you should choose the most appropriate species as the Fuel species
for the soot formation model.
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Fuel Carbon Number (Soot)

After selecting Fuel species enter the related Fuel Carbon Number for use in the
mixture fraction calculation.

Fuel Hydrogen Number

After selecting Fuel species enter the related Fuel Hydrogen Number for use in the
mixture fraction calculation.

Note:

When Partially Premixed combustion model is chosen then both Soot and Nox will
be PDF mixture. If Chemkin is chosen then both Soot and Nox will be PDF temperature
beta 20 with transported variance. These settings are done internally.
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12.1.3. Boundary Conditions

In the Boundary Conditions tab you can see the boundary conditions set depending upon the type
of combustion simulation you have chosen. You can use the Create, Edit, or Copy options to change
the default settings.
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In the Create Boundary Conditions dialog box select the zone to which you like to apply the
boundary conditions to from the list under Zones. Then select Type and enter the required values
for the variables, either a constant value or a variable profile from the drop-down list. You can select
a profile in case you have read a profile before, or you can select PROFILE EDITOR option which will
open the Profile Editor dialog box where you can check the plot of the profile or read a new profile.
After you click OK you can see the zone name and the details in the Boundary Conditions tab.

For the boundary conditions, you can parameterize the quantity by enabling the check box next to
it.
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12.1.4. Monitor Definitions

In the Monitor Definitions tab you can see that several monitors have been set. Depending upon
the selection of Combustion Simulation Type the list will vary. For Full Engine Full Cycle and Full
Engine IVC to EVO most monitor types will be same as for Cold Flow Simulation. Select each
monitor and click Edit to check the details. Listed below are some default monitors for Sector type.

• vol-mon plots the Volume.
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• vol-avg-temp-mon plots the Volume Integral of Temperature.

• vol-avg-pres-mon plots the Volume Integral of Pressure.

• max-vel-mon plots the Max Velocity.

• max-temp-mon plots the Max Temperature.

• max-pres-mon plots the Max Pressure.

• mass-mon plots the Volume Integral of Density.

• mass-avg-tke-mon plots the Mass Average of Turbulent Kinetic Energy.

You can see additional details in the Monitors  (p. 453) task page in Ansys Fluent. You can create
additional monitors by clicking Create. Then select the Type, Report Type, and the Field Variable
from the respective drop-down lists.

You can select Volume, Surface, Probe, or DPM Monitor from the Type drop-down list.

If you select Probe you can create a point or surface on which you can monitor a variable.
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You need to enter values (in meters) for Point X, Point Y, and Point Z to position the point. If you
retain the value of 0 for Radius then a point monitor is created. If you enter a value for Radius then
a circular surface with the given Radius and the center as the given Point is created. You can monitor
the variables of your choice on this surface or point.

If you select DPM Monitor, you can create a DPM monitor for the selected injections.
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The monitoring variable is referred to as the term Injection Fate. You can select from

• influid-mass: These are the unsteady particle parcels that are currently in the computational
domain, but are not a part of the Lagrangian wall film.

• injected-mass: These are entirety of all DPM particles/unsteady particle parcels that have
been injected. In steady-state tracking, these correspond to the dispersed phase flow rate
defined in the injection(s). In unsteady tracking, it refers to the amount of unsteady particle
parcels that have been injected since the beginning of the calculation.

• vapor-mass: These are the particle parcels that have (already) evaporated completely.

You can select New Variable from the Field Variable drop-down list. This opens the Add Quant-
ity/Variable dialog box.

You can select the variable by selecting from the options under the Quantity and Quantity Subtype
drop-down lists. You also have an option of User Defined under the Quantity drop-down list.

Here you can add the quantity or variable of your choice of which you would like postprocessing
images, in the User Defined text box. You will have to check Fluent if the term is valid for the simu-
lation. After you click OK this quantity will be available in the drop-down list of Field Variable.

The Name will be set according to your selections. You can enter a name of your choice. Click OK to
create the monitor. It will now appear in the list in the Monitor Definitions tab.

12.1.5. Initialization

Depending upon the mixture material you have chosen some terms in this tab will vary. Here you
can define the initial values for the flow variables.
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Click Patch to open the Patching Zones dialog box. You can patch the various listed variables at
your desired values to the listed zones.
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12.1.6. Solution Control

In the Solution Control tab you can set additional specific Crank Angles at which the case and data
files should be saved and also set the starting and ending crank angles for activating the equations.
There are two tabs under the  Solution Control tab.

12.1.6.1. Solution Control

Save Case/Data

The case and data are saved at a specific frequency which you have entered in the Basic Settings
(p. 396) tab. In the Save Case/Data list you can see the additional crank angles at which the case
and data are saved while running the solution. These are at the events of valve opening, valve
closing, TDC, etc. You can change these angles. In the Comment column you can see the event or
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definition for the crank angle. You can enter your own definition for the comment column. If you
right-click on the list you get options of Insert Row Below, Insert Row Above, and Delete Row.
You can use these options to customize your solution.

Equation Events

As per your selection of the combustion models the list of Equations Events will change. Here you
can enter the starting and ending crank angles for which you want the specific equations activated.
The starting crank angle (Start SA) is set to the decomposition crank angle by default. If you do
not enter anything for the ending crank angle (End CA) then the equation will be activated
throughout the simulation cycle. To reset the Equations Events settings to default values click
Reset Equation Events.

Adaptive Time Step

By using the options provided under Adaptive Time Step you can control how the solver changes
the time step size within the specified limits based on convergence criteria. This will help in
achieving a better and faster convergence of the solution.

During the solution run, if for one time step the maximum number of iterations are used to converge
then it means that the solution is far from converging. In this case the solution will execute the
number of time steps according to the crank angle size specified as Max CA Before Decreasing
Step Size and then reduce the time step by half of the present value. If the solution still uses the
maximum number of iterations in the time step then it will again reduce the time step by half. This
will go on until Min CA Step Size is reached.

On the other hand if the solution is converging in less than half of the maximum number of iterations
in the time step, then the time step is doubled after executing the number of time steps according
to the crank angle size specified as Max CA Before Increasing Step Size. This will go on until Max
CA Step Size is reached.

In case there is an event of KeyGrid replacement then the time step is reduced such that the event
is within the tolerance limit of Min CA Step Size. This will take priority over any other criteria which
will try to increase the time step. After the KeyGrid replacement the solution will go back to run
on the settings of Adaptive Time Step.

Also, if there are any direct events which try to change time step size, the program will respect
them but from next time step the Adaptive Time Step criteria will control the solution.

• For using the option select Yes from the Enable Adaptive Timestep drop-down list.

• When the solution starts to converge you can increase the time step size. Enter the crank
angle step size to which it can increase in Max CA Step Size.

• Similarly if the solution reaches the maximum iterations in a time step then the time step
size is decreased. Enter the crank angle step size to which the time step can decrease in Min
CA Step Size.

• The number of angles the solution will wait before increasing the step size is entered for
Max CA Before Increasing Step Size.

• The number of angles the solution will wait before decreasing the step size is entered for
Max CA Before Decreasing Step Size.
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12.1.6.2. Solution Summary

In this group box you can view different profiles overlapping each other. You can enable the profiles
you would like to see on the chart from the list on the left hand side. All the profiles are plotted
on the base of crank angles. The Summary Chart gives a graphic view of the valve profiles, piston
profiles, timesteps, etc. Observing the chart gives you an account of the position of the piston and
valve at the injection time. This will help if you want to manipulate the default time step settings,
or any other events. The chart can be manipulated using the following table.

Table 12.2: Chart Manipulation

Operation
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ZoomRotate Middle Mouse

ZoomShift + Middle Mouse

PanCtrl + Middle Mouse

Box ZoomDrag Right Mouse

Fit to WindowF key

12.1.7. Postprocessing

In the Post Processing tab you can see some of the default images that will be automatically saved
during simulation Depending upon the combustion type simulation these images may vary. Select
any and click Edit to check the details.

1. Here we have an example of one of the images created.
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Here we have an example of one of the images created.

• image2 is plotted on ice-cutplane_1.

• The image is captured at a saved view, ice-top-view.

• Velocity-Magnitude contours are displayed.

• Images are saved from the Start Crank Angle  of 0 to the End Crank Angle  of 720 at a
Frequency of every 4 time-steps.

• Animation is set to Yes signifying that animation of the velocity contour images will be
created at the end of the simulation.

• Overlay With Vectors is set to No. You can select Yes if you want the vectors along with
the contours to be displayed.

• Table is set to Yes signifying that the saved images will be displayed in the report in a
table of 5 Rows and 3 Columns.

2. Another example is of image3.
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Since DPM is set to Yes it plots the particles of the discrete phase colored by velocity mag-
nitude. The contours are not displayed. The Surfaces will be used as an outline boundary.

In the Edit Image dialog box you can change the settings and values as required. To create additional
postprocessing images click Create.
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1. Select the Surfaces on which you want to plot the contours or particle tracks.

2. Select a view from the View drop-down list.

3. Select the parameter from the Quantity drop-down list. You can select New Variable from
the Quantity drop-down list. This opens the Add Quantity/Variable dialog box.

Here you can add the quantity or variable of your choice of which you would like postpro-
cessing images. You will have to check Fluent if the term is valid for the simulation.

4. Select Yes from the DPM drop-down list if you want to plot the particle tracks.
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5. If you select Yes from the DPM drop-down list then the Injection option is displayed. Select
the injection from the drop-down list.

6. Enter the Start Crank Angle and End Crank Angle. The images will be saved only within
these two crank angles. Ensure that these are the crank angles during which spray injection
occurs.

7. Enter a value for Frequency. The images will be captured at the entered frequency.

8. If you need to create an animation from the saved images you can select Yes from the An-
imation drop-down list.

9. The option Overlay With Vectors is by default set to No. You can set it to Yes if you want
the vectors to overlap the contour images.

10. If you want the saved images to be displayed in the report in a table format select Yes from
the Table drop-down list.

11. Enter the values for Rows and Columns depending on how you want to format the table.

12. You can add a tag for the image. You can use this Tag if you want only the final images of
different surfaces in a single table. In this case you have to provide the same tag to all the
images.

13. Click Add Iso Surface if you want to create an iso-surfaces. These surfaces are isovalued
sections of the entire domain.

a. Enter a name for the isosurface you want to create at Surface Name.

b. Select the Quantity from the drop-down list. You can select a quantity from the list or
create a new variable by selecting New Variable.

c. From the Iso Value Input drop-down list you can select either of Absolute Value or
Percentage of Range.
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Absolute Value: If you select this from the drop-down options, you can enter a
value for Absolute Value. The iso-surface created will be of this value.

•

• Percentage of Range: If you select this from the drop-down options, then you
need to enter a percentage value for Percentage of Range. The iso-surface created
will be of the percentage value of the minimum and maximum values obtained
of the quantity.

An iso-surface of the given name and of the selected quantity will be created and appear in
the list of Surfaces. This isosurface will be of the Absolute Value entered or of the percentage
of the minimum and maximum values of the quantity. You can select this isosurface to create
images in postprocessing.

14. Click Create to create the image.

15. Click Close to close the Create Image dialog box.

Once the changes are done in the Solver Settings dialog box you can close it and then update the
ICE Solver Setup  cell by choosing Update from the context menu.

12.2. Solver Default Settings

When you double-click the Setup cell, FLUENT Launcher opens.

Note:

Depending upon your machine configuration you may be able to increase the Number
of Processes to decrease the time taken to arrive at a solution. A reasonable value for
the Number of Processes is the number of cores on your machine.
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When you click OK, Ansys Fluent reads the mesh file and sets up the IC Engine case. It will:

• Read the valve and piston profile.

• Create various dynamic mesh zones.

• Create interfaces required for dynamic mesh setup.

• Set up the dynamic mesh parameters.

• Set up the required models.

• Set up the default boundary conditions and material.

• Create all the required events.

• Sets up the under-relaxations factors.

• Set up the default monitors.

• Initialize and patch the solution.

In the Ansys Fluent application, you can check the default settings by highlighting the items in the
navigation pane.
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Figure 12.1: The Ansys Fluent Navigation Pane

12.2.1. General Settings

12.2.2. Models

12.2.3. Injections

12.2.4. Materials

12.2.5. Mesh Interfaces

12.2.6. Dynamic Mesh

12.2.7. Events

12.2.8. Solution Methods

12.2.9. Solution Controls

12.2.10. Monitors

12.2.11. Solution Initialization

12.2.12. Run Calculation
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12.2.1. General Settings

In the General task page the following settings are done:

• Solver Type is set to Pressure-Based.

• Solver Time is set to Transient.

12.2.2. Models

The models selected for combustion will vary upon your selection in the Solver Settings. These are
some of the default models selected for the analysis for a sector combustion:

• The Energy model is enabled.

• From the Viscous models, the Standard k-epsilon model is selected, with Standard Wall
Functions as Near-Wall Treatment.
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• Species Transport  is selected from the list of models under Species. Depending upon your
selection in the Solver Settings dialog box the options will vary.
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– Volumetric is enabled from the Reactions group box.

– From the Options group box Inlet Diffusion, Diffusion Energy Source, and Stiff
Chemistry Solver are enabled.

– If you have provided a CHEMKIN file, then chemkin-import is chosen from the Mixture
Material drop-down list. Else a default material n-heptane-air, is provided form the
Fluent database of materials.

– From the Turbulence-Chemistry Interaction group box Laminar Finite-Rate is selected.

• The Discrete Phase Model is enabled. Depending upon your selection in the Solver Settings
dialog box the options will vary.
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– Interaction with Continuous Phase and Update DPM Sources Every Flow Iteration
are enabled in the Interaction group box.

– Unsteady Particle Tracking and Track with Fluid Flow Time Step are enabled in the
Particle Treatment group box.

– In the Tracking tab, Max. Number of Steps is set to 5000 and Step Length Factor
to 5.

– In the Physical Models tab Stochastic Collision, Coalescence, and Breakup are enabled
from the list of Options.

12.2.3. Injections

Depending upon your choices in the Solver Settings dialog box injections and their settings will
vary. Here is an example of a default setting for sector. The spray injection properties are defined in
the Set Injection Properties dialog box. You can open the dialog box through the Define menu or
by the Injections... button in the Discrete Phase Model dialog box.Define Injections...

This dialog box can also be opened through the Discrete Phase Model dialog box.
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Depending upon the injections that you have set up in the Solver Settings dialog box the options
will vary. You can selec the listed injections and click Set... to open the Set Injection Properties
dialog box.

• Particle Type selected is Droplet.
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• Material of injection is selected as diesel-liquid.

• The default Evaporating Species selected is c7h16.

• You can check the rest of the values of the variables in the Point Properties tab.

Check the settings In the Physical Models tab.

• In the Drag Parameters group box, dynamic-drag is chosen from the Drag Law drop-down
list.

• In the Breakup group box KHRT is chosen as the Breakup Model.

12.2.4. Materials

Material will differ upon your selection in the Solver Settings.
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• If you have provided a CHEMKIN file, then chemkin-import is chosen as the material from
the list of Mixture drop-down list. Else a default mixture material n-heptane-air, is selected
form the Fluent database of materials.

Note:

You can check the properties of the mixture in the Properties group box.

• Droplet Particle chosen is diesel-liquid.

Note:

You can add your material through the CHEMKIN file or import a mixture material
from the Fluent Database and then change the properties as required in the Cre-
ate/Edit Materials dialog box.

12.2.5. Mesh Interfaces

You can check the three periodic mesh interfaces created in the Mesh Interfaces task page. Following
is an example for a sector combustion.
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• A periodic interface is created between ice-periodic-faces1-chamber-bottom and ice-periodic-
faces2-chamber-bottom. It is called sector-chamber-bottom-periodic-interface.

• The second periodic interface is created between ice-periodic-faces1-chamber-top and ice-
periodic-faces2-chamber-top. It is called sector-chamber-top-periodic-interface.

• The third periodic interface is created between ice-periodic-faces1-piston and ice-periodic-
faces2-piston. It is called sector-piston-periodic-interface.
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12.2.6. Dynamic Mesh

In the Dynamic Mesh dialog box you can check the mesh methods and their settings. Click Settings...
in the Mesh Methods group box to open the Mesh Method Settings dialog box. Depending upon
the type of combustion simulation the settings may vary. Following are examples for sector combustion.
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In the Smoothing tab the method is set to Spring/Laplace/Boundary Layer. The Parameters are
set by default. For more information, refer to Smoothing Methods in the Fluent User's Guide.

In the Layering tab Ratio Based is chosen from the Options group box. You can control how a cell
layer is split by specifying either Height Based or Ratio Based. The Split Factor and Collapse Factor
are the factors that determine when a layer of cells that is next to a moving boundary is split or
merged with the adjacent cell layer, respectively. For more information, refer to Dynamic Layering in
the Fluent User's Guide.

You can also see the three dynamic mesh zones created and the type to which each zone is set.

• ice-fluid-chamber zone is set to Rigid Body.

• ice-fluid-piston zone is set to Rigid Body.

• ice-sectortopfaces zone is set to Stationary.

12.2.7. Events

Events are used to reduce the time steps at the beginning of spray injection and increase the time
steps after the spray stops. This is done to capture the process details during this period.
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The events are specified for one complete engine cycle. Depending upon the type of combustion
simulation the settings may vary. Following are examples for sector combustion.

If you click Events in the Dynamic Mesh task page, you can see these events.

• In the event report-event-for-cell-count-at-bdc the cell count at BDC is added to the report.

• Similarly, in the event report-event-for-cell-count-at-tdc the cell count at TDC is added to
the report.

• In the event reduce-dt-injection-0, the time step size is reduced to 0.1° of Crank Angle Step
Size (deg) at injection start crank angle.
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• In the event increase-dt-injection-0, the time step size is increased to 0.25° at injection stop
crank angle.

• In the event enable-pt-cal-act-for-injection-0, the particle track calculation is enabled at the
injection start crank angle.

• Similarly, in the event disable-pt-cal-act-for-injection-0 the particle track calculation is disabled
at the injection stop crank angle.
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• If you have selected Inert Model then an event ice-inert-egr-reset is added. This event is
before IVO.

You can check the events by clicking Define, next to each event name.

12.2.8. Solution Methods

The settings under Solution Methods will vary depending upon the type of combustion simulations
and the settings in the Solver Settings dialog box. Following is an example for sector combustion.
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• The Scheme for the analysis is set to PISO with Skewness Correction and Neighbor Correction
set to 1, in the Pressure-Velocity Coupling group box.

• Green-Gauss Node Based is selected from the Gradient drop-down list.

• Standard is selected from the Pressure drop-down list.
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• Density, Momentum, Turbulent Kinetic Energy, Species, and Energy are all set to Second
Order Upwind.

• Turbulent Dissipation Rate  is set to First Order Upwind

• High Order Term Relaxation and Set All Species Discretization Together are enabled.

12.2.9. Solution Controls

The Under-Relaxation Factors will vary depending upon the type of combustion simulations and
the settings in the Solver Settings dialog box. Following is an example for sector combustion:

• Pressure: 0.3

• Momentum: 0.5

• Turbulent Kinetic Energy and Turbulent Dissipation Rate: 0.4

• Discrete Phase Sources: 0.5
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• Density, Body Forces, Turbulent Viscosity, Species, Energy, and Discrete Phase Sources,
are all set to 1

• Set all Species URFs Together is enabled

12.2.10. Monitors

To check the output results of the parameters, some monitors have been created. The monitors set
will vary depending upon the type of combustion simulations and the settings in the Solver Settings
dialog box. Following is just an example.

The monitors defined by default for sector are Volume Monitors. The variables they plot are

• Max of temperature, pressure, and velocity magnitude.

• Volume Integral of density, static temperature, and static pressure.

• Volume Average of pressure.

• One monitor plots the Volume.

These monitors are defined on the all the listed cell zones.
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You can create your own Surface Monitors or Volume Monitors from the Monitors task page. Enable
Write so that an output file is written, which can be loaded and viewed later. The monitor settings
which are done by default can be seen in the icBcSettings.txt file.

12.2.11. Solution Initialization

Initialization settings will vary depending upon the type of combustion simulations and the settings
in the Solver Settings dialog box. Following is an example for sector combustion. Standard initializ-
ation is used.

• The Initial Values of Turbulent Kinetic Energy  and Turbulent Dissipation Rate are set to
1.

• Temperature is set to 300.

• The Initial Values of all the rest of the parameters are set to 0 or as per the values you have
set through the Solver Settings dialog box.
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12.2.12. Run Calculation

You can enter the Number of Time Steps you want. Click Calculate to run the simulation.

Running the Calculation from Windows on Remote Linux Machines

To run the simulation on Linux, some changes in the setup are required.
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1. In the FLUENT Launcher, click Show More Options to display the tabs.

2. Click the Parallel Settings tab.
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a. Select the Run Types from the list.

Note:

If you selected Distributed Memory on a Cluster, then you have to
provide the Machine Names.

3. Click the Remote tab.
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a. Enable Use Remote Linux Nodes.

b. Enter the path for Remote FLUENT Root Path. It is the root directory of Fluent in-
stallation.

c. Select your choice from the list of Remote Spawn Command.

Note:

For SSH, you need to set up a password-less connection before running
the solution remotely.

d. Enable Use Remote Cluster Head Node and provide the node.
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e. Enter the number for Number of Processes under Processing Options.

Note:

When the node for Use Remote Cluster Head Node is specified, then
that name will be reflected under Processing Options.

When the remote connection is set, it will use the nodes of the remote Linux machine. The details
are displayed in the Fluent console.

All the files will be saved in the working directory. Once the solution is completed, the project is up-
dated and you can proceed with your postprocessing.

For details, see Setting Additional Options When Running on Remote Linux Machines in the Fluent
User's Guide.

Note:

You can also submit the run on different Linux machines though RSM.

Running on Standalone Fluent

1. Open Fluent and read the case and data file from the ~project-
name_files\dp0\ICE\Fluent directory.

File Read Case & Data...
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2. Note:

In Calculation Activities task page click Edit.... next to Autosave Every (Time Steps)
and check if that the name and path under File Name is correct.

3. In Run Calculation task page enter the required Number of Time Steps and click Calculate.

Note:

If the case is setup in the previously released versions, then you might have to read
the scheme file, (WB-ICE-Solver-Setup.scm) from ~ANSYS
Inc\v150\Addins\ICEngine\CustomizationFiles folder in the mapped
directory before running it in the present version.

Note:

If you want the generate the report from IC Engine System report template, then you need
to first make sure that Solution cell is updated. This can be done by running the solution
for 1 timestep. Then, copy all the files generated by your standalone run into the Fluent
directory and update the Results cell.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.460

Combustion Simulation: Setting Up the Analysis in IC Engine



Chapter 13: KeyGrid in IC Engine
This chapter explains what are KeyGrids and how you can set them up. The KeyGrid option is applied
to provide multiple meshes during pre-processing for the solver run. The information in this chapter is
divided in the following sections:

13.1. KeyGrid Setup in Solver

13.2. Importance of KeyGrid

13.3. Supported Mesh Topologies

13.1. KeyGrid Setup in Solver

In the Properties pane of the ICE Solver Setup cell select Yes from the KeyGrid drop-down list.

An additional option is now seen under Keygrid, Reset Mesh on Keygrid Mesh Failure. As this is enabled
by default, it will reset the KeyGrid mesh if it fails and to generate it again. The Crank Angles property
is now displayed. Click Select KeyGrid Angles to open the Crank Angle Selection dialog box.
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Active Angles

contains a list of crank angles which will be considered for update. These will be the ones you
have set for keygrid. The list displays the information about the crank angle:

• Description: One crank angle will be added by default, Initial. You can edit the Descrip-
tion of the other crank angles you add.

• Status: This column shows the current status of the crank angle. For example, it could
be Mesh Generated, Not Generated, Geometry Failed, or Mesh Failed.

• Skewness displays the skewness of the mesh.

• No of Elements displays the number of elements of the generated mesh.

Inactive Angles

contains a list of crank angles which have been removed from the list of Active Angles with
the help of the arrow buttons.

Add Angle

will open the Add Angle dialog box.
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Add Angle Option

To add a single angle select Single  from the Add Angle Option drop-down list.
Multiple angles can be added by selecting Multiple .

Angle

When you select Single  you can enter the specific angle in the Angle text box.

Start Angle, Interval, Number of Angles

When you select Multiple  from the Add Angle Option drop-down list, the multiple
angles will be created by entering values for Start Angle, Interval and Number of
Angles.

Description

You can edit the Description.

Topology Option

You can select Full for ICE topology, or Single for single zone topology, from the To-
pology Option drop-down list. This will generate meshes with your choice of topology
in KeyGrid. Default choice will be the topology of the default angle.
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Decompose Chamber

You can select Yes, No, or Program Controlled. For more information see chapter
Cold Flow Simulation: Preparing the Geometry (p. 164).

Mesh Type

You can choose Medium, Fine, or Coarse from the Mesh Type drop-down list.

Reference Size

You can edit the Reference Size value. This will change the other dependent mesh
control parameters.

Number of Inflation Layers

You can edit the default value.

Inflation in Chamber

This is set to No by default. You can change this if required.

Local Refinement Around Spark

This option will be present only when spark is defined in a combustion simulation.
This option will be disabled if Multiple is chosen from the Add Angle Option drop-
down list. The default selection will be Yes only if the crank angle is between IVC and
(TDC+10). You can select Yes or No from the drop-down list. Spark refinement for the
mesh will only be done if Yes is selected for Local Refinement Around Spark.

Refinement Radius

By default this value is set to 3.3 X Reference Size.

Browse Angle

will open the Browse Mesh dialog box.

Here enter the angle for which you would like to read and replace the mesh. Click Browse to
open the browser window where you can select the mesh. While selecting the mesh, ensure
that it meets the minimum zone requirement as required by the IC Engine system. For more
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information about the IC Engine supported mesh topologies go to Supported Mesh Topolo-
gies (p. 477).

Note:

While browsing the mesh ensure that the order of selection of vales while decom-
position is the same as for the mesh you are browsing. The valve names and zone
names must be consistent with the upstream data.

Delete Angle

will remove the selected angle from the Active Angles list.

Reset Angle

will clear the mesh and other backup data of the selected angle from the Active Angles list.

Update with duplicate system

When this option is enabled, and you click Update Keygrid, a new system is created in the
Workbench Project Schematic.
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If large number of crank angles are included in KeyGrid, substantial amount of time (over few
hours if frequent keygrids are used) is required to complete the meshing before you can start
the solver. However, the solver will not need these meshes immediately.

An option to run the solver while meshes are being generated is therefore highly desirable
and will greatly expedite the workflow. This feature of creating a new system, will run mesh
generation and solution simultaneously to save time.

The new system is a duplicate system of the original ICE system and will be named as ICE-
KeyGrid. This duplicate system will have the cells only till ICE Solver Setup. This system will
update the KeyGrid meshes. In the meanwhile you can do solver setting changes and run the
Fluent solution. You can check the status of mesh generation anytime by clicking on Select
KeyGrid Angles which opens the KeyGrid Angle Selection dialog box.
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Once the KeyGrid duplicate system is created, KeyGrid Angle Selection dialog box will point
to the data in the duplicate system only. Any changes made in the dialog box like add, remove,
reset angle, set new default, etc. will be affected in the duplicate system only.

In the solver for each of the KeyGrids defined in the duplicate ICE-KeyGrid system, separate
mesh-replace event will be created. So even if you insert new KeyGrid in the duplicate system
while the solver run is going on, then also dynamic event of mesh replace will be created for
that newly inserted KeyGrid. If during the foreground solver run, the KeyGrid mesh file is not
found due to mesh failure or the Keygrid being not generated as yet, then the solver will stop
at that event for user input. A dialog box will pop up which will have two options —

• Check for Mesh File — Clicking this, the solver will search for the mesh file in
../ICE/Keygrids directory and in the current working directory. If it finds the mesh in
either place mesh replacement is done. If it cannot find the mesh then the same dialog
box will pop up again.

• Continue with Existing Mesh — On clicking this option, the solver will proceed without
mesh replacement.

If the solver is running in the background mode and if the mesh file is not found then this
dialog box will not pop up and the solution will continue without mesh replacement.

Update Keygrid

will update the mesh for all those crank angles in the Active Angles list, whose status is other
than Mesh Generated.

After Update Keygrid is clicked you will get a message of closing the mesh and geometry
editors.

Ensure that all the windows are closed and click OK.

The Update Keygrid button is now replaced with the Stop Update button. Also a progress
bar and current update status are displayed.
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Once update starts, a backup will be taken of the project and mesh files. Mesh files will be
saved in the KeyGrids folder. The other files will be saved in the BackupFiles\Crank
Angle folders. If you click Stop Update the update process is terminated after completing
the current geometry or mesh generation. After update is finished or terminated, keygrid.txt
file is written which contains a list of the angles for a which a mesh is successfully generated.

The first time the Crank Angle Selection dialog box opens the Initial Angle will be the default angle.
This angle will be highlighted. To change the default angle right-click on the angle of your choice from
the list of Active Angles and click on Set default angle. You will be asked to confirm if you would like
to set the selected angle as the default angle. After you click Yes the angle chosen to be default will
be highlighted.

Important:

When the option of Update with duplicate system is enabled, then in duplicate system if
you change the default angle it will not be reflected in the original system.

Before the mesh in generated you can edit the properties of the added angle. Right-click on the angle
of your choice from the list of Active Angles and click on Edit angle. Other than the Add Angle Option
and Angle options others can be edited.
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In the list of Active Angles you will see the crank angles. If you do not want to update the mesh for
any of the crank angles in the list, select it and move it to the Inactive Angles list. You can always add
these angles later to the list of Active Angles. If you would like to update the mesh for an additional
angle, click Add Angle and enter the angle of interest. You can remove a selected angle by selecting
and clicking Delete Angle. After you click Update, the mesh is updated for all the Active Angles. Fluent
automatically:

• Replaces mesh.

• Creates required interface.

• Creates events for mesh replacement.

Following is an example of a KeyGrid mesh replace event:
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(wb-ice-mesh-replace "../ICE/KeyGrids/CA-300-eygrid.msh" "program-controlled" '(fluid-ch fluid-exvalve-1-port fluid-invalve-1-port) '(wb_ice_only_smoothing? #f) '(kg-wait-seconds 600)) 

Here the argument '(kg-wait-seconds 600) is set to 600 by default. So the event waits
for 600 seconds or 10 minutes to find the mesh. If the mesh file is not found, then a message
will be printed for '(kg-wait-seconds 600)/10 times. So if you are not monitoring the
run then a message will popup 60 times, which is every 10 seconds for 10 minutes. You can
change the default waiting period.

• Interpolates data.

By default, data is interpolated between matching zone pairs. That is, between the zones with
the same names in both the current mesh and the replacement mesh. A keygrid event of enabling
interpolate across zones option is created in Fluent.

The command in the event will be something similar to :

• (wb-ice-mesh-replace "../ICE/KeyGrids/CA-7-ICE-5.msh" "program-con-
trolled" (fluid-ch fluid-piston fluid-crevice))

In the command you can enable or disable the interpolate across zones option.

– When this option is set to yes then the solution data will be interpolated across the
zones.

– When it is set to no then the solution data will not be interpolated across the zones but
will be interpolated from each zone to the corresponding zone in the replaced/new mesh.

– When this option is set to program-controlled, then number of fluid zones in keygrid
mesh will be extracted from keygrid.txt file present in /ICE/Keygrids directory. So, if
you are running the solution in stand alone Fluent (instead of Workbench) with different
directory structure, then you should copy keygrid.txt in present- working directory.
If all the fluid zones in the existing mesh are not present in the new replacement mesh
then the option will be set to yes. If the fluid zones in both meshes match then the option
will be set to no.

You can change the program-controlled option in the Define Event dialog box.

Note:

Global conservation of data is not enforced when the Interpolate Data Across Zones
option is enabled, so it should only be used when absolutely necessary. For best data
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interpolation, the zone boundaries of the replacement mesh should be coincident
with those of the current mesh.

For more information see Replacing the Mesh.

• Continues solution for the requested number of time steps.

This is how you can set up the simulation using KeyGrids.

13.2. Importance of KeyGrid

During a complete engine cycle, the mesh changes with the crank angle. If required, you can change
the crank angle, and observe the changes in the decomposed geometry and the mesh, at the different
crank angles.

When crank angle is set to 0 (TDC position), the chamber is not decomposed. The chamber mesh consists
of single tetrahedron mesh zone. See Figure 13.1: Mesh at 0 Degrees Decomposition Angle (p. 471).

Figure 13.1: Mesh at 0 Degrees Decomposition Angle

When the crank angle is increased beyond the piston cutoff limit, then the planes created automatically
in decomposition are used to decompose the chamber into three bodies: fluid-ch, fluid-layer-cylinder,
and fluid-piston. New named selections are created for these bodies and the mesh controls are updated.
The valves are moved to their position defined by the valve lift curves.
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Figure 13.2: Piston Cutoff

Figure 13.3: Decomposition at Different Decomposition Crank Angles

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.472

KeyGrid in IC Engine



Figure 13.4: Mesh at 270 Degrees Decomposition Crank Angle

After meshing you will be able to see three different mesh zones. The center one is the layer-cylinder
and contains the sweep mesh. As the valves open, the mesh will be updated depending upon the valve
lift. Thus using parameters you can observe the effect of change of crank angle on the decomposition
and the mesh.

Chamber Inflation in KeyGrids

In KeyGrid, Fluent meshes are replaced by better quality Ansys Meshing meshes. It is beneficial to have
a prism layer or inflation in chamber region, so that the boundary layer flows can be correctly captured.

When Decompose Chamber is set to No, chamber inflation is created if the following conditions are
satisfied:

• The piston has moved more than the piston stroke cutoff distance.

• All valves are closed. A tolerance of two degrees before valve opening is considered.

• The KeyGrid attribute is set. This attribute is present in the Tree Outline of the DesignModeler.
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Under the Details of Attribute_Keygrid set the Integer value to 1.

In the following valve-piston motion profile, the angles at which chamber inflation is possible are
marked.
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For example, at 0 degree crank angle even though both the valves are closed, piston has not moved
more than piston limit (piston stroke cutoff ). Hence inflation will not be created.
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Figure 13.5: Mesh at 0 degree

For crank angle of about 40–140 degrees inflation will be created as both of the conditions are satisfied.
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Figure 13.6: Mesh When Prism Layer is Created

The concept of KeyGrid is replacing the existing mesh in the simulation with better and improved
quality mesh. With the help of design points you can generate meshes at different crank angles. For a
simulation, all the meshes generated through design points update will be saved in ~\pro-
ject_name\dp0\ICE\ICE\KeyGrids\ directory. If you want to modify/improve these meshes in-
dividually you can do so. After generating the meshes, start the solver in the main project file. Events
are written in Fluent for importing the generated/modified meshes at the specified crank angles, so
while running the simulation the modified meshes will be swapped into the simulation at the specified
crank angles.

13.3. Supported Mesh Topologies

If the mesh topology is different from the IC Engine generated topology, ensure that the mesh meets
the requirement of minimum zones, and that the zones and interfaces are properly named. Mesh topo-
logies are categorized based on number of bodies and the type of mesh the bodies have (hex, layered,
tet mesh). The types of mesh topologies supported in the IC Engine system are discussed below. If you
follow the minimum required conventions you can also use engine mesh created outside Workbench.

13.3.1. ICE Topology

In this type of mesh, vlayer, ib and ports are present. This kind of mesh is the result of ICE default
decomposition and meshing where, in the port region and near the dynamic zones maximum possible
hex cells are generated. As a result, this topology has maximum number of hex cells as compared to
the other mesh topologies. In the ib and vlayer, hex layering occurs when the valves move.
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Figure 13.7: ICE Toplogy

For more information about the minimum zone requirements check Nomenclature of Decomposed
Geometry (p. 167). Ensure that the named selection is similar to the IC Engine system convention.

13.3.2. Vlayer and Port

In this type of mesh only the vlayer and port zones of the mesh are present. The fluid zone related
to the ib region is not present. You can use this topology when you want to study only the region
of velocity jet with hex mesh. In this type of mesh topology, the valyer fluid zone has layered mesh,
and layering will happen in that region when the valve moves. The vlayer should have non-conformal
interface between port and chamber.

Vlayer is only at seat region

In this case the vlayer is smaller. It is present only in the seat region.
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Figure 13.8: Vlayer at Seat Region

Minimum zones required

The minimum interface boundary zones required for this type of mesh are:

• intf-valveID-vlayer

– intf-valveID-vlayer-fluid-port

This zone id defined as deforming under Dynamic Zones.

– intf-valveID-vlayer-fluid-vlayer

• valveID

– intf-valveID-ob-fluid-vlayer

– intf-valveID-ob-fluid-ch

This zone id defined as deforming under Dynamic Zones.

The minimum fluid zones required for this type of mesh are:

• fluid-ch

• fluid-valveID-vlayer

• fluid-valveID-port

Dynamic zones

The following dynamic zones will be defined for this kind of mesh:
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• valveID-ib: rigid body

• valveID-ob: rigid body

• valveID-ch: rigid body

• valveID-seat: stationary with layer height

13.3.3. Only Port is Present

In this mesh topology only the port is present. Vlayer and ib are absent. In this type of mesh topology
there should be non-conformal meshes between port and chamber bodies. Thus there will be an in-
terface between the port and the chamber. The zones are as seen in the Figure 13.9: Only Port with
Interface Between Port and Chamber (p. 480).

Figure 13.9: Only Port with Interface Between Port and Chamber

Minimum zones required

The minimum interface boundary zones required for this type of mesh are:

• valveID

– intf-valveID-ch-fluid-port

This zone id defined as deforming under Dynamic Zones.

– intf-valveID-port-fluid-ch
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This zone id defined as deforming under Dynamic Zones.

The minimum fluid zones required for this type of mesh are:

• fluid-ch

• fluid-valveID-port

Dynamic zones

The following dynamic zones will be defined for this kind of mesh:

• valveID-stem: deforming

• valveID-ib: rigid body

• valveID-ch: rigid body

13.3.4. Single body

In this of mesh topology only a single body is present. This kind of topology is seen in the CFX meshes.
There are no separate port, ib, or vlayer bodies. A single mesh topology can have two different cases.

Port and Chamber Have Different Bodies

In this case you can have different bodies for ports and chamber but with conformal meshes between
them. There will be an interior zone between the port and the chamber. Since the ports are in different
bodies they can be deactivated independently. Also zone wise patching can be easily done.
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Figure 13.10: Port and Chamber Have Different Bodies

Minimum zones required

The minimum interface boundary zones required for this type of mesh are:

• None

The minimum fluid zones required for this type of mesh are:

• fluid-ch

• fluid-valveID-port

Dynamic zones

The following dynamic zones will be defined for this kind of mesh:

• valveID-stem: deforming

• valveID-ib: rigid body

• valveID-ch: rigid body

Port and Chamber are in a Single Body

In this case the ports and the chamber are in a single body.
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Figure 13.11: Port and Chamber in a Single Body

Minimum zones required

The minimum interface boundary zones required for this type of mesh are:

• None

The minimum fluid zones required for this type of mesh are:

• fluid-ch

Dynamic zones

The following dynamic zones will be defined for this kind of mesh:

• valveID-stem: deforming

• valveID-ch: rigid body
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Chapter 14: Working with the Simulation Results
After Ansys Fluent finishes running the calculation for the entered number of steps, you can close it.
In Ansys Workbench the Solution cell changes its state to up-to-date. Right-click on the Results cell
and click on Update from the context menu.

After the Results cell is updated, you can check the result in the report. An HTML file is generated,
having the details of setup and results of the simulation. You can open the report file by clicking on
View from the menu bar.

View Files
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In the Files pane, right-click on Report.html and click on Open Containing Folder from the context
menu. In the Report folder double click on Report.html to open the report. The details about the post-
processing are described in the following sections.

For Forte you can find the report at:

..\dp0\ICE\Post\Nominal

for first design point/Default solution. For parameters you can find the report at:

..\dp0\ICE\Post\Run_001

Where Run_001 is for the DP1

14.1. Report

14.2. Postprocessing in CFD-Post

14.1. Report

This is a sample report.
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The File Report displays information about the Fluent data file location, date and time of file creation,
and version.

The Mesh Report shows mesh count and node count of the cell zones.
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Monitor: Volume-Average Cell Equivolume Skew (fluid-piston fluid-layer-cylinder fluid-ch) is a
monitor chart, which shows the volume-average cell skewness at different crank angles of fluid zones.

The table Cell count at crank angles, shows the mesh count at 0 and 180 degree crank angles.
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The table Boundary Conditions, shows the boundary conditions of all inlets, outlets, and walls.
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The section Piston and Valves Lift profiles displays the profiles of valve lifts and piston.
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The section Lift profiles displays the profiles of valve lifts.

The table Relaxations shows the under-relaxation factors at different crank angles.
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The table Dynamic Mesh Setup list the events taking place at specific crank angles.
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In the section IC Engine System Inputs you can check the engine inputs you have entered in the
Properties dialog box. It also lists the Journal Customization files if they are provided.
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In the section Solution Data, you can see the animation of mesh and velocity contours under the An-
imation subsection.
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You can also check the images of the mesh at the cut-plane in the table mesh-on-ice_cutplane_1.
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The table velocity-magnitude on ”ice_cutplane_1” displays the saved images of the velocity contours
on the cut-plane.
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Under subsection Charts, plots of residuals, swirl data, tumble, and charts of other defined monitors
are displayed.
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If you would like to add some images or animations to the report you can do so by placing the images
or animations in the Report folder under ICE.

• Ensure that the names of the images you would like to add in the report start with "ice-im-
age-". All such images will be displayed in the report under the section User Defined Images.
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• Ensure that the names of the images in the animation start with "ice-anim-". The animation
of the images will then be added to the Solution Data section along with other animations.

14.2. Postprocessing in CFD-Post

Once the report is generated you can also open it in CFD-Post. You can do further postprocessing here.

To open the report in CFD-Post, double click the Results cell.
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The CFD-Post window opens. It loads the geometry.
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The Report is loaded in CFD-Post. You can see the plane created in the geometry in the 3D Viewer
tab. In the Report Viewer tab you can see the report as it was seen in Report.html.
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Note:

Instead of the animation, an image is displayed.

You can open the charts, tables, and reports listed under Report in the Outline tree.
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Creating Streamlines in CFD-Post

1. You can choose the time step at which you want to display the streamlines.

Open the Timestep Selector dialog box by selecting Timestep Selector ( ) from the Tools
menu.

Tools Timestep Selector
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a. Select the Step of your choice from the list and click Apply.

b. Close the Timestep Selector dialog box.

2. Select Streamline ( ) from the Insert menu.

Insert Stramline

a. You can change the name here and then click OK in the Insert Streamline dialog box.
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b. Click Location Editor ( ) next to Locations, in the Geometry tab.

c. Select all items under ICE in the Location Selector dialog box and click OK.

d. You can change the name, color, symbol, and other factors of the vectors.

e. Click Apply.
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Creating Contours in CFD-Post

1. After selecting the time step at which you want the contours to be displayed, select Contour

( ) from the Insert menu.

Insert Contour

a. You can change the name here and click OK in the Insert Contour dialog box.

b. In the Geometry tab you can select the location and the variable whose contour you would
like to display and click Apply.
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Creating Plots in CFD-Post

1. Select Chart ( ) from the Insert menu.

2. You can select XY - Transient or Sequence from the Type list in the General tab.

3. You can select Time from the Expression drop-down list in the X Axis tab.
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4. Select the variable you would like to plot from the Variable drop-down list in the Y Axis tab
and click Apply.

You can create additional planes, contour images, reports, etc. For more information on CFD-Post, see
the CFD-Post User's Guide.
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Chapter 15: Troubleshooting the Simulation
This section is intended to provide you with tips and strategies for avoiding and handling problems
that may occur. It has been divided into the following sections.

15.1. Geometry Check

15.2. Geometry Preparation

15.3. Mesh Generation

15.4. KeyGrid Troubleshooting in IC Engine

15.5. Solver Troubleshooting in IC Engine

15.1. Geometry Check

It is a good practice to check the geometry before decomposing. There are a few things that should
be verified so that the problems occurring later on can be reduced.

• Piston should be at TDC position.

• If you are importing a Parasolid geometry, set the Clean Bodies option to No.

• The imported geometry should have only one flow volume with solid valves. If no flow volume
is present see Creating Flow Volume (p. 566) for the procedure to fix it.

• Ensure that the valves are not extracted from the port volume in the initial geometry as shown
in Figure 15.1: Valves Extracted from Port Volume (p. 518).
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Figure 15.1: Valves Extracted from Port Volume

To fix this use the Pre Manager  (p. 149).

• Ensure that the valve stem protrudes out of the port body. If the stem is fully enclosed in the
port body, then you will have to modify the geometry by increasing the stem length. See Fig-
ure 15.2: Check Stem Size (p. 519).
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Figure 15.2: Check Stem Size

• Ensure that the valve is in correct position. The valve should be located below the valve seat. It
should not be present above the valve seat. The valve body should not overlap the valve seat,
as shown in Figure 15.3: Valve Body Overlapping Valve Seat (p. 520). It should not cut the port
body as shown in Figure 15.4: Incorrect Valve Position (p. 520). If the criteria are not met you will
have to cleanup the geometry before the decomposition. There should be some minimal gap
between the valve body and valve seat as shown in Figure 15.5: Correct Valve Position (p. 521).
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Figure 15.3: Valve Body Overlapping Valve Seat

Figure 15.4: Incorrect Valve Position
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Figure 15.5: Correct Valve Position

• Ensure that the valve is centrally aligned to the valve guide. An off-centered valve can result into
failures and wrong results. See Figure 15.6: Check Valve Alignment (p. 522).
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Figure 15.6: Check Valve Alignment

To correct the alignment follow the steps listed in the section Aligning the Valves With the Seat
Faces (p. 525).

• Ensure that there are no extra bodies in the geometry, other than one port body and the valve
bodies. If any extra body is present, then you will get the following warning while decomposing:

You will have to delete the body or unite it with the appropriate body so that other than port
and valves no other body is present. Suppressing the body can also work.
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• If you want to decompose the chamber for a straight (vertical) valve engine with valve pockets
you need to do some manual operations as explained in Decomposing a Straight Valve Pocket
Engine (p. 552).

Important:

If there are any hard edges in the geometry they will be automatically removed to avoid
further errors/failures in the simulation.

15.2. Geometry Preparation

Following are some warning and error messages you might get, while preparing the geometry for de-
composition.

TroubleshootingWarning/Error Message

Selecting face(s) for Cylinder Faces in the Input
Manager dialog box is mandatory. You cannot
proceed with decomposition unless this step is
completed. If you fail to select any face for the
Cylinder Faces option, then the warning is
displayed.

If while selecting faces for inlet, exhaust, cylinder,
or symmetry, you select a face which had already
been selected for another parameter, then you
get the warning that, the face has already been
selected; you will have to change the selections if
you want to continue.

Selecting a plane or face for Top Plane/Face in
the Input Manager dialog box is mandatory if
Decompose Chamber is set to Yes. You cannot
proceed with decomposition unless this step is
completed. If you fail to select any face/plane then
the warning is displayed.
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Selecting a plane or face for Bottom Plane/Face
in the Input Manager dialog box is mandatory if
Decompose Chamber is set to Yes. You cannot
proceed with decomposition unless this step is
completed. If you fail to select any face/plane then
the warning is displayed.

Selecting a body for Valve is mandatory. If you

click Decompose ( ) without
selecting a body for the Valve option in the Input
Manager then the warning message is displayed.

When prompted to select a body for a valve, if
you select a body which can be a part of the port
body, then the warning is displayed.

Even though the warning is displayed the
body part you selected will be accepted. If
during decomposition the program recognizes
that the selected valve body is a part of the
port body, then the decomposition will not
be completed and another warning is
displayed. If the selected body part is
accepted again as the valve body then
decomposition will take place.

Selecting a face for Valve Seat in the Input
Manager is mandatory. If you fail to select a face
for the valve seat then the warning is displayed.

When prompted to select a face for the Valve
Seat in the Input Manager, and you select a face
which can be a part of valve body, then the
warning is displayed.

Even though the warning is displayed, the
face you selected will be accepted and
decomposition will take place. But if the
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program determines that the chosen face is
wrong another warning is displayed. You will
have to then select the right face and execute
the decomposition again.

If the program determines that the chosen face
for the Valve Seat is wrong the error is displayed.
You will have to select the right face and execute
the decomposition again.

In some cases this warning is repeatedly
displayed even after you have ensured that
you have selected the right faces. In such a
case add a Body Operation, set the Type to
Clean Bodies, and select all the bodies. Clean
Bodies should be set to High. After this
recreate Input Manager.

If the distance between the valve body and the
Valve Seat is less than the minimum required
then the error is displayed while decomposing.
You should move the valves to create some gap
and execute the decomposition again.

The format of the profile file selected for Valve
Lift and Piston Motion Profile should be correct.
Also not all values of the lifts in the profile file
should be zero.

• If you change any of the decomposition parameters like Decomposition Crank Angle, and you
get errors while updating the model, then you should delete all the features under Input Manager
in the tree and decompose the geometry again.

•Aligning the Valves With the Seat Faces

You get the following warning after decomposition if the valve is not aligned to the seat.
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The warning will mention which valve(s) are not aligned to their respective seat face(s). To correct
the problem perform the following steps:

1. First you need to create a plane using the valve seat. For creating a plane three non-
colinear points/vertices are required. Two points on the valve seat can be selected, but
the third point should be at the center.

a. Select the valve seat face. It is easy to manipulate the geometry if the other
faces are hidden. You can hide the other faces by first selecting the face and
then selecting Hide All Other Faces from the context menu.

b. Create a line.

Concept Lines From Points

i. Select the two edge points of he valve seat for Point Segments in the Details
of Line dialog box and click Apply.

ii. Select Add Frozen from the Operation drop-down list.
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iii. Click Generate .

c. Create a center point of the lines.

Concept Split Edges

Select the line created and the edge of the valve seat for Edges in the Details

of EdgeSplit dialog box and click Generate .
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This will split the created line and the valve seat edge into two equal halves.
Thus you now have the center points of both the lines.

d. Click on New Plane .

i. Select From Three Points from the Type drop-down list.

ii. Select the three points as shown in the Figure 15.7: Selecting 3 Points
For Creating Plane (p. 529). Ensure that while selecting the points, you
first select the center point of the line created. This sequence is import-
ant. Also all the three points should not be colinear.
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Figure 15.7: Selecting 3 Points For Creating Plane

iii. Ensure that the Normal or Z-Axis points upwards else you can select
Yes from the Reverse Normal/Z-Axis drop-down list

iv. You can name the plane as seat_plane and then click Generate

.

2. Similarly create a plane for the valve face. This is the face of the valve body which comes
into contact with the valve seat.
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You can name the plane created as valve_plane.

3. Move the valve body to align it with the seat.

Create Body Transformation Move
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a. Select Move from the Type drop-down list in the Details of BodyOp dialog
box.

b. Retain By Plane for Move Type.

c. Select the valve body for Bodies.

d. Select valve_plane for Source Planes.

e. Select seat_plane for Destination Planes.

f. Click Generate . to complete the operation.

4. If the valve moves in the upward or downward direction while aligning, you can use the
Translate operation to bring it to proper position. Ensure that the valve is correctly po-
sitioned. Refer to the section on valve positioning (p. 519) for more information.

• If you have enough squish volume to separate the chamber and piston by a layer body and still
you select No for Decompose Chamber, then the following warning is displayed. The squish
volume is checked internally and you are given a chance to go back to the Input Manager and
change the option of Decompose Chamber to Yes.
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• If you select multiple faces for IC Inlet Plenum in the port flow simulation, then you should
ensure that the angle between the normals of the faces is less than 30°. Else you will get the
following warning.

You should create different groups for the faces.

• If the geometry decomposes successfully only at TDC and at no other angle, then add a Body
Operation, set the Type to Clean Bodies, and select all the bodies. Clean Bodies should be set
to High. After this recreate Input Manager.

15.3. Mesh Generation

Following are some troubleshooting techniques for meshing.

• If the chamber meshing fails, then you should delete its pinch controls and execute the meshing
again.

• If after mesh setup you have created some virtual faces then you may sometime get following
error message.
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You must check and add these faces to the appropriate Named Selection it belongs to. If some
faces belonging to a named selection group are not selected for the Geometry option they belong
to, then the warning is displayed.

• If there are any small faces causing a meshing failure, then these faces should be merged with
their adjacent faces using Virtual Topology. This helps in successful mesh generation.

• If vlayer meshing fails, then you should try to project and imprint the edge of the valve face on
the valve seat, in the direction of the valve.

Figure 15.8: Imprint and Project the Edge of the Valve Face

This will split the valve seat. You will have to decompose the geometry again. This procedure
will create a proper sweep mesh in the vlayer.
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Figure 15.9: Valve Seat Split After Projection and Imprint

• Sometimes sweep in vlayer meshing fails due to high valve curvature. You might get the error
message as shown in the following figure.
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The following figure shows the high curvature region where the sweep fails in vlayer.
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In such case enable the beta option. This problem will be resolved automatically. The mesh
generates without errors.

• If the mesh skewness is high, i.e. close to 1, then you can try to improve the mesh by performing
the following steps.

1. Display the area where highly skewed elements are present.
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Select Mesh in the tree Outline.a.

b. In the Details of “Mesh” ensure that Skewness is selected from the Mesh
Metric drop-down list under Statistics.

c. In the Mesh Metrics dialog box click Controls.

d. Enter the Range of skewness and close the Mesh Metrics dialog box.

e. Select the bars from the bar chart displayed.

All the elements having skewness in the specified range are highlighted in the
graphics window in the meshed geometry.
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2. To improve the skewed mesh any of the following methods can be used depending
upon the geometry.

– If edges/lines are present in the close proximity then you can create new pinch
controls or increase the default tolerance for the existing pinch controls.

– If small faces are present then you can merge them with adjacent faces using
Virtual Topology.

– Sometimes in the chamber body, very small faces, faces at small angles, or faces
in close proximity are present, which create skewed elements. To improve this,
specify additional hard face sizing controls, or reduce the body sizing control of
the chamber, or reduce the curvature angle related to the body sizing control of
the chamber mesh control. Reducing body sizing and curvature angle will increase
the mesh size. On the other hand, specifying local hard face sizing controls will
result in an improved mesh without a substantial increase in mesh size.

• V-layer meshing can fail in some cases where the face has a step. In such a case select Show
the Problematic Geometry from the context menu of the error message in the Messages win-
dow. This will point to the face which has the step. See Figure 15.10: Face Having a Step  (p. 539).
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Figure 15.10: Face Having a Step

The problem can be corrected by reducing the V Layer Slice Angle parameter in the Input
Manager, such that the face is split into two as shown in Figure 15.11: Face Split Into Two (p. 539).
You should then reset the Mesh cell and follow the meshing procedure to re-mesh the geometry.

Figure 15.11: Face Split Into Two

• If an IC Engine project of older version is opened in the latest version then, during Mesh cell
update it may give the following error.
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To avoid this error you should delete the Contacts group under Connections in the tree of
Meshing application.

• If there are sharp corners between piston and liner or in valve pockets of the piston, then these
can cause bad mesh elements during mesh motion. To prevent such issues you can create partial
crevices.

15.4. KeyGrid Troubleshooting in IC Engine

• During Keygrid generation if you get an Attention Required ( ) cell state for ICE Solver Setup
cell then mesh for one of the given crank angles has failed. In such a case you can correct the
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mesh as given in the point below (p. 541). If you want to continue with further computation you
can also move the failed angle(s) to the Inactive Angles list.

• During Keygrid generation if mesh generation fails for any angle, set that angle as the default
angle by selecting Set Default Angle from the context menu, which you get by right mouse
click. Check the error message.

– If the message says that the geometry failed, then open DesignModeler.

1. Decompose the geometry once more.

2. Reset the Mesh cell in the Project Schematic.

3. Open Ansys Meshing by double-clicking the Mesh cell.

4. Set the mesh parameters.

5. Generate the mesh.

– If the message says that mesh failed, then try the following steps.

1. Open Ansys Meshing and check the meshing errors. See if you can rectify them. If you
cannot close Ansys Meshing.

2. Reset the Mesh cell in the Project Schematic.

3. Open Ansys Meshing by double-clicking the Mesh cell.

4. Set the mesh parameters.

5. Generate the mesh.

• While browsing mesh in KeyGrid, valve names and zone names must be consistent with upstream
data. Else after mesh replace valve-ch is swapped leading to negative volume error. So always
remember the order of selection of the valve bodies.

15.5. Solver Troubleshooting in IC Engine

• If you want to use the case file generated by IC Engine system and run the simulation in stan-
dalone Fluent, you should read the scheme file (WB-ICE-Solver-Setup.scm) after you read
the case file in Fluent. This is mandatory. Else you will get some errors while running.

Important:

The report (Report.html) may not be properly generated if you run the simulation
in standalone Fluent.

• In the cold flow simulation case, if the cyl-tri or symm-cyl-tri face zone contains a
curvature then it might result in smaller elements at the curve. See Figure 15.12: Curvature in
cyl-tri  (p. 542).
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Figure 15.12: Curvature in cyl-tri

In such cases if you are facing “Negative Volume Cell" errors while running the mesh motion or
computation, then enabling Local Face remeshing option both globally and locally for those
face zones will improve the solver stability. To enable local face remeshing in Fluent:

1. Go to Dynamic Mesh in the navigation pane.

a. Click Settings.... under Mesh Methods.

b. In the Mesh Method Settings dialog box click the Remeshing tab and enable Local
Face.
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c. Click OK and close the dialog box.

2. Select the cyl-tri and symm-cyl-tri (in case of symmetry) face zone from the Dynamic
Mesh Zones list and click Create/Edit....

a. In the Dynamic Mesh Zones dialog box click the Meshing Options tab.

b. Enable Local in the Remeshing Methods group box.
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c. Click Create and close the Dynamic Mesh Zones dialog box.

• In some cold flow or combustion cases cyl-tri and symm-cyl-tri mesh might be stretched as
shown in the figure below, due to failure of remeshing in cyl-tri and symm-cyl-tri.

This is mainly because of the small kinks in the piston faces. To avoid this problem, you need to
enable the following options manually:
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– Enable the "Local Face" remeshing both globally as well as locally for cyl-tri and symm-
cyl-tri zones as shown in troubleshooting point above (p. 541).

Note:

You cannot enable Local Face remeshing in all cases because it affects the
cycle to cycle mesh repeatability.

– Enable zone-remeshing through following TUI:

/define/dynamic-mesh/controls/remeshing-parameters/zone-remeshing
yes

Note:

You cannot enable zone remeshing for all cases — In parallel, the zone
remeshing will automatically migrate all elements to be remeshed to a single
CPU. Consequently, the machine memory will limit the size of the zone that
can be remeshed.

• In case you get a negative volume error during computation —

– Check the mesh. If you observe that the zone motion is not happening properly, then in
the DesignModeler check that the named selections are having proper supports, especially
near the chamber and piston areas.

– If you have used Kegrids, check that the replaced mesh has the same order of selection
of valve bodies as per the originally decomposed mesh. Else, after mesh replace valve-ch
is swapped, leading to negative volume.

• When you select Crank Angle from the Auto Save Type drop-down list in the Solver Settings
dialog box, then Auto Save Frequency is set to some value, say “X”. In Fluent Autosave Every
(Time Steps) in the Calculation Activities task page is set to 1, but the case and data are saved
at the frequency “X” which you have set.

If you take the ICEngine system generated case file to standalone Fluent and run the simulation
without reading the ICEngine scheme file (WB-ICE-Solver-Setup.scm) then the case and
data will be saved at every time step. To avoid this problem and to make sure that case and
data get saved at requested frequency “X” (Auto Save Frequency), you will have to read ICEngine
scheme file WB-ICE-Solver-Setup.scm before reading the case file in standalone Fluent. If
this is not done then the case and data files will be saved on the frequency set in Autosave
Every (Time Steps), which is 1 by default.

• During remeshing if you observe denser cells near piston regions while the piston is moving
upwards or skewness is increasing, then you need to increase the Number of Iterations in the
Smoothing tab of the Mesh Method Settings dialog box in Fluent. This will help in improving
the mesh, but it might increase the mesh motion time. It has been observed that values between
50 to 150 for Number of Iterations are more effective.
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Chapter 16: Customization and Improvements
This chapter has some topics on customizing and improving the simulation.

16.1. How IC Engine System Moves the Piston to the Specified Crank Angle

16.2. How IC Engine System Calculates Valve Opening and Closing Angles

16.3. Decomposing a Straight Valve Pocket Engine

16.4. Creating Flow Volume

16.5. Separating the Crevice Body

16.6. Boundary Conditions, Monitor Settings and Solver Settings

16.7. Calculating Compression Ratio

16.1. How IC Engine System Moves the Piston to the Specified Crank
Angle

When you enter a value for the Decomposition Crank Angle in the Input Manager, the IC Engine
System moves the piston to that specified angle. The actions performed internally are as follows:

• A plane is created above the piston along the line of cylinder axis. By inserting Sketch Projection
and selecting the border edges of the piston surface a projected profile is created.

The Pattern feature is used to translate the piston surface.
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• Extrude the named selection by a distance more than that of the piston bottom position.

The extruded body is then sliced with the piston surface. Deleting the top body and uniting the
bottom body with the port body and then, slicing the united body with the bottom piston surface,
completes the operation.
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16.2. How IC Engine System Calculates Valve Opening and Closing Angles

The valve opening and closing angles are internally calculated in such a way that the flow to the
chamber is neither under-predicted nor over-predicted. As there is a minimum lift for the valve, the
actual valve opening will allow too much of flow into the chamber.

According to the profile and in practice the flow will vary according to the lift profile. For example in
the following figure the valve opens at 312° crank angle (CA) according to the profile. At about 360°
CA the valve lift will reach 0.20 mm.

Figure 16.1: Actual Valve Opening Profile

If you specify Minimum Lift as 0.20 then the valve will open at 312°, and the simulated valve profile
will be as shown in Figure 16.2: Valve Opened at CA 312°  (p. 550), and the flow will be over-predicted.
Hence the valve opening and closing angles are modified.
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Figure 16.2: Valve Opened at CA 312°

The valve opening and closing angles are calculated using the trapezoidal method of numerical integ-
ration. As shown in Figure 16.3: Mass Flow Value Equivalent to Variation of the Curve (p. 551), an average
value of CA is calculated when the mass flow value of A1 and A2 are equivalent. Here it comes as 340°.
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Figure 16.3: Mass Flow Value Equivalent to Variation of the Curve

With the calculated value, the simulated valve lift profile is as shown in Figure 16.4: Simulated Valve Lift
Profile (p. 552).
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Figure 16.4: Simulated Valve Lift Profile

16.3. Decomposing a Straight Valve Pocket Engine

Figure 16.5: Straight Valve Engine with Pockets (p. 553) shows a straight valve engine with valve pockets.
For decomposition of a straight valve pocket engine you will have to do some changes manually. Refer
to Straight Valve Geometry With Chamber Decomposition for IC Engine (p. 167) for the nomenclature
of the decomposed geometry.
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Figure 16.5: Straight Valve Engine with Pockets

Perform the following steps:

1. In the Input Manager ensure that Yes is selected for the Decompose Chamber option.

2. Select Manual from the IC Plane Insert Option.

3. Select the bottom plane such that the pockets will come under the ch-lower body as shown
in the Figure 16.6: Bottom Plane Face (p. 554).
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Figure 16.6: Bottom Plane Face

4. Ensure that you have entered all the required data in the Input Manager and then decompose
the geometry.

5. Disable Share Topology.

6. After decomposition you will have to slice the pockets from the ch-lower body and unite it
with the piston body. For slicing perform the following steps:

a. Delete the named selection fluid-ch-lower from the tree.
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b. Click Slice .

c. Select Slice by Surface from the Slice Type drop-down list.

Note:

In some cases sharp corners are generated in the piston body by using Slice
by Surface. To avoid this create a plane slightly above the surface highlighted
in Figure 16.7: Slicing (p. 556). Then select Slice by Plane from the Slice Type
drop-down list.

d. Select Selected Bodies from the Slice Targets drop-down list.

e. Select the ch-lower body for Bodies.

555
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Decomposing a Straight Valve Pocket Engine



Figure 16.7: Slicing

f. Click Generate .

7. For uniting perform the following steps:

a. Select Boolean from the Create menu.

Create Boolean

b. Ensure that Unite is selected from the Operation drop-down list.

c. For Total Bodies select the piston body and the body formed by the pockets.
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Figure 16.8: Piston Body and Body Formed by Pockets

d. Click Generate .

e. Create the named selection fluid-ch-lower by selecting the body.
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Figure 16.9: Create named selection fluid-ch-lower

8. Redefine the intf-piston-ch interface with proper faces, which are all the faces of ch-lower
body and interface of piston body:

a. Delete the named selection intf-piston-ch from the tree.

b. Select the proper face as shown in the Figure 16.10: Create Named Selection intf-piston-
ch (p. 559) and then create the named selection with the name intf-piston-ch.
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Figure 16.10: Create Named Selection intf-piston-ch

9. Redefine the intf-piston-bowl interface with proper faces, which are all the faces of piston
body and interface of ch-lower body and ch-valveID body.

a. Delete the named selection intf-piston-bowl from the tree.

b. Select the proper faces as shown in the Figure 16.11: Create Named Selection intf-piston-
bowl (p. 560) and then create the named selection with the name intf-piston-bowl.
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Figure 16.11: Create Named Selection intf-piston-bowl

10. Redefine all piston faces, which are supposed to be given rigid body motion in Fluent.

a. Delete the named selection piston from the tree.

b. Select the proper faces as shown in the Figure 16.12: Create Named Selection pis-
ton (p. 561) and then create the named selection with the name piston.
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Figure 16.12: Create Named Selection piston

11. Redefine the intf-valveID-ob-fluid-ch-lower with faces belonging to ch-lower body and interface
of ch-valveID body.

a. Delete the named selection intf-valveID-ob-fluid-ch-lower for an individual valve from
the tree.

b. Select all the proper faces as shown in Figure 16.13: Create Named Selection intf-valveID-
ob-fluid-ch-lower (p. 562) and then create the named selection intf-valveID-ob-fluid-
ch-lower.
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Figure 16.13: Create Named Selection intf-valveID-ob-fluid-ch-lower

c. Select all the faces as shown in Figure 16.14: Create New Named Selection (intf-valveID-
ob-fluid-piston-lower) (p. 563) and create a new named selection for it (for example intf-
valveID-ob-fluid-piston-lower). This belongs to the piston body and the interface of
ch-valveID body.
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Figure 16.14: Create New Named Selection (intf-valveID-ob-fluid-piston-lower)

d. Similarly redefine the intf-valveID-ob-fluid-ch-lower for all the valves present.

12. Mesh the geometry.

13. After meshing the geometry, click Setup in the Project Schematic to open Fluent.

a. The new interfaces you have created (here you have named them as intf-invalve1-ob-
fluid-piston-lower) will be of type wall. Change the type to interface.

i. Double-click to open Boundary Conditions in the Fluent tree.
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ii. From the list of Zone, filter for *piston-lower and, for each one, select it and
change the Type to interface. A dialog pops up for renaming; click OK.

b. Create the interface zones for the valve mesh interface.

i. On the Fluent tree, double-click Mesh Interfaces.

ii. In the list of Unassigned Mesh Interface Zones select the four interfaces
whose type you just changed, assign an Interface Name Prefix (here, "auto-"
is used), and click Auto Create.
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Figure 16.15: Select and Name Interface Zones
(intf-invalveN-ob-fluid-piston-lower)

iii. The Mesh Interfaces dialog box shows the new interfaces in the Mesh Inter-
faces list (here, auto-:01 and auto-:02).
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iv. Select one of the two automatically created mesh interfaces and click Edit...
to rename it, based on its Interface Zones. (Here, auto-:01 is renamed to ex-
valve and auto-:02 becomes invalve.) Repeat the renaming for your second
new mesh interface.

16.4. Creating Flow Volume

Sometimes the imported geometry has no flow volume. It may consist of only the surface body. In such
a case you will have to create a flow volume before proceeding with decomposition.

Figure 16.16: Geometry with No Flow Volume (p. 566) shows a geometry with no enclosed flow volume
and no solid valves.

Figure 16.16: Geometry with No Flow Volume

For creating a flow volume:

1. Select all the edges at any one of the open ends. See Figure 16.17: Edges Selected of the Open
End (p. 567).
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Figure 16.17: Edges Selected of the Open End

2. From the Tools menu select Surface Patch.

a. All the edges at the open end are selected for Patch Edges.

b. Click Generate ( ).

3. Repeat the procedure for all the open ends.

4. After all the open edges are patched select Fill from the Tools menu.

a. In the Details View of Fill select By Caps from the Extraction Type drop-down list.

b. Click Generate ( ) to complete the operation. See Figure 16.18: Creating a Flow
Volume (p. 568). A solid body is created in the Tree Outline.
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Figure 16.18: Creating a Flow Volume

Now the geometry has a flow volume but the solid valves are extracted. You can use Pre Manager
(p. 149) to create the valves.

16.5. Separating the Crevice Body

If the imported geometry has a crevice, then the crevice body should be separated before decomposition.
The crevice body will be set as a rigid body during simulation and the neighboring bodies will be set
as deforming bodies. So the separation of the crevice body from the rest of the geometry is important.
The following steps have to be followed:

1. Read the geometry with the crevice.
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2. Select the cylinder face and hide it to expose the inner faces and edges.
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3. Create a line body of the edge of the crevice.

Concept Lines From Edges

For Edges select all the edges of the crevice.

When you click Generate a Line Body  is formed under Parts, Bodies in the tree.
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4. Tools Freeze

5. Project a point from the inner edge of the crevice onto the cylinder surface.

Note:

If inside edge is single and circular, then you may need to create a point on the
edge, which you can use to split the edge.

Tools Projection

a. Select Points on Face from the Type drop-down list.

b. Select a point on the edge for Points.
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c. Unhide the previously hidden cylinder face and select it for Target.

d. Click Generate.

6. Create a line from the points.

Concept Line From Points

a. For Point Segments select both the point and the projected point.

b. Click Generate. A small line body is created between the two faces of the crevice.
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7. Generate a surface body by sweeping the line body over the edge of the crevice.

Create Sweep

a. For Profile select the Line Body under Parts, Bodies, which is the line segment created
between the inner and outer faces of the crevice.

b. For Path select the Line Body under Parts, Bodies which is the edge of the crevice.
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c. For Operation select Add Material from the drop-down list.

d. Select Yes from the As Thin/Surface? drop-down list.

e. Enter 0 for Inward Thickness and Outward Thickness.

f. Click Generate.

A Surface Body is created under Parts, Bodies.
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8. Extend the surface inwards and outwards so that the slicing is proper.

Note:

Ensure that the surface extension is adequate. Too much extension will interfere
with the piston body. The surface should only separate the crevice from the flow
volume and should not enter into the piston part of the flow volume.

Tools Surface Extension

a. For Edges select all the outer edges of the crevice.

b. Retain Fixed from the Extent drop-down list.

c. Enter an appropriate number for distance.

d. Click Generate.

9. Similarly extend the inner edge of the surface.

10. Separate the crevice body.

Create Body Operation

575
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Separating the Crevice Body



a. Select Cut Material from the Type drop-down list.

b. Select the surface body created under Parts, Bodies for Body.

c. Retain No for Preserve Bodies?.

d. Click Generate.

Note:

Before decomposing the geometry delete the 2 line bodies you have created from
the tree under Parts, Bodies.

16.6. Boundary Conditions, Monitor Settings and Solver Settings

After decomposition, DesignModeler writes a Default Boundary Conditions and Monitor Settings
file (icBcSettings.txt). The solver will read this file to set up the solver settings. This is file is
modified by the input parameters defined in the ICE Solver Setup. You can also change the settings by
copying the format from this default file and saving your conditions to the User Boundary Conditions
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and Monitor Settings file (icUserSettings.txt). This file will be stored at ~Project-
Name_files\dp0\ICE\ICE . The format is described below.

Note:

The settings in the icUserSettings.txt file will override the settings in the default
icBcSettings.txt file.

Similarly, DesignModeler will also write a solver settings file, icSolverSettings.txt. The solver
will read this file to set up the simulation located at ~ProjectName_files\dp0\ICE\ICE\, The
solver will read this file to set up the simulation. The format is described below.

16.6.1. Format and Details of an icUserSettings.txt File

16.6.2. Format and Details of the Solver Settings File

16.6.1. Format and Details of an icUserSettings.txt File

The following list shows the format and details of each of the fields.

solution-type

Set to "cold-flow" or "port-flow", or "combustion"depending upon the solution type
you have chosen.

combustion-simulation-type

Set to "sector", or "full_engine_ivc_to_evo", or "full_engine_full_cycle"
depending upon the combustion simulation type you have chosen.

initialize-flow?

Set to #t (true) or #f (false) depending upon whether you want to initialize the flow or not.

report-mesh?

Set to #t (true) or #f (false) depending upon whether you want to generate a mesh report after
running the calculation.

report-urf?

Set to #t (true) or #f (false) depending upon whether you want the under relaxation factors in-
cluded in the report or not.

set-default-models?

Set to #t (true) or #f (false) depending upon whether you are using the default models set for
this type of solution.

data-sampling

Set to #t (true) or #f (false) depending upon whether sampling of date is enabled during the
unsteady calculation.
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auto-save-type

Set to "CA" (Crank Angle) or "time" (time steps) depending upon whether you want to save
the case and data files at a specific frequency of crank angle or time steps.

auto-save-freq

The number of crank angle or time steps after which the case and data file is saved in Fluent. If
it is set to #f, then only the final case and data files are saved.

num-of-CA

Set to the number of crank angles you want the solution to run.

ice-swirl-number

Set to the default swirl number of 1.3 or to the value you chose.

ice-chemkin-file

Set to #f if no file is provided. If file is provided then it shows the path where the file is saved.

ice-them-data-file

Set to #f if no file is provided. If file is provided then it shows the path where the file is saved.

profile-file

Set to #f if no file is provided. If file is provided then it shows the path where the file is saved.

set-default-urf?

Set to#t (true) or #f (false) depending upon whether you are using the default under-relaxation
factors or setting your own.

set-bc?

Set to#t (true) or #f (false). When this is #t it will set the boundary conditions specified in the
inlet_outlet_bc_list and wall_bc_list.

ice-initialization values

Shows the parameters and their initialization values.

ice-combustion-model-param

Shows the selected combustion model and the mixture material

inlet_outlet_bc_list

Lists the information about the inlets and outlets in the format:

(list-no (zone "Zone-Name") (type "Type")(data-profile "no" "profile-
name" "field-name" /value) (temperature-profile "yes/no" value)
(turbulence "Turbulence Specification Method" value1 value2)))
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Here list-no is used to list the serial number of inlets and outlets.

"Zone-name" is the name of the zone to which you are applying the boundary conditions.

"Type" will be "pressure-inlet", "pressure-oulet", or "mass-flow-inlet".

You can enter yes or no for the data-profile or temperature-profile. If you want to
provide a profile enter yes. The format changes to (data-profile "yes" "profile-
name" "field-name"). Here "profile-name" is the name of the profile in the file provided,
and "field-name" is the field within the profile that contains the data.

If you specify no, then a value should be provided for the parameter.

The "Turbulence Specification Method" can be either Intensity and Viscosity Ratio
("int-vis-ratio") or Intensity and Hydraulic Diameter ("int-hyd-dia").

The value1 is value of Turbulent Intensity. value2 can be Turbulent Viscosity Ratio or Hy-
draulic Diameter depending on the Specification Method selected. An example is shown below.

inlet_outlet_bc_list (
(1(zone "ice-inlet")(type "pressure-inlet")(data-profile "no" 500)(temperature-profile "no" 400)
(turbulence "int-hyd-dia" 2 5))
(2(zone "ice-outlet")(type "pressure-outlet")(data-profile "no" 0)(temperature-profile "no" 700)
(turbulence "int-hyd-dia" 2 5))
(3(zone "ice-inlet-invalve-1-port")(type "pressure-inlet")(data-profile "yes" "in-mflow-prof")
(temperature-profile "yes" "in-temp-prof" "temp")(turbulence "int-hyd-dia" 2 0.027)) )

wall_bc_list

Lists the information about the walls in the format shown:

((list-no (zone "Zone-Name") (data-profile "no" value)(slipwall
"yes")))

Here list-no is used to list the serial number of walls.

"Zone-name" is the name of the zone to which you are applying the boundary conditions. If
you want to set one value on all the zones, set "Zone-name" to "all". You can add individual
zones thereafter that will overwrite the conditions set for "all" zones.

You can enter yes or no for the data-profile. If you want to provide a profile enter yes.
The format changes to (data-profile "yes" "profile-name" "field-name"). Here
"profile-name" is the name of the profile in the file provided, and "field-name" is the
field within the profile that contains the data.

If you specify no, then a value should be provided for the parameter.

You can enter yes or no for the slipwall. If you choose "yes" then Specified Shear is selected
from Shear Condition group box and you can provide the Shear Stress in the wall boundary
condition dialog box in Fluent. For "no", No Slip is selected from Shear Condition group box.
slipwall term is present only for Port Flow Simulation.
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patching_values

Temperature and pressure of multiple zones can be patched to specific values using the following
string. This term is present only for Cold Flow Simulation.

(("pressure" value (zone1 zone2...)))(("temperature" value (zone1
zone2...)))

post_planes

Lists the location and the name of the plane created for postprocessing the results, default planes
created and any planes you added after decomposition. You can also add your planes here in the
file using the format given. Ensure that the plane name starts with "ice_user_plane_".

This takes input in the form of (("plane" (x y z) (x y z) (x y z)))

You can add a plane using IC_setting_manager. After decomposition this feature is created in
the Tree Outline. Right-click IC_setting_manager and select Insert and then New Plane from
the context menu. Ensure that the plane name starts with "ice_user_plane_". Click Generate
to complete the procedure.

If you would like to add a swirl plane for port flow simulation, follow the procedure of creating
a plane using the IC_setting_manager feature. Ensure that the name starts with
"ice_swirl_plane_".

Insert → New Plane

After you add the new planes using IC_setting_manager they are automatically added to the
icBcSettings.txt file under the tag of post_planes.

post_plane_images

This term has different formats depending on how you want the images captured.

post_plane_images (

• When you want only animation from the images and do not require a table, use the fol-
lowing format:

( (name "imagename1") (surfaces ("plane1" "inlet1" "outlet1")) (view "ice-plane1-view1") 
(quantities ("velocity-magnitude" "pressure")) (interval-tag ((start-CA 15) (end-CA 45) (frequency 2)) ) 
(anim-properties (animation? #t)) (table-properties (table? #f) (columns #f) (rows #f) (tag "")) )

• When you require an animation and also a table for some of the images, use the following
format:

( (name "imagename2") (surfaces ("plane1" "inlet1" "outlet1")) (view "ice-plane1-view1") 
(quantities ("velocity-magnitude" "pressure")) (interval-tag ((start-CA 15) (end-CA 45) (frequency 2)) ) 
(anim-properties (animation? #t)) (table-properties (table? #t)  (columns #3) (rows #5) (tag "")) )

• When you do not require an animation but a table for images taken in intervals so that
all images appear in the table, use the following format:
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( (name "imagename3") (surfaces ("plane1" "inlet1" "outlet1")) (view "ice-plane1-view1") 
(quantities ("velocity-magnitude" "pressure")) (interval-tag ((start-CA 15) (end-CA 45) (frequency 2)) ) 
(anim-properties (animation? #f)) (table-properties (table? #t) (columns #3) (rows #5) (tag "my-table-new")) )

• When the frequency is 0, only the last image of the simulation is captured. To arrange the
multiple images in a table use the following format:

( (name "imagename4") (surfaces ("plane1")) (view "ice-plane1-view1") (quantities ("velocity-magnitude")) 
(interval-tag ((start-CA #f) (end-CA #f) (frequency #f)) ) (anim-prperties (animation? #f) ) 
(table-properties (table? #t) (columns #3) (rows #5) (tag "my-table")) )

( (name "imagename5") (surfaces ("plane2")) (view "ice-plane1-view1") (quantities ("velocity-magnitude")) 
(interval-tag ((start-CA #f) (end-CA #f) (frequency #f)) ) (anim-prperties (animation? #f) ) 
(table-properties (table? #t) (columns #3) (rows #5) (tag "my-table")) )

• When you need just the images without any animation or the table, use the following
format:

( (name "imagename6") (surfaces ("plane2")) (view "ice-plane1-view1") 
(quantities ("velocity-magnitude" )) (interval-tag ((start-CA 0) (end-CA 360) (frequency 20)) ) 
(anim-prperties (animation? #f) ) (table-properties (table? #f) (columns #3) (rows #5) (tag "")) )

Note:

In this case the images are stored in the Report folder. The images will not
appear in the Report.html.

In the above formats there are different tags, like name, surfaces, view, interval-tag, and
so on. Each tag is explained in detail below.

name

The name given to each sublist of the post_plane_image list. Each list should be
named differently.

surfaces

These are the surfaces on which the images are displayed. You can choose multiple valid
surfaces as ("plane1" "inlet1" "outlet1") or any plane you have created.
Every image will contain all the surfaces you have entered. If you require a different image
for another surface then you should create a different sublist with a different name.

view

View is required to capture an image. So you have to specify at which view you want
the image captured. Some views are created by default, based on the number of
post_planes in the format of "plane_name-view". Apart from these views one
ice_iso_view is also created.
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quantities

You can specify any parameter for the contour you require, for example, velocity, temper-
ature, pressure, and so on. For every quantity one image will be captured on the number
of surfaces you have provided.

interval-tag

You can use this feature when you require images in between some crank angles. It gives
you the flexibility to specify the intervals and the frequency at which you require the
images.

The tags start-CA and end-CA are for transient solutions where crank angle is taken
as input. So in between the specified start-CA and end-CA images will be captured
at the specified frequency of crank angle. For example, if frequency is set to 2 then
images are captured at every 2 crank angles, from start-CA to end-CA.

For steady cases the tags are changed to start-iter and end-iter, where iteration
is taken as input. For a steady case you can give input as frequency only, and the rest
two tags can be set to #f. In this case the images will be captured at that frequency of
iterations, starting from the beginning of the solution. For example, if frequency is set
to 2 then images are captured at every 2 iterations.

anim-properties

If you require animation of some images you must provide the animation? tag as #t.
Then the animation of the images will be created in the report.

table-properties

Creates a table of the images captured. The table is created only when table? tag is
set to #t. You then have to mention the table size by providing values for columns and
rows tag.

tag is useful if you want only the final images of different surfaces in a single table. In
this case you have to provide the same tag to each sublist. The row and column numbers
of the first sublist of the same tag will be considered.

swirl_def

This term helps in monitoring swirl ratio on the swirl planes. This term is present only for Port
Flow Simulation. The swirl definition is as follows:

 =  x 

SN = [ ] * mass flow rate

where

 = angular momentum per unit mass

SN = swirl number

r = radial coordinate, (that is, facet center-swirl center)
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 = velocity

 = swirl axis

The swirl_def term is defined in the following way in the icBcSettings.txt file.

(
((name "swirl1")
(swirl-center ( X Y Z ))
(swirl-axis ( X1 Y1 Z1 ))
(function "(X1*am_x_swirl1) + (Y1*am_y_swirl1) + (Z1*am_z_swirl1)") )
)

Here a custom field function is created in Fluent with the name given for the name tag. swirl-
center signifies the location of swirl center, and swirl-axis signifies the direction of swirl
axis. function tag is used to create the custom field function using the corresponding formula.

Custom field functions with the names am_x_name, am_y_name, and am_z_name are created
automatically based on swirl-center. These terms are the components of the vector am. You
can use these terms and create any formula using the function tag.

If you would like to add a swirl plane for port flow simulation, use the feature IC_setting_manager.
After decomposition this feature is created in the Tree Outline. Right-click IC_setting_manager
and select Insert and then New Plane from the context menu. Ensure that the plane name starts
with "ice_swirl_plane_". Click Generate to complete the procedure.

IC_setting_manager Insert New Plane

After you add the new planes using IC_setting_manager they are automatically added to the
icBcSettings.txt file under the tag of post_planes and the custom field function is also
automatically added under the swirl_def tag.

monitor_def

Defines the default monitors.

("Name of the monitor" "Monitor Type" "Report Type" "Field Variable"
(Cell Zones))

The Monitor Type can be volume for Volume Monitor or surface for Surface Monitor.

For volume monitor the Report Type can be Volume-Average, Volume, Sum, Max, Min,
Volume-Integral, Mass Integral, or Mass Average.

For surface monitor the Report Type can be Integral, Standard Deviation, Flow
Rate, Mass Flow Rate, Volume Flow Rate, Area-Weighted Average, Mass-
Weighted Average, Sum, Uniformity Index - Mass Weighted, Uniformity Index
- Area Weighted, Facet Average, Facet Minimum, Facet Maximum, Vertex Aver-
age, Vertex Minimum, or Vertex Maximum.

You can choose the field you want to monitor by entering it for Field Variable.

You can also choose the zone you want to monitor by entering it for (Cell Zones).
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In the example here, the first monitor name is vol-avg-pressure-mon. The Monitor Type
is volume (Volume Monitor). The Report Type chosen is Volume-Average and the Field
Variable is pressure. The Cell Zones on which the variable is monitored are fluid-ch
fluid-piston-layer.

swirl_data

term helps in plotting swirl ratio as a function of CA. This term is present only for Cold Flow
Simulation.

(( 0 0 0 ) zone-name1 zone-name2)

Here ( 0 0 0 ) is the location of swirl axis. zone-name1 zone-name2 are the zones from
dynamic mesh zones where data is calculated.
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16.6.2. Format and Details of the Solver Settings File
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Format of Solver Settings File

The following table shows the format and details of each of the fields.

ValuesKeys

"combustion"solution-type

"full_eng_full_cycle"combustion_simulation_type

1800rpm

0.25crank_angle_step_size

0.045crank_radius

0piston_pin_offset

0.013piston_stroke_cutoff

0.144connecting_rod_length

0.0002min_valve_lift

#tauto_activate_deactivate

#tsymmetry_engine

#tice_mesh_topology
ice_mesh_topology

(0 1 0)symm_normal

(0 0.0002)point_on_symmetry

"h"hybrid/layering

nconf/nonconf

#fwithbowl

3piston_type

2no_of_valves

(0 0 1)cylinder_axis

(0 -0 0.011)cylinder_axis_origin

0.042cylinder_radius

0start_crank_angle

47insert_angle

313delete_angle

0.000930reference_mesh_size

((1 "invalve1" "invalve1" 323 563 0.015 (0
-0.24 0.97) (-0.02 -0.15 0.009) (smoothing

setup_valve_list

#t) (end-valve-open-smoothing 384.4 ) (be-
gin-valve-close-smoothing 528.7))

(2 "exvalve1" "exvalve1" 160 402 0.014
(-0 0.327 0.94) (-0.02 0.0197 0.0088)
(smoothing #t) (end-valve-open-smoothing
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185.3) (begin-valve-close-smoothing
365.4)) )

Note:

• The order of the keys is not important in the file.

• All the units are in SI.

Details of Fields

solution-type

is the type of simulation you have chosen. Here it is set to "combustion”.

combustion_simulation_type

is the sub type of combustion simulation you have chosen. Here it is set to "full_en-
gine_full_cycle”.

rpm

is the engine speed, which will be used along with crank angle step size to calculate the time
step size.

crank_angle_step_size

will be used to calculate the time step. 0.25 is a good default value.

∆t=θ/6N(RPM)

crank_radius

is the crank radius in meter when the piston is at the Bottom Dead Center (BDC) position.

piston_pin_offset

is piston offset value in meter.

piston_stroke_cutoff

is the distance till which the layering part of the mesh will move as a rigid body. After this
it will stop moving, but the piston head will continue to move until it reaches BDC. Thus the
layering process will begin from the cutoff distance. This is required to create a large enough
space in the upper part of the cylinder, that is meshed with tetrahedra. It ensures that the
valves can fully move in that zone and the smoothing and remeshing process can happen.
This value along with the value of min_valve_lift are used to control the actual values of
the valve lift and piston stroke, such that:

νlift = max (vc
lift, v

min
lift)
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ps = min (pc
s, p

min
s)

connecting_rod_length

is the length of the connecting rod in meters.

min_valve_lift

takes the floating numerical value of the minimum valve lift in meters. Fluent assumes that
once you have set up the mesh topology, the mesh topology is unchanged throughout the
entire simulation. Therefore, Fluent does not allow you to completely close the valves such
that the cells between the valve and the valve seat degenerate (become flat cells) when
these surfaces come in contact. (Removing these flat cells would require the creation of new
boundary face zones). To prevent this collapse, you need to define a minimum valve lift and
Fluent will automatically stop the motion of the valve when the valve lift is smaller than the
minimum valve lift value.

auto_activate_deactivate

is set to Boolean #t or #f. This will be used to deactivate some of the fluid zones which are
not part of the simulation.

symmetry_engine

will take the value #t or #f, depending on whether the engine has symmetry defined or
not.

ice_mesh_topology

will take the value #t if the mesh topology is the default ICE topology.

symm_normal

takes the format of (x y z). If symmetry is defined, you have to provide the normal at the
given point.

point_on_symmetry

takes the format of (x y z). If symmetry is defined, you have to provide a point on the
symmetry.

hybrid/layering

takes the input "h" or "l" with quotes. If you are opting for a hybrid mesh i.e. layering in
the valve region and combination of re-meshing and layering in the cylinder and dome region,
you need to set it as "h". If you are opting for a layered mesh in the valve, dome, and the
cylinder region, then you need to set it as "l".

conf/nonconf

takes the input "n" or “c” (with quotes) depending on whether the mesh has non conformal
interfaces ("n") or conformal ("c" ) interfaces.
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withbowl

takes the Boolean value #t or #f, and will be used to define proper interfaces.

piston_type

will be used in the case of a hybrid approach. It takes input 1 or 3. 1 is for straight valve, or
canted valve engine with chamber decomposition. 3 is used for straight or canted valve en-
gines, without chamber decomposition. In the case of layered approach this value will not
be used.

no_of_valves

is the number of valves in the setup valve list.

cylinder_axis

takes the input in the form of (x y z). It is the axis of the cylinder.

cylinder_axis_origin

takes the input in the form of (x y z). It signifies the point of origin of the cylinder axis.

cylinder_radius

is the radius of the cylinder in meters.

Values of cylinder axis, origin, and radius are used to define the rigid body motion for the
piston and also for remeshing of the dynamic cylinder zone.

start_crank_angle

is the angle at which decomposition takes place. It is set to 0 by default.

insert_angle

is used to insert an interior zone in case of canted or straight valve engines without chamber
decomposition. This is in the case where there is no initial layering zone.

delete_angle

is used to delete the interior zone inserted by the insert_angle.

reference_mesh_size

is a reference value. Some global and local mesh setting values are dependent on this term.
This term is used to set layering height for vlayer, ch-lower, and ch-valve bodies.

• For vlayer layer height is equal to (0.4 X reference_mesh_size).

• For ch-lower and ch-valve layer height is equal to (0.8 X reference_mesh_size).

setup_valve_list

contains all the information related to valve in the format shown.

589
Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Boundary Conditions, Monitor Settings and Solver Settings



((Valve-Index “Valve-Name” “Valve-Profile-Name” Valve-Open-Angle
Valve-Close-Angle (valve Axis vector) (Valve origin coordinates)
Variable-urf? Variable-timestep? (smoothing #t) (end-valve-open-
smoothing 384.4) (begin-valve-close-smoothing 528.7))(Valve-Index
……..))

If the field Variable-urf? is #t Fluent automatically increases and decreases the URF
(under relaxation factors) values of the flow.

Similarly if Variable-timestep is #t Fluent will modify the time step during valve
openings.

If smoothing is set to #t, solver will only do smoothing while valve is opening, till reaching
the crank angle end-valve-open-smoothing. (Here for the invalve you have set it to
384.4). Also solver will stop layering and start smoothing while closing the valve at begin-
valve-close-smoothing. (In this example it for the invalve it is set at 528.7 degrees).

16.7. Calculating Compression Ratio

The following procedure shows how the compression ratio for any engine is calculated internally in
this system.

Compression Ratio = Volume at BDC / Volume at TDC

Volume at BDC = Volume at TDC + Stroke Volume

Stroke Volume = (The projected area of the piston) X (The stroke length)

Volume at TDC = Volume calculated by DesignModeler at TDC + Correction Volume

Due to the minimum valve lift the valves are positioned inside the chamber. While calculating the
volume at TDC, the volume occupied by the valves is not included in the volume computation by
DesignModeler due to valve margin slice. Therefore correction is required for the calculation of the TDC
volume.
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Figure 16.19: Volume at TDC

Correction volume = (The projected area of the valve) X (The valve lift)

This is how the compression ratio is calculated.
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Appendix A. The Fluent Ribbon Tab Under Workbench

When Fluent is running within Workbench, the Fluent File ribbon tab is slightly different. The differences
are described in the sections that follow:

A.1. File/Refresh Input Data

A.2. File/Recorded Mesh Operations...

A.3. File/Save Project

A.4. File/Reload

A.5. File/Sync Workbench

A.6. File/Import/Mesh...

A.7. File/Import/Case...

A.8. File/Import/Data...

A.9. File/Import/Case and Data...

A.10. File/Export/...

A.11. File/EM Mapping/Volumetric Energy Source...

A.12. File/EM Mapping/Surface Energy Source...

A.13. File/Close Without Save

The common functionality for stand-alone Fluent is documented in the separate Fluent User’s Guide.

A.1. File/Refresh Input Data

The File/Refresh Input Data ribbon tab item allows you to refresh your Fluent input data from within
Fluent. This option is only enabled if new input data exists, or if a parameter value has changed. For
more information, see Refreshing Fluent Input Data (p. 59).

A.2. File/Recorded Mesh Operations...

The File/Recorded Mesh Operations ribbon tab item allows you to view common mesh manipulation
operations that you perform within Fluent while working in Workbench. For more information, see Re-
cording Mesh Manipulation Operations and Resolving Mesh Incompatibility in Fluent (p. 76).

A.3. File/Save Project

The File/Save Project ribbon tab item allows you to save your current Workbench project within Fluent,
along with your current Fluent case and/or data files. For more information, see Saving Your Work in
Fluent with Workbench (p. 41).
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A.4. File/Reload

The File/Reload ribbon tab item allows you to reload the Workbench project’s cell information into
Fluent. Available if the case or mesh information is present. For more information, see Reloading Data
and Synchronizing Fluent with Workbench (p. 60).

A.5. File/Sync Workbench

The File/Sync Workbench ribbon tab item allows you to synchronize recent changes in Fluent to the
corresponding Workbench project. Not available if the case or mesh information is not present. For
more information, see Reloading Data and Synchronizing Fluent with Workbench (p. 60).

A.6. File/Import/Mesh...

The File/Import/Mesh... ribbon tab item opens the Select File dialog box which allows you to select
the appropriate mesh file to be read. For more information see Importing Fluent files in Work-
bench (p. 49).

A.7. File/Import/Case...

The File/Import/Case... ribbon tab item is used to read in a Fluent case file (extension .cas.h5), or
a mesh file (extension .msh.h5, .msh, .grd, .MSH.h5, .MSH, or .GRD) that has been saved in the
native format for Fluent. See the  User's Guide for details.

The File/Import/Case... ribbon tab item opens the Select File dialog box which allows you to select
the appropriate file to be read. For more information see Importing Fluent files in Workbench (p. 49).

A.8. File/Import/Data...

The File/Import/Data... ribbon tab item is used to read in a Fluent data file (which has a .dat.h5
extension). This ribbon tab item will not be available until you read in a case or mesh file. See the sep-
arate Fluent User’s Guide for details.

The File/Import/Data... ribbon tab item opens the Select File dialog box which allows you to select
the appropriate file to be read. For more information see Importing Fluent files in Workbench (p. 49).

A.9. File/Import/Case and Data...

The File/Import/Case & Data... ribbon tab item is used to read in a Fluent case file and the corresponding
data file (for example, myfile.cas.h5 and myfile.dat.h5) together. See the separate Fluent User’s
Guide for details.

The File/Import/Case & Data... ribbon tab item opens the Select File dialog box which allows you to
select the appropriate files to be read. Select the appropriate case file, and the corresponding data file
(that is, the file having the same name with a .dat.h5 extension) will also be read in. For more inform-
ation see Importing Fluent files in Workbench (p. 49).

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.596

The Fluent Ribbon Tab Under Workbench



A.10. File/Export/...

When running under Workbench, several commands located under the Write option under the File
ribbon tab have been moved to the Export option under the File ribbon tab. The new commands are:

File → Export → Case

File → Export → Data

File → Export → Case & Data

File → Export → PDF

File → Export → ISAT Table

File → Export → Flamelet

File → Export → Surface Clusters

File → Export → Profile

File → Export → Boundary Mesh

These items are used when you want to manually export a file independent of the project. Files exported
in this way are not used by the project unless you later import them into a new system. When you use
an Export command, you can export the files to the location of your choice with a name of your choice.

There is no need to export files since Workbench always saves the files it needs automatically. These
export commands are provided for your convenience when you want to save a specific file for later
use.

A.11. File/EM Mapping/Volumetric Energy Source...

The File/EM Mapping/Volumetric Energy Source... ribbon tab item opens the Maxwell Mapping
Volumetric Dialog Box (p. 597).

A.11.1. Maxwell Mapping Volumetric Dialog Box

The Maxwell Mapping Volumetric dialog box allows you to map the volumetric loss results from
an Ansys Maxwell electromagnetic simulation onto the centroids of cell zones in the Fluent mesh as
a heat source.

See Performing Fluent and Maxwell Coupling in Workbench (p. 97) for details.
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Controls

Fluent Cell Zones

contains a list of cell zones from the Fluent mesh, onto which the loss information can be mapped.
For these zones, Fluent requests the heat source (loss) terms from Maxwell.

Transfer Definition

contains elements related to the transfer of data, including:

Solution

contains available solution sets. Since Maxwell may have multiple solutions, Fluent will request
the generated heat source data for the selected solution.

Frequency

(only available for steady simulations) contains available frequencies. Fluent will request that
Maxwell provide the heat source data for the selected frequency.

Start time

(only available for transient simulations) contains the simulation start time. Maxwell will request
to consider the selected time as the start time.

End time

(only available for transient simulations) contains the simulation end time. Maxwell will request
to consider the selected time as the end time.

A.12. File/EM Mapping/Surface Energy Source...

The File/EM Mapping/Surface Energy Source... ribbon tab item opens the Maxwell Mapping Surface
Dialog Box (p. 599).
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A.12.1. Maxwell Mapping Surface Dialog Box

The Maxwell Mapping Surface dialog box allows you to map the surface loss results from an Ansys
Maxwell electromagnetic simulation onto the faces of solid zones in the Fluent mesh as a heat source.

Note:

To import heat loss (source terms) for an interior zone, split the zone into wall and wall-
shadow. These face zones will then be available for Surface EM Mapping.

See Performing Fluent and Maxwell Coupling in Workbench (p. 97) for details.

Controls

Fluent Face Zones

contains a list of face zones (adjacent to the solid zones) from the Fluent mesh, onto which the
loss information can be mapped. For these zones, Fluent requests the heat source (loss) terms
from Maxwell.

Transfer Definition

contains elements related to the transfer of data, including:

Solution

contains available solution sets. Since Maxwell may have multiple solutions, Fluent will request
the generated heat source data for the selected solution.

Frequency

(only available for steady simulations) contains available frequencies. Fluent will request that
Maxwell provide the heat source data for the selected frequency.
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Start time

(only available for transient simulations) contains the simulation start time. Maxwell will request
to consider the selected time as the start time.

End time

(only available for transient simulations) contains the simulation end time. Maxwell will request
to consider the selected time as the end time.

A.13. File/Close Without Save

The File/Close Without Save ribbon tab item allows you to close Fluent without saving the most recent
changes. Not available if the case or mesh information is not present.
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Appendix B. The Fluent Meshing Menu under Workbench

When Fluent Meshing is running within Workbench, the Fluent Meshing File menu is slightly different
from stand-alone Fluent Meshing. The differences are described below:

B.1. File/Refresh Input Data

B.2. File/Save Project

B.3. File/Import

B.4. File/Export

B.5. File/Close Without Save

The common functionality for stand-alone Fluent Meshing is documented in the separate Fluent User's
Guide.

Note:

If you read a case file into Fluent Meshing and click Switch to Solution, only the mesh will
be transferred to the Fluent solver (no case settings).

B.1. File/Refresh Input Data

The File/Refresh Input Data menu command is similar to the File/Refresh Input Data ribbon tab
command in Fluent.  For details, see File/Refresh Input Data (p. 595).

B.2. File/Save Project

The File/Save Project menu command is similar to the File/Save Project ribbon tab command in Fluent.
For details, see File/Save Project (p. 595).

B.3. File/Import

The following commands found under the File/Read main menu item in stand-alone Fluent Meshing
have been moved to under the File/Import main menu item:

• File/Import/Mesh...

• File/Import/Case...

• File/Import/Boundary Mesh...

• File/Import/Size Fields...
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The File/Import commands enable you to import a previously generated mesh, case, boundary mesh,
or size fields file directly into Fluent Meshing. The action of these commands is identical to those in
stand-alone Fluent Meshing.

For more information, see Reading and Writing Files in the Fluent User's Guide.

B.4. File/Export

The following commands found under the File/Write main menu item in a stand-alone Fluent Meshing
have been moved to under the File/Export main menu item:

• File/Export/Mesh...

• File/Export/Case...

• File/Export/Boundaries…

• File/Export/Domains...

• File/Export/Size Fields...

You can use these commands when you want to manually export mesh, case, boundaries, domains or
size fields data into a file independent of the project. Files exported in this way are not used by the
project. Files created by the export commands could be imported into a new system. When you use
an Export command, you can specify the file name and file location.

There is no need to export files since Workbench always saves the files it needs automatically. These
export commands are provided for your convenience when you want to save a specific file for later
use.

For more information, see Reading and Writing Files in the Fluent User's Guide.

B.5. File/Close Without Save

The File/Close Without Save ribbon tab item allows you to close Fluent Meshing without saving the
most recent changes. Not available if the case or mesh information is not present.

Release 2021 R2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.602

The Fluent Meshing Menu under Workbench



Appendix C. The Workbench Tools Toolbar Commands

When Fluent is running within Workbench, the Workbench Tools toolbar is displayed in the editor
window.

The Workbench Tools toolbar provides direct access to general Workbench and Fluent functions from
within Fluent and allows you to quickly setup, update, and reset your case, define output parameters,
exchange data between Fluent and Workbench, and so on. You can hover over the toolbar icons to
display the function of the tools, as a tooltip.

Table 1: Workbench Tools Toolbar Commands

DescriptionCommandIcon

Contains an expandable list of the Mesh cell
commands. See Table 2: Mesh Cell Commands (p. 604)
for details.

Mesh Cell Commands
(Fluent Meshing mode)

Contains an expandable list of the Setup cell
commands. See Table 3: Setup Cell
Commands (p. 604) for details.

Setup Cell Commands

Contains an expandable list of the Solution cell
commands. See Table 4: Solution Cell
Commands (p. 604) for details.

Solution Cell Commands

Refreshes cell input data from upstream cells, and
refreshes properties and input parameters of the

Refresh input data of
Mesh/Setup/Solution

modified cell (Mesh, Setup and Solution). This
command is only enabled if new input data exists,
or if a parameter value has changed.

Note: If the input data for a Mesh cell of a Fluent
(with Fluent Meshing) system has changed when
the editor is in the solution mode, then on refresh,
the editor will switch to the meshing mode and
reread the mesh data from the Mesh cell.

Contains an expandable list of commands for
controlling the solution process. See Table 5: Update
Mesh/Setup/Solution (p. 605) for details.

Update Mesh/Setup/Solution

Synchronizes recent changes in Fluent to the
corresponding Workbench project.

Synchronize WB cell status

Opens the Parameter dialog box.Parameter System
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DescriptionCommandIcon

Opens the Recorded Mesh Operations and Incom-
ing Zones dialog box.

Recorded Mesh Operations

Table 2: Mesh Cell Commands

DescriptionCommand

Reloads the mesh file or, if the mesh file has not yet been
generated, re-imports available CAD files. Any unsaved changes
you may have previously made will be discarded.

Reload

Discards all unsaved changes and the current mesh in the editor
(Fluent Meshing) session, deletes the generated mesh file
associated with the Mesh cell, and re-imports available CAD files.

Clear Generated Data

Performs the same actions as the Clear Generated Data
command, and in addition, sets the Mesh cell property values to
their defaults.

Reset

Table 3: Setup Cell Commands

DescriptionCommand

Reads available input files (case, mesh, settings, and so on) into
the Setup cell and executes the recorded mesh operations (if

Reload

available). Any unsaved changes you may have previously made
will be discarded.

Discards all unsaved changes, deletes the name-Setup-Out-
put.cas.h5 file and generated mesh file associated with the

Clear Generated Data

Mesh cell, reads all available input files (case, mesh, settings, and
so on), and executes the available recorded mesh operations.

Discards any unsaved changes and recorded mesh operations,
deletes name-Setup-Output.cas.h5 file, sets the Setup cell

Reset

property values to their defaults, and reads the input files from
the upstream cells (if available).

Allows you to import previously saved settings files.Import Settings

Allows you to export a settings file (.set).Export Settings

Note: The exported settings file can become incompatible with
your case if the mesh has been modified either upstream or in
the Fluent editor.

Table 4: Solution Cell Commands

DescriptionCommand

Reloads the latest available solution (case/data) files from the
project directory. If a data file is not available, the case is initialized

Reload

using the specified method. Any unsaved changes you may have
previously made will be discarded.
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DescriptionCommand

Deletes all generated files and loads the input data (reads the
mesh/case files and initializes the case using the specified
method).

Clear Generated Data

Performs the same actions as the Clear Generated Data
command, and in addition, sets the Solution cell property values
to their defaults.

Reset

Table 5: Update Mesh/Setup/Solution

DescriptionCommand

Performs the calculation as specified in the case settings. Once
the calculation is complete, the state of the Solution cell becomes

Update

Up-To-Date. This command is available only if no calculation has
been performed yet.

Reinitializes the case using the selected initialization method and
then performs the calculation. This command allows you to re-run

Restart

the case after you have performed some iterations and changed
the settings for you case. This command is available only after
some calculations have been performed.

Continues the calculation from the current solution state until the
specified number of iterations or time steps is reached, or the

Continue

solution meets the convergence criteria. This command allows
you to continue your calculation after altering the case settings.
The changed settings will be saved for future calculations. This
command is available only after some calculations have been
performed.

Note:

• Any case modifications that you make after starting the
calculation will not be saved or recorded for future
calculations.

• For parametric studies, you can enable Automatically
Initialize and Modify Case in the Calculation Activities
task page in Fluent in order to automatically apply the
case modifications for each design point calculation.
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